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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

This guide provides detailed instructions on how to configure and 
administer the HP Business Availability Center platform.

This chapter includes:

 ➤  How This Guide Is Organized on page 11

 ➤  Who Should Read This Guide on page 12

 ➤  Getting More Information on page 12

How This Guide Is Organized

The guide contains the following parts:

 Part I Accessing and Navigating HP Business Availability Center

Describes the various options for logging into and accessing HP Business 
Availability Center and how to navigate among its applications and 
administration options. 

 Part II Setup and Maintenance

Describes how to download components, manage licenses, administrate the 
profile and management databases, enable data purging, configure the 
infrastructure settings, view the audit log, and monitor report schedules.
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 Part III Data Collection

Describes how to configure the settings and resources related to data 
collection, including upgrading and removing data collectors; scheduling 
downtime and events; filtering and removing transactions, locations, and 
groups; setting the order for transactions to run; adding and updating 
definitions of user-defined samples; and setting filters for report data.

 Part IV Managing Users

Describes how to create and manage users and user groups, the permissions 
that apply to them across the platform’s resources, and the customizations 
to set per user, including refresh interval, time zone, menus, and default 
pages. Also describes how to configure HP Business Availability Center to 
work with authentication strategies.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

Readers of this guide should be knowledgeable about enterprise system 
administration and highly knowledgeable about HP Business Availability 
Center.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the the HP Business Availability Center Deployment Guide PDF.



Part I

Accessing and Navigating HP Business
Availability Center
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1
Logging Into HP Business Availability 
Center

This chapter provides details on how to log into HP Business Availability 
Center.

This chapter includes:

Concepts

 ➤  Logging In and Out - Overview on page 16

 ➤  Logging Into HP Business Availability Center with Lightweight Single Sign-
On (LW-SSO) on page 16

 ➤  Advanced Login Options on page 17

 ➤  Linking to a Specific Page on page 18

 ➤  Using the JMX Console on page 19

 ➤  HP Business Availability Center Login Flow on page 21

Tasks

 ➤  Log In and Out on page 22

 ➤  Use Advanced Login Options on page 24

 ➤  Change the JMX Password on page 27

 ➤  Create a Keystore Certificate on page 28

Reference

 ➤  Security Notes and Precautions on page 29

 ➤  Logging Into HP Business Availability Center User Interface on page 30

Troubleshooting and Limitations on page 32
Concepts
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Logging In and Out - Overview

You access HP Business Availability Center using a supported Web browser, 
from any computer with a network connection (intranet or Internet) to the 
HP Business Availability Center servers. The level of access granted to a user 
depends on the user’s permissions. For details on granting user permissions, 
see “Assign Permissions” on page 392.

HP Business Availability Center is by default configured with Lightweight 
Single Sign-On (LW-SSO). LW-SSO enables you to log into HP Business 
Availability Center and automatically have access to other configured 
applications, without needing to log into those applications. For details on 
how LW-SSO affects logging into HP Business Availability Center, see 
“Logging Into HP Business Availability Center with Lightweight Single Sign-
On (LW-SSO)” on page 16.

For details on Web browser requirements, as well as minimum requirements 
to successfully view HP Business Availability Center, see “Reviewing System 
Requirements” in the HP Business Availability Center Deployment Guide PDF.

Note to HP Software-as-a-Service customers: You access HP Business 
Availability Center via the HP Software-as-a-Service support Web site 
(saas.hp.com).

Logging Into HP Business Availability Center with 
Lightweight Single Sign-On (LW-SSO)

When Lightweight Single Sign-On Authentication Support (LW-SSO) is 
enabled, you must ensure that the other applications in the Single Sign-On 
environment have LW-SSO enabled and are working with the same 
initString. 

If you do not require Single Sign-On for HP Business Availability Center, it is 
recommended that you disable LW-SSO. You can disable LW-SSO using one 
of the following utilities:
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➤ The Authentication Strategy Wizard. For details on using the 
Authentication Strategy Wizard, see “Authentication Wizard - Introduction 
Page” on page 500. 

➤ The JMX console. For details on disabling LW-SSO through the JMX console, 
see “Resetting LDAP/SSO Settings via the JMX Console” on page 37.

Once LW-SSO is disabled, the default HP Business Availability Center 
authentication service is automatically enabled. When either LW-SSO is 
disabled, or the Identity Management Single Sign-On (IDM-SSO) or 
Lightweight Directory Access Protocol (LDAP) authentication strategies are 
enabled, you do not need to enter the syntax .<domain_name> in the 
HP Business Availability Center login URL 
(http://<server_name>.<domain_name>/HPBAC).

For details on implementing either an IDM-SSO or LDAP authentication 
strategy, see “Authentication Wizard - Introduction Page” on page 500.

For details on the requirements for logging into HP Business Availability 
Center, see “Log In and Out” on page 22.

Advanced Login Options

Advanced login options enable you to automate login, provide direct login 
capabilities, limit login access, and link to a specific page in HP Business 
Availability Center. 

Advanced login options include:

➤ Automatic login. You can configure HP Business Availability Center so that 
after the initial login, you do not have to enter a login name and password, 
but instead, the default page that is set to open for the user opens 
automatically. For details, see “Use the Automatic Login URL Mechanism” 
on page 25.

➤ Direct login capabilities. You can guide another user to a specific target page 
in HP Business Availability Center. For details, see “Use the Link to This Page 
Option to Open a Specific Page” on page 26.
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➤ Limiting login access. You can limit the number of machines accessing 
HP Business Availability Center using the same login name. For details, see 
“Limit Access by Different Machines Using the Same Login Name” on 
page 26.

➤ Linking to specific pages. You can guide another user to a specific target 
page in HP Business Availability Center by creating a URL with a user name, 
password, and information about the target page. For details, see “Linking to 
a Specific Page” on page 18.

Linking to a Specific Page

You can guide another user to a specific target page in HP Business 
Availability Center by creating a URL with a user name, password, and 
information about the target page. 

Depending on how you use the Link to this page option, the receiver 
accesses the page using one of the following: 

➤ His own user name and password. 

➤ A URL encrypted with your user name and password. 

➤ A URL encrypted with another user’s user name and password. 

If using an encrypted URL, the receiver bypasses the HP Business Availability 
Center login page because the URL supplies the user name and password 
information.

The user name sent in the URL must be an account with sufficient privileges 
to access the target page. If the account does not have sufficient privileges, 
the receiver is sent to the page above the target page. 

For example, you want to direct the receiver to the Infrastructure Settings 
page, but you configure the Link to this page option selecting Use 
Credentials of a regular user (who is not authorized to view Infrastructure 
Settings). When the receiver uses this URL, he is sent to the Setup and 
Maintenance page and is unable to access Infrastructure Settings.
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The Link to this page option does not verify the user name and password 
sent in the URL. Verification is done only when the receiver tries to access 
the target page. If the user name and password are not correct, or the user 
account has been deleted, the receiver is sent to the HP Business Availability 
Center login page to log in normally. Once logged in, the receiver does not 
proceed to the target page. There is no informational message about the 
reason for the login failure.

For details on the user interface for the Link to this page option, see “Link to 
This Page Window” on page 31.

Using the JMX Console

The JMX console comes embedded in HP Business Availability Center, and 
enables you to perform management operations, view performance of 
processes, and troubleshoot problematic areas of HP Business Availability 
Center.

To access the JMX console, you must first enter the relevant URL 
(http://<Gateway or Data Processing server name>:8080/jmx-console/, 
where Gateway or Data Processing server name is the name of the machine 
on which HP Business Availability Center is running), and enter the JMX 
console authentication credentials, which by default are: 

Login name = admin

Password = admin

It is recommended that you change the JMX password to prevent 
unauthorized entry. For details on changing the JMX password, see “Change 
the JMX Password” on page 27.

Note: The login name cannot be changed.
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You can monitor the availability of your HP Business Availability Center 
system by accessing the following file, located on either the Gateway or 
Data Processing server: 

<HP Business Availability Center root 
directory>\AppServer\webapps\myStatus.war\myStatus.html

On a Windows operating system, this file is also accessible through the 
following Start Menu path: 

Start > Programs > HP Business Availability Center > Administration > 
HP Business Availability Center Server Status

You must enter your JMX username and password to access this page. 

You can configure the JMX console to work with SSL, to encrypt JMX data 
for added security. For details, see “Configuring the Application Server JMX 
Console to Work With SSL” of the HP Business Availability Center Hardening 
Guide PDF.
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HP Business Availability Center Login Flow

This section describes the general authentication flow in HP Business 
Availability Center:

➤ A user accesses the login page and enters a principal (login name) and 
credentials (password) and submits the login request (in this case, clicks Log 
In).

➤ The request is transferred to the HP Business Availability Center 
Authentication Manager together with the strategy name, principal, and 
credentials. You configure an authentication strategy in the Authentication 
Strategy wizard. For details, see “Authentication Wizard - Introduction Page” 
on page 500. 

➤ The Authentication Manager reads the strategy name and dispatches the 
request to the relevant authentication strategy to validate the user.

➤ The relevant authentication strategy accepts the request and tries to 
authenticate the user against the authentication service in question.

➤ If authentication is approved, HP Business Availability Center verifies the 
user according to the selected strategy.
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Note: When creating users in HP Business Availability Center, make sure 
that user names match the user names in the relevant strategy database. A 
user can not log into HP Business Availability Center if the name does not 
match.

➤ If the user passes the previous steps, they are considered an authenticated 
user. The HP Business Availability Center Site Map page is displayed in the 
Web browser (or whichever page has been defined as the default page).

If any of the steps fail, the user is notified (a page and error message are sent 
back to the Web browser). The page content and error message depend on 
which strategy you are implementing.

Tasks

Log In and Out

You log into HP Business Availability Center from the login page.

When you have completed your session, it is recommended that you log out 
to prevent unauthorized entry.

To access the HP Business Availability Center login page and log in:

 1 In a Web browser, enter the URL 
http://<server_name>.<domain_name>/HPBAC, where server_name is the 
name or IP address of the HP Business Availability Center Gateway server, 
and domain_name is the name of the user’s domain according to his 
network configuration. If there are multiple servers, or if HP Business 
Availability Center is deployed in a distributed architecture, specify the load 
balancer or Gateway server URL, as required.

 2 Enter the login parameters (login name and password) of a user defined in 
the HP Business Availability Center system, and click Log In. After logging 
in, the user name appears at the top right of the page, under the top menu 
bar. 

Initial access can be gained using the default superuser login parameters: 
Login Name=admin, Password=admin. 
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Important: 

➤ It is recommended that the system superuser change this password 
immediately to prevent unauthorized entry. For details on the user 
interface for changing the password, see “General Tab” on page 464.

➤ The login name cannot be changed.

For details on the user interface for creating users in the HP Business 
Availability Center system, see “Create User Dialog Box” on page 477.

For details on login authentication strategies that can be used in 
HP Business Availability Center, see “Authentication Strategies” on 
page 495.

For login troubleshooting information, see “Troubleshooting and 
Limitations” on page 32.

Note: For details on accessing HP Business Availability Center securely, see 
the HP Business Availability Center Hardening Guide PDF.

To log out of HP Business Availability Center:

Click Logout at the top of the page.

Note: Clicking Logout cancels the Automatic Login option. If a user has 
logged out, the next time the user logs in, the Login page opens and the user 
must enter a login name and password. This can be useful if another user 
must log in on the same machine using a different user name and password.
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Use Advanced Login Options

You can choose to enable advanced login options for HP Business 
Availability Center. For details, see “Advanced Login Options” on page 17.

This section includes the following topics:

➤ “Enable Automatic Login in the Login Page” on page 24

➤ “Use the Automatic Login URL Mechanism” on page 25

➤ “Use the Link to This Page Option to Open a Specific Page” on page 26

➤ “Limit Access by Different Machines Using the Same Login Name” on 
page 26

➤ “Open an Application Page Using a URL” on page 27

 1 Enable Automatic Login in the Login Page

To enable automatic login:

 a On the HP Business Availability Center login page, select the option to 
Remember my login name and password for 14 days. 

Important: This could be considered a security risk and should be used with 
caution.

 b When completing your session, close the browser window. Do not click 
Logout at the top of the page. 

Clicking Logout disables the automatic login option and requires the login 
name and password to be entered when again accessing HP Business 
Availability Center.

To modify automatic login settings:

 a Navigate to Admin > Platform > Setup and Maintenance > Infrastructure 
Settings. 



Chapter 1 • Logging Into HP Business Availability Center

25

 b Choose Foundations, and select Security. In this context, you can:

➤ customize the number of days to enable the option by editing the Days 
to remember login value to the desired number of days (the default 
value is 14).

➤ completely remove the automatic login option from appearing on the 
login page by setting the Enable automatic login value to false (the 
default value is true).

➤ configure the number of machines that can simultaneously access HP 
Business Availability Center using the same login name by configuring 
the Maximum machines per login name value (the default value is 0). 
A value of 0 means that the number of logins is unlimited.

For details on using the Infrastructure Settings page, see “Infrastructure 
Settings Manager Page” on page 147.

When automatic login is enabled from the login page and the user enters 
the URL to access HP Business Availability Center, 

➤ the login page does not open.

➤ the login name and password do not have to be entered.

➤ the default page that is set to open for the user opens automatically.

 2 Use the Automatic Login URL Mechanism
You can use a special URL, containing several parameters (including login 
name and password), to access HP Business Availability Center and 
automatically log in. 

Important: Though convenient, this method is not secure since the 
password is not encrypted in the URL.
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To access HP Business Availability Center and log in using the automatic 
login mechanism:

In a Web browser, enter the URL 
http://<server_name>.<domain_name>/<HP Business Availability Center 
root directory>/TopazSiteServlet?autologin=yes&strategy
Name=Topaz&requestType=login&userlogin=<loginname>&userpassword=
<password>&createSession=true, where:

➤ server_name represents the name of the HP Business Availability Center 
server

➤ domain_name represents the name of the user’s domain according to his 
network configuration

➤ loginname and userpassword represent the login name and password of a 
user defined in HP Business Availability Center

To enable direct entry to HP Business Availability Center, bookmark this 
URL.

 3 Use the Link to This Page Option to Open a Specific Page
Use the Link to this page option to guide another user to a specific target 
page in HP Business Availability Center. Link to this page creates a URL with 
a user name, password, and information about the target page.

Depending on how you configure the parameters in the Link to this page 
dialog box, the receiver accesses the target page using his own user name 
and password, or through a URL encrypted with either your user name and 
password or another user’s user name and password. You can send this URL 
by  email or SMS to another user. If accessing the page through an encrypted 
URL, the receiver bypasses the HP Business Availability Center login page 
because the URL supplies the user name and password information. For 
details, see “Link to This Page Window” on page 31.

 4 Limit Access by Different Machines Using the Same Login Name
HP Business Availability Center can be accessed using the same login name 
from different machines. The number of machines accessing HP Business 
Availability Center using the same login name can be limited using the 
Infrastructure Settings page.
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To modify the Maximum machines per login name value in Infrastructure 
Settings, select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Foundations, select Security, and locate the Maximum 
machines per login name entry. Modify the value to the number of 
machines you want to enable to access HP Business Availability Center using 
the same login name. The default value is zero (0), which enables limitless 
logins.

If the maximum value has been reached when a user tries to log into 
HP Business Availability Center, the user receives a login error message and 
is unable to log in.

For a limitation of this feature, see “Limiting Access by Different Machines 
Using the Same Login Name Limitation” on page 37.

 5 Open an Application Page Using a URL
You can open a specific HP Business Availability Center page directly in your 
browser by using a URL. For details, see “Create a URL for a Direct Link” on 
page 39.

Change the JMX Password

This task describes how to change the JMX password. 

To change the JMX password:

 1 Stop the HP Business Availability Center Gateway or Data Processing server.

 2 Run the appropriate file, depending on the operating system in use, on 
either the Gateway or Data Processing server: 

Operating System File Name

Windows <HP Business Availability Center root 
directory>\tools\jmx\changeCredentials.bat

Solaris <HP Business Availability Center root 
directory>\tools\jmx\changeCredentials.sh
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The Change Password dialog box opens, where you enter and confirm your 
new password. The password change is registered and encrypted in the 
following files, located on either the Gateway or Data Processing server:

➤ \<HP Business Availability Center root 
directory>\EJBContainer\server\mercury\conf\props\jmx-console-
users.properties

The syntax in this file appears as username=password. 

➤ \<HP Business Availability Center root directory>\conf\jmxsecurity.txt

The syntax in this file appears as username password. 

 3 Restart HP Business Availability Center.

Note: The login name cannot be changed.

Create a Keystore Certificate

This task describes how to create a keystore certificate if you do not already 
have one.

To create a keystore parameter:

 1 Open a cmd.exe window.

 2 Run the following command to generate the keystore file:

keytool -genkey -dname 
"CN=YourName,OU=yourDepartment,O=yourCompanyName,L=yourLocation,S
=yourState,C=yourCountryCode" -alias <youralias> -keypass changeit -keystore 
"<keystore location>" -storepass changeit -keyalg "RSA" -validity 360

For example: 

keytool -genkey -dname "CN=John Smith, OU=FND, O=HP, L=Los Angeles, 
ST=Unknown, C=USA" -alias john -keypass mypassword -keystore 
"D:\HPBAC\JRE\lib\security\cacerts" -storepass changeit -keyalg "RSA" -validity 
360
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 3 The keystore certificate is generated in the location you specified in the -
keystore parameter. 

 4 Restart HP Business Availability Center. 
Reference

Security Notes and Precautions

This section describes security notes and precautions to be aware of when 
using Direct Login to log into HP Business Availability Center:

➤ The user name and password in the URL are encrypted so that no login 
information is ever revealed. 

➤ Sending encrypted information by email still entails a security risk, since the 
mail system can be breached. If the email is intercepted, access to 
HP Business Availability Center is given to an unknown party.

➤ Do not use the URL from Direct Login as a link in any Web page.

➤ The receiver has all privileges of the user name he was given in the URL. 
Once the receiver accesses the target page, he can perform all actions 
permitted to that user name anywhere in HP Business Availability Center.
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Logging Into HP Business Availability Center User 
Interface

This section describes:

 ➤  HP Business Availability Center Login Page on page 30

 ➤  Link to This Page Window on page 31

HP Business Availability Center Login Page

The following elements are included:

Description Enables you to log in to HP Business Availability Center. 

To access: In a Web browser, enter the URL 
http://<server_name>.<domain_name>/<HP Business 
Availability Center root directory>, where server_name is 
the name or IP address of the HP Business Availability 
Center server, and domain_name is the name of the 
user’s domain according to his network configuration.

Important 
Information

If Lightweight Single Sign-On (LW-SSO) is disabled, you 
do not need to add the .<domain_name> syntax in the 
login URL. 

Included in Tasks “Log In and Out” on page 22

Useful Links “Logging Into HP Business Availability Center with 
Lightweight Single Sign-On (LW-SSO)” on page 16

GUI Element (A-Z) Description

Login Name Enter the relevant login name to access HP Business 
Availability Center. 
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Link to This Page Window

The following elements are included (listed alphabetically):

Password Enter the relevant password to access HP Business 
Availability Center. 

Remember my login 
name and password 
for 14 days

Select to enable HP Business Availability Center 
remember your login name and password for 14 days. 
Login credentials are automatically entered in future 
login sessions when this option is selected. 

Description Enables you to guide another user to a specific target 
page in HP Business Availability Center. 

To access: Select Admin > Link to this page.

Included in Tasks “Use Advanced Login Options” on page 24

Useful Links “Advanced Login Options” on page 17

“Create a URL for a Direct Link” in Model Management.

GUI Element (A-Z) Description

Cancel Click to cancel the Link to this page operation.

Confirm password Re-enter the password entered in the Password field.

Copy to Clipboard Click to copy the content of the Link field to the 
clipboard.

Create Link Click to create a URL for the user to enter into their 
browser and view the specified HP Business Availability 
Center page.

Note: If you select this option after selecting No 
Credentials, and you want to invoke the login URL on 
the same local machine you created it on, you must log 
out of HP Business Availability Center.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

Use the information below for troubleshooting information and limitations 
relating to logging into HP Business Availability Center. 

This section contains the following topics:

➤ “Login Troubleshooting” on page 33

➤ “Limiting Access by Different Machines Using the Same Login Name 
Limitation” on page 37

➤ “Configuring the JMX Console to Work with SSL Limitations” on page 37

➤ “Resetting LDAP/SSO Settings via the JMX Console” on page 37

Generate HTML Click to generate an HTML page for the specified 
HP Business Availability Center page.

Note: If you select this option after selecting No 
Credentials, and you want to invoke the login URL on 
the same local machine you created it on, you must log 
out of HP Business Availability Center.

Link The URL that the receiver uses to access the specified 
HP Business Availability Center page.

Login name The login name to be encrypted in the URL the receiver 
uses to access the specified page. This must be the login 
name of an actual user.

My credentials Select if the link is to be encrypted with your login 
name and password.

No credentials Select if the receiver uses his own login name and 
password to access the page specified in the link. 

Password The password to be encrypted in the URL the receiver 
uses to access the specified page. This must be the 
password of an actual user.

Use credentials Select if the link is to be encrypted with the login name 
and password of another user. 

GUI Element (A-Z) Description
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Login Troubleshooting
Reference the possible login failure causes using the error number shown in 
the error alert dialog box. For additional troubleshooting information, refer 
to the HP Software Self-solve knowledge base.

Error No. Problem/Possible Cause(s) Solution(s)

LI001 HP Business Availability Center 
failed to connect to the jboss 
application server running on 
the Gateway server. This may be 
due to:

➤ the jboss server being down

➤ problems with the 
HP Business Availability 
Center service

➤ the port required by the 
application server being used 
by another application

Solution 1: Close all applications 
on the Gateway server machine 
and restart the machine.

Solution 2: Ensure that there are 
no other running applications 
on the Gateway server machine 
that use this port (for example, 
applications that run from the 
Startup directory, another 
instance of jboss, an MSDE or 
Microsoft SQL Server, or any 
other process).

LI002 The jboss application server 
running on the Gateway server is 
not responding or is not 
installed correctly.

Restart the HP Business 
Availability Center application.

LI003 The management database is 
corrupted (for example, if a user 
record was accidentally deleted 
from the database).

Try logging in as a different user, 
or ask the HP Business 
Availability Center administrator 
to create a new user for you.

LI004 The connection between the 
Tomcat servlet engine and the 
jboss application server failed 
due to an RMI exception. This 
may be due to problems in RMI 
calls to jboss.

Ensure that none of the jboss 
ports are in use by another 
process. Also, ensure that the 
RMI ports are bound.

For details on ports, see “Bus 
Communication and Port 
Usage” in the HP Business 
Availability Center Deployment 
Guide PDF.
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LI005 The HP Business Availability 
Center login fails or hangs. This 
may be due to:

➤ an incorrect login 
name/password combination

➤ inability to connect to the 
management database

➤ current user does not have 
access rights to any profile

➤ authentication strategy has 
not been set/configured 
correctly

Solution 1: Ensure that you or 
the user enters a correct login 
name/password combination.

Solution 2: Ensure that the 
connection to the management 
database is healthy. To do so:

1. In the Web browser, type 
http://<Gateway or Data 
Processing server 
name>:8080/jmx-
console/index.html to connect 
to the JMX management 
console.

2. Click the link System > JMX 
MBeans > Topaz > 
Topaz:service=Connection Pool 
Information.

3. Locate java.lang.String 
showConfigurationSummary() 
and click the Invoke button.

4. In Active configurations in the 
Connection Factory, find the 
appropriate row for the 
management database.

5. Verify that columns Active 
Connection and/or Idle 
Connection have a value greater 
than 0 for the management 
database.

6. If there is a problem with the 
connection to the database, 
verify that the database machine 
is up and running; if required, 
rerun the Server and Database 
Configuration utility.

...cont’d

Error No. Problem/Possible Cause(s) Solution(s)
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LI005 
(cont’d)

The HP Business Availability 
Center login fails or hangs. 

Solution 3: Ensure that the user 
has appropriate permissions to 
access HP Business Availability 
Center. For details on user 
permissions, see “Permissions 
Overview” on page 371. 

Solution 4: Verify that an 
authentication strategy has been 
configured correctly. For details 
on authentication strategies, see 
“Authentication Strategies” on 
page 495.

LI006 The HP Business Availability 
Center login fails. This may be 
due to:

➤ incorrect cookie settings in 
the Web browser

➤ an unsupported character in 
the names of the machines 
running the HP Business 
Availability Center servers

Solution 1: Ensure that the client 
Web browser is set to accept 
cookies from HP Business 
Availability Center servers.

Solution 2: Ensure that there are 
no underscore characters (_) in 
the names of the machines 
running the HP Business 
Availability Center servers. If 
there are, either rename the 
server or use the server's IP 
address when accessing the 
machine. For example, to access 
HP Business Availability Center, 
use 
http://111.222.33.44/<HP Business 
Availability Center root directory> 
instead of 
http://my_server/<HP Business 
Availability Center root directory>

Error No. Problem/Possible Cause(s) Solution(s)
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LI007 The HP Business Availability 
Center login fails. This is because 
the maximum number has been 
reached of concurrent logins 
from different machines that 
access HP Business Availability 
Center using the same login 
name.

Solution 1: Log out of the 
instances of HP Business 
Availability Center that have 
logged in using the same login 
name from different machines. 
You can then retry logging in, if 
the maximum number has not 
been reached.

Solution 2: Log in using a 
different login name, if 
available.

Solution 3: The administrator 
can edit the Infrastructure 
Settings to remove the limitation 
or increase the maximum 
number of concurrent logins 
using the same login name from 
different machines. To edit this 
setting, select Admin > 
Platform > Setup and 
Maintenance > Infrastructure 
Settings, choose Foundations, 
select Security and locate the 
Maximum machines per login 
name entry in the Security - 
Login table. Modify the value as 
required. The default value is 0, 
which enables limitless logins.

Error No. Problem/Possible Cause(s) Solution(s)
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Limiting Access by Different Machines Using the Same 
Login Name Limitation
In certain network configurations where multiple clients are funneled 
through a default Gateway or Proxy server, the IP resolved to HP Business 
Availability Center is that of the Gateway or Proxy server and not the IP of 
the client. As a result, HP Business Availability Center treats each client as 
coming from the same IP. Since the number of logins from the same 
machine (IP) is not limited, all of the clients can login to HP Business 
Availability Center, even though they originate from different IPs.

Configuring the JMX Console to Work with SSL 
Limitations
After configuring the JMX Console to work with SSL, it is not possible to 
access the \<HP Business Availability Center root 
directory>\AppServer\webapps\myStatus.war\myStatus.html page to view 
the availability of HP Business Availability Center. 

Resetting LDAP/SSO Settings via the JMX Console
If your LDAP or SSO settings have not been configured properly, you may be 
prevented from accessing HP Business Availability Center. If this happens, 
you must reset your LDAP or SSO settings remotely via the JMX console in 
the Application server that comes with HP Business Availability Center:

To reset LDAP/SSO settings via the JMX console:

 1 Enter the URL of the JMX console (http://<Gateway or Data Processing 
server name>:8080/jmx-console/) in a web browser.

 2 Enter your JMX console authentication credentials. If you do not know your 
authentication credentials, contact your system administrator.

 3 Modify the appropriate settings, depending on the authentication method 
you are resetting:

➤ To reset LDAP settings, modify the JMX settings as follows:

➤ Domain name: Foundations

➤ Service: users-remote-repository

➤ Method: RemoteUserRepositoryMode = Disabled
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➤ To reset SSO settings, modify the JMX settings as follows: 

➤ Domain name: Topaz

➤ Service: SSO

➤ Method: setSingleSignOnMode() = Disabled

When accessing the JMX console, you must enter the JMX authentication 
credentials, which by default are: 

Username: admin

Password: admin

You can change the authentication credentials by accessing the relevant 
properties files. For details on the files, see “Using the JMX Console” on 
page 19. 
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2
Create a URL for a Direct Link

This chapter provides information on how to create a URL that guides 
another user to a specific target view or CI in HP Business Availability 
Center, or embeds a UCMDB applet into an external application.

This chapter includes:

Concepts

 ➤  Generate a Direct Link – Overview on page 40

Tasks

 ➤  Generate a Direct Link — Scenario on page 41

Reference

 ➤  Generate Direct Link User Interface on page 42
Concepts
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Generate a Direct Link – Overview

You can create a URL that:

➤ Opens a specific HP Business Availability Center view or CI directly in 
HP Business Availability Center. This enables users to retrieve 
information from HP Business Availability Center without being located 
in the HP Business Availability Center context. 

Note: To open a specific view or CI directly in HP Business Availability 
Center, use the Open in context links option. For details, see “Select 
Command Page” on page 44.

➤ Enables integration with HP Business Availability Center:

➤ If you create a URL using the Embedded links option, the URL takes 
you first to the HP Business Availability Center login page. After you 
enter your login name and password, the target page opens in your 
browser.

Note: To open the target page in your browser, use the Embedded 
links option. For details, see “Select Command Page” on page 44.

➤ (Intended for integration developers only) You can directly embed a 
UCMDB applet into external applications. For details, see Embedded 
UCMDB Applets.

When you create a URL, you can:

➤ Send the URL to an email recipient

➤ Copy the URL to the clipboard

➤ Test the URL to ensure that the target application page can be found
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The user to whom you are sending the URL must have an account with 
sufficient privileges to open the target page. You must apply the appropriate 
viewing and editing permissions to the users and user groups that want to 
access the target view. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, see 
“Assign Permissions” in Platform Administration.

Note: You can use Link to this Page function to open a target HP Business 
Availability Center page in your browser. While the Link to this Page 
function enables you to access another application page in HP Business 
Availability Center, it does not enable you to access a specific CI or view. For 
details, see “Linking to a Specific Page” in Platform Administration.

Tasks

Generate a Direct Link — Scenario

This scenario describes how to generate a direct link to email the URL of a 
specific CI to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has 
encountered a problematic CI in a view she has created. She wants to inform 
Henry Jones, who is working with the same view through HP ServiceCenter, 
about the problematic CI. Since the view Jane has created contains many 
hundreds of CIs, she decides to email Henry the URL of the CI so that he 
does not have to spend a lot of time searching for that specific CI.

In IT Universe, Jane selects the Generate Direct Link wizard from the Edit 
menu. In the Select Command page, she selects the Show View option and 
clicks Next. 

In the Direct Link Parameters — Show View page, she selects the view she 
created, the problematic CI, and IT Universe as the mode in which Henry 
should open the CI. When the URL is created, she emails Henry the link to 
the problematic CI.
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For details on the Generate Direct Link wizard, see “Generate Direct Link 
Wizard” on page 43.

Reference

Generate Direct Link User Interface

This section describes:

 ➤  Generate Direct Link Dialog Box on page 42

 ➤  Generate Direct Link Wizard on page 43

Generate Direct Link Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Creates a URL to send to users so that they can access 
HP Business Availability Center.

To access: Click the Generate Direct Link to View button 
in:

➤ Admin > Universal CMDB > Modeling > IT Universe 
Manager

➤ Applications > Universal CMDB > Applications > 
Topology View

Included in Tasks “Generate a Direct Link — Scenario” on page 41

GUI Element (A-Z) Description

Advanced Enables you to build a direct link and choose specific 
elements such as views or CIs, for the end user to access. 
For details, see “Generate Direct Link Wizard” on 
page 43.

Copy URL Copies the URL to the clipboard.
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Generate Direct Link Wizard

Description Describes the parameters that are included in the URL. 
For details on selecting the parameters, see “Select 
Command Page” on page 44.

Link URL The created URL that accesses the specified HP Business 
Availability Center function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application 
page can be found.

Description Creates a URL that guides another user to a specific target 
view or CI in HP Business Availability Center, or embeds a 
UCMDB applet into an external application.

To access: Admin > Universal CMDB > Modeling > Edit > 
Generate Direct Link

Important 
Information

The Welcome page includes a Do not show this page 
again button.

GUI Element (A-Z) Description



Chapter 2 • Create a URL for a Direct Link

44

Select Command Page

Included in Tasks “Generate a Direct Link — Scenario” on page 41

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

Description Enables you to select the required parameters that must 
be added to the URL.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

For general information about the Generate Direct Link 
wizard, see “Generate Direct Link Wizard” on page 43.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected command.

Description A description of the selected command.
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Embedded links Creates a URL that enables you to embed a UCMDB 
applet into external applications. 

➤ Show impact map. Embeds an impact map into an 
external application. For details, see “Direct Link 
Parameters – Show Impact Map Page” on page 56.

➤ Show change report. Embeds a report displaying 
changes made to a specific CI into an external 
application. For details, see “Direct Link Parameters – 
Show Change Report Page” on page 49.

➤ CI type selector. Embeds the CI type selector into 
external applications. For details, see “Direct Link 
Parameters – CI Type Selector Page” on page 47.

➤ Show change report on view. Embeds a report 
displaying changes made to a specific view into an 
external application. For details, see “Direct Link 
Parameters – Show Change Report on View Page” on 
page 51.

➤ Show CI neighborhood. Embeds a topology map into 
an external application. For details, see “Direct Link 
Parameters – Show CI Neighborhood Page” on 
page 53.

➤ Show topology report. Embeds a Topology Report into 
an external application. For details, see “Direct Link 
Parameters – Show Topology Report Page” on page 60.

➤ Show instances grid. Displays all the CI instances 
found in the CMDB for a selected CI type and its 
children. For details, see “Direct Link Parameters – 
Show Instances Grid Page” on page 57.

➤ Show CI properties. Displays a CI’s properties. For 
details, see “Direct Link Parameters – Show CI 
Properties Page” on page 54.

➤ Show view topology. Displays the topology map of the 
selected view and embeds it in an external application. 
For details, see “Direct Link Parameters – Show View 
Topology Page” on page 63.

GUI Element (A-Z) Description
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Direct Link Parameters – CI Type Selector Page

Open in context links Creates a URL that guides another user to a specified 
application page without having to be in the HP Business 
Availability Center context:

➤ Show related CIs. Opens a topology map displaying 
the selected CI and its immediate neighbors within the 
selected view. For details, see “Direct Link Parameters – 
Show Related CIs Page” on page 59.

➤ Show view. Displays the selected view and optionally 
preselects a node in it. For details, see “Direct Link 
Parameters – Show View Page” on page 62.

➤ Start in mode. Opens HP Business Availability Center 
at the selected page. For details, see “Direct Link 
Parameters – Start in Mode Page” on page 65.

Steps The current step in the procedure.

Description Enables you to create a URL to a hierarchical tree or list of 
selected CI types, which you can embedded into an 
external application.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links “CI Type Manager” on page 315

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > 
(Direct Link Parameters – Show Change Report Page) > 
(Direct Link Parameters – Show Change Report on View 
Page) > (Direct Link Parameters – Show CI Neighborhood 
Page) > (Direct Link Parameters – Show CI Properties 
Page) > (Direct Link Parameters – Show Impact Map Page) 
> (Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

CI type selector 
mode

View the selected CI types in either a hierarchical tree or 
list.

Invisible CITs (tree 
only)

Select the CI types you do not want to appear in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types you want to appear in the tree.

➤ Click  to delete the selected CI types. 

Root CI Type (tree 
only)

Select the CI type you want to use as the root CI type in a 
hierarchical tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI type you want to use as the root CI type 
in the tree. 

➤ Click  to delete the selected CI type. The default is 
IT Universe.

Selection mode Allow single or multiple selection of CI types.
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Direct Link Parameters – Show Change Report Page

Unselectable CITs 
(tree only)

Select the CI types which cannot be selected in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which cannot be selected in the 
tree.

➤ Click  to delete the selected CI types. 

Visible CITs (list only) Select the CI types which you want to appear in the CI 
type list.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which you want to appear in the CI 
type list.

➤ Click  to delete the selected CI types. 

Note: If you choose to view the CITs in a list, then you 
are required to select at least one CI type.

Description Enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its 
children.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links ➤ “Change Report” on page 813

➤ “Working in Reports” in Reports

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.
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Direct Link Parameters – Show Change Report on View 
Page

Source CI object ID Enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its 
children.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” in Model Management.

➤ Click  to delete the value in the Source CI object ID 
box. 

Time range: Select a time range for which you want to view the 
report. For more information on defining a time period 
using the Time Range options, see “Generating Reports” 
in Reports.

Description Enables you to create a URL to a specific Change report 
that displays the changes made to a specific view.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links ➤ “Change Report” on page 813

➤ “Working in Reports” in Reports

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) 
> (Direct Link Parameters – Show CI Neighborhood Page) 
> (Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.

Selected view ➤ Click  to select the required view. Opens the Select 
View dialog box.

➤ Click  to delete the value in the Selected View box. 

Time range: Select a time range for which you want to view the 
report. For more information on defining a time period 
using the Time Range options, see “Generating Reports” 
in Reports.
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Direct Link Parameters – Show CI Neighborhood Page

Description Enables you to embed into an external application, a 
topology map that displays a specific CI, and all the CIs 
that are linked to it by a distance of no more than one 
relationship.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood 
Page) > (Direct Link Parameters – Show CI Properties 
Page) > (Direct Link Parameters – Show Impact Map Page) 
> (Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters – Show CI Properties Page

GUI Element (A-Z) Description

Restrict results to CI 
types

Restrict the results of the topology map to related CIs of 
one or more CI types.

➤ Click  to select the required CI types. Opens the CI 
Type Selector dialog box.

➤ Click  to delete the value in the Restrict results to 
CI types box. 

Restrict results to 
view

Restrict the results of the topology map to related CIs 
from a specific view.

➤ Click  to select the required view. Opens the Select 
View dialog box.

➤ Click  to delete the selected view in the Restrict 
results to view box.

Source CI Select the CI whose related CIs you want to display in an 
embedded topology map.

➤ Click  to select the required CI and retrieve its 
object ID. Opens the Select Source CI dialog box. For 
details, see “View Explorer” in Model Management.

➤ Click  to delete the value in the Source CI box. 

Description Enables you to view basic information for an existing CI. 

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links “Configuration Item Properties Dialog Box” on page 83

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

Source CI object ID Select the required CI.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” in Model Management.

➤ Click  to delete the value in the Source CI object ID 
box. 



Chapter 2 • Create a URL for a Direct Link

56

Direct Link Parameters – Show Impact Map Page

Description Enables you to run a Correlation rule defined in 
Correlation Manager.

The URL you create enables you to embed a topology 
map showing a simulation of all the CIs that are affected 
by the selected trigger CI for the selected severity and 
state.

For details, see “Run Correlation Dialog Box” in Model 
Management.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Useful Links “Topology View Application” on page 729

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters – Show Instances Grid Page

GUI Element (A-Z) Description

State and Trigger 
Severity

➤ Click  to select the required severity and state. 
Opens the Correlation State and Trigger Severity dialog 
box. For details, see “Run Correlation Dialog Box” on 
page 742.

➤ Click  to delete the selected severity and state. 

Trigger CIs Click  to select the CIs that represent the simulated 
changes to be made to the system. Opens the Select CIs 
dialog box. For details, see “Select CIs Dialog Box” on 
page 66.

Description Display all of the CI instances found in the CMDB for 
selected CI type, and its children.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links “Element Instances Dialog Box” on page 544

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page

GUI Element (A-Z) Description

CI type Select the required CI type.

➤ Click  to select the required CI type. Opens the CI 
Type Selector dialog box.

➤ Click  to delete the CI type. 
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Direct Link Parameters – Show Related CIs Page

Description Enables you to create a URL to a topology map displaying 
the related CIs of the selected (source) CI. The topology 
map opens in either Topology view or IT Universe.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters – Show Topology Report Page

GUI Element (A-Z) Description

Initial mode Displays the related CIs in either Topology Map or 
IT Universe.

Source CI object ID The object ID of the source CI.

Select the (source) CI whose related CIs you want to 
display in a topology map.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” in Model Management.

➤ Click  to delete the value in the Source CI object ID 
box. 

Description Enables you to create a URL to a specific Topology report. 

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links ➤ “Topology Report” on page 823

➤ “Working in Reports” in Reports

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) 
> (Direct Link Parameters – Show View Page) > (Direct 
Link Parameters – Show View Topology Page) > (Direct 
Link Parameters – Start in Mode Page) > (Select CIs Dialog 
Box) > (Correlation State and Trigger Severity Dialog Box) 
> Finish Page

GUI Element (A-Z) Description

Report name Select the required Topology report.

➤ Click  to select the required Topology report. 
Opens the Reports Tree dialog box.

➤ Click  to delete the value that appears in the 
Report name box. 
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Direct Link Parameters – Show View Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a URL to a specific view and 
optionally select a specific node in that view. When the 
view opens, the CI you chose is selected in the view.

Note: The view opens in either Topology view or 
IT Universe.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct 
Link Parameters – Show View Topology Page) > (Direct 
Link Parameters – Start in Mode Page) > (Select CIs Dialog 
Box) > (Correlation State and Trigger Severity Dialog Box) 
> Finish Page

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected option.

Initial mode Displays the view in either Topology Map or IT Universe.
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Direct Link Parameters – Show View Topology Page

Selected View The target view to be opened by the URL.

➤ Click  to select the target view to be opened by the 
URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

Select CI from view 
result

(Optional) Click to select a CI and retrieve its object ID. 
When the view opens, the CI you chose is selected in the 
view.

➤ Click  to choose the CI you want selected in the 
target view and retrieve its object ID. Opens the Select 
Source CI dialog box. For details, see “View Explorer” 
in Model Management.

➤ Click  to delete the object ID for the selected CI in 
the Select CI from view result box.

View mode The view options are:

➤ View Topology. Displays an entire layer within a view.

➤ Related in View. Displays the selected CI and its 
immediate neighbors within the current view.

➤ Related in DB. Displays the selected CI and its 
immediate neighbors in the CMDB.

Description Enables you to display the topology map of the selected 
view and embed it in an external application.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct 
Link Parameters – Show View Topology Page) > (Direct 
Link Parameters – Start in Mode Page) > (Select CIs Dialog 
Box) > (Correlation State and Trigger Severity Dialog Box) 
> Finish Page

GUI Element (A-Z) Description

Selected View ➤ Click  to select the required view to be opened by 
the URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.
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Direct Link Parameters – Start in Mode Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Starts the UCMDB application at the selected page, for 
example, at the Modeling Studio page.

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog 
Box) > (Correlation State and Trigger Severity Dialog Box) 
> Finish Page

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the UCMDB application in the selected mode.
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Select CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the required CIs. 

Important 
Information

➤ For general information about the Generate Direct 
Link wizard, see “Generate Direct Link Wizard” on 
page 43.

➤ Click Finish to close the wizard and create a URL. For 
details, see “Generate Direct Link Dialog Box” on 
page 42.

➤ For details on the CI Selector, see “View Explorer” in 
Model Management.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog 
Box) > (Correlation State and Trigger Severity Dialog Box) 
> Finish Page

GUI Element (A-Z) Description

Moves the selected CI in the CI Selector pane to the 
Trigger CIs pane.

Moves the selected CI in the Trigger CIs pane to the CI 
Selector pane.
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Moves all the CIs in the Trigger CIs pane to the CI 
Selector pane.

CI Selector pane Enables you to choose the CIs to be used as the trigger in 
an impact map.

➤ Select the Browse Views tab to search for and display a 
view, and browse through the view to locate a 
particular CI.

➤ Select the Search CIs tab to search for and display a 
view, and browse through the view to locate a 
particular CI. 

For details on how to use the CI Selector pane, see “View 
Explorer” in Model Management. 

Trigger CIs pane The CIs that are used as the triggers in an impact map.

GUI Element (A-Z) Description
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Correlation State and Trigger Severity Dialog Box

Description Enables you to select the required severity and state to 
display in the requested impact map. For details, see the 
“Run Correlation Dialog Box” in Model Management.

To access: 

➤ From the Direct Links wizard: Select Admin > Universal 
CMDB > Modeling > <TQL editor> > Edit > Direct Links 
Wizard > Select command > Embedded links > Show 
impact map. Next, click the Edit button in the State 
and Trigger Severity box.

➤ From the Show CI Instances report: Select Application 
> Overview Reports. Select the relevant report and 
drill down to the Show CI Instances report. In the 
report, select Display Label. Right-click a node and 
select Show Impact Map.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Finish Page

GUI Element (A-Z) Description

Correlation State Select the required State. For details about States, see 
“State Manager” in Model Management.

Correlation Trigger 
Severity

Select the required severity. 

Note: The severity list was defined for the state in the 
System Type Manager. For details, see “System Type 
Manager” in Model Management.

For example, you can create a Correlation rule in the 
Correlation Manager (see the “Correlation Definition 
Dialog Box” in Model Management), that defines the 
severity of the trigger node as other than No Change. If 
you select a severity other than No Change, for example, 
Plan, the condition is met and the simulated changes in 
the system are triggered.

Description This is the final page of the Generate Direct Link wizard. 
Click Finish to close the wizard and create a URL. Opens 
the Generate Direct Link dialog box.
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Important 
Information

For general information about the Generate Direct Link 
wizard, see “Generate Direct Link Wizard” on page 43.

Wizard Map The Generate Direct Link wizard contains:

Generate Direct Link Wizard > Select Command Page > 
(Direct Link Parameters – CI Type Selector Page) > (Direct 
Link Parameters – Show Change Report Page) > (Direct 
Link Parameters – Show Change Report on View Page) > 
(Direct Link Parameters – Show CI Neighborhood Page) > 
(Direct Link Parameters – Show CI Properties Page) > 
(Direct Link Parameters – Show Impact Map Page) > 
(Direct Link Parameters – Show Instances Grid Page) > 
(Direct Link Parameters – Show Related CIs Page) > 
(Direct Link Parameters – Show Topology Report Page) > 
(Direct Link Parameters – Show View Page) > (Direct Link 
Parameters – Show View Topology Page) > (Direct Link 
Parameters – Start in Mode Page) > (Select CIs Dialog Box) 
> (Correlation State and Trigger Severity Dialog Box) > 
Finish Page



71

3
Navigating HP Business Availability 
Center 

This chapter provides details on how to navigate HP Business Availability 
Center.

This chapter includes:

Concepts

 ➤  Navigating HP Business Availability Center on page 72

 ➤  Working with the HP Business Availability Center Documentation Library 
on page 75

Reference

 ➤  Menus and Options on page 78
Concepts
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Navigating HP Business Availability Center

HP Business Availability Center runs in a Web browser. You move around 
HP Business Availability Center using the following navigation functions:

➤ Site Map. Enables quick access to all top-level contexts in the Applications 
menu or the Administration Console. The Site Map is the first page that 
opens, by default, after logging into HP Business Availability Center. If the 
default page is changed after login, you can access the Site Map by clicking 
the Site Map link, either on the top menu or from the Help menu.

➤ Menu bar. Enables navigation to the applications, Administration Console 
pages, help resources, and a link to the site map.  

Additionally, there is a Logout button on the top right corner of the page.
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➤ Tabs. Enable navigation to various contexts within a particular area of 
HP Business Availability Center, such as to different types of reports within 
an application, different views within a report, or different administrative 
functions within the Administration Console. In certain contexts, tabs are 
used to distinguish between functions; in other contexts, tabs are used to 
group logically similar functions or features together.

➤ Tab main menus. Enable navigation from a tab front page to various 
contexts related to the tab. Tab main menus appear when selecting a tab 
that represents a category containing several contexts, such as report types 
or administrative settings. Tab main menus include a description and 
thumbnail image of each tab context.

➤ Tab controls. Assist in navigation from any context related to a tab to any 
other of the tab’s contexts. To open the tab main menu, click the tab name.
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To quickly jump to another context related to the tab, move your pointer 
over the tab and click the down arrow to open the tab dropdown menu. 
Click a tab menu option to move to that context.

➤ Breadcrumbs. Enable returning to previous pages within a multi-level 
context by clicking the appropriate page level. For example, in the following 
breadcrumb trail, you would click Breakdown Summary to return to the 
Breakdown Summary report:

Note: The Web browser Back function is not supported in HP Business 
Availability Center. Using the Back function does not always revert the 
current context to the previous context. To navigate to a previous context, 
use the breadcrumb function.
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Working with the HP Business Availability Center 
Documentation Library

The HP Business Availability Center Documentation Library is an integrated 
help system comprising all the guides contained in the end-user 
documentation set delivered with Business Availability Center. The sections 
below describe how to navigate and use the Documentation Library.

Navigating the Documentation Library
The Documentation Library can be navigated in the following ways:

➤ From the home page. To access the home page, select Documentation 
Library in the HP Business Availability Center Help menu. The home page 
can also be accessed by clicking the Home entry on the Contents tab of the 
Documentation Library Navigation Pane (described below) and by clicking 
the Home icon  located at the top of every content page.

The home page is divided into the following tabs:

➤ Main Topics tab. Organizes the various guides contained in the 
Documentation Library into logical sections.

➤ Get Started tab. Provides a checklist of major steps required to get up 
and running with HP Business Availability Center, and links to details for 
each step.

➤ PDFs tab. Organized similar to the Main Topics tab, but provides links to 
the guides in PDF format.

➤ From the Navigation pane. To access the navigation pane if it is not 
displayed, click the Show Navigation button.

The navigation pane is divided into the following tabs:

➤ Contents tab. The Contents tab organizes the various guides in a 
hierarchical tree, enabling direct navigation to a specific guide or topic.

➤ Index tab. The Index tab enables you to select a specific topic to display. 
Double-click the index entry to display the corresponding page. If your 
selection occurs in multiple documents, a dialog box is displayed 
enabling you to select a context.
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➤ Search tab. The Search tab enables you to search for specific topics or 
keywords. Results are returned in ranked order. You can limit your search 
to a specific guide or set of guides by selecting a value from the scope list.

➤ Favorites tab. The Favorites tab enables bookmarking specific pages for 
quick reference. Note that the Favorites tab is available only when using 
the Java implementation of the Documentation Library. If your browser 
does not support Java, the JavaScript implementation is automatically 
used and the Favorites tab is not displayed.

Documentation Library Functionality
The following functionality is available from the top frame in the 
Documentation Library main pane.

➤ Show Navigation button.  Click to display the navigation pane, which 
includes the Contents, Index, Search, and Favorites tabs. For details on the 
Navigation pane, see “Navigating the Documentation Library” on page 75. 
Note that this button is displayed only when the navigation pane is closed.

➤ Show in Contents button.  Click to open the table of contents in the 
Contents tab and highlight the entry corresponding to the currently 
displayed page. This button is displayed only when the navigation pane is 
open.

➤ Previous and Next buttons.  Click to move forward or backward in the guide 
currently displayed.

➤ Send Documentation Feedback to HP button.  Click to open your email 
client and send feedback to HP. An email message opens with the To and 
Subject fields already completed and a link to the current page in the 
message body. Make sure to complete the email by entering your feedback. 
Note that you must have an email client configured on the machine for this 
function to operate correctly.

➤ Print button.  Click to print the currently displayed page.



Chapter 3 • Navigating HP Business Availability Center

77

Organization of Information into Topics
The material in most of the Documentation Library guides is organized by 
topic types. Three main topic types are in use: Concepts, Tasks, and 
Reference. The topic types are differentiated visually using icons. Below is 
an explanation of each topic type along with its corresponding icon:

➤ Concepts.  Concept topics provide background, descriptive, or conceptual 
information. Read concept topics to get general information about what a 
feature does and how it works.

➤ Tasks.  Task topics provide step-by-step guidance on how to complete 
specific tasks that are typically required to administer or use the software. 
Task topics also include scenarios for certain tasks. Read task topics and 
follow the steps listed to get a task done.

➤ Reference.  Reference topics provide detailed lists and explanations of 
parameters, common user interface elements, and other reference-oriented 
material. Read reference topics when you need to look up some specific 
piece of reference information relevant to a particular context.

➤ User Interface.  User Interface topics are a specialized form of reference 
topics that are used mainly for context-sensitive help. Help links from the 
software generally open the user interface topics.

➤ Troubleshooting and Limitations.  Troubleshooting and limitations topics 
are a specialized form of reference topics that provide troubleshooting and 
list limitations of the feature. Read troubleshooting and limitations topics if 
you encounter unexpected behavior of the software. It is recommended that 
you review a feature’s limitations before using it.

Reference
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Menus and Options

The top menu bar enables navigation to the following applications and 
resources:

This section includes the following topics: 

➤ “Business User Applications” on page 78

➤ “Administration Console” on page 81

➤ “Help Menu” on page 83

Business User Applications
HP Business Availability Center features the business user applications listed 
below. You access all applications from the Applications menu, except for 
the My BSM application which is accessed from the top menu bar.

 Menu Option Description

My BSM Select to open the My BSM application, a portal that 
individual users can customize to display key 
content relevant to them. For details, see Using My 
BSM.

Dashboard Select to open the Dashboard application, a 
real-time dashboard for viewing performance and 
availability metrics from a business perspective. For 
details, see Using Dashboard.

Service Level 
Management

Select to open the Service Level Management 
application to proactively manage service levels 
from a business perspective. Service Level 
Management provides IT Operations teams and 
service providers with a tool to manage service 
levels and provide service level agreement (SLA) 
compliance reporting for complex business 
applications in distributed environments. For 
details, see Using Service Level Management.
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End User Management Select to open the End User Management 
application, used to monitor applications from the 
end user perspective and analyze the most probable 
cause of performance issues. For details, see Using 
End User Management.

Diagnostics Select to open the HP Diagnostics application (if a 
licensed version of HP Diagnostics is installed), to 
gain end-to-end visibility and comprehensive 
diagnostics for Java 2 Enterprise Edition (J2EE), 
.NET-connected, Siebel, SAP, Oracle, and other 
complex environments. For details, see the 
HP Diagnostics documentation accessed from the 
Help menu in HP Business Availability Center, or 
the HP Diagnostics documentation installed with 
the product.

Business Process Insight Select to view business processes and business 
process monitors, which enable you to visualize the 
health, performance, and effectiveness of your 
business processes. For details, see Using Business 
Process Insight.

TransactionVision Select to view transaction topology and 
infrastructure for data collection and report 
viewing. For details, see Using TransactionVision.

System Availability 
Management

Select to open the System Availability Management 
application, used for complete system and 
infrastructure monitoring as well as event 
management. For details, see Using System 
Availability Management.

Alerts Select to open the Alerts application to view CI 
Status Alert, SLA Alert, and Event-Based Alert 
reports. For details, see Alerts.

Problem Isolation Select to open the Problem Isolation application, 
used for triaging and isolating problematic CIs 
identified by HP Business Availability Center as well 
as for viewing and analyzing proactive analysis 
data. For details, see Using Problem Isolation.

 Menu Option Description
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User Reports Select to access the Report Manager and create and 
save user reports—customized reports containing 
user-defined data and formatting that can help you 
focus on specific aspects of your organization's 
application and infrastructure resource 
performance. For details on the Report Manager, see 
Reports.

Universal CMDB Select to open the HP Universal CMDB application, 
used to view a topology map of CIs, to compare CIs 
and views, to view reports about changes that occur 
in the CMDB, and to view overview reports. For 
details, see Model Management.

Business Availability 
Center for Siebel

Select to open HP Business Availability Center for 
Siebel Applications diagnostics tools. For details, see 
Solutions and Integrations.

Business Availability 
Center for SOA

Select to open HP Business Availability Center for 
SOA reports. For details, see Solutions and 
Integrations.

Performance and 
Availability Lifecycle

Select to open the Performance and Availability 
Lifecycle application, used to assist in constructing 
load tests based on real-user transaction data 
collected by the Real User Monitor. For details, see 
Solutions and Integrations.

 Menu Option Description
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Administration Console
Administrators use the Administration Console to administer the 
HP Business Availability Center platform and applications. The 
Administration Console consists of several sections, organized by function. 
You access each functional area from the Admin menu. You select from the 
following menu options:

Menu Option Description

My BSM Select to open the My BSM Administration pages, 
where you manage portal modules (including 
portlets), and set viewing permissions. For details, see 
Using My BSM.

Dashboard Select to open the Dashboard Administration pages, 
where you attach Key Performance Indicators (KPIs) to 
CIs, define the custom and geographical maps, and 
customize the repositories. For details, see Using 
Dashboard.

Service Level 
Management

Select to open the Service Level Management 
Administration pages, where you create service 
agreements (SLAs, OLAs, UCs) and build services that 
link to the data that Service Level Management 
collects. For details, see Using Service Level Management.

End User Management Select to open the End User Management 
Administration pages, where you configure and 
administer Business Process Monitor and Real User 
Monitor data collectors, as well as configure 
transaction order, color settings, and report filters. For 
details, see Using End User Management.

Diagnostics Select to open the HP Diagnostics configuration page, 
where licensed HP Diagnostics users connect to an 
installed Diagnostics server and configure 
HP Diagnostics. For details, see the HP Diagnostics 
documentation installed with the product.

Business Process Insight Select to create business processes and business process 
monitors, which enable you to visualize the health, 
performance, and effectiveness of your business 
processes. For details, see Using Business Process Insight.
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TransactionVision Select to set up and configure transactions for data 
collection and report viewing. For details, see Using 
TransactionVision.

System Availability 
Management

Select to open the System Availability Management 
Administration pages, where you configure and 
administer the SiteScope data collector. For details, see 
Using System Availability Management.

Alerts Select to open the Alerts Administration pages, where 
you configure alerts and system recipients. For details, 
see Alerts.

Problem Isolation Select to open the Problem Isolation Administration 
pages, where you configure on-demand monitors, 
problem suspects, and proactive analysis. For details, 
see Using Problem Isolation.

Universal CMDB Select to open the Universal CMDB Administration 
pages, where you build and manage a model of your IT 
universe in the CMDB. From Universal CMDB 
Administration, you manage Discovery and 
Dependency Mapping and the adapter sources that are 
used to populate the IT Universe model with 
configuration items (CIs), the templates for creating 
CIs, and the viewing system for viewing the CIs in 
HP Business Availability Center applications. You can 
also manually create CIs to add to the model. For 
details, see Model Management.

Business Availability 
Center for Siebel 
Administration

Select to open the Business Availability Center for 
Siebel Applications Administration page. For details, 
see Solutions and Integrations.

Platform Select to open the Platform Administration pages, 
which provide complete platform administration and 
configuration functionality. 

Menu Option Description
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Help Menu
You access the following online resources from the HP Business Availability 
Center Help menu:

➤ Help on this page. Opens the Documentation Library to the topic that 
describes the current page or context.

➤ Documentation Library. Opens the Documentation Library home page. The 
home page provides quick links to the main help topics.

➤ Diagnostics Help. Opens the HP Diagnostics Help, if an HP Diagnostics 
server is connected to HP Business Availability Center.

➤ Troubleshooting & Knowledge Base. Opens the HP Software Support Web 
Site directly to the troubleshooting landing page (required HP Passport 
login). The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp

EMS Integrations Select to open the EMS Integrations application, where 
you access out-of-the-box integrations 
(HP ServiceCenter, HP OVO, Netscout nGenius, and 
others) and customize the Integration Monitor 
configuration files to correctly map the data 
Integration Monitors collect to a format recognizable 
by HP Business Availability Center. For details, see 
Solutions and Integrations.

Link to this page Select to access the Link to this page feature, where 
you can create a URL that enables direct access to a 
specific page in HP Business Availability Center. For 
details, see “Link to This Page Window” on page 31.

Personal Settings Select to access the Personal Settings tab, which 
enables personalization of various aspects of 
HP Business Availability Center, including menus and 
passwords. Note that Personal Settings are available to 
all users.

Menu Option Description
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➤ HP Software Support. Opens the HP Software Support Web Site. This site 
enables you to browse the knowledge base and add your own articles, post 
to and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. The URL for this Web site is 
http://www.hp.com/go/hpsoftwaresupport

➤ HP Software Web Site. Opens the HP Software Web site, which contains 
information and resources about HP Software products and services. The 
URL for this Web site is http://www.hp.com/go/software

➤ Task Assistant. Opens the Task Assistant, which assists in accomplishing 
specific tasks by listing the task steps and providing links to the relevant 
Help topics for each step.

➤ Site Map. Opens the site map, which enables quick access to all top-level 
contexts in the Applications menu or the Administration Console.

Note: The Site Map is the default entry page when you log into HP Business 
Availability Center. Click Change the default page on the Site Map to open 
the Personal Settings tab and select a different entry page. For details on 
configuring Personal Settings, see “Personal Settings” on page 483. 

➤ What's New? Opens the What’s New document, which describes the new 
features and enhancements of the version.

➤ About HP Business Availability Center. Opens the About HP Business 
Availability Center dialog box, which provides version, license, patch, and 
third-party notice information.
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4
Downloads

This chapter provides details on downloading components to HP Business 
Availability Center, and updating license information.

This chapter includes:

Concepts

 ➤  Downloads Overview on page 87

Tasks

 ➤  Download Components on page 88

Reference

 ➤  Downloads User Interface on page 88
Concepts

Downloads Overview

Once the servers for HP Business Availability Center are installed, there are 
several components that must be downloaded. These components include 
tools for monitoring your enterprise and recording business processes. 

To view and download components from the Downloads page after 
installing HP Business Availability Center, you must install the data 
collector setup file. For details, see "Installing Component Setup Files" in the 
HP Business Availability Center Deployment Guide PDF.

Tasks



Chapter 4 • Downloads

88

Download Components

This task describes how to download components on the Download 
Components page:

To download components on the Download Components page:

 1 Click the component you want to download. 

 2 Save the component's setup file to your computer.

 3 Run the component's setup file to install the component.
Reference

Downloads User Interface

This section describes:

 ➤  Download Components Page on page 89
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Download Components Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Lists the HP Business Availability Center components 
available for download, including tools for monitoring 
your enterprise and recording business processes. 

To access: Select Admin > Platform > Setup and 
Maintenance > Downloads.

Important 
Information

➤ You can filter the downloadable components either 
by category or by system. 

➤ Since some files run immediately when you click to 
download them, right click the file you want to 
download, select Save Target As, and choose the 
location in which you want to save the file.

Useful Links “Downloads Overview” on page 87

GUI Element (A-Z) Description

Click to reset the table columns’ width to its default 
setting. You can adjust the width of the table’s columns 
by dragging the borders of the column to the right or the 
left.

Click the Select Columns button to open the Select 
Columns dialog box and select the columns you want to 
be displayed on the table. 

For details on the Select Columns dialog box, see 
“Working with Tables” in Reference Information.  

Divides the table of data into pages. You move from page 
to page by clicking the relevant button:

➤ To view more reports, click the Next page or Last page 
buttons.

➤ To view previous reports in the list, click the Previous 
page or First page buttons.
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Category The downloadable component’s category. Available 
categories are: 

➤ Business Process Insight. Downloadable files that 
enable you to install and run Business Process Insight 
components on HP Business Availability Center. 

➤ Business Process Monitor. Downloadable files that 
enable you to install and run Business Process Monitor 
components on HP Business Availability Center.

➤ Dashboard Ticker. The HP Dashboard Ticker 
downloadable file that enables you to install and run 
the Dashboard Ticker component on HP Business 
Availability Center. 

Note: The 7.50 version of the HP Dashboard Ticker is 
compatible with HP Business Availability Center 
version 8.00.

➤ Diagnostics. Downloadable files that enable you to 
install and run Diagnostics components.

➤ Discovery Probe. The Discovery Probe downloadable 
file that enables you to install and run the Discovery 
Probe component on HP Business Availability Center.

➤ Real User Monitor. Downloadable files that enable you 
to install and run Real User Monitor components.

➤ SiteScope. The SiteScope downloadable file that 
enables you to install and run SiteScope components.

Note: Ensure that you have selected the file that 
corresponds to the Operating System with which you 
are working.

➤ TransactionVision. Downloadable files that enable you 
to install and run TransactionVision components.

➤ TransactionVision or Diagnostics. Downloadable files 
that enable you to install and run the HP 
Diagnostics/TransactionVision Agent for Java file. 

➤ Yahoo! Widgets. Downloadable files that enable you 
to continuously monitor the operational status of your 
business, without having Business Availability Center 
Dashboard open on your screen.

Note: Ensure that you have selected the file that 
corresponds to the Operating System with which you 
are working.

GUI Element (A-Z) Description
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Description An explanation of the specific downloadable file.

Document A link to the PDF describing the component. 

Note: Not all components have a corresponding PDF 
document available.

File Name The name of the specific file available for download. 

System The operating system on which the HP Business 
Availability Center components are to run.

GUI Element (A-Z) Description
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5
Licenses

This chapter provides details on updating license information in 
HP Business Availability Center.

This chapter includes:

Concepts

 ➤  License Management Overview on page 93

Reference

 ➤  Licenses User Interface on page 95
Concepts

License Management Overview

HP Operations administers these pages and the interface is hidden from 
your view.

To run monitors and transactions, as well as use various integral 
applications in HP Business Availability Center, you must have a valid 
license key. 

The HP Business Availability Center license enables you to simultaneously 
run a predetermined number of monitors and transactions for a specified 
period of time. The number of monitors and transactions that you can run 
simultaneously, the specific applications that you can run, and the license 
key expiration date, all depend on the license your organization has 
purchased from HP.
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The initial license key is installed during the installation process. Do not use 
Platform Administration to install it. 

HP Business Availability Center posts a license expiration reminder on the 
login page of the Web site seven days before license expiration. To review 
the status of your maintenance number and license key, select Help > About 
HP Business Availability Center. 

A number of HP Business Availability Center applications require additional 
licensing. In order to use these applications, you must obtain an updated 
license key from HP and then update the license key in HP Business 
Availability Center. For more information on updating your license key, see 
“License Management Page” on page 95.

Reference
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Licenses User Interface

This section describes:

 ➤  License Management Page on page 95

License Management Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information on general license properties, 
Business Process Monitor and Script Assignment 
license and general information, and the license status 
of various HP Business Availability Center applications. 
Enables you to update your license key, as necessary.

To access: Select Admin > Platform > Setup and 
Maintenance > License Management

Important 
Information

➤ To review the status of your license key, select Help > 
About HP Business Availability Center.

➤ The maintenance number has no relevance to 
HP Business Availability Center 8.0x.

Useful Links “License Management Overview” on page 93

GUI Element (A–Z) Description

New License Key Click to update your license key.

New Maintenance 
Number

Click to update your maintenance number.

Note: The maintenance number has no relevance to 
HP Business Availability Center 8.0x.
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General License Properties Pane

Business Process Monitor Pane

Description Displays information on general license properties in 
HP Business Availability Center. The General License 
Properties pane provides the following information: 

➤ License Key

➤ License Host ID

➤ Maintenance Number

➤ License Type

➤ Expiration Date

To access: Select Admin > Platform > Setup and 
Maintenance > License Management

Useful Links “License Management Overview” on page 93

Description Displays license and general information on the 
Business Process Monitor data collectors installed in 
HP Business Availability Center. 

The Business Process Monitor pane provides the 
following information: 

➤ Allowed transactions. The maximum number of 
transactions allowed to run simultaneously under 
the current license key.

➤ Running transactions. The number of transactions 
currently running in all profiles.

➤ Total transactions. The total number of transactions 
currently configured in the database for all profiles 
(both running and stopped).

To access: Select Admin > Platform > Setup and 
Maintenance > License Management

Useful Links “License Management Overview” on page 93
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Operations Management Pane

Description Displays license information on the Operations 
Management Components installed in HP Business 
Availability Center. 

The Operations Management pane provides the 
following information: 

➤ Event Management Foundation 

➤ Topology Based Event Correlation 

➤ Health Perspective Views 

To access: Select Admin > Platform > Setup and 
Maintenance > License Management

Useful Links “License Management Overview” on page 93
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Applications Pane

Description Displays the validity of licenses for applications in 
HP Business Availability Center.

The Applications Pane displays the validity of the 
licenses for the following areas of HP Business 
Availability Center:

➤ Service Level Management

➤ End User Management

➤ Real User Monitor

➤ System Availability Management

➤ Business Availability Center for Siebel Applications

➤ Diagnostics

➤ Business Availability Center for SAP Applications

➤ Automatic Discovery

➤ Business Availability Center for SOA

➤ Problem Management

➤ Performance and Availability Lifecycle

➤ RUM for Generic TCP/IP Applications

To access: Select Admin > Platform > Setup and 
Maintenance > License Management

Useful Links “License Management Overview” on page 93
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6
Database Administration

You can maintain and administer the databases HP Business Availability 
Center uses to store profile and monitoring data. You can create and manage 
profile databases directly from the Platform Administration. You can also 
enable the Partition and Purging Manager to purge the data in the database 
periodically according to your organization’s needs.

This chapter includes:

Concepts

 ➤  Database Management - Overview on page 100

 ➤  Partitioning and Purging Historical Data from Profile Databases on page 102

 ➤  Removing Unwanted Data from the Profile Database on page 107

Tasks

 ➤  Configure a Profile Database on a Microsoft SQL Server on page 109

 ➤  Configure a User Schema on an Oracle Server on page 110

 ➤  Work with the Purging Manager on page 112

 ➤  Enable the Re-aggregation-Only Option on page 114

 ➤  Determine the Events Per Minute (EPM) for Data Arriving in HP Business 
Availability Center on page 115

 ➤  Customize Data Marking Utility Configurations on page 116

Reference

 ➤  Database Administration User Interface on page 117

Troubleshooting and Limitations on page 130
Concepts
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Database Management - Overview

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from your view.

Before you create profiles, you must configure the database into which you 
want profile data saved. A profile database can store data for multiple 
profiles, as well as from different types of profiles (Business Process Monitor, 
SiteScope). You can either create one database for all profile data or create 
dedicated databases (for example, for each profile type).

Note: The term database is used to refer to a database in Microsoft SQL 
server. The term user schema refers to a database in Oracle server.

HP Business Availability Center supports two database types:

➤ Microsoft SQL server. This database runs on Windows operating systems 
only. For details on how to configure a database on a Microsoft SQL server, 
see “Configure a Profile Database on a Microsoft SQL Server” on page 109.

➤ Oracle server. This database runs on any HP Business Availability Center 
supported operating system. An Oracle server database is referred to as a user 
schema. For details on how to configure a database on an Oracle server user 
schema, see “Configure a User Schema on an Oracle Server” on page 110. 

The Profile Database Management page, accessed from Admin > Platform > 
Setup and Maintenance, enables you to perform the following database 
management tasks:
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➤ Create a new database. HP Business Availability Center automatically 
creates a new database and populates it with profile tables.

➤ Assign a default profile database. You must assign a default profile database, 
to enable HP Business Availability Center to collect the following types of 
data:

➤ Service Level Management data

➤ SOA data

➤ data from Real User Monitor

➤ data used in Dashboard

➤ HP Diagnostics data

➤ persistent custom data

Note: The first database added on the Database Management page is 
automatically designated as the default profile database.

➤ Add profile tables to an existing, empty database. HP Business Availability 
Center connects to an empty database that was manually created on your 
database server, and populates it with profile tables.

➤ Connect to an existing database populated with profile tables. HP Business 
Availability Center connects to a profile database that was either manually 
created and populated with profile tables, or previously defined in Platform 
Administration.

To deploy profile databases on Microsoft SQL server or Oracle server for your 
organization’s particular environment, follow the instructions in 
“Introduction to Preparing the Database Environment” in the HP Business 
Availability Center Database Guide PDF. It is recommended that you review 
the relevant portions of the HP Business Availability Center Database Guide 
PDF before performing profile database management tasks.
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Partitioning and Purging Historical Data from Profile 
Databases

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from your view.

You use the Partition and Purging Managers to instruct the platform to 
automatically partition historical data for later removal from profile 
databases.

The data collection tables in the profile databases can grow to a very large 
size. Over time, this can severely degrade system performance. 

When enabled together, HP Business Availability Center’s Partition and 
Purging Manager splits fast-growing tables into partitions at defined time 
intervals. After a defined amount of time has elapsed, data in a partition is 
made inaccessible for use in HP Business Availability Center reports. After an 
additional defined amount of time, a partition is purged from the profile 
database.

Once enabled, the Partition and Purging Managers partition and later 
remove data according to the time period listed for the database table. The 
size of each partition is determined by the EPM (events per minute) value 
displayed on the Purging Manager page. The default EPM values are preset 
according to the appropriate level of the specified database table. 
Optionally, you may want to adjust the EPM value, if necessary:

➤ If data partitions are too large (accumulating much more than 1 million 
rows), raise the EPM value to create new partitions more frequently.

➤ If data partitions are too small (accumulating much less than 1 million 
rows), lower the EPM value to create new partitions less frequently.

Note: Partitions are utilized only if Native Partitioning is enabled. View 
Partitioning utilizes tables instead of partitions.
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HP Business Availability Center includes default time periods for keeping 
the data in each database table. After the retention time period set for each 
table has completed, the Purging Manager removes data that has been 
aggregated. 

You can also use the Partition and Purging Manager to set a specific time 
period—per table—for removing data. For details on the user interface for 
performing this task, see “Purging Manager Page” on page 127.

The Partition and Purging Manager runs every hour to check if a new data 
partition needs to be created. If you do not modify the default time period 
and the Partition and Purging Manager is enabled, data is removed 
according to the default range listed for each table. 

For guidelines and tips on using the Partition and Purging Manager, see 
“Guidelines and Tips for Using the Partition and Purging Manager” on 
page 106.

The Purging Manager page is divided into the following tabs: 

➤ Template and Multiple Databases. Used to modify the template 
configurations, as well as database configurations in multiple databases. Any 
databases added at a later time adopt the template configurations. 

Once you have made changes, the settings displayed in the Template and 
Multiple Databases tab remain the template settings, even if you did not 
make changes to the template and have manually changed settings for 
specific databases. Once those manual changes are applied, the settings 
displayed revert to the template settings. To see the settings you changed for 
specific databases, navigate to the Database Specific tab and select the 
appropriate database.

➤ Database Specific. Displays the configurations for the specified database.

For details on advanced partitioning and purging capabilities, see “Data 
Partitioning and Purging” in the HP Business Availability Center Database 
Guide PDF.
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Partitioning Types
The HP Business Availability Center Purging Manager supports the 
following partitioning types:

➤ Native Partitioning. Used by databases and user schema that enable 
partitioning and purging separately. In Native Partitioning databases, 
partitioning and purging are automatically enabled. These databases run 
based on the Enterprise template on the Template and Multiple Databases 
tab in the Purging Manager.

➤ View Partitioning. Used by databases and user schema that enable 
partitioning and purging together. HP strongly recommends that you enable 
the Partition and Purging Manager. These databases run based on the 
Standard template on the Template and Multiple Databases tab in the 
Partition and Purging Manager.

For details on partitioning and purging capabilities according to database 
type, see “Partitioning by Database Type” on page 105.
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Note: If there are no profile databases configured, the purging manager 
displays the template settings for the system (Enterprise or Standard), based 
on the template configured in the management database.

Partitioning by Database Type
Depending on the type of partitioning that is enabled, the Partition and 
Purging Manager can be used with profile databases located on specific 
database servers, as follows:

Database Server 
Type

View Partitioning Native Partitioning

Oracle Any Oracle server 
version supported by 
HP Business Availability 
Center

Any Oracle server 
version supported by 
HP Business Availability 
Center, except standard 
editions of each version

MS SQL ➤ MS SQL server 2000 
Standard Edition

➤ Microsoft SQL server 
2000 Enterprise 
editions (Microsoft 
SQL server 7.0 and 
MSDE are not 
supported)

Microsoft SQL server 
2005 Enterprise Edition
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Guidelines and Tips for Using the Partition and 
Purging Manager
This section contains guidelines and tips for using the Partition and Purging 
Manager.

➤ Prior to purging, the Partition and Purging Manager performs an additional 
check to ensure that raw data is not purged before it has been aggregated 
and reported to HP Business Availability Center. 

If a particular profile database’s data is scheduled for purging but its raw data 
has not yet been aggregated, the Partition and Purging Manager does not 
purge the data according to its schedule. The Partition and Purging Manager 
automatically purges the data on its next hourly run only after the data has 
been aggregated. 

For example, if data was scheduled to be purged on Sunday at 8:00 but its 
data is only aggregated on Sunday at 10:00, the Partition and Purging 
Manager checks the data at 8:00, does not purge the data, and automatically 
purges the data on its next hourly run only after Sunday at 10:00 once the 
data has been aggregated.

➤ If you find that data is not being purged according to the schedules set in 
the Partition and Purging Manager and your profile databases are growing 
too large, check that the aggregator is running properly and view the 
Partition and Purging Manager logs located on the Data Processing server at 
<HP Business Availability Center server root directory>/log/pmanager.log. 

HP Business Availability Center displays raw data only in the following 
contexts: SiteScope Warning Summary and SiteScope Error Summary 
reports, transaction breakdown data used in Trend reports, Service Level 
Management reports, Real User Monitor reports, and Excel reports that use 
raw data. 
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Because aggregated data is not used in these reports, if the raw data for a 
specific time period has been removed from the profile database using the 
Partition and Purging Manager, those reports do not contain any data when 
generated for that time period.

➤ The default configuration uses the following principle: the length of time 
that raw data is kept is shorter than the length of time that one-hour chunks 
of aggregated data are kept, which is shorter than the length of time that 
one-day chunks of aggregated data are kept.

➤ Any changes made under the Template and Multiple Databases tab affect 
the default time periods for new profile databases created in the system. If a 
new profile database is created after you have made modifications to the 
time periods under the Template and Multiple Databases tab, data is kept in 
the tables of that new profile database for the time periods now listed under 
Template and Multiple Databases for all tables. 

Removing Unwanted Data from the Profile Database

Note to HP Software-as-a-Service customers: This section is not relevant to 
HP Software-as-a-Service customers. 

The Data Marking utility enables HP Business Availability Center users with 
superuser security privileges to mark specific sets of data in profile databases 
as unwanted. This filters out unwanted data and enables HP Business 
Availability Center to display only the most relevant data for the specified 
time period. After the utility marks the specified data as unavailable, 
HP Business Availability Center automatically re-aggregates the remaining 
raw data for the selected time period. 

The Data Marking utility also enables removal of unwanted Business Process 
Monitor and SiteScope data. 
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After you mark a specific set of data from a given time period as unwanted, 
HP Business Availability Center reruns the aggregation process on remaining 
raw data for the relevant time period so that the marked data is not 
displayed. The Data Marking utility also enables you to re-aggregate a 
defined set of data without marking it as unavailable. For details, see 
“Enable the Re-aggregation-Only Option” on page 114.

During installation, HP Business Availability Center installs the Data 
Marking utility on the Gateway server. While the utility does not physically 
remove marked data from the database, it renders it unusable in reports and 
applications by assigning the marked data a status of unavailable in the 
database. 

The Data Marking utility supports partitions. Thus, users running the 
Partition and Purging Manager can also use the Data Marking utility.

Tasks
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Configure a Profile Database on a Microsoft SQL Server

This task describes how to configure one or more profile databases on a 
Microsoft SQL server.

This task includes the following steps:

➤ “Prerequisites” on page 109

➤ “Add a Database” on page 110

 1 Prerequisites
Before you begin, make sure that you have the following connection 
parameters to the database server:

 a Server name. The name of the machine on which a Microsoft SQL server 
is installed. If you are connecting to a non-default Microsoft SQL server 
instance in dynamic mode, enter the server name in the following 
format:

<host_name>\<instance_name>

 b Database user name and password. The user name and password of a 
user with administrative rights on a Microsoft SQL server (if using SQL 
server authentication).

 c Server port. The Microsoft SQL server’s TCP/IP port. The default port, 
1433, is automatically displayed. You must change the port number in 
one of the following instances:

➤ The default Microsoft SQL server instance listens to a port other than 
1433. 

➤ You connect to a non-default Microsoft SQL server instance in static 
mode.

➤ You connect to a non-default Microsoft SQL server instance in 
dynamic mode. In this case, enter port number 1434.

If required, consult with your organization’s DBA to obtain this 
information.
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 2 Add a Database

 a Access the Database Management page, located at Admin > Platform > 
Setup and Maintenance > Manage Profile Databases.

 b Select MS SQL from the dropdown list, and click Add.

 c Enter the parameters of your database on the Profile Database Properties 
- MS SQL Server page. For details on the Profile Database Properties - MS 
SQL Server page, see “Profile Database Properties - MS SQL Server Page” 
on page 122.

Configure a User Schema on an Oracle Server

This task describes how to configure one or more profile user schemas on 
your Oracle server.

This task includes the following steps:

➤ “Prerequisites” on page 110

➤ “Gather Connection Parameters” on page 111

➤ “Add a User Schema” on page 111

 1 Prerequisites
Before you begin, make sure that:

 a You have created a dedicated default tablespace for profile user schemas 
(and a dedicated temporary tablespace, if required).

 b You are using a secure network connection if you do not want to submit 
database administrator connection parameters over a non-secure 
connection. If you do not want to submit database administrator 
connection parameters via your Web browser at all, you can manually 
create profile user schemas and then connect to them from the Database 
Management page.
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 2 Gather Connection Parameters
Make sure that you have the following connection parameters to the 
database server:

 a Host name. The name of the machine on which the Oracle server is 
installed.

 b SID. The Oracle instance name that uniquely identifies the instance of 
the Oracle database being used, if different from the default value, orcl.

 c Port. The Oracle listener port, if different from the default value, 1521.

 d Database administrator user name and password. The name and 
password of a user with administrative permissions on the Oracle server. 
These parameters are used to create the HP Business Availability Center 
user, and are not stored in the system.

 e Default tablespace. The name of the dedicated default tablespace you 
created for profile user schemas (for details on creating a dedicated 
tablespace, see “Overview of Oracle Server Deployment” in the 
HP Business Availability Center Database Guide PDF). If you did not create, 
and do not require, a dedicated default tablespace, specify an alternate 
tablespace. The default Oracle tablespace is called users.

 f Temporary tablespace. The name of the dedicated temporary tablespace 
you created for profile user schemas. If you did not create, and do not 
require, a dedicated temporary tablespace, specify an alternate 
tablespace. The default Oracle temporary tablespace is called temp.

If required, consult with your organization’s database administrator to 
obtain this information.

 3 Add a User Schema

 a Access the Database Management page, located at Admin > Platform > 
Setup and Maintenance > Manage Profile Databases.

 b Select Oracle from the dropdown list, and click Add. 

 c Enter the parameters of your user schema on the Profile Database 
Properties - Oracle Server page. For details on the Profile Database 
Properties - Oracle Server page, see “Profile User Schema Properties - 
Oracle Server Page” on page 124.
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Work with the Purging Manager

This task describes how to work with the Purging Manager. 

This task includes the following topics: 

➤ “Prerequisites” on page 112

➤ “Change the Database Template” on page 112

➤ “Change Settings for Multiple Databases” on page 113

➤ “Change Settings for Individual Databases” on page 114

 1 Prerequisites
Ensure that you have at least one profile database configured in your 
HP Business Availability Center system. For details on configuring a profile 
database on a Microsoft SQL server, see “Configure a Profile Database on a 
Microsoft SQL Server” on page 109. 

For details on configuring a user schema on an Oracle server, see “Configure 
a User Schema on an Oracle Server” on page 110. 

 2 Change the Database Template
To change settings for the database template, follow these steps: 

 a Access the Template and Multiple Databases tab on the Purging Manager 
page. 

 b Select the checkbox next to the setting you want to change. You can 
select multiple checkboxes at once.

 c Modify the specified setting accordingly in the Keep Data for and 
Change to EPM fields, and click Apply.

 d Click the Apply to link and ensure that the appropriate template 
(Enterprise for Native Partitioning databases, or Standard for View 
Partitioning databases) is selected. 

 e Click OK to register your changes to the template. 
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Note: Once you have made changes, the settings displayed in the Template 
& Multiple Databases tab remain the template settings, even if you did not 
make changes to the template and have manually changed settings for 
specific databases. Once those manual changes are applied, the settings 
displayed revert to the template settings. To see the settings you changed for 
specific databases, navigate to the Database-Specific tab and select the 
appropriate database.

 3 Change Settings for Multiple Databases
To change settings for multiple databases at once, follow these steps: 

 a Access the Template and Multiple Databases tab on the Purging Manager 
page. 

 b Select the checkbox next to the setting you want to change. You can 
select multiple checkboxes at once.

 c Modify the specified setting accordingly in the Keep Data for and 
Change to EPM fields, and click Apply.

 d Click the Apply to link and ensure that the appropriate databases are 
selected. Clear the checkbox next to the template if you do not want 
your changes to apply to the template.

 e Click OK to register your changes to the selected databases. 

Note: Changes made to the databases are displayed only on the Database 
Specific tab, after the relevant database has been selected in the Select a 
profile database dropdown. 
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 4 Change Settings for Individual Databases
To change settings for individual databases, follow these steps:

 a Access the Database Specific tab on the Purging Manager page. 

 b Select the checkbox next to the settings you want to change.

 c Select the profile database that you want your changes to apply to in the 
Select a profile database field. 

 d Modify the specified setting accordingly in the Keep Data for and 
Change to EPM fields, and click Apply.

Enable the Re-aggregation-Only Option

By default, the Data Marking utility always runs the data marking process, 
followed by the re-aggregation process. If required, you can enable a feature 
that allows you to instruct HP Business Availability Center to run only re-
aggregation. This might be required if data marking passed successfully but 
re-aggregation failed. Alternatively, you can use this feature to re-aggregate a 
defined set of data without marking it as unavailable (for example, if data 
was aggregated and then late-arriving data was inserted into the raw data 
tables in the database).

To enable the re-aggregation-only option:

 1 Open the file <Gateway server root 
directory>\tools\dataMarking\dataMarking.bat in a text editor.

 2 Change the line:

SET ADD_OPTS=-Dflipper.logging.home=%PRODUCT_HOME_PATH%/log -
Dconfig=%PRODUCT_HOME_PATH%/conf

to

SET ADD_OPTS=-Dflipper.logging.home=%PRODUCT_HOME_PATH%/log -
Dconfig=%PRODUCT_HOME_PATH%/conf -DadvancedMode=true

 3 Save the file. The next time you open the Data Marking utility, the 
Advanced button appears.

After you enable this feature, you can instruct the Data Marking utility to 
only run the data re-aggregation process when clicking the Start button.
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To run data re-aggregation-only:

 1 Define the set of data you want to re-aggregate, as described in “Removing 
Unwanted Data from the Profile Database” on page 107.

 2 Click the Advanced button. The Advanced window opens.

 3 Select the Run re-aggregation-only checkbox.

 4 Select the categories of data for the re-aggregation and click OK to confirm 
selection.

 5 Click Start.

Determine the Events Per Minute (EPM) for Data 
Arriving in HP Business Availability Center

You can determine the amount of data per minute that is arriving in 
HP Business Availability Center. You enter this number in the Change to 
EPM box at the top of the Purging Manager page. 

To determine the Events Per Minute for the selected data type:

 1 Open the file located at: 

<Gateway server root 
directory>\log\mercury_db_loader\LoaderStatistics.log

 2 Locate the line in the select data sample that reads:

Statistics for: DB Name: <database name> Sample: <sample name> - 
(collected over <time period>):

 3 Locate the line in the statistics section of the data sample that reads: 

Insert to DB EPS (MainFlow)

The selected number represents the events per second. Multiply this number 
by 60 to retrieve the events per minute.

If you have more than one Gateway server, you must total the values 
obtained from each server.
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Customize Data Marking Utility Configurations

You can configure the maximum duration for each data marking run. The 
current default is 6 hours and 59 minutes.

To configure the maximum duration:

 1 Open the <Gateway server root 
directory>\tools\dataMarking\dataMarking.bat file in a text editor.

 2 Add the -DmaximumDuration=xx property to the command line, where 
<xx> represents the maximum duration in hours. 

For example, to change the maximum duration to 23 hours and 59 minutes, 
replace:

% _HOME%\JRE\bin\java -Dtopaz.home=%TOPAZ_HOME% -jar 
datamarking.jar 

with:

%TOPAZ_HOME%\JRE\bin\java -Dtopaz.home=%TOPAZ_HOME% -
DmaximumDuration=24 -jar datamarking.jar

 3 Save and close the file.
Reference
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Database Administration User Interface

This section describes:

 ➤  Database Management Page on page 117

 ➤  Data Marking Utility Page on page 119

 ➤  Profile Database Properties - MS SQL Server Page on page 122

 ➤  Profile User Schema Properties - Oracle Server Page on page 124

 ➤  Purging Manager Page on page 127

Database Management Page

Description Enables you to maintain and administer the databases 
HP Business Availability Center uses to store profile 
and monitoring data. 

To access: Select Admin > Platform > Setup and 
Maintenance > Manage Profile Databases

Important 
Information

The first database added on the Database Management 
page is automatically designated as the default profile 
database.
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The following elements are included (listed alphabetically):

GUI Element Description

Click to disconnect the database or user schema. 

Note: 

➤ You cannot delete the default profile database or a 
database which is in use.

➤ Disconnecting a user schema removes its reference 
from the management database, but does not 
physically remove the user schema from the Oracle 
Server machine. To delete a user schema from your 
Oracle Server machine, follow the instructions 
provided in your Oracle Server documentation. 

Add Click to add a Microsoft SQL server database or Oracle 
server user schema, as specified in the dropdown 
database list. 

Database Name The name of the database.

Database Type The type of database, either Microsoft SQL or Oracle. 

Server Name The name of the server on which the database is 
running.
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Data Marking Utility Page

The following elements are included (listed alphabetically):

Description Enables you to select sets of data for removal by profile 
or by location for Business Process Monitor data, and 
by SiteScope target machine for SiteScope data. 

To access: On the Gateway server, double click the 
<HP Business Availability Center Gateway server root 
directory>\tools\dataMarking\dataMarking.bat file. A 
Command Prompt window opens, followed by the 
Data Marking utility login dialog box. Enter the user 
name and password of an HP Business Availability 
Center user with superuser privileges.

Important 
Information

➤ Do not run more than one instance of the Data 
Marking utility at a time, as this can affect the re-
aggregation process.

➤ Do not mark data sets for time periods that include 
purged data (data that has been removed using the 
Partition and Purging Manager) as this can affect the 
re-aggregation process.

Useful Links “Removing Unwanted Data from the Profile Database” 
on page 107

“Data Marking Utility Limitations” on page 130

GUI Element Description

Duration Select the period of time, starting from the specified 
start time, for the utility to mark data as unavailable.

Note: You can set a maximum duration of up to 6 
hours and 59 minutes for each data marking run. For 
details on customizing this value, see “Customize Data 
Marking Utility Configurations” on page 116.

Get Info Click before running the Data Marking utility to view 
the number of data rows to be marked. 

Locations List of locations you can mark as obsolete.
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Mark data as 
obsolete

Click to mark the filtered criteria (i.e. - Profiles, 
Transactions, Locations, or SiteScope Targets) as 
obsolete. 

Mark data as valid 
(undo mark as 
obsolete)

Click to make selected data available again after having 
been marked as obsolete.

Profiles List of profiles you can mark as obsolete. 

Progress Displays the progress of the data marking process and 
re-aggregation process. 

SiteScope Targets List of SiteScope target machines (i.e. - machines being 
monitored by SiteScope) you can mark as obsolete. 

Note: This field is visible only in the SiteScope view 
(i.e. - if you chose SiteScope View in the View by 
dropdown).

Start Click to activate the Data Marking utility and mark 
data as obsolete.

Start Time Select a starting data and time for data to be marked as 
unavailable.

Transactions List of transactions you can mark as obsolete.

Note: This field is visible only in the Profile view (i.e. - 
if you chose Profiles in the View by dropdown).

View by Select the type of view to be visible in the Data 
Marking utility.

GUI Element Description
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Data Marking Information Window

The following elements are included (listed alphabetically):

Description Displays the data to be marked as obsolete by the Data 
Marking utility.

To access: Click the Get Info button on the Data 
Marking utility page.

Important 
Information

The lower portion of the Data Marking Information 
window displays the SLAs affected by the marked data. 
You can recalculate the affected SLAs on the 
Agreements Manager tab under Admin > Service Level 
Management. For details, see “Working with the 
Service Level Management Application” in Using Service 
Level Management.

Useful Links “Removing Unwanted Data from the Profile Database” 
on page 107

“Data Marking Utility Limitations” on page 130

GUI Element Description

Number of Rows to 
Update

The number of data rows to be marked as obsolete.

Profile Name The name of the profile to be marked as obsolete.

Total Rows to Update The total number of rows available to be marked as 
obsolete. This number can differ from the value of the 
Number of Rows to Update field. For details, see “Data 
Marking Utility Limitations” on page 130. 
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Profile Database Properties - MS SQL Server Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure a new or existing profile 
database on Microsoft SQL server. 

To access: Select Admin > Platform > Setup and 
Maintenance > Manage Profile Databases, select 
Microsoft SQL from the dropdown database list and 
click Add.

Important 
Information

➤ It is recommended that you configure Microsoft SQL 
server databases manually, and then connect to 
them in the Database Management page. For details 
on manually configuring Microsoft SQL server 
databases, see "Overview of Microsoft SQL server 
Deployment" in the HP Business Availability Center 
Database Guide PDF.

➤ Database creation can take several minutes.

Included in Tasks “Configure a Profile Database on a Microsoft SQL 
Server” on page 109

Useful Links “Database Management - Overview” on page 100

GUI Element (A–Z) Description

Create database 
and/or tables

Select or clear as required. 

➤ To create a new database, or connect to an existing, 
empty database and populate it with profile tables, 
select the checkbox.

➤ To connect to an existing database already 
populated with profile tables, clear the checkbox.

Database name ➤ If you are configuring a new database, type a 
descriptive name for the database.

➤ If you are connecting to a database that was 
previously created, type the name of the existing 
database. 
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Disconnect Click to disconnect the database from HP Business 
Availability Center.

Note: This button appears only after you have clicked 
the Disconnect Database button  on the Database 
Management page.

Make this my 
default profile 
database (required 
for custom data 
types)

Select or clear as required.

Note: 

➤ This setting is required if you are collecting 
Dashboard, Real User Monitor, HP Diagnostics (if 
installed), Service Level Management, SOA, or 
persistent custom data. For details about custom 
data, see “Working with Measurement Filters” on 
page 319.

➤ Selecting this checkbox overwrites the existing 
default profile database.

Password ➤ If you are using Windows authentication, enter the 
password that runs the HP Business Availability 
Center service on the current machine. 

➤ If you are using SQL server authentication, enter the 
password of a user with administrative rights on 
Microsoft SQL server.

Port Enter the port number if:

➤ The Microsoft SQL server's TCP/IP port is configured 
to work on a port different from the default (1433).

➤ You use a non-default port in static mode.

➤ You use a non-default port in dynamic mode. In this 
case, enter port 1434.

Server name Enter the name of the machine on which the Microsoft 
SQL server is installed. If you are using a non-default 
instance in dynamic mode, enter the server name in 
the following format: <my_server\my_instance>

SQL server 
authentication

Select if the Microsoft SQL server is using SQL server 
authentication. 

GUI Element (A–Z) Description
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Profile User Schema Properties - Oracle Server Page

User name ➤ If you are using Windows authentication, enter the 
user name that runs the HP Business Availability 
Center service on the current machine. 

➤ If you are using SQL server authentication, enter the 
user name of a user with administrative rights on 
Microsoft SQL server.

Windows 
authentication

Select if the Microsoft SQL server is using Windows 
authentication. 

Description Enables you to configure one or more profile user 
schemas on your Oracle server. 

To access: Select Admin > Platform > Setup and 
Maintenance > Manage Profile Databases, select 
Oracle from the dropdown database list and click Add.

Important 
Information

➤ It is recommended that you configure Oracle server 
user schemas manually, and then connect to them 
in the Database Management page. For details on 
manually configuring Oracle server user schemas, 
see “Overview of Oracle Server Deployment” in the 
HP Business Availability Center Database Guide PDF.

➤ User schema creation can take several minutes. The 
browser might time out before the creation process 
is completed. However, the creation process 
continues on the server side. 

If a timeout occurs before you get a confirmation 
message, verify that the user schema name appears 
in the database list on the Database Management 
page to ensure that the user schema was successfully 
created.

Included in Tasks “Configure a User Schema on an Oracle Server” on 
page 110

Useful Links “Database Management - Overview” on page 100

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Create database 
and/or tables

Select or clear as required. 

➤ To create a new user schema, or connect to an 
existing, empty user schema and populate it with 
profile tables, select the checkbox.

➤ To connect to an existing user schema already 
populated with profile tables, clear the checkbox.

Note: Clearing this checkbox disables the database 
administrator connection parameter and tablespace 
fields on the page, and instructs the platform to ignore 
the information in these fields when connecting to the 
Oracle server machine. 

Database 
administrator 
password

Enter the password of a user with administrative 
permissions on Oracle server.

Note: This field is enabled only if you selected the 
Create database and/or tables checkbox.

Database 
administrator user 
name

Enter the user name and password of a user with 
administrative permissions on Oracle server.

Note: This field is enabled only if you selected the 
Create database and/or tables checkbox.

Default tablespace Enter the name of the default tablespace designated for 
use with profile user schemas. 

Default Value: users

Disconnect Click to disconnect the user schema from HP Business 
Availability Center.

Note: This button appears only after you have clicked 
the Disconnect Database button  on the Database 
Management page.

Host name Enter the name of the machine on which the Oracle 
server is installed.
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Make this my 
default profile 
database (required 
for custom data 
types)

Select or clear as required.

Note: 

➤ This setting is required if you are collecting 
Dashboard, Real User Monitor, HP Diagnostics (if 
installed), Service Level Management, SOA, or 
persistent custom data. For details about custom 
data, see “Working with Measurement Filters” on 
page 319.

➤ Selecting this checkbox overwrites the existing 
default profile database.

Port Enter the required Oracle listener port, or accept the 
default value.

Retype password Retype the user schema password.

SID Enter the required Oracle instance name, or accept the 
default value.

Temporary 
tablespace

Enter the name of the temporary tablespace designated 
for use with profile user schemas. 

Default Value: temp

User schema name ➤ If you are configuring a new user schema, enter a 
descriptive name for the user schema. 

➤ If you are connecting to a user schema that was 
previously created, enter the name of the existing 
user schema. 

User schema 
password

➤ If you are configuring a new user schema, enter a 
password that enables access to the user schema. 

➤ If you are connecting to a user schema that was 
previously created, enter the password of the 
existing user schema. 

Note: You must specify a unique user schema name for 
each user schema you create for HP Business 
Availability Center on the Oracle server. 

GUI Element (A–Z) Description
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 Purging Manager Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description From the Purging Manager page, you can enable or 
disable the Partition and Purging Manager to instruct 
HP Business Availability Center to begin or stop the 
process of partitioning the data.

To access: Select Admin > Platform > Setup and 
Maintenance > Data Partitioning and Purging. 

Important 
Information

When working with an Oracle standard edition 
database, it is strongly recommended that you set 
PARTITION_VIEW_ENABLED parameter in the init.ora 
file to true. For details on purging data from an Oracle 
database, see "About Data Partitioning and Purging" in 
the HP Business Availability Center Database Guide PDF.

Useful Links “Partitioning and Purging Historical Data from Profile 
Databases” on page 102

GUI Element (A–Z) Description

Apply to Click to select the databases and template to which you 
want the configurations on the Template and Multiple 
Databases tab to apply. You can clear all databases to 
make changes only to the selected template. 

Change to EPM The amount of data per minute configured to arrive in 
HP Business Availability Center. 

Note: Leave this field empty to retain the existing EPM 
value. 

For details on determining this value, see “Determine 
the Events Per Minute (EPM) for Data Arriving in 
HP Business Availability Center” on page 115.

Database Specific Select this tab to change the time range for purging 
data in a table per individual profile database.

Description Describes the corresponding database table.
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Disable Click to disable the Partition and Purging Manager. 

Note: This button is displayed only when a database 
that supports View partitioning has been configured. 

Enable Click to enable the Partition and Purging Manager.

Note: This button is displayed only when a database 
that supports View partitioning has been configured. 

Epm Value The amount of data per minute that is arriving in 
HP Business Availability Center. For details on 
determining this value, see “Determine the Events Per 
Minute (EPM) for Data Arriving in HP Business 
Availability Center” on page 115.

Keep Data for The time range for keeping data in the database tables 
whose checkbox is selected. This element appears as 
follows: 

➤ Selection fields. At the top of the page, set the time 
period for how long you want data kept in the 
selected database tables. 

➤ Column heading. Displays the time range for 
keeping data in each database table. This value is 
configured in the Keep Data for selection fields at 
the top of the page.

Note: The time period configured in the Keep Data for 
fields indicates that the data is stored for at least the 
specified amount of time - it does not indicate when 
the data is purged.

GUI Element (A–Z) Description



Chapter 6 • Database Administration

129

Name of Table in 
Database

The name of the table in the database. 

Database tables are listed by the data collector from 
which the data was gathered. The following data types 
are available:

➤ Alerts

➤ BPI (Business Process Insight)

➤ Business Logic Engine

➤ Business Process Monitor

➤ Diagnostics

➤ Real User Monitor

➤ SOA (Service Oriented Architecture)

➤ Service Level Management

➤ SiteScope

➤ TV (TransactionVision)

➤ UDX (custom data)

➤ WebTrace

Select a profile 
database

Select a profile database for which you want to modify 
time range configurations for purging data. 

Note: This field is visible only on the Database Specific 
tab.

Template and 
Multiple Databases

Select this tab to:

➤ Change the partitioning and purging parameters for 
multiple profile databases.

➤ Change the database template, for parameters to be 
adopted by new databases added in the future.

Note: Once you have made changes, the settings 
displayed in the Template & Multiple Databases tab 
remain the template settings, even if you did not make 
changes to the template and have manually changed 
settings for specific databases. Once those manual 
changes are applied, the settings displayed revert to the 
template settings. To see the settings you changed for 
specific databases, navigate to the Database-Specific 
tab and select the appropriate database.

GUI Element (A–Z) Description
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Troubleshooting and Limitations

Troubleshooting Data Marking Utility Errors
Various types of errors might occur while using the Data Marking utility. 
Generally, when an error occurs, the utility displays the following error 
message:

The Data Marking utility must shut down due to an internal error. For details see: 
<HP Business Availability Center Gateway server root 
directory>\log\datamarking.log

Reasons for which the utility might display this error include:

➤ failure to connect to the database server or profile database

➤ failure to complete the data marking process, for example, due to a 
communication error between the Aggregation server and database

➤ failure of HP Business Availability Center to successfully re-aggregate raw 
data for the defined data set

In case of error, check the <HP Business Availability Center Gateway server 
root directory>\log\datamarking.log file for error information.

Data Marking Utility Limitations
Following are limitations associated with the Data Marking utility:

➤ The utility does not support the removal of late arriving data. 

For example, if a set of data for a specific time period is marked for removal 
and HP Business Availability Center later receives data from that time period 
(which arrived late due to a Business Process Monitor temporarily being 
unable to connect to the Gateway server), the late arriving data is not 
available for use in reports. Use the Get Info button to check for late arriving 
data. If any value other than zero rows are displayed, run the utility again, if 
required, to remove the data that arrived late.

➤ The utility does not support removal of data arriving during the data 
marking process. 
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For example, if a set of data for a specific time period is marked for removal, 
and during that same time period (while the utility is running), data arrives 
and enters the profile database, the rows of newly arrived data are not 
marked for removal, and are therefore not removed. In this case, after the 
utility finishes running, use the Get Info button to determine whether all 
rows of data were removed for the selected time period. If rows are 
displayed, run the utility again, if required, to remove the data that arrived 
during the run. This is a rare scenario, as you typically mark data for a 
previous time period and not for a time period that ends in the future.

➤ While the utility is running and removing data, reports that are generated 
for that time period may not show accurate results. Therefore, it is 
recommended to run the utility during off-peak hours of HP Business 
Availability Center usage.
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7
Infrastructure Settings

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from view, except for the user 
accessing with superuser permissions.

You can configure HP Business Availability Center settings to meet your 
organization’s specifications for the platform and its applications. You 
configure most Infrastructure Settings directly within the Administration 
Console.

This chapter includes:

Concepts

 ➤  Infrastructure Settings Manager - Overview on page 134

Tasks

 ➤  Modify the Ping Time Interval on page 135

 ➤  Modify the Location and Expiration of Temporary Image Files on page 136

Reference

 ➤  Infrastructure Settings User Interface on page 147
Concepts
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Infrastructure Settings Manager - Overview

HP Business Availability Center enables you to modify the value of many 
settings that determine how HP Business Availability Center and its 
applications run. 

Important: Modifying certain settings can adversely affect the performance 
of HP Business Availability Center. It is highly recommended not to modify 
any settings without first consulting HP Software Support or your HP 
Services representative. 

In the Infrastructure Settings Manager, you can select different contexts 
from which to view and edit settings. These contexts are split into the 
following groups: 

➤ Applications

This list includes those contexts that determine how the various 
applications running within HP Business Availability Center behave. 
Contexts such as Dashboard Application, My BSM, and Service Level 
Management are listed.

➤ Foundations

This list includes those contexts that determine how the different areas of 
the HP Business Availability Center foundation run. Contexts such as 
UCMDB common and LDAP Configuration are listed.

Descriptions of the individual settings appear in the Description column of 
the table on the Infrastructure Settings page. 

There are some infrastructure settings which are configured outside the 
Infrastructure Settings Manager. For details, see “Modify the Ping Time 
Interval” on page 135, and “Modify the Location and Expiration of 
Temporary Image Files” on page 136.

Tasks
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Modify the Ping Time Interval

Note: This Infrastructure Settings task is performed outside the 
Infrastructure Settings Manager.

You can modify the time interval after which the HP Business Availability 
Center Web site pings the server to refresh a session. 

To modify the ping time interval:

 1 Open the file <Gateway server root directory>\conf\settings\website.xml 
in a text editor.

 2 Search for the parameter: user.session.ping.timeinterval.

 3 Change the value (120, by default) for the ping time interval. This value 
must be less than half of the value specified for the session timeout period 
(the previous value defined in the file).

 4 Restart HP Business Availability Center on the Gateway server machine.

If you have multiple Gateway server machines, repeat this procedure on all 
the machines.
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Modify the Location and Expiration of Temporary Image 
Files

Note: This Infrastructure Settings task is performed outside the 
Infrastructure Settings Manager.

When you generate a report in HP Business Availability Center applications, 
or when HP Business Availability Center automatically generates a report to 
send through the scheduled report mechanism, images (for example, 
graphs) are created. HP Business Availability Center saves these images, for a 
limited period of time, in temporary directories on the Gateway server 
machines on which the images are generated. 

You can modify the following settings related to these images:

➤ the path to the directory in which the temporary image files are stored 

For details, see “Modify the Directory in Which Temporary Image Files Are 
Stored” on page 137.

➤ the length of time that HP Business Availability Center keeps temporary 
image files before removing them 

For details, see “Modify the Length of Time that HP Business Availability 
Center Keeps Temporary Image Files” on page 142.

➤ the directories from which temporary images are removed

You modify temporary image file settings in the <Gateway server root 
directory>\conf\topaz.config file. For details, see “Specify the Directories 
from Which Temporary Image Files Are Removed” on page 146.
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Modify the Directory in Which Temporary Image Files Are 
Stored
You can modify the path to the directory where HP Business Availability 
Center stores generated images used in scheduled reports and Analytics. For 
example, you might want to save generated images to a different disk 
partition, hard drive, or machine that has a greater storage capacity than the 
partition/drive/machine on which the Gateway server machine is installed.

In certain cases, you might be required to modify the path to the directory 
in which images are stored. For example, if HP Business Availability Center 
reports are accessing the Gateway server machine via a virtual IP—typical 
when there are multiple Gateway server machines running behind a load 
balancer in the HP Business Availability Center architecture—since the load 
balancer could send requests to any of the Gateway server machines, the 
image files need to be in a common location that is configured on all the 
Gateway server machines and shared among them. For more details, see 
“Access Temp Directory with Multiple Gateway Server Machines” on 
page 138.

To support a shared location for temporary images in a Windows 
environment, the following configuration is recommended:

➤ All Gateway servers—and the machine on which the shared image directory 
is defined, if different from the Gateway servers—should be on the same 
Windows domain.

➤ The IIS virtual directory should be configured to use the credentials of an 
account that is a member of the domain users group.

➤ The account for the virtual directory should be given read/write permissions 
on the shared image directory.

Note: If your server configuration requires placing servers on different 
Windows domain configurations, contact HP Software Support. 
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To support a shared location for temporary images in a Solaris environment, 
the following configuration is recommended:

➤ The shared directory must be mounted with read/write access from other 
machines.

➤ The HP Business Availability Center user account must have read/write 
access on the shared directory.

To modify the path to the directory holding temporary image files:

 1 Open the file <Gateway server root directory>\conf\topaz.config in a text 
editor.

 2 Search for the parameter images.save.directory.offline.

 3 Remove the comment marker (#) from the line that begins 
#images.save.directory.offline= and modify the value to specify the required 
path.

Note: In Windows environments, use UNC path syntax (\\\\server\\path) 
when defining the path. In a Solaris environment, use forward slashes (/) 
and not backslashes (\) when defining the path.

 4 Save the topaz.config file.

 5 Restart HP Business Availability Center on the Gateway server machine.

 6 Repeat the above procedure on all Gateway server machines.

 7 Map the newly defined physical directory containing the images to a virtual 
directory in the Web server on all Gateway server machines. For details, see 
the next section.

Access Temp Directory with Multiple Gateway Server 
Machines
If you define a custom path to temporary images (as defined in the 
images.save.directory.offline parameter), you must map the physical 
directory containing the images to a virtual directory in the Web server on 
all Gateway server machines.
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To configure the virtual directory in IIS:

 1 Rename the default physical directory containing the temporary scheduled 
report images on the Gateway server machine.

For example, rename:

<Gateway server root directory>\AppServer\webapps\
site.war\Imgs\chartTemp\offline

to

<Gateway server root directory>\AppServer\webapps
\site.war\Imgs\chartTemp\old_offline

 2 In the IIS Internet Services Manager on the Gateway server machine, 
navigate to Default Web site > Topaz > Imgs > ChartTemp.

The renamed offline directory appears in the right frame.

 3 In the right frame, right-click and select New > Virtual Directory. The Virtual 
Directory Creation Wizard opens. Click Next.

 4 In the Virtual Directory Alias dialog box, type offline in the Alias box to 
create the new virtual directory. Click Next.

 5 In the Web Site Content Directory dialog box, type or browse to the path of 
the physical directory containing the temporary images (the path defined in 
the images.save.directory.offline parameter). Click Next.

 6 If the physical directory containing the temporary images resides on the 
local machine, in the Access Permissions dialog box, specify Read and Write 
permissions.

If the physical directory containing the temporary images resides on a 
machine on the network, in the User Name and Password dialog box, enter 
a user name and password of a user with permissions to access that 
machine.

 7 Click Next and Finish to complete Virtual Directory creation.

 8 Restart HP Business Availability Center on the Gateway server machine.

 9 Repeat the above procedure on all Gateway server machines.
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To configure the virtual directory on Apache HTTP Web Server:

 1 Rename the default physical directory containing the temporary scheduled 
report images on the Gateway server machine.

For example, rename:

<Gateway server root 
directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to

<Gateway server root 
directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_offline

 2 Open the Apache configuration file <Gateway server root 
directory>\WebServer\conf\httpd.conf with a text editor.

 3 Map a virtual directory named offline to the physical location of the 
common directory by adding the following line to the file:

Alias /Imgs/chartTemp/offline <shared_temp_image_directory>

where <shared_temp_image_directory> represents the path to the physical 
directory containing the temporary scheduled report images (the path 
defined in the images.save.directory.offline parameter).

 4 Save the file.

 5 Restart HP Business Availability Center on the Gateway server machine.

 6 Repeat the above procedure on all Gateway server machines.
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To configure the virtual directory on Sun Java System Web Server:

 1 Rename the default physical directory containing the temporary scheduled 
report images on the Gateway server machine.

For example, rename:

<Gateway server root 
directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to

<Gateway server root 
directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_offline

 2 Open the Sun Java System Web Server configuration file <Sun Java System 
Web Server installation directory>\server\<server_nam>\config\obj.conf 
with a text editor.

 3 Add the following line inside the <Object name=default> directive (but 
before the line NameTrans fn="pfx2dir" from="/Imgs" dir="ProductDir/Site 
Imgs/", if it exists, and before the line NameTrans fn=document-root 
root="$docroot"):

NameTrans fn="pfx2dir" from="/topaz/Imgs/chartTemp/offline"  
dir="<shared_temp_image_directory>"

where <shared_temp_image_directory> represents the path to the physical 
directory containing the temporary scheduled report images (the path 
defined in the images.save.directory.offline parameter).

 4 Save the file.

 5 Restart the Sun Java System Web Server on the Gateway server machine.

 6 Repeat the above procedure on all Gateway server machines.
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Modify the Length of Time that HP Business Availability 
Center Keeps Temporary Image Files
You can modify settings that control how long HP Business Availability 
Center keeps temporary image files generated by the Gateway server 
machine, before removing them from the defined temporary directories. 
You can modify settings for the following directories in the <HP Business 
Availability Center Gateway server root directory>\conf\topaz.config file: 

 

For the above temporary image directories, you can modify the following 
settings:

➤ remove.files.directory.number=<number of directories>

Specifies the total number of directories for which you are defining settings.

➤ remove.files.<num_of_path>.path=<path to directory>

Specifies the path to the directory that contains the files you want to 
remove. For the default directories that remove temporary image files, these 
values must match the images.save.directory.online and 
images.save.directory.offline parameters, also defined in the topaz.config 
file.

Directory Setting Description

remove.files.0.path=../../AppServer/webapps/site.war/
Imgs/chartTemp/offline 

Path to images created 
when generating 
Scheduled reports and 
Analytics reports

remove.files.1.path=../../AppServer/webapps/site.war/
Imgs/chartTemp/online 

Path to images created 
when generating reports 
in HP Business 
Availability Center 
applications

remove.files.3.path=../../AppServer/webapps/site.war/
snapshots 

Path to images created 
by the Snapshot on Error 
mechanism and viewed 
in Error Summary 
reports
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Note: In Windows environments, use UNC path syntax (\\\\server\\path) 
when defining the path. In Solaris environments, use only forward slashes 
(/) when defining the path.

➤ remove.files.<num_of_path>.expirationTime=<file expiration time in sec>

Specifies the time, in seconds, that HP Business Availability Center leaves a 
file in the specified directory. For example, if you specify "3600" (the 
number of seconds in 1 hour), files older than one hour are removed.

Leave this setting empty if you want HP Business Availability Center to use 
only maximum size criteria (see below).

➤ remove.files.<num_of_path>.maxSize=<maximum size of directory in KB>

Specifies the total size, in KB, to which the defined directory can grow 
before HP Business Availability Center removes files. For example, if you 
specify "100000" (100 MB), when the directory exceeds 100 MB, the oldest 
files are removed in order to reduce the directory size to 100 MB.

If you also define a value in the 
remove.files.<num_of_path>.expirationTime parameter, HP Business 
Availability Center first removes expired files. HP Business Availability 
Center then removes additional files if the maximum directory size limit is 
still exceeded, deleting the oldest files first. If no files have passed their 
expiration time, HP Business Availability Center removes files based only on 
the maximum directory size criteria.

This parameter is used in conjunction with the 
remove.files.<num_of_defined_path>.deletePercents parameter (see below), 
which instructs HP Business Availability Center to remove the specified 
percentage of files, in addition to the files removed using the 
remove.files.<num_of_path>.maxSize parameter.
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Leave this and the remove.files.<num_of_defined_path>.deletePercents 
settings empty if you want HP Business Availability Center to use only the 
expiration time criterion.

➤ remove.files.<num_of_path>.deletePercents=<percent to remove>

Specifies the additional amount by which HP Business Availability Center 
reduces directory size—expressed as a percentage of the maximum allowed 
directory size—after directory size has been initially reduced according to 
the remove.files.<num_of_path>.maxSize parameter. HP Business 
Availability Center deletes the oldest files first.

Leave this and the remove.files.<num_of_path>.maxSize settings empty if 
you want HP Business Availability Center to use only the expiration time 
criterion.

➤ remove.files.<num_of_path>.sleepTime=<thread sleep time in sec>

Specifies how often HP Business Availability Center runs the mechanism 
that performs the defined work.

Example:

HP Business Availability Center is instructed to perform the following work 
once every 30 minutes: HP Business Availability Center first checks whether 
there are files older than 1 hour and, if so, deletes them. Then HP Business 
Availability Center checks whether the total directory size is greater than 
250 MB, and if so, it reduces directory size to 250 MB by removing the oldest 
files. Finally, HP Business Availability Center reduces the total directory size 
by 50% by removing the oldest files. As a result, HP Business Availability 
Center leaves files totaling 125 MB in the directory.

# remove files older than 1 hour (3600 sec.)
remove.files.0.expirationTime=3600
# reduce folder size to 250 MB
remove.files.0.maxSize=250000
# remove an additional 50% of max. folder size (125 MB)
remove.files.0.deletePercents=50
# perform work once every 30 min. (1800 sec)
remove.files.0.sleepTime=1800
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Note: You can configure the file removal mechanism to remove files from 
any defined directory. You define the parameters and increment the index. 
For example, to clean out a temp directory, you would specify 6 instead of 5 
for the number of directories in the remove.files.directory.number 
parameter; then you would define the directory’s path and settings using the 
index value 4 (since 0-4 are already being used by the default settings) in the 
num_of_path section of the parameter. Do not use this mechanism to 
remove files without first consulting with your HP Software Support 
representative. 

To modify the default settings:

 1 Open the file <HP Business Availability Center Gateway server root 
directory>\conf\topaz.config in a text editor.

Tip: Before modifying the values, back up the file or comment out (using #) 
the default lines so that the default values are available as a reference.

 2 Modify the settings as required.

 3 Save the topaz.config file.

 4 Restart HP Business Availability Center on the Gateway server machine.

Repeat the above procedure on all Gateway server machines.
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Specify the Directories from Which Temporary Image Files 
Are Removed
By default, temporary image files are removed from the root path of the 
specified directory. However, you can also configure HP Business Availability 
Center to remove temporary image files from the subdirectories of the 
specified path.

To configure HP Business Availability Center to remove temporary images 
files from subdirectories:

 1 Open the file <Gateway server root directory>\conf\topaz.config in a text 
editor.

 2 Insert the following line after the specified path’s other settings (described 
in the previous section):

remove.files.<num_of_path>.removeRecursively=yes

 3 Save the topaz.config file.

 4 Restart HP Business Availability Center on the Gateway server machine.

 5 Repeat the above procedure on all Gateway server machines.
Reference
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Infrastructure Settings User Interface

This section describes:

 ➤  Infrastructure Settings Manager Page on page 147

Infrastructure Settings Manager Page

The Infrastructure Settings Manager page includes the following elements 
(listed alphabetically):

Description Enables you to define the value of many settings that 
determine how HP Business Availability Center and its 
applications run. 

To access: Select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings

Important 
Information

Modifying certain settings can adversely affect the 
performance of HP Business Availability Center. It is 
highly recommended not to modify any settings 
without first consulting HP Software Support or your 
HP Services representative.

Useful Links “Infrastructure Settings Manager - Overview” on 
page 134

GUI Element Description

All Select to view all the settings for both Applications and 
Foundations.

Applications Select to edit one of the HP Business Availability Center 
Applications.

Description Describes the specific infrastructure setting.

Note: This field is visible on both the Infrastructure 
Settings Manager page, and the Edit Setting dialog box 
after clicking the Edit button  next to the relevant 
setting.
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Foundations Select to edit one of the HP Business Availability Center 
Foundations.

Name The name of the setting. 

Note: This field is visible on both the Infrastructure 
Settings Manager page, and the Edit Setting dialog box 
after clicking the Edit button  next to the relevant 
setting.

Restore Default Click to restore the default value of the setting. 

Note: This button is visible on the Edit Setting dialog 
box after clicking the Edit button  next to the 
relevant setting.

Value The current value of the given setting.

Note: This field is visible on both the Infrastructure 
Settings Manager page, and the Edit Setting dialog box 
after clicking the Edit button  next to the relevant 
setting.

GUI Element Description
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8
System Health

This chapter includes the main concepts, tasks, and reference information of 
System Health.

This chapter includes:

Concepts

 ➤  System Health - Overview on page 150

 ➤  System Health Setup Wizard – Overview on page 153

 ➤  System Health Displays on page 154

 ➤  Understanding the Monitors Table on page 160

 ➤  Understanding Service Reassignment on page 161

Tasks

 ➤  Deploy and Access System Health on page 163

 ➤  Ensure the Health of Your System - Workflow on page 170

Reference

 ➤  HP Business Availability Center Components on page 175

 ➤  HP Business Availability Center Processes on page 177

 ➤  System Health Monitors on page 179

 ➤  Component and Monitor Status Indicators on page 217

 ➤  System Health User Interface on page 218

Troubleshooting and Limitations on page 256
Concepts
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System Health - Overview

System Health uses the SiteScope monitoring system to enable you to 
monitor the servers, databases, and data collectors running as part of your 
system.

Note: If you do not deploy the new System Health interface, your system 
defaults to the Legacy System Health application. For details on how to 
deploy the new System Health interface, see “Deploy and Access System 
Health” on page 163. For details on Legacy System Health, see “Legacy 
System Health” on page 257. To view the Legacy System Health interface, 
see below.

HP Business Availability Center servers can be deployed through either the 
Recommended or Legacy Deployment configurations. For details, see 
“HP Business Availability Center Server Deployment” on page 152. 
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You use System Health to:

➤ Measure performance by viewing the output from monitors running on the 
various system components.

➤ Monitor areas of the databases that influence performance.

➤ Display problematic areas of the servers, databases, and data collectors.

➤ Perform operations on your environment, such as:

➤ Move Backend Services. You can move backend services from one server 
to another of the same type, in case the server machine is not 
functioning properly or requires downtime for servicing. For details on 
the user interface for performing this task, see “Service Manager Dialog 
Box” on page 251. 

➤ Configure Backup Servers. You can define a backup server in case the 
server machine is not functioning properly or requires downtime for 
servicing. For details on the user interface for performing this task, see 
“Backup Server Setup Window” on page 252.

➤ Manage BAC Processes. You can start or stop various HP Business 
Availability Center processes. For details on the user interface for 
performing this task, see “Process Manager Dialog Box” on page 253. 

➤ View log files on specific components in a variety of formats.

➤ View information on components and monitors in .csv format (displaying 
current status) and Quick Report format (displaying status of the past 24 
hours).
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HP Business Availability Center Server Deployment
HP Business Availability Center servers can be deployed through either of 
the following configurations: 

Recommended Deployment

The recommended deployment consists of a Gateway Server (or two 
Gateway Servers behind a load balancer) and a Data Processing Server. The 
Data Processing server can also have a backup server. 

You can also deploy a separate Business Process Insight (BPI) server (BPI 
Full), to enable BPI Instance Tracking for full BPI functionality. For details 
on the BPI Application, see "BPI Application Concepts" in Using Business 
Process Insight, available from the Business Process Insight Portal in the 
HP Business Availability Center Documentation Library.

Legacy Deployment

In legacy enterprise environments, the Data Processing Server is split into 
three standalone servers: 

➤ Modeling Data Processing Server

➤ Online Data Processing Server

➤ Offline Data Processing Server

Each server is installed on a separate machine, and may also have one 
backup machine defined for it.

You can reassign the HP Business Availability Center services from one 
server to another. For details, see “Understanding Service Reassignment” on 
page 161.

For details on the HP Business Availability Center deployment 
configurations, see “Deployment Configuration” in the HP Business 
Availability Center Deployment Guide PDF in the HP Business Availability 
Center Documentation Library.
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System Health Setup Wizard – Overview

The System Health Setup Wizard enables you to create remote connections 
to the servers which System Health monitors. If remote connections are not 
created, only the monitors that do not require credential authorization to 
access the System Health servers will provide data. 

Important: It is not possible for another user to access the System Health 
interface while you are configuring the System Health Setup Wizard.

For details on configuring the System Health Setup Wizard, see “Ensure the 
Health of Your System - Workflow” on page 170.

For details on the pages and elements contained in the System Health Setup 
Wizard, see “System Health Setup Wizard” on page 237.

Accessing the System Health Setup Wizard
The System Health Setup Wizard is accessible in one of the following ways:

➤ The first time you access the System Health application on the machine 
running HP Business Availability Center.

➤ Clicking the Full Model Synchronization button on the System Health 
Dashboard toolbar or the Inventory tab Toolbar, when no specific 
component is selected. 

➤ Clicking the Soft Sync button on the System Health Dashboard Toolbar or 
the Inventory tab Toolbar.

Note: Clicking the Soft Sync button displays only the portion of the wizard 
relevant to changes made in the system. If no changes were made, the 
System Health Setup Wizard does not appear.
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System Health Displays

You can view the status of the HP Business Availability Center components 
using the following formats:

System Health Dashboard
Displays a map of all components. The color of the component box outline, 
as well as the status icon’s color in the Monitors table, determines the 
component status. For details on the components’ outline colors, see 
“Component Status and Description” on page 230. For details on the status 
icon colors, see “Component and Monitor Status Indicators” on page 217.

Click the Expand icon on a component to view its subcomponents.

Click the Collapse icon on a component to hide its subcomponents.

You can perform actions on the components by clicking the various icons 
on the System Health Dashboard Toolbar. For details on the System Health 
Dashboard Toolbar, see “Toolbar” on page 245.

You can also retrieve information on HP Business Availability Center servers 
using the General table, and information on the server’s components on the 
Monitors table in the System Health Dashboard Right pane. The displayed 
monitors run on the selected component in the System Health Dashboard 
Left pane. For details, see “Understanding the Monitors Table” on page 160.
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The monitors table is displayed as follows:
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The Dashboard tab is displayed as follows:
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Inventory Tab
Displays information on Gateway Server and Data Processing Server 
components and their subcomponents, in table format. The Inventory tab 
enables you to compare the performance of the subcomponents and 
monitors on multiple servers by presenting their statuses in a single view.

The Inventory tab is divided into the following tables: 

➤ Gateway Machines. Displays the status of the various components running 
on the HP Business Availability Center Gateway machines.

➤ Processing Machines. Displays the status of the various components 
running on the HP Business Availability Center Data Processing machines.

➤ <Subcomponent Name> Details. Displays information about the selected 
component’s monitors. The Monitor Details area provides additional 
information on the subcomponent’s monitors, if applicable.

Note: The <Subcomponent Name> Details table is displayed only when a 
specific component is selected on either on the Gateway Machines or 
Processing Machines table on the Inventory tab. 

The Inventory tab is displayed as follows:



Chapter 8 • System Health

158

The component and monitor status is indicated on both the monitors table 
in the System Health Dashboard, and in the Inventory tab tables as a 
colored icon. For details on the colored icons, see “Component and Monitor 
Status Indicators” on page 217.

Log Manager Tab
The Log Manager tab displays the various log files associated with the 
components that System Health is monitoring. Logs are arranged 
hierarchically in log bundles. Nested under the log bundles are the 
machines in the HP Business Availability Center deployment that contain 
the individual log files. The entities that can be seen in the Log Bundle pane 
tree are: 

➤ Log Bundles. Can contain any or all of the following: 

➤ Other log bundles

➤ Machines

➤ Logs (if there is no model configured on the System Health Dashboard), 
arranged by category.

➤ Machines. Contains a group of logs arranged by the machine on which they 
are located. Machines are nested under the log bundles in the hierarchical 
tree.

➤ Individual Logs. The individual log files monitoring the behavior of the 
monitored components. Logs are nested either under the log bundles, or the 
specific machines on which they are running. 

You configure a time frame for which you want data to be retrieved in the 
Time Frame pane, and then select one or more of the components in the 
Log Bundles pane. You can then perform one of the following actions: 

➤ Download and save the selected logs by clicking the Save Output button in 
the Log Bundles pane.

➤ Retrieve and view the selected logs by clicking the Retrieve Logs button. The 
logs are displayed in the Main pane, where you can also save the displayed 
output by clicking the Save Output button.

You can select any combination of log bundles, machines, and log files.
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For each log retrieval action that is performed, a separate tab opens in the 
Main pane displaying the logs contained in your selection. Tabs are 
numbered chronologically, according to the retrieval actions you perform. 
For details on the available functions in the Log Manager, see “Log 
Manager” on page 221.

The Log Manager tab is displayed as follows:
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Understanding the Monitors Table

The Monitors table displays information about the monitors running on the 
component selected in the System Health Dashboard. 

Once you have drilled down to a specific monitor in the Monitors table, you 
can: 

➤ enable the monitor

➤ disable the monitor

➤ run the monitor immediately, instead of waiting for it to run according to 
its schedule

The monitor groups correspond to the components contained in the 
highlighted component in the System Health Dashboard Left pane. 
Additional information on the individual monitors is displayed in the 
Monitor Details pane.

You can double click a group in the Monitors table to open the monitor’s 
parent component on the System Health Dashboard.

For details on the System Health monitors that are run by the SiteScope 
application, click the SiteScope link at the top left corner of the System 
Health interface.

For details on the Monitors table user interface, see “Monitors Table” on 
page 225. 
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Understanding Service Reassignment

You may want to reassign services running on HP Business Availability 
Center Data Processing servers, if a certain machine is not functioning 
properly or requires downtime for servicing. You can also preconfigure a 
specific Data Processing server to automatically fail over to a specific backup 
machine, to ensure that your data is not lost in the event of system 
downtime. 

Note: Service Reassignment can be performed only by an administrator.

HP Business Availability Center servers can be deployed either through the 
recommended deployment configuration or legacy deployment 
configuration. For details, see “HP Business Availability Center Server 
Deployment” on page 152.

When reassigning services, the secondary machine must also be a Data 
Processing server. 

The reassignment process can take up to 25 minutes, at which point the 
system is in downtime. 

For details on reassigning services, see “Service Manager Dialog Box” on 
page 251.

Service Reassignment Flow Table
There are several theoretical scenarios for reassigning services among 
machines, depending on the type of deployment with which HP Business 
Availability Center servers are configured. For details on HP Business 
Availability Center server deployment, see “HP Business Availability Center 
Server Deployment” on page 152. 
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The table below illustrates these scenarios by indicating the paths along 
which services can be reassigned.

Tasks

To Full Data 
Processing 
Server 
(Backup 
server in 
recommended 
deployment)

To Modeling 
Data 
Processing 
Server

To Online 
Data 
Processing 
Server

To Offline 
Data 
Processing 
Server

From Full 
Data 
Processing 
Server 

Yes

Note: This is 
the 
recommended 
sever 
deployment

Yes - for 
modeling 
services

Yes - for 
online 
services

Yes - for 
offline 
services

From 
Modeling 
Data 
Processing 
Server 

Yes Yes No No

From Online 
Data 
Processing 
Server 

Yes No Yes No

From Offline 
Data 
Processing 
Server 

Yes No No Yes
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Deploy and Access System Health

You deploy System Health in one of the following ways: 

➤ On a standalone machine with access to HP Business Availability Center 
(recommended so that System Health continues to run if HP Business 
Availability Center servers are down).

➤ On any HP Business Availability Center Gateway server (should be done 
only if a standalone machine is not available). 

Deploying System Health
You must ensure that the Gateway server and the Management database are 
up and running before deploying System Health. System Health must be 
deployed in the same domain as HP Business Availability Center, and any 
firewalls must be open. 
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To deploy System Health:

 1 Insert the SiteScope installation disk into your machine.

 2 Select the setup.exe option. The HP SiteScope installation wizard is 
displayed.

 3 Select I accept the terms of the license agreement and click Next.

 4 Enter a directory to install SiteScope on, or accept the default C:\SiteScope, 
and click Next.
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 5 Select the HP System Health setup type, and click Next.

 6 Enter the following information in the HP SiteScope Configuration window:

➤ The HP SiteScope server port number. Accept the default port number of 
18080, or choose another port that is free.

➤ Optionally, the administrator email address, used to notify the 
administrator of important events that took place. 
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➤ The name of the HP Business Availability Center Gateway server.

 7 Verify the summary of the information in the resulting window and click 
Next. The HP SiteScope installation process runs.

 8 Click Next when the installation process finishes.

 9 You must restart your computer for the HP SiteScope installation to take 
effect. Click Yes to restart your computer immediately, or No if you want to 
restart your computer later.

 10 Click Finish to exit the HP SiteScope installation wizard.

Note: If System Health is deployed on a Solaris machine, it can monitor 
other Solaris machines only. You can configure general properties on the 
System Health setup wizard, but advanced properties must be configured 
using SiteScope.
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Accessing System Health
You can access System Health:

➤ directly, through a Web browser using the syntax: 
http://<server_name>.<domain_name>:<HP SiteScope Server port 
number>/, where <server_name> is the name of the Gateway or dedicated 
server that System Health is deployed on, depending on the type of 
deployment you are using.

➤ as an application embedded in HP Business Availability Center, after 
configuring the appropriate URL in the Infrastructure Settings section of 
Platform Administration. For details, see the procedure below.

The System Health application can be accessed only by users with Superuser 
or Administrator permissions.

To access System Health directly, through a Web browser:

 1 Ensure that System Health has been installed properly, either on your 
dedicated server or on your Gateway server.

 2 Enter the following link into your browser window:

http://<machine name>:<port number>

Where the following values are true:

<machine name> = The machine System Health is installed on.

<port number> = 18080 by default, or you can choose another port that 
is free.

Note: It can take several minutes for the System Health application to 
appear on your screen.

 3 Enter your login name and password in the appropriate boxes to log into 
System Health.

Initial access can be gained using the following default login parameters: 

Login Name = systemhealth, Password = systemhealth
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Administrator level access can be gained using the following default login 
parameters: 

Login Name = administrator, Password = syshealthadmin

It is recommended that you change the password immediately to prevent 
unauthorized entry. To change the password, click the Change Password 
link on the System Health login page.

Note: After changing your password on the System Health login page, you 
must enter your System Health username and password when accessing 
System Health in HP Business Availability Center. Once you have done this, 
HP Business Availability Center does not require you to re-enter this 
information to access System Health until the next time your password is 
changed on the System Health login screen. 

To access System Health in HP Business Availability Center:

 1 Ensure that System Health has been installed, either on your dedicated 
server or on your Gateway Server.

 2 Log into your HP Business Availability Center machine. For details, see “Log 
In and Out” on page 22.

 3 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select System Health, and locate the URL entry in the 
System Health table. Modify the value to the following URL:

http://<machine name>:<port number>/SiteScope/Main.do

Where the following values are true:

<machine name> = The machine System Health is installed on.

<port number> = 18080 by default, or you can choose another port that 
is free.

 4 Click Save to register the URL for accessing System Health in HP Business 
Availability Center.
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Note: Steps 3 - 4 are performed the first time you access the System Health 
interface.

 5 Select Admin > Platform > Setup and Maintenance > System Health to access 
the System Health interface.

Deploying System Health in a Secured Environment
When deploying System Health in a secured environment, note the 
following:

➤ On the System Health Dashboard, Reverse Proxy components are depicted 
in the Left pane, together with the Load Balancer components, called 
mediators.

➤ The WDE URL monitor appears red until you enter the monitor’s username 
and password in SiteScope.

➤ When accessing System Health via HP Business Availability Center, you 
must enter a username and password to view the System Health interface.

➤ You must supply the name of the Gateway server, and not the reverse proxy. 
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Ensure the Health of Your System - Workflow

This task describes how to monitor the components of your system and 
ensure they are functioning properly. 

This task includes the following steps:

➤ “Prerequisites” on page 170

➤ “Configure Remote Connection Details for Monitors” on page 170

➤ “Monitor Performance of Components” on page 170

➤ “Move Backend Services” on page 171

➤ “Configure Backup Servers” on page 172

➤ “Manage BSM Processes” on page 173

➤ “Display a Quick Report” on page 174

 1 Prerequisites
Before you can monitor the health of your HP Business Availability Center 
system, you must ensure that the System Health application is deployed 
properly. For details, see “Deploy and Access System Health” on page 163.

 2 Configure Remote Connection Details for Monitors
You optionally provide the server’s remote connection details for the 
HP Business Availability Center monitors that require it, using the System 
Health Setup Wizard. You can also configure recipients to receive System 
Health alerts through email. For details, see “System Health Setup Wizard” 
on page 237.

 3 Monitor Performance of Components
You can monitor the performance of the servers, databases, and data 
collectors running as part of your HP Business Availability Center system 
and view the results using either the System Health Dashboard tab or the 
Inventory tab. For details on the available System Health displays, see 
“System Health Displays” on page 154.
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 4 Move Backend Services
In the Service Manager dialog box, you move backend services from one 
Data Processing server to another of the same type, in case the server 
machine is not functioning properly or requires downtime for servicing. 

For details on the user interface for performing this task, see “Service 
Manager Dialog Box” on page 251.

Example

 a On the Toolbar on either the System Health Dashboard or the Inventory 
tab, click the Service Manager button.

 b In the Select Source Machine window, select the machine that you want 
to move services from.

 c In the Select Operation window, select the operation you want to 
perform.

 d In the Select Target Machine window, select the machine you want to 
move services to. 
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 e Click the Execute button. The Operation Status window indicates 
whether or not the operation request was sent successfully.

 5 Configure Backup Servers
In the Configure Backup Servers dialog box, you define a backup server, in 
case the server machine is not functioning properly or requires downtime 
for servicing. For details on the user interface for performing this task, see 
“Backup Server Setup Window” on page 252.

Example

 a On the Toolbar on the System Health Dashboard or the Inventory tab, 
click the Backup Server Configuration button.

 b In the left pane, select a backup server.

 c In the right pane, select a server to be backed-up.

 d Click the Enable Automatic Failover check box to activate your backup 
server selection.
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 e Click Execute to register your backup server. The Operation Status 
window indicates whether or not the operation succeeded.

 6 Manage BSM Processes
In the Process Manager dialog box, you stop or start processes on specific 
servers. For details on the user interface for performing this task, see 
“Process Manager Dialog Box” on page 253.

Example

 a On the Toolbar on the System Health Dashboard or the Inventory tab, 
click the Process Manager button .

 b In the Select Server window, select the server to start or stop processes 
on.

 c In the Select Process(es) window, select the process you want to start or 
stop. 
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 d Click Start to start the selected processes, Stop to stop the selected 
processes, or Refresh to refresh the processes’ status. You can also start all 
processes by clicking the Start All button, and stop all processes by 
clicking the Stop All button. The Operation Status window indicates 
whether or not the operation was successful. 

 7 Display a Quick Report
Click the Quick Report button to display a Quick Report with information 
gathered over the past 24 hours on the monitors deployed on the selected 
component. For details on the Quick Report screen, see “Quick Report 
Screen” on page 254.
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Example

Reference

HP Business Availability Center Components

The System Health interface displays the following components:

➤ Data Collectors. Tools that collect availability and performance data. Data 
collectors include:

➤ BPMs. Business Process Monitors, which run scripts simulating user 
actions and collect resulting data.

➤ RUM Engines. Real User Monitors, which monitor actual user traffic and 
activity and collect resulting data.

➤ SiteScopes. Monitor performance of IT infrastructure.
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➤ Discovery Probes. Discovers the components of your IT infrastructure, 
creates CIs for them, and sends the data to the CMDB.

➤ HP Business Availability Center Servers. System Health displays the 
following types of HP Business Availability Center servers: 

➤ Gateway Machines. Servers on which HP Business Availability Center 
runs. Gateway servers are responsible for: 

➤ running HP Business Availability Center applications.

➤ producing reports.

➤ operating the Administration Console.

➤ receiving data samples from the data collectors and distributing this 
data to the relevant HP Business Availability Center components.

➤ supporting the bus.

➤ Data Processing Machines. Servers on which HP Business Availability 
Center runs. Data Processing servers are responsible for: 

➤ aggregating and partitioning data.

➤ running the Business Logic Engines.

➤ controlling the HP Universal CMDB-related services.

Server components are displayed on both the System Health Dashboard and 
the Inventory tab.

➤ Load Balancing Machines. Displayed only if deployed. Load balancers 
ensure that the data flow is evenly distributed among all HP Business 
Availability Center Gateway Servers so that no one particular server becomes 
overloaded.

➤ Business Process Insight Machines. Displayed only if deployed. A separate 
Business Process Insight (BPI) server (BPI Full) enables instance tracking and 
full BPI functionality. For details on the BPI machine, see "BPI Application 
Concepts" in Using Business Process Insight, available from the Business 
Process Insight Portal.

➤ Databases. Monitors the databases HP Business Availability Center is using.
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➤ UCMDB. Displayed only if deployed separately. The UCMDB serves as a 
central repository for configuration information.

➤ Reverse Proxy Server. Displayed only when System Health is configured in a 
secure environment. For details on Reverse Proxies, see “Using a Reverse 
Proxy in HP Business Availability Center” in the HP Business Availability 
Center Hardening Guide PDF. 

HP Business Availability Center Processes

The following table displays the processes that run on the HP Business 
Availability Center servers:

GUI Element (A-Z) Description

CMDB Process Runs on the CMDB database that stores all the 
configuration item data. It does not always run, 
depending on your HP Business Availability Center 
deployment.

Process name: cmdb

data_upgrade Enables transferring of data from a previous version of 
HP Business Availability Center to a newer version.

Process name: DataUpgrade

dbloader Runs the component on the server which loads the 
data into the database. 

Process name: mercury_db_loader

domain_manager Responsible for all the bus processes in all HP Business 
Availability Center servers.

Process name: DomainManager

ldap Runs queries and modifications for directory services.

Process name: slapd

mercuryAS Runs the jboss application server, which provides 
access to all HP Business Availability Center 
applications.

Process name: MercuryAS



Chapter 8 • System Health

178

message_broker Enables the transference of a message from the formal 
messaging protocol of the sending machine to the 
formal messaging protocol of the receiving machine.

Process name: MessageBroker

offline_engine Runs the engine which controls the offline 
components of the HP Business Availability Center 
system.

Process name: mercury_offline_engine

bpi_process_reposito
ry

Manages process definitions, which you create using 
the BPI Modeler, to monitor IT operational resources 
defined within the CMDB.

Process name: BPI Process Repository

online_engine Runs the engine which controls the online 
components of the HP Business Availability Center 
system.

Process name: mercury_online_engine

pmanager Runs the Partition Manager to create new or purge old 
partitions in the profile database, as necessary.

Process name: mercury_pm

schedulergw Enables scheduling tasks to be continually run on the 
Gateway Server. 

Process name: schedulergw

schedulerpr Enables scheduling tasks to be continually run on the 
Data Processing. 

Process name: schedulerpr

tmu Checks the HP Business Availability Center license 
every five minutes and updates the database 
accordingly.

Note: This process can be run only on a Windows 
server.

Process name: TMU

GUI Element (A-Z) Description
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System Health Monitors

System Health uses SiteScope monitors to measure the performance of your 
components. Some of the monitors are monitors that are available in the 
SiteScope application and some are configured specifically for System 
Health. 

Monitors are displayed in the Monitors table, located in the Right pane of 
the System Health Dashboard. For details on the Monitors table, see 
“Monitors Table” on page 225.

This section describes the following groups of monitors:

➤ “Machine Hardware Monitors” on page 180

➤ “Database Monitors” on page 181

➤ “HP Business Availability Center Server Monitors” on page 182

➤ “Gateway Server Monitors” on page 190

➤ “Processing Server Monitors” on page 199

➤ “BPI Server Monitors” on page 210

➤ “Data Collectors” on page 213

WDE Runs the Web Data Entry component of the Gateway 
Server, which receives data from all registered data 
collectors and publishes the data to all HP Business 
Availability Center engines.

Process name: mercury_wde

webserverGuard Ensures that the webserver is continually running.

Process name: MercuryWSGuard

GUI Element (A-Z) Description



Chapter 8 • System Health

180

Machine Hardware Monitors
The following group of monitors monitor the hardware and databases 
(where indicated) on which the Business Availability Center applications 
run:

Machine Hardware Monitors
.

Monitor Name Description

Ping Checks the availability of the host via the 
network. Runs on HP Business Availability 
Center and Database servers. If Business 
Availability Center includes a proxy server or 
load balancer, this monitor runs on the 
mediator or load balancer.

Included Measurements: 

➤ Round Trip Time 

➤ Loss Percentage 

Threshold Configured In: SiteScope

For details on the monitor, see “Ping Monitor 
Overview” in Using System Availability 
Management.

Server Virtual 
Memory

Tracks how much virtual memory is currently 
in use on the server. Runs on HP Business 
Availability Center and Database servers.

Threshold Configured In: SiteScope

For details on the monitor, see “Memory 
Monitor Overview” in Using System Availability 
Management.

Server CPU Tracks how much CPU is currently in use on the 
server. Runs on HP Business Availability Center 
and Database servers.

Threshold Configured in: SiteScope

For details on the monitor, see “CPU Utilization 
Monitor Overview” in Using System Availability 
Management.



Chapter 8 • System Health

181

Database Monitors
The following monitors run on the database servers. There can be multiple 
databases running on a server, and there is a monitor instance for each 
database:

Server Disk Space Tracks how much disk space is currently in use 
on the hard disk drive where HP Business 
Availability Center is installed. Runs only on 
the server.

Threshold Configured In: SiteScope

For details on the monitor, see “Disk Space 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose

DB Statistics Verifies that database statistics have been 
collected for all tables created more than 24 
hours ago.

Database 
Connectivity

Verifies the connection between HP Business 
Availability Center and the database.

Monitor Name Description
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HP Business Availability Center Server Monitors
The following monitors run on the Gateway server, the Processing server, or, 
if not otherwise indicated, on both:

General Monitors

Monitor Name Description

Out of Memory in 
Log

Searches for unexpected behavior due to the 
server being out of memory, displayed as 
instances of Out of Memory in topaz_all.ejb.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Nanny Manager 
Process

Monitors whether HP Business Availability 
Center server processes are up and running. 

Threshold Configured In: SiteScope

For details on the monitor, see “Service Monitor 
Overview” in Using System Availability 
Management.

Log Level for 
<configuration 
directory>

Checks if any of the log files in the specified 
directory are configured to debug log level (i.e. - 
searches for the string loglevel=debug).

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

BAC Application 
Server Response

Checks that the BAC Application server is 
responsive. Information goes straight to the 
application server and does not travel via the 
web server. This monitor runs only on the 
Gateway Server.

Threshold Configured In: SiteScope

For details on the monitor, see “URL Monitor 
Overview” in Using System Availability 
Management.



Chapter 8 • System Health

183

Process Monitors

For descriptions of the processes, see “Process Manager Dialog Box” on 
page 253.

The two JVM monitors listed in the table below monitor only the Java 
processes, which include:

➤ cmdb 

➤ DataUpgrade 

➤ mercury_db_loader 

➤ MercuryAS 

➤ MessageBroker

➤ mercury_offline_engine

➤ mercury_online_engine 

➤ topaz_pm_process 

➤ mercury_wde 

➤ MercuryWSGuard 

Logged In Users Displays the percentage and number of total 
users logged into HP Business Availability 
Center.

Web Server Status Displays the current status of the Web server 
indicating its availability.

Monitor Name Description
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The <process name> monitor monitors the both the Java and non-Java 
processes. For details on the processes, see “HP Business Availability Center 
Processes” on page 177.

Monitor Display 
Name

Description

<Process name> Verifies whether the <process name> process is 
running, its CPU, and virtual memory 
utilization. 

For details on the monitor, see “Service Monitor 
Overview” in Using System Availability 
Management.

<Process Name> 
JVM Statistics 
Memory Monitors

Monitors the memory measurements for a Java 
process.

Included Measurements:

➤ Heap Free. Displays the amount of Heap Free 
space in JVM.

➤ Permanent Heap Free Memory. Displays the 
amount of Permanent Heap Free space in 
JVM.

<Process Name> 
JVM Statistics 
Threads Monitors

Monitors the threads measurements for a Java 
process. The process name is in the name of the 
monitor.

Included Measurements:

➤ Current Thread Count. Current number of 
threads used by the process.

➤ Dead Locked Threads. Number of 
deadlocked threads in the process.
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Bus

Monitor Display 
Name

Purpose

Subscriber 
Group

Monitors subscriber-related measurements.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Broker Group Monitors broker measurements.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Durable 
Subscriber 
Group

Provides information about durable subscribers 
in the broker.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Modeling/CMDB

Monitor Display 
Name

Purpose

Model Objects 
Quota and Count

Compares current CI count with the CI quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

TQL Quota and 
Count

Compares current TQL count with the TQL 
quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Oversized TQLs Displays TQLs that are larger than the size 
permitted by the configured threshold.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Availability and 
Performance

Checks system availability and response time.

Included Measurements: 

➤ Run AdHoc TQL. Checks how long the Run 
AdHoc TQL operation takes.

➤ Load ClassModel. Checks how long the Load 
ClassModel operation takes.

Threshold Configured In: Infrastructure 
Settings.

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

DB - Could not 
reset timeout 
because the 
object is not 
monitored

Searches for Couldn't reset timeout because the 
object isn't monitored in cmdb.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

DB - Failed to 
borrow object 
from pool

Searches for Failed to borrow object from pool in 
cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

DB - Failed to 
create a 
connection

Searches for Failed to create a connection for in 
cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Notification - 
Cannot Publish

Searches for cannot publish in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Notification - 
Cannot get 
notifications 
from the BUS

Searches for error occurred during receive of JMS 
message in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Performance - 
Request Timeout

Searches for Request Timeout in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Modeling/Viewing System

Monitor Display 
Name

Purpose

All Symbols 
Quota and Count

Compares current symbols count with symbols 
quota. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Views Quota and 
Count

Compares current views count with views 
quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Oversized Views Checks for views that are larger than the 
threshold configured in Infrastructure Settings.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Gateway Server Monitors
The following monitors run on the Gateway Server:

Data In/Web Data Entry

Monitor Name Description

Web Data Entry 
Status

Determines the overall status of the Web Data 
Entry component.

Included Measurements: 

➤ Bus Status. Determines Web Data Entry 
connection to the bus. 

➤ Gateway Status. Determines Gateway 
availability.

➤ Failures to Publish. Indicates number of 
samples which failed to publish. 

➤ Output EPS. Determines the number of 
published samples per second. 

Out of Memory 
Exception in Log

Searches for unexpected behavior, displayed as 
instances of the string 
OutofMemoryExceptionInLog in the wde.log file.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Class Not Found 
Exception in Log

Searches for unexpected behavior, displayed as 
instances of the string ClassNotFoundException 
in the wde.log file.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Web Data Entry 
Availability

Determines if Web Data Entry is up and 
running.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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Data In/Loader

Monitor Name Description

Main Flow Measures flow of data in component.

Included Measurements: 

➤ Number of Samples in Queues. Used to 
control memory usage of the loader. 

➤ Bus Connection Status. Checks loader 
connectivity to the bus.

Threshold Configured In: JMX of Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

EPS ratio in main 
flow

Enables you to evaluate the ratio of the average 
insert rate to the loader with the average data 
insert rate to the database from the loader.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Connection to 
DB

Checks connection to the database from loader 
process.

Average Insert 
Rate to DB 
(Recovery Flow)

Monitors the average insert rate to the database 
from the recovery persistency folder. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Dashboard Application

Out of Memory 
Exception in Log

Searches for the string Out of Memory in 
Loader.log. 

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Class Not Found 
Exception in Log

Searches for errors in Loader.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Max Files in 
Queue in 
Recovery 
Persister

Displays the number of files in the longest 
queue in the recovery persister directory.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Monitor Name Description

Dashboard 
Admin

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.admin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard 
Application

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.app.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Name Description
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Dashboard 
Application 
Front-end

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.app.frontend.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard 
Front-end 
Actions 

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.actionbase.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard BLE 
Plug-in

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.ble.plugin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard Rules Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.app.rules.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard 
Business Reports

Searches for unexpected behavior, displayed as 
instances of ERROR, in bzd.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Name Description
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Dashboard Open 
API

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.open.api.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Repositories Searches for unexpected behavior, displayed as 
instances of ERROR, in repositories.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Repositories UI Searches for unexpected behavior, displayed as 
instances of ERROR, in repositories.ui.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Repositories 
Upgrade

Searches for unexpected behavior, displayed as 
instances of ERROR, in 
repositories.upgrade.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Name Description
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Portal Application

Repositories 
Context Menu UI

Searches for unexpected behavior, displayed as 
instances of ERROR, in context.menu.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Center High 
Availability 

Searches for unexpected behavior, displayed as 
instances of ERROR, in bac.ha.centers.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Description

MyBAC Searches for unexpected behavior, displayed as 
instances of ERROR, in portal.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Name Description
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Verticals Application

Monitor Display 
Name

Description

Verticals Core Searches for unexpected behavior, displayed as 
instances of ERROR, in vertical.ejb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

BAC for Siebel Searches for unexpected behavior, displayed as 
instances of ERROR, in siebel.ejb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

BAC for SAP Searches for unexpected behavior, displayed as 
instances of ERROR, in sap.ejb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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System Availability Management Application

Monitor Display 
Name

Purpose

SAM Admin Fatal Searches for unexpected behavior, displayed as 
instances of FATAL, in sam-admin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

SAM Admin 
SiteScope 
Profiles on DB

Searches for unexpected behavior, displayed as 
instances of ERROR-Unable to get SiteScope 
profiles from DB, in sam-admin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

SAM Admin 
SiteScope 
Profiles List

Searches for unexpected behavior, displayed as 
instances of Failed retrieve SiteScope profiles list, 
in sam-admin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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Service Level Management Application

Monitor Display 
Name

Purpose

SLAs Monitor 
Leaf Validator

Indicates that the SLM hierarchy does not 
detect its monitors, due to removed or replaced 
transactions or CIs. 

SLM Logic Searches for unexpected behavior, displayed as 
instances of unexpected result, in slm.rules.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

SLM Reports Searches for unexpected behavior, displayed as 
instances of unexpected result, in 
slm_reports.ejb.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

SLM Snapshot Searches for unexpected behavior, displayed as 
instances of unexpected result, in 
slm_snapshot.ejb.log.

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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Processing Server Monitors
The following component monitors run on the Processing Server:

Alerts Engine

Monitor Display 
Name

Purpose

BLE-BUS 
Connection 
Monitor

Monitors connection between the BLE Offline 
Engine and the bus.

queue/alert_engin
e_alert

Measures the size of the queue between the BLE 
and the Alerts Listener.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

queue/alert_engin
e_notification

Measures the size of the queue between the 
Alerts Listener and the Notification Listener.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Bus

Monitor Display 
Name

Purpose

Subscriber 
Group

Monitors subscriber related measurements.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Broker Group Monitors broker measurements.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Durable 
Subscriber 
Group

Provides information about durable subscribers 
in the broker.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Database Services/Partition Manager

Monitor Display 
Name

Purpose

Partition Timely 
Creation

Verifies that partitions are created according to 
partitioning policy.

Note: This monitor is displayed as red for two 
hours after being connected. 

Oversized 
Partitions

Finds partitions with more than the allotted 
number of rows specified in threshold settings.

Threshold Configured In: 

<HP Business Availability Center Root 
Directory>\conf\pmanager.properties, located on 
the server that System Health is deployed on.

You can edit these settings in the properties file:

➤ MAX_ROWS_PER_PARTITION. The optimal 
number of rows per partition that PM strives 
to create.

➤ WARN_ROWS_PER_PARTITION. The number 
of rows in the partition that generate a 
warning.

➤ ERROR_ROWS_PER_PARTITION. The number 
of rows in the partition that generate an 
error.
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Application Engines/Dashboard Engine

Monitor Display 
Name

Purpose

BLE Online 
Monitor

Monitors BLE Online calculations.

Included Measurements:

➤ Size of Model. Percentage of model size 
relative to the maximum capacity.

➤ DB Availability. Verifies connection to the 
database.

➤ Bus Connectivity. Verifies connection to the 
bus.

➤ Persistency. Indicates the number of failures 
in saving persistency data.

➤ Calculation Duration. Average calculation 
time.

Threshold Configured In: Infrastructure 
Settings. To access, go to Admin > Platform > 
Setup and Maintenance > Infrastructure 
Settings and search under System Health or the 
applicable component application.

Dashboard BLE 
Plug-in

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.ble.plugin.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Dashboard Rules Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.app.rules.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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Application Engines/SLM Engine

Repositories Searches for unexpected behavior, displayed as 
instances of ERROR, in repositories.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Repositories 
Upgrade

Searches for unexpected behavior, displayed as 
instances of ERROR, in 
repositories.upgrade.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose

BLE Offline Tasks Indicates whether the time taken to perform 
the SLM tasks took longer than the time 
allotted in Infrastructure Settings.

Included Measurements:

➤ Delayed Tasks. Shows whether there are 
delayed or failed SLM calculation tasks.

➤ Cycle Time. Shows the percentage of the 
overall measurement period used to 
complete calculation of ongoing SLM tasks. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Monitor Display 
Name

Purpose
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BLE Offline 
Monitor

Monitors BLE Offline calculations.

Included Measurements:

➤ DB Availability. Verifies connection to the 
database.

➤ Bus Connectivity. Verifies connection to the 
bus.

➤ Persistency. Indicates the number of failures 
in saving persistency data. 

➤ Max Task Duration. Displays the duration of 
the longest task over the time configured in 
Infrastructure Settings, indicating whether or 
not the SLM calculation is too slow.

➤ Data Stream Fuse Violations. Indicates 
performance problems due to the amount of 
data queried for SLM calculations.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

SLM Logic 
Monitor

Searches for unexpected behavior, displayed as 
instances of unexpected result, in slm.rules.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Application Engines/Reports DB Aggregator

Monitor Display 
Name

Purpose

DB Aggregator Indicates whether the time to perform the DB 
Aggregation task took longer than the time 
configured in Infrastructure Settings. 

Included Measurements: 

➤ Delayed Tasks. Displays whether delayed or 
failed tasks are found. 

➤ Cycle Time. Shows the percentage of the 
overall measurement period used to 
complete aggregation calculations. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Validator Responsible for the creation of DB Aggregation 
and SLM tasks. 

Included Measurements:

➤ Validation Time. Checks whether validation 
ran within the time frame defined in the 
Offline Aggregation settings.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Scheduler Schedules when the DB Aggregator and SLM 
tasks are performed.

Included Measurements:

➤ Threads Alive. Checks for active threads in 
the offline aggregation scheduler.
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Application Engines/CDM

Modeling/CMDB

Monitor Display 
Name

Purpose

Adapters 
Framework

Searches for unexpected behavior, displayed as 
instances of ERROR, in bam.shared.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose

Model Objects 
Quota and Count

Compares current CI count with the CI quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

TQL Quota and 
Count

Compares current TQL count with the TQL 
quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Oversized TQLs Displays TQLs that are larger than the size 
permitted by the configured threshold.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Availability and 
Performance

Checks system availability and response time.

Included Measurements: 

➤ Run AdHoc TQL. Checks how long the Run 
AdHoc TQL operation takes.

➤ Load ClassModel. Checks how long the Load 
ClassModel operation takes.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

DB - Could not 
reset timeout 
because the 
object is not 
monitored

Searches for Couldn't reset timeout because the 
object isn't monitored in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

DB - Failed to 
borrow object 
from pool

Searches for Failed to borrow object from pool in 
cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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DB - Failed to 
create a 
connection

Searches for Failed to create a connection for in 
cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Notification - 
Cannot Publish

Searches for cannot publish in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Notification - 
Cannot get 
notifications 
from the BUS

Searches for error occurred during receive of JMS 
message in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Performance - 
Request Timeout

Searches for Request Timeout in cmdb.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Modeling/Viewing System

Monitor Display 
Name

Purpose

All Symbols 
Quota and Count

Compares current symbols count with symbols 
quota. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Views Quota and 
Count

Compares current views count with views 
quota.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

Oversized Views Checks for views that are larger than the 
threshold configured in Infrastructure Settings.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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BPI Server Monitors
The following component monitors run on the BPI Server:

Monitor Display 
Name

Purpose

Data Samples 
Provider

Searches for [SEVERE|ERROR] in 
bia_bacdatasamples0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Notification 
Server

Searches for [SEVERE|ERROR] in 
bia_notify0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Servlet Engine Searches for [SEVERE|ERROR] in 
bia_tomcat0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

CI Status Poller Searches for [SEVERE|ERROR] in 
bia_adaptor_framework0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.
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JMS Business 
Event Handler

Searches for ERROR in 
Rolling_Adaptor_BIAJMSEngineAdaptor.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Process 
Repository 

Searches for [SEVERE|ERROR] in 
bia_model_repository0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Engine Searches for [SEVERE|ERROR] in 
bia_metric_engine0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Business Event 
Handler

Searches for ERROR in 
Rolling_Adaptor_BIAEngineAdaptor.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Web Services 
Provider

Searches for [SEVERE|ERROR] in 
bia_webservices0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Business Impact 
Engine

Searches for [SEVERE|ERROR] in 
bia_bce0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Admin Server Searches for [SEVERE|ERROR] in 
bia_adminserver0_0.log.

Threshold Configured In: SiteScope

For details on the monitor, see “Log File 
Monitor Overview” in Using System Availability 
Management.

Monitor Display 
Name

Purpose
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Data Collectors
Following are the data collectors that run as part of HP Business Availability 
Center:

BPM Data Collector

Monitor Display 
Name

Purpose

BPM Last Ping 
Time

Reports time of most recent ping performed 
from BPM data collectors. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.

BPM Last 
Reported Data 
Time

Measures last reported time of data received 
from BPM data collectors. 

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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SiteScope Data Collector

Monitor Display 
Name

Purpose

SiteScope status 
on <SiteScope 
instance>

Measures the overall status of the SiteScope data 
collector.

Included Measurements: 

➤ Last Heartbeat. Indicates the time of the 
most recent sample received from SiteScope 
that indicates the basic availability (i.e. - 
heartbeat) of the system.

➤ Health Status. Indicates the status of the 
SiteScope Health group, and number of 
monitors in the group with error status.

Note: Both measurements are monitored only if 
using SiteScope version 9.0 or higher. If a 
previous version is installed, only the Last 
Heartbeat measurement is monitored.

Threshold Configured In: Infrastructure 
Settings. 

To access, go to Admin > Platform > Setup and 
Maintenance > Infrastructure Settings and 
search under System Health or the applicable 
component application.
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Discovery Probe Data Collector

Monitor Display 
Name

Purpose

Discovery Probe 
status on 
<Discovery 
Probe instance>

Receives discovery tasks from the server, 
dispatches them, and sends the results back to 
the CMDB through the server.

Included Measurements: 

➤ Last Report Time. The most recent report 
time.

➤ Amount of Reported CIs. The number of CIs 
reported by the probe.

➤ Last Access Time. The most recent time the 
probe was accessed.
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RUM Data Collector

Monitor Display 
Name

Purpose

RUM Status on 
<RUM Engine 
Instance Name>

Displays the aggregated status of the Real User 
Monitor data collector.

Included Measurements: 

➤ RUM Engine. Aggregated status of the Real 
User Monitor engine monitors.

➤ RUM Probe IP. Aggregated status of the Real 
User Monitor probe with the specified IP 
address. Each probe has its own entry. 

➤ Database. Aggregated status of Real User 
Monitor internal DB monitors.

➤ Samples to Business Availability Center 
server. Aggregated status of the Real User 
Monitor samples sent to HP Business 
Availability Center.

Threshold Configured In: Real User Monitor 
internal configuration.

Note: If the Real User Monitor data collector’s 
status is problematic, refer to the Real User 
Monitor web console for troubleshooting. For 
details, see “Monitoring the Health of HP Real 
User Monitor Components” in the Real User 
Monitor Administration PDF.
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Component and Monitor Status Indicators

The following table displays a colored icon and a description of its status, as 
displayed on both the Inventory tab and the Monitors table in the System 
Health Dashboard Right pane:

Note: After deploying System Health, the monitor colors appear gradually as 
each monitor runs according to its schedule.

Status Description

The component and all 
subcomponents are working properly 
(status is good).

The component or a subcomponent 
has a critical problem (status is error). 

A red indicator is accompanied by an 
x symbol. 

It is recommended that you drill 
down in the component to identify 
its specific problematic monitors.

The component or a subcomponent 
has a non-critical problem, or did not 
receive an answer from the server 
(status is warning). 

The yellow indicator is accompanied 
by a ! symbol.

There is no data available for the 
monitors. Displayed if the monitors 
have not yet run. 

The gray indicator is accompanied by 
a - symbol.
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System Health User Interface

This section describes:

 ➤  Inventory Tab on page 218

 ➤  Log Manager on page 221

 ➤  System Health Dashboard on page 224

 ➤  System Health Setup Wizard on page 237

 ➤  Toolbar on page 245

Inventory Tab

Description Displays the status of the HP Business Availability 
Center servers and their respective components in 
table format. 

The Inventory tab enables you to compare the 
performance of servers of the same type and to view 
statuses in a flat view, versus the hierarchal view of the 
Dashboard.

To access: Click the Inventory tab on the System 
Health interface.

Important 
Information

In addition to fields representing the monitors and 
components displayed on the System Health 
Dashboard, the tables contain the following fields:

➤ Name. The name of the server. 

➤ Type. The type of server (appears only for Gateway 
and Processing server tables).

➤ Status. The overall status of the machine, indicated 
by a colored icon. For details on the colored icons, 
see “Component and Monitor Status Indicators” on 
page 217.

Descriptions of the monitors are displayed on the 
Monitor Details pane.

Useful Links “System Health Monitors” on page 179
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Gateway Machines Table

Processing Machines Table

Description Displays information about the Gateway machines 
being monitored by System Health, and their 
subcomponents.

Important 
Information

➤ Click the arrows in the header to expand or collapse 
the table.

➤ The subcomponents’ status is indicated by a colored 
ball icon. For details on the status represented by 
each color, see “Component and Monitor Status 
Indicators” on page 217.

➤ Details on the selected subcomponent appear in the 
<Subcomponent Name> Details table.

Note: The cell names are identical to the corresponding 
component or subcomponent displayed on the System 
Health Dashboard.

Useful Links “System Health Displays” on page 154

“HP Business Availability Center Components” on 
page 175

“System Health Monitors” on page 179

Description Displays information about the Data Processing 
machines being monitored by System Health, and their 
subcomponents.
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<Subcomponent Name> Details Table

Important 
Information

➤ Click the arrows in the header to expand or collapse 
the table.

➤ The subcomponents’ status is indicated by a colored 
ball icon. 

➤ Details on the selected subcomponent appear in the 
<Subcomponent Name> Details table.

Note: The cell names are identical to the 
corresponding component or subcomponent 
displayed on the System Health Dashboard.

Useful Links “System Health Displays” on page 154

“HP Business Availability Center Components” on 
page 175

“System Health Monitors” on page 179

Description Displays information about the specific component or 
subcomponent selected in the Gateway Machines table 
or the Processing Machines table.

Important 
Information

➤ The status of the subcomponent and its monitors 
are indicated by a either a colored icon, or, where 
applicable, a numerical value in the color indicating 
its status. For details on the colors’ status, see 
“Component and Monitor Status Indicators” on 
page 217.

➤ The cell headings correspond to the monitors 
running on the selected component. The Name and 
Status cell headings display the name of the 
machine and its overall status, respectively. 

➤ The Monitor Details pane provides additional 
information on the monitor selected in the 
<Subcomponent Name> Details table.

Useful Links “System Health Monitors” on page 179

“Monitors Table” on page 225
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Log Manager

Description Displays the logs file output associated with the various 
components being monitored by System Health. 

To access: Click the Log Manager tab on the System 
Health interface.

Important 
Information

➤ You can view a log file by selecting a component in 
the Log Bundles pane and performing one of the 
following actions: 

➤ Double click

➤ Drag and drop it into the Main pane

➤ Click the Retrieve Logs button  

➤ You can search for a string in the Main pane by 
selecting any point in the pane and typing the string 
you want to find. You can also search the content of a 
set of logs by saving the output to a .txt file and 
performing a search. 

Useful Links “Log Manager Tab” on page 158
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to retrieve logs for the specified entities. You can 
retrieve log files by selecting a specific file, a bundle, or a 
machine. 

Note: 

➤ You can also view log files by dragging the selected 
entity to the main frame.

➤ The Log Manager cannot display a log file larger than 
1 MB. If you try to retrieve a log file larger than this, a 
message is displayed prompting you to download the 
file to your local machine. 

Click to save the selected log files. 

➤ When selecting this button in the main frame, the 
currently displayed logs are saved. 

➤ When selecting this button on the Log Bundles pane, 
the selected entities are saved, without being displayed 
in the main frame. This option is useful if you are 
saving a large output of data, or if you want to perform 
a complex search on the data output.

Indicates a log bundle or machine whose content has 
been collapsed or not expanded in the Log Bundles 
hierarchical tree.

Note: This is the default view in the Log Bundles pane.

Indicates a log bundle or machine whose content has 
been expanded in the Log Bundles hierarchical tree.

Indicates a log file. You can view a log file in one of the 
following ways: 

➤ Double click the log file 

➤ Drag and drop the log file into the main pane

➤ Select the log file and click the Retrieve Logs button 
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<tab #> Indicates a selection of any combination of bundles, 
machines, or log files. The tabs are numbered 
chronologically, according to the number of retrieval 
actions you have performed. 

Note: The specific logs displayed in the tab are listed at 
the top of the pane. If more than 5 logs have been 
retrieved, the message Assorted logs (more than 5) is 
displayed in place of the log list. 

From Select a date and time from which the log data is to begin 
being displayed.

To Select a date and time until which the log data is to be 
displayed.

GUI Element (A-Z) Description
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System Health Dashboard

Left Pane

Description Enables you to view HP Business Availability Center 
components and their status, including information 
on the properties and monitors associated with the 
components. 

This is the default display when you access System 
Health.

The System Health Dashboard consists of the following 
areas: 

➤ Left pane

➤ Right pane

➤ Monitors table

➤ General table

You can perform actions on the System Health 
Dashboard using the Toolbar above the Left pane. For 
details, see “Toolbar” on page 245.

To access: Select Admin > Platform > Setup and 
Maintenance > System Health

Additional Links “Deploy and Access System Health” on page 163

“System Health Setup Wizard” on page 237

“System Health Displays” on page 154

Description Displays a map of the databases, servers, data 
collectors, and mediators and load balancers (if they 
exist in your deployment) deployed on HP Business 
Availability Center. For details, see “Map of 
HP Business Availability Center System and 
Components” on page 229.

Important 
Information

The status of the components is indicated by the color 
of the box surrounding the icon and the 
accompanying symbol. For details, see “Component 
Status and Description” on page 230.

Useful Links “System Health Displays” on page 154
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Right Pane

Monitors Table

The Monitors table includes the following elements (listed alphabetically):

Description Displays information on components selected in the 
Left pane. 

Important 
Information

The Right pane consists of the following tables:

➤ Monitors. Displays information about the monitors 
and subcomponents on the highlighted component 
in the Left pane.

➤ General. Displays information about the properties 
of the highlighted server in the Left pane.

➤ Data Collector Details. Displays information about 
the data collector highlighted in the Left pane. 

Useful Links “System Health Displays” on page 154

Description Displays information on the monitors running on the 
selected component in the System Health Dashboard.

Click the arrows in the header to expand or collapse 
the table.

Useful Links “HP Business Availability Center Components” on 
page 175

GUI Element (A-Z) Description

Click to disable the selected monitor. 

Click to reactivate the selected monitor’s schedule.

Click to run the selected monitor immediately. The 
monitor must first be enabled for you to use this 
option. 
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Click to expand the list of monitors to list all monitors 
and measurements for that object. This is the default 
view.

Click to collapse the list of monitors to display only the 
monitors and hide the monitor measurements.

Click to refresh the list of monitors to display the latest 
status for the monitors.

An individual monitor that is running on the selected 
component.

A group of monitors that are running on the selected 
component.

Last Updated Indicates the last time that the monitor ran.

Monitor Details Contains the following fields: 

➤ Description. Describes the selected monitor. 

➤ Additional Information. Displays a text string result 
of the selected monitor’s output. 

➤ Value. Displays a numerical result of the selected 
monitor’s output. 

Note: Not all fields are displayed for every monitor. 

Monitor/Group 
Name

The name of the monitor or group of monitors 
running on the component selected in the Left pane.

Status Indicates the monitor or monitor group’s status, 
displayed as a colored ball icon. For details on these 
icons, see “Component and Monitor Status Indicators” 
on page 217. 

GUI Element (A-Z) Description
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General Table

The General table includes the following elements (listed alphabetically):

Data Collector Details Table

Description Displays information about the properties associated 
with the selected server in the Left pane.

Click the arrows in the header to collapse and expand 
the table.

Click the header name to sort by the header’s value.

Important 
Information

This table appears only when a server is selected in the 
System Health Dashboard.

GUI Element (A-Z) Description

Property Name Lists the properties associated with the selected 
component, such as: 

➤ IP Address

➤ Build number

➤ Operating system type

Value Lists the value of the specified property.

Description Displays information, in tree form, about the data 
collector selected in the Left pane.

Click the arrows in the header to collapse and expand 
the table.

Important 
Information

This table appears only when a data collector is 
selected in the System Health Dashboard.
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The Data Collector Details table includes the following elements (listed 
alphabetically):

GUI Element (A-Z) Description

A Discovery Probe.

A Business Process Monitor (BPM) data collector.

A Real User Monitor (RUM) data collector.

A SiteScope (SiS) data collector. 

Displayed next to the IP address of the machine on 
which the Discovery Probe is running.

Displayed next to the IP address of the machine on 
which the Business Process Monitor (BPM) data 
collector is running.

Displayed next to the IP address of the machine on 
which the Real User Monitor (RUM) data collector is 
running.

Displayed next to the IP address of the machine on 
which the SiteScope (SiS) data collector is running.

Denotes an instance of a Discovery Probe. 

Denotes an instance of a Business Process Monitor 
(BPM) data collector.

Denotes an instance of a Real User Monitor (RUM) data 
collector.

Denotes an instance of a SiteScope (SiS) data collector.
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Map of HP Business Availability Center System and 
Components

Property Name Lists the properties associated with the selected data 
collector, such as:

➤ Build number

➤ Port number

➤ Version number

Value Lists the value of the specified property.

Description Depicts the various HP Business Availability Center 
components measured by System Health.

➤ Database components appear on the left side of the 
map.

➤ Server components appear to the right of the 
database components.

➤ Load Balancer components (if deployed) appear to 
the right of the HP Business Availability Center 
Server components.

Note: When System Health is deployed in a secured 
environment, Reverse Proxy components appear 
with the Load Balancer components.

➤ Data collector components appear on the right side 
of the map.

To access: Click the Dashboard tab on the System 
Health interface.

GUI Element (A-Z) Description
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Component Status and Description

Important 
Information

You may also see obsolete hosts that are no longer 
running HP Business Availability Center. To disable 
these obsolete hosts, browse to the URL 
http://<Gateway Server machine name>.< 
domain_name>/topaz/systemConsole/displayBACHost
s.do and disable all obsolete hosts.

Useful Links “System Health Displays” on page 154

“Component and Monitor Status Indicators” on 
page 217

“Monitors Table” on page 225

Description Displays the status of the components monitored by 
System Health.

Important 
Information

The color of all component outlines reflects the lowest 
functioning level subcomponent or monitor contained 
in the component, known as the worst child rule. The 
exception to this rule is the gray outlined components, 
which do not automatically cause their parent 
components to be outlined in gray.

Useful Links “System Health Displays” on page 154

“Component and Monitor Status Indicators” on 
page 217

“Monitors Table” on page 225
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The following table displays a sample icon and a description of its outlined 
color and status, as displayed on the System Health Dashboard:

Status Description

A green outline indicates that the component and 
its subcomponents are working properly. The 
component’s icon is accompanied by a check 
symbol inside a green square.

A red outline indicates that a critical problem exists 
in the component, in one of its subcomponents, or 
both. The component’s icon is accompanied by an x 
symbol inside a red square.

It is recommended that you drill down in the 
component to identify its specific problematic 
monitors.

A yellow outline indicates one of the following: 

➤ A non-critical problem exists either in the 
component, in one or more of its 
subcomponents, or both. 

➤ The component’s monitors were unable to 
connect with the server.

The component’s icon is accompanied by a ! symbol 
inside a yellow square.

A gray outline indicates that there are currently no 
monitors scheduled to run for the component. The 
component’s icon is accompanied by a - sign inside 
a gray square. 

A jagged blue outline, together with the 
component’s status color represents the currently 
highlighted component.
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Icons and Buttons

Following are the component icons and buttons on the Map of HP Business 
Availability Center System and Components:

GUI Element (A-Z) Description

Click to expand the component and view its 
subcomponents.

Important: You must select the cursor button  on 
the System Health Dashboard Toolbar to operate the 
Expand button. 

Click to hide the subcomponents contained within the 
selected component.

Important: You must select the cursor button  on 
the System Health Dashboard Toolbar to operate the 
Hide button.

A Database server

A Database

A Gateway server

A Processing server

A group of processes

A group of server monitors

A bus component

A logical group

Example: Alerts Engine
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Database Components

An application

Example: Dashboard

A group of applications

A service

Example: Service Level Management Engine

A group of Business Process Monitor data collectors

A group of SiteScopes

A group of Discovery Probes

A group of Real User Monitor data collectors

Indicates the flow of data.

Note: Click the Navigation button  and then click 
anywhere on an arrow line to find the arrow’s 
destination or origin.

Description The databases that are deployed on HP Business 
Availability Center. 

Database components appear on the left side of the 
System Health Dashboard Left pane.

GUI Element (A-Z) Description
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The following elements are displayed:

Server Components and Processes

The Map of HP Business Availability Center System and Components  
includes the following server elements (listed alphabetically): 

➤ Alerts Engine

➤ Applications (Dashboard application, Service Level Management, System 
Availability Management, and Portal components)

➤ Applications Engines

➤ BPMs (Business Process Monitors)

➤ bus

Important 
Information

You may also see obsolete hosts that are no longer 
running HP Business Availability Center. To disable 
these obsolete hosts, browse to the URL 
http://<Gateway Server machine name>.< 
domain_name>/topaz/systemConsole/displayBACHost
s.do and disable all obsolete hosts.

Useful Links “System Health Displays” on page 154

“Component and Monitor Status Indicators” on 
page 217

“Monitors Table” on page 225

GUI Element (A-Z) Description

CMDB Database A central repository for configuration information.

Foundation Database Used to store system-wide and management-related 
metadata for the HP Business Availability Center 
environment.

History Database Used for storage of data, over time, of the CMDB 
configuration items (CIs).

Profile Database Used to store raw and aggregated measurement data 
obtained from the HP Business Availability Center data 
collectors.
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➤ CMDB

➤ CDM

➤ Dashboard Engine

➤ Discovery and Dependency Mapping Probes

➤ modeling 

➤ Portal application (My BSM)

➤ Processes (for details, see “HP Business Availability Center Processes” on 
page 177)

➤ Real User Monitor Engines

➤ Reports database aggregator

➤ SAM (System Availability Management - Management of SiteScopes)

➤ Scheduler (NOA service scheduler)

➤ Server monitors

➤ SiteScopes

➤ SLM (Service Level Management) Engine

➤ Validator (NOA service validator)

➤ Verticals (SAP service and Siebel service)

Data Collector Components

Description Depicts the data collector elements that are deployed 
on HP Business Availability Center. 

Data Collector components appear on the right side of 
the System Health Dashboard Left pane.



Chapter 8 • System Health

236

The following elements are displayed: 

Important 
Information

You may also see obsolete hosts that are no longer 
running HP Business Availability Center. To disable 
these obsolete hosts, browse to the URL 
http://<Gateway Server machine name>.< 
domain_name>/topaz/systemConsole/displayBACHost
s.do and disable all obsolete hosts. 

Useful Links “System Health Displays” on page 154

“Component and Monitor Status Indicators” on 
page 217

“Monitors Table” on page 225

GUI Element (A - Z) Description

BPMs Displays the status of the Business Process Monitor 
data collectors.

Discovery Probes Displays the status of the Discovery Probes.

RUM Engines Displays the status of the Real User Monitor engines.

SiteScopes Displays the status of the SiteScopes.
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System Health Setup Wizard

Description Enables you to establish remote connectivity to the 
HP Business Availability Center and database servers 
for full monitoring.

To access: Select Admin > Platform > Setup and 
Maintenance > System Health.

Note:

➤ To enable configuring the System Health 
application, the System Health Setup Wizard opens 
automatically the first time you access the 
application after installation. For subsequent users 
and user instances, the wizard does not open 
automatically.

➤ You can also access the System Health Setup Wizard 
by performing either Full Model Synchronization or 
Soft Synchronization. Soft Synchronization 
generates the wizard only if changes were made to 
the System Health model, and Full Model 
Synchronization generates the wizard only if no 
component is selected. 

➤ The user whose remote connection information you 
enter into the System Health Setup Wizard can 
perform only those actions for which they have 
permissions.

Important 
Information

➤ If you do not enter remote connection details for the 
server, System Health retrieves information only for 
monitors that do not require credential 
authorization to access the HP Business Availability 
Center servers.

➤ The Left pane of the System Health Setup Wizard 
indicates the page of the wizard on which you are 
currently working.
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Sample Status and Description

When creating remote connections through the System Health Setup 
Wizard, a colored icon indicates the connection status.

The following table describes each color and its status:

Wizard Map The System Health Setup Wizard contains:

Remote Servers Setup Page > Remote Databases Setup 
Page > Recipients Setup Page

Additional Links “System Health Setup Wizard – Overview” on page 153

“Deploy and Access System Health” on page 163

“System Health Monitors” on page 179

Status Description

A green icon indicates that the credentials entered 
are sufficient for all of the monitors to access the 
HP Business Availability Center servers. 

A red icon indicates that remote connectivity to the 
selected server has failed, due to one of the 
following reasons: 

➤ The permissions level of the user entered in the 
wizard are not sufficient for the monitors to 
retrieve information from the specified server.

➤ The user entered in the wizard does not exist on 
the HP Business Availability Center machine 
running on the specified server. 

➤ A mistake has been made in the user credentials 
entered in the wizard. 

A red icon is accompanied by an "x" symbol inside a 
red square. 

A gray icon indicates that no attempt was made to 
establish remote connectivity to the specified server. 

A gray icon is accompanied by a "-" symbol inside a 
gray square. 
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Remote Servers Setup Page

The Servers Remote Setup Page includes the following elements (listed 
alphabetically):

Description Enables you to create a remote connection to 
HP Business Availability Center servers for System 
Health to monitor.

Important 
Information

➤ You can configure different settings for each server, 
or apply the same settings to all servers.

➤ You must configure the remote connection details 
for the server in order for System Health to run all of 
the server’s available monitors. If you do not enter 
remote connection details for the server, System 
Health retrieves information only for monitors that 
do not require credential authorization to access the 
HP Business Availability Center servers.

General information about the wizard is available in 
“System Health Setup Wizard” on page 237.

Additional Links “System Health Setup Wizard – Overview” on page 153

Wizard Map The System Health Setup Wizard contains:

Remote Servers Setup Page > Remote Databases Setup 
Page > Recipients Setup Page

GUI Element (A-Z) Description

Click to show descriptions of the Remote connection 
details fields. Click again to hide descriptions.

Apply Click to apply the remote connection configurations 
for the selected servers.

Encoding The encoding used by the server.

Example: Cp1252, UTF-8
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Login Enter the login name to be used for establishing remote 
connectivity between the monitors and the specified 
servers.

The user whose login name is entered must have the 
appropriate permission level for the monitors to run on 
the server.

The format for entering information into this cell is 
DOMAINNAME\login. 

Method Select the method of communication for connecting to 
the HP Business Availability Center components.

Example: NetBIOS, SSH

OS Type Enter the Operating System running on the server.

Example: Windows, UNIX

Note: This field is visible only if System Health does 
not identify an operating system on the server.

Password Enter the password of the login name to be used for 
establishing remote connectivity with the specified 
servers. 

The user whose password is entered must have the 
appropriate permission level for the monitors to run on 
the server.

GUI Element (A-Z) Description
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Remote Databases Setup Page

The Databases Remote Setup Page includes the following elements (listed 
alphabetically):

Description Enables you to create a remote connection to databases 
for System Health to monitor.

Important 
Information

➤ You can configure different settings for each server, 
or apply the same settings to all servers.

➤ You must configure the remote connection details 
for the database in order for System Health to run all 
of the database’s available monitors. If you do not 
enter remote connection details for the database, 
System Health retrieves information only for 
monitors that do not require credential 
authorization to access the HP Business Availability 
Center servers.

General information about the wizard is available in 
“System Health Setup Wizard” on page 237.

Wizard Map The System Health Setup Wizard contains:

Remote Servers Setup Page > Remote Databases Setup 
Page > Recipients Setup Page

Additional Links “System Health Setup Wizard – Overview” on page 153

GUI Element (A-Z) Description

Click to show descriptions of the Remote connection 
details fields. Click again to hide descriptions.

Apply Click to apply configurations for the selected database.

Encoding Indicate the encoding used by the server running the 
database.

Example: Cp1252, UTF-8
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Initialize Shell 
Environment 

Optionally, enter any shell commands to be executed 
at the beginning of the session. Separate multiple 
commands with a semicolon (;). This option specifies 
shell commands to be executed on the remote machine 
directly after a Telnet or SSH session has been initiated. 

Login Enter the login name used to access the operating 
system running on the server on which the database is 
installed.

Note: The format for entering information into this 
cell is DOMAINNAME\login. 

Login Prompt The prompt output when the system is waiting for the 
login to be entered. 

Default: login:

Method Select the method of communication for System 
Health to speak to the database.

Example: NetBIOS, SSH

Operating System Enter the Operating System running on the server.

Example: Windows, UNIX

Note: This field is visible only if System Health does 
not identify an operating system on the server.

Password Enter the password used to access the operating system 
running on the server on which the database is 
installed.

Password Prompt The prompt output when the system is waiting for the 
password to be entered. 

Default: password:

Prompt The prompt output when the remote system is ready to 
handle a command. 

Default: #

GUI Element (A-Z) Description
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Recipients Setup Page

Secondary Prompt Optionally, enter the secondary prompts if the telnet 
connection to the remote server causes the remote 
server to prompt for more information about the 
connection. Separate multiple prompt string by 
commas (,). 

Secondary Response Optionally, enter the responses to any secondary 
prompts required to establish connections with this 
remote server. Separate multiple responses with 
commas (,). 

Description Enables you to configure recipients to receive 
predefined System Health alerts through email.

Important 
Information

General information about the wizard is available in 
“System Health Setup Wizard” on page 237.

Wizard Map The System Health Setup Wizard contains:

Remote Servers Setup Page > Remote Databases Setup 
Page > Recipients Setup Page

Additional Links “System Health Setup Wizard – Overview” on page 153

GUI Element (A-Z) Description
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The Recipients Setup Page contains the following elements:

GUI Element (A-Z) Description

Click to display descriptions of the Recipient Details 
fields. Click again to hide descriptions.

<Recipients Pane> Displays a list of recipients configured to receive 
predefined System Health alerts through email.

Click the recipient’s name to edit their details. 

Click Add new recipient to configure a new recipient. 

BSM Databases Select to receive alerts on the status of HP Business 
Service Management Databases.

BSM servers, 
services, and 
applications

Select to receive alerts on status of HP Business Service 
Management servers, services, and applications.

Create Adds the configured recipient to the recipient list pane.

Email Enter the recipient’s email address.

Mediators Select to receive alerts on status of HP Business 
Availability Center Mediators and Load Balancers.

Name Enter the recipient’s name.
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Toolbar

Dashboard Customization Buttons

Description Enables you to:

➤ Customize the display of the HP Business 
Availability Center components on the System 
Health Dashboard. 

➤ Perform actions on the components.

➤ Perform management operations on the 
components.

➤ Synchronize the status and model of the 
components.

To access: The Toolbar is located at the top of both the 
System Health Dashboard and the Inventory tab.

Important 
Information

Buttons that customize the display of the HP Business 
Availability Center components (Dashboard 
Customization Buttons) appear only on the System 
Health Dashboard. All other buttons appear on both 
the System Health Dashboard and the Inventory tab.

Useful Links “Service Manager Dialog Box” on page 251 

“Backup Server Setup Window” on page 252

“Process Manager Dialog Box” on page 253

“Quick Report Screen” on page 254

Description Enable you to customize the appearance of the 
components on the System Health Dashboard.

Note: The buttons that customize the display of the 
HP Business Availability Center components appear 
only on the System Health Dashboard, and do not 
appear on the Inventory tab.

Useful Links “System Health Displays” on page 154
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The Dashboard Customization Buttons are:

GUI Element Description

Click to enable selecting a component on the System 
Health Dashboard Left pane.

Note: This button is selected by default upon entering 
the System Health Dashboard.

Click to pan the System Health Dashboard Left pane.

Click to zoom on a specific area of the System Health 
Dashboard Left pane.

You zoom by holding down the left click button on 
your pointer. Move the pointer down to zoom in; move 
the pointer up to zoom out.

Click to navigate between components of the 
dashboard.

You click the Navigation button and then click a line 
connecting two components or subcomponents. 
Depending on where on the line you click, the cursor 
navigates to either the original or endpoint 
component, whichever is further.

Click to fit all open components and subcomponents 
into the visible area.

Click to undo your previous action and go back to the 
previous display on the System Health Dashboard Left 
pane. 

Note: This button is enabled only if you have 
generated more than one view on the System Health 
Dashboard Left pane.

Click to redo an action that has been undone with the 
Undo button .

Note: This button is enabled only if you have 
generated more than one view on the System Health 
Dashboard, and are not currently resting on the most 
recent view.
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Action Buttons

Click to realign System Health Dashboard Left pane 
components, so that the components are aligned in 
their original order, which is (left to right):

➤ Databases

➤ Servers

➤ Load Balancers (if deployed)

➤ Data Collectors

Click to return the System Health Dashboard Left pane 
to its default view. This includes closing open 
components and realigning component boxes to their 
original state.

Click for an overview map of all the component boxes 
on the System Health Dashboard Left pane.

The Overview Map appears in a separate window, with 
blue lines denoting the boundaries of the System 
Health Dashboard Left pane.

Note: You cannot perform other functions on the 
System Health Dashboard while the Overview Map is 
open.

Description Enable you to perform actions on the HP Business 
Availability Center components monitored by System 
Health.

Useful Links “System Health Displays” on page 154

GUI Element Description



Chapter 8 • System Health

248

The Action Buttons are: 

GUI Element Description

Click to open the Service Manager dialog box. This 
option enables you to move backend services from one 
server to another of the same type if the server 
machine is not functioning properly, requires 
downtime for servicing, or is overloaded. For details on 
the Service Manager dialog box, see “Service Manager 
Dialog Box” on page 251.

Note: You must have more than one server of the same 
type configured in your HP Business Availability 
Center environment for this button to be enabled.

Click to define a backup server, in case the current 
server is not functioning properly or requires 
downtime for servicing.

Note: You must have more than one server of the same 
type configured in your HP Business Availability 
Center environment for this button to be enabled.

Click to stop or start processes on selected servers, for 
maintenance purposes or in case these processes 
display a problematic status on the System Health 
Dashboard or the Inventory tab.
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Information Buttons

The Information Buttons are:

Description Enable you to retrieve information on the HP Business 
Availability Center components monitored by System 
Health. 

Useful Links “System Health Displays” on page 154

GUI Element Description

Click to receive a Quick Report on data collected over 
the past 24 hours for the selected component. For 
details on Quick Reports, see “Quick Report Screen” on 
page 254.

Click to export a report containing of the System 
Health monitors’ and HP Business Availability Center 
components’ current status to a .csv file.

Click to generate a .zip file containing the log files of a 
specific server. 

Note: You must select a server component on the 
System Health Dashboard Left pane for this button to 
be enabled.



Chapter 8 • System Health

250

Synchronization Buttons

The Synchronization Buttons are:

Description Enable you to synchronize the status and model of the 
HP Business Availability Center components 
monitored by System Health. 

Important 
Information

If an HP Business Availability Center component was 
down while Soft or Full Model Synchronization was 
performed, System Health may not have configured 
the full monitoring solution onto these components. 
To prevent this from happening, ensure that all 
components are up and running during the System 
Health Setup Wizard configuration, and while 
performing Soft or Full Model Synchronization.

Useful Links “System Health Displays” on page 154

GUI Element Description

Click to refresh the selected component and retrieve its 
current status, without running the component’s 
monitors.

Click to update System Health with any changes to the 
System Health model. If required, the System Health 
Setup Wizard is generated for the area of System Health 
in which the changes were applied.

Click to reset the configuration of the selected 
component, including resetting of all monitors and 
their status. If no specific component is selected, the 
entire System Health configuration is reset, and the 
System Health Setup Wizard is generated, where you 
must reconfigure the connection of all system 
monitors to the servers. For details, see “System Health 
Setup Wizard” on page 237. 
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Service Manager Dialog Box

The Service Manager dialog box includes the following elements (listed 
alphabetically):

Description Enables you to move backend services from one server 
to another of the same type, in case the server machine 
is not functioning properly, requires downtime for 
servicing, or is overloaded. 

To access: Click the Service Manager button  on 
the Toolbar on either the System Health Dashboard or 
the Inventory tab.

Important 
Information

➤ You can move services from a server only to another 
server of the same HP Business Availability Center 
type. 

➤ You cannot move services from or to an external 
machine (such as UCMDB).

➤ When automatic failover moves processes to the 
backup machine, it may move only part of a service 
group, causing System Health to display the same 
service group on two different servers.

Useful Links “Understanding Service Reassignment” on page 161

GUI Element Description

Execute Click to move the indicated customer services from 
one server to another.

Operation Status Displays the status of the performed operation.

Select Operation Select the type of service you want to move.

Select Source 
Machine

Select the machine from which you want to move the 
services.

Select Target 
Machine

Select the machine to which you want to move the 
services.
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Backup Server Setup Window

The Backup Server Setup Window includes the following elements (listed 
alphabetically):

Description Enables you to define a backup server to run the 
HP Business Availability Center server components, in 
case the server machine is not functioning properly or 
requires downtime for servicing.

To access: Click the Backup Server Setup button  
on the Toolbar.

Important 
Information

➤ This button is enabled only if you have configured 
more than one Processing server. 

➤ You must click the Enable Automatic Failover box 
for the backup server to be enabled.

➤ External machines, such as UCMDB, cannot be 
defined as a backup server.

Useful Links “Move Backend Services” on page 171

GUI Element Description

Enable Automatic 
Failover

Select to activate the selected server as the backup 
server.

Execute Click to define the selected server as the backup server.

Operation Status Displays the status of the performed operation.

Select Backed-up 
Servers

Select the servers to be backed up.

Select Backup Server Select the backup server.
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Process Manager Dialog Box

The Process Manager dialog box includes the following elements (listed 
alphabetically):

Description Enables you to stop or start processes on specific 
servers, in case these processes display a problematic 
status on the System Health Dashboard or Inventory 
tab, or the processes require maintenance.

To access: Click the Process Manager button  on 
the Toolbar.

Important 
Information

You can select multiple processes to start or stop in the 
Process Manager dialog box. 

Useful Links “Manage BSM Processes” on page 173

“HP Business Availability Center Processes” on 
page 177

GUI Element Description

Indicates the selected process is running.

Indicates the selected process was started and is not yet 
running.

Indicates the selected process was stopped.

Indicates the selected process is currently being 
stopped.

Indicates the selected process was launched.

Indicates the selected process’ status is unknown.

Operation Status Displays the status of the performed operation.

Refresh Click to refresh process statuses.

Note: A stopped process appears in red.

Select Process(es) Select the process you want to stop or start. 
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Quick Report Screen

Select Server Select the server on which you want to start or stop 
processes.

Start Click to start the selected processes.

Start All Click to start all of the processes in the Select 
Process(es) window.

Stop Click to stop the selected processes.

Stop All Click to stop all of the processes in the Select 
Process(es) window. 

Description Displays a report on data gathered from the past 24 
hours on the selected component’s monitors.

To access: Click the Quick Report button  on the 
Toolbar.

Important 
Information

The following links appear on the Quick Report screen, 
which enable you to view specific information on the 
monitors:

➤ Table Format: 

➤ Error List:

➤ Warning List:

➤ Good List:

For details on the information each of these links 
displays, see below.

Useful Links “Display a Quick Report” on page 174

“New SiteScope Quick Report Dialog Box” in System 
Availability Management.

GUI Element Description
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The Quick Report screen includes the following elements (unlabeled GUI 
elements are shown in angle brackets):

GUI Element Description

<Graphs> Displays the monitor groups’ output in graph format.

Error List Click to display the monitor runs that retrieved an 
error status, based on the thresholds configured for the 
monitor.

Good List Click to display the monitor runs that retrieved a good 
status, based on the thresholds configured for the 
monitor.

Measurement 
Summary Table

Displays measurement data for each of the HP Business 
Availability Center monitors. 

Table Format Click to display the monitor groups’ output in table 
format.

Uptime Summary 
Table

Displays the percentage of uptime each HP Business 
Availability Center monitor experienced over the 
indicated time period.

Warning List Click to display the monitor runs that retrieved a 
warning status, based on the thresholds configured for 
the monitor.
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Troubleshooting and Limitations

The following table illustrates potential problems that can occur on the 
System Health interface, and suggested solutions:

Problem Solution

Interface does not display 
any HP Business 
Availability Center 
components

Click the Refresh button on your browser.

Note: This problem is most common when first 
logging into System Health on Microsoft Internet 
Explorer 7.0.

All components and 
monitors are displayed in 
gray

Click the Full Model Synchronization 
button in the Toolbar on either the System 
Health Dashboard or the Inventory tab. The 

Full Model Synchronization button resets the 
System Health configuration and erases all of the 
monitors’ history in HP Business Availability 
Center. You then reconfigure System Health to 
create remote connections to the servers which 
System Health monitors, using the System Health 
Setup Wizard. For details, see “System Health Setup 
Wizard” on page 237.

Monitors are not displayed 
on a component
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9
Legacy System Health

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from your view.

The System Health page enables high-level HP Business Availability Center 
administrators to manage the workload of the Data Processing Servers and 
the services they are running by setting up Automatic Failover or manually 
reassigning services among servers in response to resource issues or for 
maintenance purposes.

This chapter includes:

Concepts

 ➤  Legacy System Health - Overview on page 259

 ➤  Service Reassignment in Legacy System Health on page 260

 ➤  Understanding Backup Servers on page 263

 ➤  Data Processing Server Resource Status on page 265

Tasks

 ➤  Monitor System Resources on the System Health Page on page 268

 ➤  Configure Automatic Failover for the Data Processing Server on page 269

 ➤  Remove Automatic Failover on page 272

 ➤  Reassign Services Manually on page 273

Reference

 ➤  System Health Monitoring on page 275
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 ➤  Legacy System Health User Interface on page 278

Troubleshooting and Limitations on page 284

Important: Legacy System Health is available only if you have not deployed 
the new System Health interface, either as a stand-alone application or as an 
imbedded part of HP Business Availability Center. For details on deploying 
the new System Health interface, see “Deploy and Access System Health” on 
page 163.

Concepts
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Legacy System Health - Overview

The System Health page enables high-level HP Business Availability Center 
administrators to monitor the load on the Data Processing servers in the 
HP Business Availability Center server architecture and manage the Data 
Processing servers—by setting up Automatic Failover or by manually 
reassigning services from one server to another —to prevent downtime due 
to insufficient resources on a particular machine or due to required server 
machine maintenance. Automatic Failover is supported only in Data 
Processing servers.

Administrators can also view static information about the machines on 
which the Gateway servers are running.

Note: 

➤ For complete details on setting up a High Availability deployment of 
HP Business Availability Center servers, as well as descriptions of all 
services that run on the Data Processing server, see “High Availability for 
HP Business Availability Center” in the HP Business Availability Center 
Deployment Guide PDF.

➤ Reassigning services from one server to another can also be done using 
the JMX Console. It is recommended that the JMX Console be used only 
to reassign services that cannot be reassigned via the System Health page. 
For details, see “Manually Reassigning Services” in the HP Business 
Availability Center Deployment Guide PDF.

Permissions Required to Access the System Health Page
The System Health page can be accessed by users with Superuser or 
Administrator permissions.
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System Health Page Layout
The System Health page can be viewed by selecting Admin > Platform > 
Setup and Maintenance > System Health. The System Health page is divided 
into three panes:

➤ Servers. The Servers pane is located on the top left of the page and lists:

➤ in the All tab, the names and types of all the installed servers.

➤ in the Data Processing tab, the names of all the Data Processing servers, 
the service configuration for each, and the status of the worst monitored 
server resource.

➤ Services. The Services pane is located on the top right of the page and 
displays the statuses of all the monitored server resources for the server 
currently selected in the Servers pane.

➤ Management. The Management pane is located across the bottom of the 
page and displays the status of tasks that are running or were run during the 
course of the current Web session.

Service Reassignment in Legacy System Health

In typical enterprise environments, the Data Processing server is split into 
three standalone servers: 

➤ Modeling Data Processing server

➤ Online Data Processing server

➤ Offline Data Processing server

Each server is installed on a separate machine. Each server might also be 
installed on one or more backup machines.

If a certain Data Processing server machine is not functioning properly or 
requires downtime for servicing, administrators can manually reassign the 
services running on that machine to a different Data Processing server 
machine. Administrators can also preconfigure a specific Data Processing 
server to automatically fail over to a specific backup machine. For details on 
backup servers, see “Understanding Backup Servers” on page 263.
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Important: Before manually reassigning services to another server or 
configuring a server as a backup server for Automatic Failover, ensure that 
the HP Business Availability Center service is running on that server.

When a service is reassigned via the System Health interface from an active 
Data Processing server to a different Data Processing server, for example a 
backup server, HP Business Availability Center modifies the setting in the 
management database that defines the active Data Processing server. The 
newly defined server setting in the management database is read by the 
high availability controller running on the Data Processing servers. At that 
point, a process begins whereby HP Business Availability Center stops using 
the services on the previously active server and begins using the services on 
the newly active server. This process can take up to several minutes, during 
which time the system is in downtime.

Note: The Source Adapters service (also known as the CDM service) on the 
Offline Data Processing server uses the <HP Business Availability Center root 
directory>\CMDB directory. The CMDB directory must be moved to a 
separate machine for high availability purposes (that is, configured as a 
shared directory) to enable success of the Automatic Failover mechanism 
when backing up the Offline Data Processing server. For details on 
configuring the CMDB directory as a shared directory, see “High Availability 
for the CDM” in the HP Business Availability Center Deployment Guide PDF.

Logging
All service reassignments are written to the Audit Log (Admin > Platform > 
Setup and Maintenance > Audit Log).

To view the history of service reassignments, select the System Console 
context in the Audit Log. If required, use the up and down arrows to scroll 
through the entries.
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Log messages are written to the log file <HP Business Availability Center root 
directory>\log\systemConsole.log. The type of messages depend on the 
level of logging enabled. By default, only errors are written to this log. For 
details on changing log level, see “Changing Log Levels” in Reference 
Information. 

Configuring Service Reassignment
High-level HP Business Availability Center administrators can use the 
System Health page to:

➤ configure Automatic Failover for the Data Processing server. For details, see 
“Configure Automatic Failover for the Data Processing Server” on page 269.

➤ manually reassign services to accommodate the need for server machine 
maintenance. For details, see “Reassign Services Manually” on page 273.

There are several theoretical scenarios for reassigning services among 
machines, to manage resource issues or enable server administration. The 
table that follows illustrates these scenarios by indicating the paths along 
which services can be reassigned.
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Understanding Backup Servers

The following factors must be considered when configuring a backup server 
using automatic failover: 

➤ A primary server does not have a default backup server. A backup server 
must be explicitly defined. If no backup server is defined, Automatic 
Failover does not try to locate a suitable backup server, even if one is 
available. 

➤ Each server can have only one backup server.

➤ Several primary servers can be assigned to the same backup server. Keep in 
mind, however, that if several primary servers fail simultaneously, the 
backup server may also fail if it exceeds its performance capacity.

To Full Data 
Processing 
Server

To Modeling 
Data 
Processing 
Server

To Online 
Data 
Processing 
Server

To Offline 
Data 
Processing 
Server

From Full 
Data 
Processing 
Server

Yes Yes Yes Yes

From 
Modeling 
Data 
Processing 
Server

Yes Yes No No

From Online 
Data 
Processing 
Server

Yes No Yes No

From Offline 
Data 
Processing 
Server

Yes No No Yes
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➤ The backup server cannot have a defined backup server. 

➤ After a primary fails and its services move to a backup, the primary, after it 
restarts, acts as a backup to the backup server for its original services.

For example, in the above diagram, when Data Processing Server A fails, its 
services automatically move to Backup Server. When it returns online, it acts 
as a backup for its original services which are now running on Backup 
Server. However, Data Processing Server A is not defined as a backup for 
Backup Server.

➤ The backup server must have the same operating system as the Data 
Processing server it backs up. In other words, the active server and its backup 
server must both be either Solaris or Windows.

➤ The active server and its backup server must both have the same version of 
HP Business Availability Center.

➤ The HP Business Availability Center service must be running on the backup 
server so that it can poll the database intermittently to know when it 
receives service assignments.

➤ If, after enabling Automatic Failover and configuring backup servers, you 
then disable Automatic Failover, the backup server assignments remain 
visible on the System Health page.
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Data Processing Server Resource Status

The resource status information that is displayed on the System Health page 
is based on capacity limit and threshold settings that are preconfigured by 
HP. These settings can be viewed in the Infrastructure Settings Manager 
(select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Foundations, and select System Health).

Warning: Do not modify Capacity Limit settings, as doing so can adversely 
affect the performance of HP Business Availability Center. If your 
organization requires modification of these settings, it should be done in 
coordination with your HP representative.

Types of Resource Status Information
The following types of resource status information are displayed:

➤ percentage of capacity limit. Represents the actual usage of the resource 
relative to its configured capacity limit. In the example below, the CMDB’s 
TQLs are at 64% of capacity (in this case, 77 TQLs out of a limit of 120).
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➤ threshold representation of the percentage of capacity limit. Uses a 
color-coded icon to express the percentage of the capacity limit, based on 
the following ranges:

Resource Status Information in the Servers Pane
In the Servers pane, you can see the following resource status information:

➤ for each active server in the list, the percentage of capacity limit and its 
threshold representation, in the Worst Resource column, indicating the 
status of the worst-performing resource among all the resources being 
monitored on that server.

➤ a tooltip with resource details. Place your pointer over a threshold icon to 
view information on the specific resource whose status is being reported.
 

Range Color Code

<=70% of 
capacity limit

Green

> 70% but 
<=90% of 
capacity limit

Yellow

> 90% of 
capacity limit

Red

No data/No 
services running

Gray
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Note: The offline server configuration does not report any resource status 
information, as there are currently no monitored resources for the Offline 
Data Processing server.

Resource Status Information in the Services Pane
In the Services pane, you can see a detailed display of all monitored server 
resources for the server selected in the Servers pane.

➤ The Name column displays, per resource group, the services and their 
monitored resources. 

➤ The Performance column displays:

➤ for each resource group, a threshold icon indicating the status of the 
resource group, based on the worst child rule (the parent node inherits 
the status of its worst child).

➤ for each service, a threshold icon indicating the status of the service, 
based on the worst child rule (the parent node inherits the status of its 
worst child).
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➤ for each monitored resource, a threshold icon and accompanying 
percentage indicating the status of the resource, and the numerical 
representation of the percentage, based on the preset capacity limit for 
the resource.

Note that the capacity limits differ depending on the specific deployment 
architecture. For example, the capacity limit for CMDB TQLs is lower in a 
three-server deployment (the CMDB service runs on a Data Processing server 
running all services) than it is in a five-server deployment (the CMDB 
service runs on a dedicated Modeling Data Processing server).

Tasks

Monitor System Resources on the System Health Page

This task describes how high-level HP Business Availability Center 
administrators can use the System Health page to monitor system resource 
status to identify potential resource issues and take action before the system 
is adversely affected.

This task includes the following steps:

➤ “View Server Architecture” on page 268

➤ “View Data Processing Server Configuration” on page 268

➤ “View Data Processing Server Properties” on page 269

 1 View Server Architecture
From the All tab in the Servers pane, you can view the names of all the 
servers that are deployed in the HP Business Availability Center server 
architecture, and their type (Gateway or Data Processing).

 2 View Data Processing Server Configuration
From the Data Processing tab in the Servers pane, you can view the names 
of all the Data Processing servers that are deployed in the HP Business 
Availability Center server architecture, and their configuration (All services, 
Modeling, Online, Offline). For details on Data Processing server 
configurations, see “High Availability for the Data Processing Server” in the 
HP Business Availability Center Deployment Guide PDF.
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In addition, the status of the worst-performing monitored resource is 
displayed in the Worst Resource column. For details on resource status, see 
“Data Processing Server Resource Status” on page 265.

 3 View Data Processing Server Properties
When a specific server is selected from the Data Processing tab in the 
Servers pane, you can view properties for that server by clicking the Show 
Properties button in the Services pane. The Properties dialog box displays 
the following properties:

➤ Name. The server name.

➤ IP. The server IP address.

➤ Backup server for this server. If a backup server is configured for the server, 
the name of the backup server is displayed. Note that this information is 
displayed even if Automatic Failover has been disabled.

➤ This server is a backup for servers. If the server is configured as a backup 
server, the names of the severs the server is backing up are displayed. Note 
that this information is displayed even if Automatic Failover has been 
disabled.

Configure Automatic Failover for the Data Processing 
Server

The process of automatically moving services from a primary server to 
another server is called Automatic Failover. 

This task describes how to configure automatic failover for the Data 
Processing Server:

This task includes the following steps:

➤ “Enable Automatic Failover of Primary Servers” on page 270

➤ “Configure the Backup Server for Primary Servers” on page 270
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 1 Enable Automatic Failover of Primary Servers
To enable Automatic Failover of primary servers, perform the following 
steps:

 a Select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Foundations, select High Availability Controller, and 
locate the Automatic Failover Enabled entry in the High Availability 
Controller - General Properties table.

 b Click the Edit button for the Automatic Failover Enabled entry. The 
Automatic Failover Enabled dialog box opens. 

 c Select true and click Save. The change takes effect immediately.

Note: It is recommended to keep the Keep Alive Timeout (minutes) default 
value of 20. A lower value may give a false failure alert.

 2 Configure the Backup Server for Primary Servers
To configure the backup server for primary servers, perform the following 
steps:

 a Select Admin > Platform > Setup and Maintenance > System Health.

 b In the Servers pane, choose the Data Processing tab. Click the server to 
be the backup server. Information about the selected server is displayed 
in the Services pane.

 c In the Services pane, click the Set as Backup Server button to define the 
server as a backup server. The Set as Backup Server dialog box opens with 
a list of Data Processing servers.

For each listed server, the following information is displayed:

➤ Server. The server name.

➤ Configuration. The server configuration (All services, Modeling, 
Online, or Offline).

➤ Existing backup. Lists the backup server currently defined for the 
servers in the Server list.
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 d Select the primary servers that the backup server is to back up and click 
OK to save your selections.

When a primary server exceeds the Keep Alive Timeout with no response, 
Automatic Failover automatically reassigns the services to the predefined 
backup server. The primary server automatically shuts down its services 
to prevent duplicate services from running. 

Note: While Automatic Failover is moving services, a brief period of high 
CPU usage on the backup server may occur while those services start. 
CPU usage returns to normal once all services are running.

When the primary server becomes operational, you must manually 
reassign services to it from the backup server. For details on manually 
reassigning services, see “Reassign Services Manually” on page 273.
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Remove Automatic Failover

This procedure describes how to stop a server from acting as a backup server 
for some or all of the servers it is backing up.

To stop a server from acting as a backup server:

 1 Select Admin > Platform > Setup and Maintenance > System Health.

 2 Choose the Data Processing tab In the Servers pane. Click the server that 
you no longer want to serve as a backup server. Information about the 
selected server is displayed in the Services pane.

 3 Click the Set as Backup Server button in the Services pane to open the Set as 
Backup Server dialog box.

 4 Clear the check boxes beside some or all of the listed servers, as required.

 5 Click OK to save the settings.



Chapter 9 • Legacy System Health

273

Reassign Services Manually

When there is a need to manually reassign services from one machine to 
another (for example, due to a resource issue on a given machine, required 
server maintenance, or to reassign services to a primary server after its 
services were automatically moved to a backup server using Automatic 
Failover), follow the procedure below to create and apply server 
reassignment tasks.

Note: The Source Adapters service (also known as the CDM service) on the 
Offline Data Processing Server uses the <HP Business Availability Center root 
directory>\CMDB directory. If the CMDB directory has not been moved to a 
separate machine for high availability purposes (that is, configured as a 
shared directory), when the Offline Data Processing Server services are 
manually reassigned to a different server, the CDM service does not function 
properly until the CMDB directory is manually copied to the new Offline 
Data Processing Server. For details on configuring the CMDB directory as a 
shared directory, see “High Availability for the CDM” in the HP Business 
Availability Center Deployment Guide PDF. 

To manually reassign services:

 1 In the Servers pane, select the server whose services you want to reassign.

 2 In the Services pane (right pane), click the Move services as group button to 
view the Move Services context menu.

 3 Select one of the below options. The Move Services dialog box opens.

➤ Move all services. Select to move all services from the server to a different 
server.

➤ Move modeling services. Select to move modeling services from the 
server to a different server.

➤ Move offline services. Select to move offline services from the server to a 
different server.

➤ Move online services. Select to move online services from the server to a 
different server.
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➤ Move system services. Select to move system services from the server to a 
different server.

 4 In the Move Services dialog box, select the server to which you want to 
reassign the selected group of services. Only servers to which the services 
can be moved are listed.

 5 Click OK to move the services.

 6 Monitor the status of the running tasks from the Status tab.

The Status tab displays all tasks currently running, or that have completed 
running during the current Web session.

Note: When manually reassigning services, if a task does not complete (that 
is, the reassigned services do not start successfully), the Status tab continues 
to display a status message indicating that the task is in progress. Successful 
reassignment can be verified in the System Health log file, 
systemConsole.log, if the log file is configured to record messages at the 
INFO level. For details on the log levels, see “Log Severity Levels” in Reference 
Information.

Reference
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System Health Monitoring

The table below describes the different resource groups, services, and 
monitored resources whose status can be monitored from the System Health 
page. Note that the offline server configuration—which includes offline 
services and system services—does not report any resource status 
information, as there are currently no monitored resources for the Offline 
Data Processing Server.

Resource 
Group

Service
Monitored 
Resource

Description

Machine 
Counters (all 
servers)

Memory 
Usage

The percentage of memory usage 
by the mercury_as process. In 
addition, the absolute memory 
usage and total memory capacity 
values are displayed. These are 
taken from the server’s operating 
system.

Modeling 
Services 
(Modeling 
Data 
Processing 
Server)

Viewing 
System 

CI Instances The number of configuration item 
(CI) instances in service views 
that the server can handle 
simultaneously.

Views The number of views that the 
server can handle simultaneously.

CMDB Model 
Objects

The number of CMDB model 
objects (CIs, KPIs, and so forth) 
that the server can handle 
simultaneously.

TQLs The number of Topology Query 
Language (TQL) queries that the 
server can handle simultaneously.
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Online 
Services 
(Online 
Data 
Processing 
Server)

Online BLE CIs The number of configuration item 
(CI) instances with associated KPIs 
that the server can handle 
simultaneously.

KPIs The number of Key Performance 
Indicator (KPI) objects that 
the server can handle 
simultaneously.

Offline 
Services 
(Offline 
Data 
Processing 
Server)

Source 
Adapters

Resource not 
monitored. 
If service is 
running, the 
"-" character 
appears. If 
service is not 
running, it 
does not 
appear in 
the table.

Service responsible for adding 
data collector entities to the 
CMDB.

Resource 
Group

Service
Monitored 
Resource

Description
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System 
Services 
(Offline 
Data 
Processing 
Server)

Purging 
Manager

Resource not 
monitored. 
If service is 
running, the 
"-" character 
appears. If 
service is not 
running, it 
does not 
appear in 
the table.

Service that handles data purging 
and partitioning.

New Offline 
Aggregation 
Manager

Resource not 
monitored. 
If service is 
running, the 
"-" character 
appears. If 
service is not 
running, it 
does not 
appear in 
the table.

Service that validates and 
synchronizes new tasks for the 
offline aggregator on an hourly or 
daily basis.

Resource 
Group

Service
Monitored 
Resource

Description
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Legacy System Health User Interface

This section describes:

 ➤  System Health Page on page 278

System Health Page

Description Displays the status of the servers, resource groups, 
services, and monitored resources running HP Business 
Availability Center.

The System Health page consists of the following 
panes:

➤ Servers

➤ Services

➤ Management

To access: Select Admin > Platform > Setup and 
Maintenance > System Health

Important 
Information

When a designated backup server becomes the active 
server (it starts running the services of the server it was 
backing up), an asterisk (*) appears beside the server 
name in the Servers pane. When the server ceases to 
act as a backup server (it no longer runs the services of 
the server it was backing up), the asterisk is removed. 

Useful Links “Legacy System Health - Overview” on page 259
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Servers Pane

The Servers pane includes the following elements (listed alphabetically):

Description Displays the status of the servers running HP Business 
Availability Center.

To access: Select Admin > Platform > Setup and 
Maintenance > System Health

Important 
Information

➤ The Servers pane elements described below appear 
on either the All tab, the Data Processing tab, or 
both.

➤ If the server is configured as a backup server, the 
names of the severs the server is backing up are 
displayed. This information is displayed even if 
Automatic Failover has been disabled.

Useful Links “Legacy System Health - Overview” on page 259

“Data Processing Server Resource Status” on page 265

GUI Element Description

Click to refresh the list of servers.

All Lists the name and type of all servers running 
HP Business Availability Center.

Configuration The services that the specified server is configured for.

Data Processing Lists information on the Data Processing servers 
running HP Business Availability Center.

Name The name of the server.
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Server Type The type of the server. 

Worst Resource The status of the worst-performing resource among all 
resources being monitored on the server. Performance 
is indicated as follows:

➤ percentage of capacity limit. Represents the actual 
usage of the resource relative to its configured 
capacity limit.

➤ threshold representation of the percentage of 
capacity limit. Uses a color-coded icon to express the 
percentage of the capacity limit. For details on the 
ranges of the color-coded icons, see “Types of 
Resource Status Information” on page 265.

Tooltip: Resource details on the specific resource whose 
status is being reported.

GUI Element Description
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Services Pane

Description Displays the statuses of all the monitored resources for 
the server currently selected in the Servers pane.

To access: Select Admin > Platform > Setup and 
Maintenance > System Health

Important 
Information

The Services pane is located on the right side of the 
page.

Information is displayed only if you have selected a 
server in the Servers pane.

The capacity limits displayed in the Performance 
column differ depending on the specific deployment 
architecture. For example, the capacity limit for CMDB 
TQLs is lower in a three-server deployment (the CMDB 
service runs on a Data Processing Server running all 
services) than it is in a five-server deployment (the 
CMDB service runs on a dedicated Modeling Data 
Processing Server).

Useful Links “Legacy System Health - Overview” on page 259

“Data Processing Server Resource Status” on page 265

“System Health Monitoring” on page 275
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The Services Pane includes the following elements (listed alphabetically):

GUI Element Description

Click to show properties of the selected server. The 
<server name> Properties page contains the following 
fields:

➤ Name. The name of the server.

➤ IPs. The server IP address.

➤ Backup server for this server. If a backup server is 
configured for the server, the name of the backup 
server is displayed. Note that this information is 
displayed even if Automatic Failover has been 
disabled.

➤ This server is a backup for servers. If the server is 
configured as a backup server, the names of the 
severs the server is backing up are displayed. Note 
that this information is displayed even if Automatic 
Failover has been disabled.

Click to set the selected server as a backup server.

Click to move services from the selected server to 
another server. 

You choose which services you want to move from the 
dropdown list that appears, and then enter the 
destination server in the resulting dialog box.
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Management Pane

Name The services and their monitored resources, per 
resource group.

Performance The performance level of the corresponding service, 
monitored resource, or resource group. Performance 
data is presented as follows:

➤ for each resource group, a threshold icon indicating 
the status of the resource group, based on the worst 
child rule (the parent node inherits the status of its 
worst child)

➤ for each service, a threshold icon indicating the 
status of the service, based on the worst child rule 
(the parent node inherits the status of its worst 
child)

➤ for each monitored resource, a threshold icon and 
accompanying percentage indicating the status of 
the resource, and the numerical representation of 
the percentage, based on the preset capacity limit for 
the resource

For details on the ranges of the color-coded icons, see 
“Types of Resource Status Information” on page 265.

Description Displays the status of tasks that are running or were 
run during the course of the current Web session.

To access: Select Admin > Platform > Setup and 
Maintenance > System Health

Important 
Information

The Management Pane is located on the bottom of the 
page. 

Useful Links “Legacy System Health - Overview” on page 259

GUI Element Description
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Troubleshooting and Limitations

Use the following information to troubleshoot issues, as required.

Problem: HP Business Availability Center servers installed and running in a 
distributed architecture appear as unavailable in the Servers pane.

Problem Cause: To determine server availability, HP Business Availability 
Center pings the servers according to the name registered in the SERVERS 
table in the database. In certain environments, the host machine 
performing the ping requires the target machine’s IP (and not its machine 
name), but does not know the IP. Thus, the ping fails and the machine is 
reported as unavailable.

Solution: Map the names of all HP Business Availability Center server 
machines (Gateway and Data Processing) to their corresponding IPs in the 
C:\WINNT\system32\drivers\etc\hosts file (path may vary depending on 
Windows installation) on the Gateway Server machine. If there are multiple 
Gateway Server machines and/or Gateway Server machines behind a load 
balancer, perform the above procedure on all machines. Note that the left 
column is for IP addresses and the right column is for machine names.



285

10
Audit Log

HP Business Availability Center enables you to view a log of all the actions 
performed by different users accessing the platform.

This chapter includes:

Concepts

 ➤  Audit Log - Overview on page 285

Tasks

 ➤  Use the Audit Log on page 288

Reference

 ➤  Audit Log User Interface on page 289
Concepts

Audit Log - Overview

You use the audit log to keep track of different actions performed by users in 
the system, according to the following contexts:

➤ Alert Administration. Displays actions related to adding, modifying, 
deleting, enabling and disabling alerts, as well as registering and 
unregistering alert recipients.

➤ CI Status Alert Administration. Displays actions related to creating alert 
schemes for a configuration item (CI) status alert.

➤ Customer Package Management. For HP Software-as-a-Service only. 
Displays actions related to modifying package information such as: package 
location information, general package properties, Business Process Monitor 
package properties or SiteScope package properties.
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➤ Dashboard Administration. Displays actions related to configurations made 
in the Dashboard Administration.

➤ Data Collector Maintenance. Displays actions related to removing Business 
Process Monitors and SiteScopes.

➤ Database Management. Displays actions related to creating, deleting, and 
modifying users and passwords for profile databases, as well as modifying 
the status of the Purging Manager.

➤ Deleted Entities. Displays actions related to adding and deleting data 
collectors (Business Process profiles, Real User Monitor engines, and 
SiteScope monitors) from End User Management Administration. 

➤ Downtime/Event Scheduling. Displays actions related to creating and 
modifying downtime and scheduled events.

➤ IT World (IT Universe) Configuration. Displays actions, including editing, 
updating, and removing CIs and relationships, performed in the IT Universe 
Manager application.

➤ Monitor Administration (Business Process Monitor). Displays actions related 
to profile management and configuration, including starting and stopping 
profiles, adding and deleting transaction monitors, modifying scheduling, 
defining and modifying hosts, adding and deleting WebTrace addresses, and 
modifying transaction thresholds.

➤ Monitor Administration (Real User Monitor). Displays actions related to 
Real User Monitor management and configuration, including the addition 
and deletion of Real User Monitor probes, servers, and host groups, and the 
configuration and deletion of pages, transactions, and end users.

➤ Monitor Administration (SiteScope). Displays actions related to profile 
management and configuration, including starting and stopping profiles, 
adding and deleting monitors, modifying monitors and groups, editing 
preferences, and configuring alerts. 

➤ Notification Template Administration. Displays actions related to modifying 
open ticket information, ticket settings, closed tickets, ticket templates, and 
subscription information: notification types (locations or general messages), 
and recipients.
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➤ Permissions Management. Displays all actions related to assigning 
permissions, roles, and permissions operations for resources onto users and 
user groups.

➤ Recipient Administration. Displays actions related to modifying information 
about the recipients of audit logs.

➤ Scheduled Report Administration. Displays actions related to modifying the 
reporting method and schedule of reported events.

➤ Script Repository. For HP Software-as-a-Service only. Displays actions related 
to modifying the type of verification of Business Process Monitor scripts, 
and verification of subscription information.

➤ Service Level Management Configuration. Displays actions related to service 
level agreements performed in the Service Level Management application. 
For a list of the audited actions, see “Use the Audit Log” on page 288.

➤ SLA Alert Administration. Displays actions related to creating, modifying, or 
deleting SLA alerts.

➤ System Console. Displays all services reassignments performed in the 
System Health interface to resolve system resource issues.

➤ User Defined Reports. For HP Software-as-a-Service only. Displays actions 
related to the creation and modification of Custom reports.

➤ User/Group Management. Displays actions related to adding, modifying, 
and deleting users and user groups.

➤ View Manager. Displays actions related to KPIs such as adding a KPI, editing 
a KPI, and deleting a KPI. Additionally, it displays actions related to 
changing the Save KPI data over time for this CI and the Monitor changes 
options.

Tasks



Chapter 10 • Audit Log

288

Use the Audit Log

You access the Audit Log from the Audit Log page, available from the Setup 
and Maintenance menu in Platform Administration. 

To use the Audit Log:

 1 Select Admin > Platform > Setup and Maintenance > Audit Log. The Audit 
Log page opens.

 2 Select a context using the Context filter.

 3 Where relevant, select a profile from the list. HP Business Availability Center 
updates the table with the relevant information.

 4 Optionally, click the Auditing Filters link to open the Auditing Filters pane 
and specify filter criteria. The following filters are available:

➤ User. Specify a user in the system to view actions performed by only that 
user.

➤ Containing text. Specify a text string that the action must contain to be 
displayed.

➤ Start after and End before. Specify a starting and ending time period to 
view actions for only that period. Click the More button to open the 
Calendar dialog box where you can select a date.

 5 Click OK. HP Business Availability Center updates the table with the 
relevant information. 

If required, use the Previous Page arrow to navigate to the previous page of 
the Audit Log, or the Next Page arrow to navigate to the next page of the 
Audit Log.

Reference
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Audit Log User Interface

This section describes:

 ➤  Audit Log Page on page 289

Audit Log Page

The Audit Log page includes the following elements (listed alphabetically):

Description Enables you to keep track of different actions 
performed by users in the system. 

To access: Select Admin > Platform > Setup and 
Maintenance > Audit Log

Useful Links “Audit Log - Overview” on page 285

GUI Element Description

Click to move to the previous page or next page in the 
Audit Log. 

Actions Displays the actions performed by the specified user.

Additional 
Information

Displays additional information, where relevant.

Auditing Filters Click the Auditing Filters heading to specify filter 
criteria. For details, see “Auditing Filters Pane” on 
page 290.

Context Select a context to view.

For user Displays the user whose actions are displayed in the 
Audit Log, as specified in the Auditing Filters pane.

Default Value: All

Modification Date Displays the date and time that the specified actions 
were performed. 

Modified By Displays the user who performed the specified actions.
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Auditing Filters Pane
The Auditing Filters pane includes the following elements (listed 
alphabetically):

Profile Select a profile for which you want to view the 
performed actions.

Note: This field is not visible for all contexts.

RUM Engine Select a RUM Engine for which you want to view the 
performed actions.

Note: This field is displayed only if you have chosen 
the Monitor Administration (RUM) context.

SiteScope Select a SiteScope for which you want to view the 
performed actions.

Note: This field is displayed only if you have chosen 
the Monitor Administration (SiteScope) context.

Time Period Displays the time period whose actions are displayed in 
the Audit Log, as specified in the Auditing Filters pane.

Default Value: All

GUI Element Description

Click to open the Calendar dialog box and select a 
date. 

Click to expand the Auditing Filters pane.

Click to collapse the Auditing Filters pane.

Apply Click to apply the selected filters.

Cancel Click to cancel filtering and close the Auditing Filters 
pane.

Clear All Click to clear the filters and display all log items. 

GUI Element Description
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Containing text Specify a text string that the action must contain to be 
displayed.

End before Specify an ending time until which you want to view 
actions. 

Start after Specify a starting time from which you want to view 
actions.

User Specify a user in the system to view actions performed 
by only that user.

GUI Element Description
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11
Report Schedule Manager

This chapter provides information on the Report Schedule Manager. 

This chapter includes:

Concepts

 ➤  Report Schedule Manager — Overview on page 293

Reference

 ➤  Report Schedule Manager User Interface on page 294
Concepts

Report Schedule Manager — Overview

A user with Administrator permissions can edit, delete, resume, or pause 
scheduled reports in the Report Schedule Manager. You schedule User 
reports (Custom reports, Trend reports, Service reports, and Favorite Filters) 
in the Report Manager to enable specific recipients to automatically receive 
the specified report, through email, at regularly defined intervals. For details 
on scheduling User reports, see “Create a Schedule” in Reports.

Reference
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Report Schedule Manager User Interface

This section describes:

 ➤  Report Schedule Manager Main Page on page 294

Report Schedule Manager Main Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to manage schedules configured on reports 
and report objects in the Report Manager.

To access: Select Admin > Platform > Report Schedule 
Manager

Important 
Information

You cannot create a new schedule from the Report 
Schedule Manager main page. For details on creating 
schedules, see “Create a Schedule” in Reports.

Included in Tasks “Create a Schedule” in Reports.

GUI Element (A–Z) Description

Click to open the Edit Schedule for the <Report Name> 
dialog box and edit the selected schedule. For details, see 
“Create New Schedule Dialog Box” in Reports.

Note: This dialog box enables you only to edit an 
existing schedule - you create a new schedule from the 
Report Manager interface. For details, see “Create a 
Schedule” in Reports.

Click to delete the selected schedule. 

Click to resume the selected schedule.

Click to pause the selected schedule.
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Click to refresh the Report Schedule Manager page.

Click to reset the width of the columns to the default 
setting. 

Click to select columns to be visible in the table. For 
details, see “Working with Tables” in Reference 
Information.

Generation Time The time (in the indicated time zone) that the schedule is 
to be generated. 

Recipients The individuals configured in the Report Manager to 
receive the report or report item at scheduled intervals. 
For details on configuring Schedules, see “Create New 
Schedule Dialog Box” in Reports.

Recurrence The recurrence pattern for the selected schedule.

Report Name The name of the report for which the schedule is 
configured.

Report Type The type of report for which the schedule is configured.

Status The status of the schedule. Possible values are:

➤ Active

➤ Paused

GUI Element (A–Z) Description
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12
Data Collector Maintenance

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from view, except for the user 
accessing with superuser permissions.

You can perform ongoing maintenance tasks on the data collectors installed 
with your platform to suit the changing requirements of your organization.

This chapter includes:

Concepts

 ➤  Data Collector Maintenance - Overview on page 300

 ➤  Removing a Business Process Monitor on page 301

Tasks

 ➤  Remove a Business Process Monitor Remotely on page 301

Reference

 ➤  Data Collector Maintenance User Interface on page 303
Concepts
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Data Collector Maintenance - Overview

The HP Business Availability Center platform includes installable 
components that provide data collection capabilities. The Data Collector 
Maintenance page enables you to manage and maintain the data collectors 
in your platform. 

You use the Data Collector Maintenance page to:

➤ view a detailed list of all data collectors in your platform

➤ remove a Business Process Monitor instance

➤ view a data collector’s current properties

You can also link to the administration site of the data collector by clicking 
the link on the right column of the Data Collector Maintenance page.

Note: Data collectors can be installed from the Downloads page in Platform 
Administration. For details on downloading, see “Downloads Overview” on 
page 87.

The Data Collector Maintenance page is available in the Data Collection tab 
of Platform Administration and displays the current data collector instances 
registered in the management database for each data collector type. The 
page is divided into tabs representing the following types of data collectors:

➤ SiteScope

➤ Business Process Monitor

➤ Real User Monitor
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Removing a Business Process Monitor

If a specific Business Process Monitor data collector becomes obsolete, you 
can use the Data Collector Maintenance page to remove it from the 
management database.

Removing a Business Process Monitor deletes it only from the management 
database, not from the profile database. For example, a removed Business 
Process Monitor instance that was added to a profile at least once, no longer 
appears in the list of available hosts that is displayed when creating profiles. 
However, the location of the removed host still appears in different areas of 
HP Business Availability Center (for example, in reports and filters). If you 
do not want a removed Business Process Monitor instance to appear in 
reports, use report filters to remove the location associated with the data 
collector. For details on configuring report filters, see “Report Filters Page” in 
Using End User Management.

Tasks

Remove a Business Process Monitor Remotely

You can use HP Business Availability Center to remove Business Process 
Monitor data collectors that are no longer in use if one of the following 
criteria is met:

➤ The Business Process Monitor is not associated with any profiles.

➤ The Business Process Monitor has not pinged the database server hosting the 
management database for at least 24 hours.

To stop the Business Process Monitor from pinging the database server, you 
must shut down the Business Process Monitor.

To remove a Business Process Monitor instance:

 1 Select Admin > Platform > Data Collection. Choose Data Collector 
Maintenance. The Data Collector Maintenance page opens.

 2 If required, filter the list using the Location filters to view specific locations 
from which you want to remove data collector instances.
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 3 Select the checkbox for the data collector instance you want to remove. The 
Removable column indicates whether or not the data collector is removable.

If the Removable column has No listed for this instance, you can click the 
Information button to see why the data collector is not removable. A dialog 
box displaying information on the data collector opens. For details, see 
“Data Collector Information Dialog Box” on page 305.

 4 Click Remove, and confirm that you want to remove the instances.

To refresh the list of services:

Click the Refresh button at the bottom of the page.

Reference
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Data Collector Maintenance User Interface

This section describes:

 ➤  Data Collector Maintenance Page on page 303

Data Collector Maintenance Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to:

➤ View a list of your data collectors

➤ View data collector properties

➤ Remove a Business Process Monitor instance

To access: Select Admin > Platform > Data Collection > 
Data Collector Maintenance

Important 
Information

➤ Elements described in the following table appear on all 
tabs, unless otherwise noted.

➤ A Business Process Monitor instance is identified by 
the combination of the Host Name and Location 
Name. Both the Host Name and Location Name are 
defined by the user when setting up a Business Process 
Monitor instance. For details, see “Business Process 
Monitor Host Page” in the Business Process Monitor 
Administration PDF. 

Useful Links “Data Collector Maintenance - Overview” on page 300

GUI Element (A–Z) Description

Click to refresh the list of services. 

Click to view the information window for the specific 
data collector. For details, see “Data Collector 
Information Dialog Box” on page 305.
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<link to data 
collector’s 
administration site>

Enables you to perform administrative tasks on the data 
collector directly from this page.

Export BPM 
Information Button

Click to export information from the selected Business 
Process Monitors to a text file. 

Note: This button is visible only on the Business Process 
Monitor tab.

Host Name The name of the host machine on which the selected 
data collector is installed.

IP Address The IP address of the host machine on which the data 
collector is installed.

Last Ping TIme The last time the service pinged the Management 
database.

Location The location of the host machine on which the data 
collector is installed.

Location drop down 
list

Select to filter the list of data collectors by host location. 

Removable An indication of whether or not the data collector 
instance is removable.

Note: This column is visible only on the Business Process 
Monitor tab.

Remove Button Click to remove selected Business Process Monitors.

Note: This button is visible only on the Business Process 
Monitor tab.

Version The version number, including build number, of the data 
collector software.

GUI Element (A–Z) Description
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Data Collector Information Dialog Box

The following elements are included:

Description Displays information on a data collector, including an 
explanation of why a non-removable instance cannot be 
removed. 

To access: Select Admin > Platform > Data Collection > 
Data Collector Maintenance, and click the Information 
Button  next to the selected data collector.

Important 
Information

The Data Collector Information dialog box displays the 
same fields that appear on the tables in the Data 
Collector Maintenance page tabs, in addition to the fields 
described in the following table.

Useful Links “Data Collector Maintenance - Overview” on page 300

GUI Element (A–Z) Description

Associated Profiles The profiles currently associated with the data collector.

Build Number The build number of the data collector software.

Installed Updates A list of the updates that have been installed on the data 
collector software.

Last Error The last reported error message, if one exists.

Last Error Time The time of the last reported error message, if one exists.
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13
Downtime/Event Scheduling

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from view, except for the user 
accessing with superuser permissions.

This chapter includes the main concepts and reference information for 
scheduling Downtime and Events.

This chapter includes:

Concepts

 ➤  Downtime and Event Scheduling - Overview on page 308

Reference

 ➤  Downtime Events User Interface on page 309
Concepts
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Downtime and Event Scheduling - Overview

Downtime or other scheduled events can sometimes skew the results of 
system availability and performance reports. You therefore may want to 
exclude these periods of time from reports and alerts.

You define downtime or a scheduled event that will occur in the future, and 
HP Business Availability Center excludes data collected during this time 
interval from its reports. For example, you might want to exclude a 
recurring maintenance event or a holiday. 

Using the Downtime/Event Scheduling page, you can apply a downtime 
event to multiple profiles. For the defined time interval, you select whether 
HP Business Availability Center stops sending alerts, stops running the 
associated profiles, or both. 

For details on defining downtime and events, see “Downtime/Event 
Schedule Page” on page 309.

Reference
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Downtime Events User Interface

This section describes:

 ➤  Downtime/Event Schedule Page on page 309

 ➤  New Downtime/Event Schedule Dialog Box on page 310

Downtime/Event Schedule Page

The following elements are included:

Description Displays the list of scheduled events in which 
HP Business Availability Center is marked as being in 
downtime.

To access: Select Admin > Platform > Data Collection > 
Downtime/Event Schedule

Important 
Information

You can edit and delete only those events for which you 
have full permissions on all the profiles associated with 
the event. For details on permissions, see “Permissions 
Overview” on page 371.

Useful Links “Downtime and Event Scheduling - Overview” on 
page 308

GUI Element (A–Z) Description

Associated Profiles The profiles associated with the event.

Event Description A description of the downtime or scheduled event.

Event Name The name of the downtime or scheduled event.

New Event Click to create a new downtime or scheduled event.
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New Downtime/Event Schedule Dialog Box

Event Schedule General Properties Pane

The following elements are included:

Description Enables you to schedule downtime or an event during 
which HP Business Availability Center excludes data 
collected from its reports. 

To access: Select Admin > Platform > Data Collection > 
Downtime/Event Schedule > New Event

Important 
Information

➤ These settings do not affect the generation of alerts 
defined in SiteScope and cannot stop SiteScope from 
running during downtime or scheduled events.

➤ The New Downtime/Event Schedule dialog box is 
divided into the following sections: 

➤ Event Schedule General Properties pane. For details, 
see “Event Schedule General Properties Pane” on 
page 310.

➤ Event Frequency pane. For details, see “Event 
Frequency Pane” on page 311. 

➤ Event Schedule Action pane. For details, see “Event 
Schedule Action Pane” on page 312.

Useful Links “Downtime and Event Scheduling - Overview” on 
page 308

Description Enables you to enter the name and description of the 
event you are creating. 

GUI Element (A–Z) Description

Event Description Enter a description of the event being configured.

Event Name Enter a descriptive name for the event being configured.



Chapter 13 • Downtime/Event Scheduling

311

Event Frequency Pane

The following elements are included:

Description Enables you to schedule the frequency with which the 
downtime or event is to occur.

Important 
Information

The time period that you define must be according to the 
time at the HP Business Availability Center server, and 
not according to the time on the client with which you 
are working (if the server and client are in different time 
zones).

GUI Element (A–Z) Description

End On... Click to configure the date and time for the event to end.

Event Duration 
(Once)

Select the duration of the event you are configuring. 
Select the relevant number of days, hours, and minutes 
that the event is to take place for.

Event Duration 
(Every)

Configure the duration of the event, in hours and 
minutes.

Every Select to configure an event that is to occur more than 
once. You then select the appropriate days of the week 
that the event is to occur on. 

Every <date> of each 
month

Select to configure an event that is to occur once per 
month. Select the date of the month from the 
corresponding drop-down box.

Limit event 
recurrence to the 
following time range

Select to limit the event recurrence to occur only during 
the specified time range.

Once Select to configure an event that is to occur one time.

Recurring Event Start 
Time

Configure the time of day that the recurring event is to 
start on. 
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Event Schedule Action Pane

The following elements are included:

Single Event Start On Click to configure the start date for the event you are 
configuring.

Start On... Click to configure the date and time for the event to 
start.

Description Enables you to specify the action to be performed during 
the event, and the profiles for which they apply.

Important 
Information

Only those profiles for which the user has full 
permissions appear in the Available or Selected profiles 
list. Additional profiles for which the user does not have 
permissions may be defined in the platform, but they do 
not appear for this user.

GUI Element (A–Z) Description

Click to remove the highlighted profiles from the 
Selected Profile list.

Click to move the highlighted profiles to the Selected 
Profiles list.

Available Profiles Highlight a profile to move it to the Selected Profiles list. 
Hold the Ctrl key while selecting to choose multiple 
profiles.

Selected Profiles The list of profiles associated with the event.

Stop Running the 
Profile during the 
event occurrence

Select to stop running the selected Business Process 
profile and data collection during the time the event is 
scheduled to occur.

Stop sending Event 
Based alerts during 
the event occurrence

Select to prevent alerts from being generated during the 
time the event is scheduled to occur.

GUI Element (A–Z) Description



313

14
Profile Entity Maintenance

This chapter includes the main concepts and reference information for 
Profile Entity Maintenance.

This chapter includes:

Concepts

 ➤  Profile Entity Maintenance Overview on page 313

Reference

 ➤  Profile Entity Maintenance User Interface on page 314
Concepts

Profile Entity Maintenance Overview

The Profile Entity Maintenance page enables you to exclude unwanted 
entities from your profiles by performing the following actions:

➤ Configure report filters globally. For details, see “Configure Report Filters 
Globally” on page 313.

➤ Delete entities from the database. For details, see “Delete Entities from the 
Database” on page 314.

Configure Report Filters Globally
Global report filters enable administrators to exclude - per profile - specific 
transactions, locations, and groups from all HP Business Availability Center 
reports for the current and future profile sessions. This is useful if you want 
information only from specific entities in your profile.
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Global report filters affect all users. Any transaction, location, or group that 
is filtered out using global report filters is unavailable in the user-level report 
filters. For details on specifying report filters per user, see “Report Filters 
Page” in Using End User Management.

Delete Entities from the Database
HP Business Availability Center enables you to delete obsolete entities that 
are no longer associated with Business Process profiles. These entity types 
include transactions, locations, and groups.

When you add a transaction monitor to a Business Process profile, the 
transaction and the transaction’s location and group are added to the profile 
database. Even when a transaction monitor is deleted from the Business 
Process profile, the transaction and its location and group are still listed in 
the profile database. Until they are deleted in the Profile Entity Maintenance 
page, they appear in reports and filter lists for the profile.

Note: You use the End User Management Administration page to create 
Business Process profiles and add transaction monitors to those profiles. You 
also delete transaction monitors from profiles in End User Management 
Administration. For details, see “Managing Business Process Profiles 
Overview” in Using End User Management.

Deleting transactions, locations, and groups affects all users. You delete only 
those transactions, locations, and groups that are no longer associated with 
the selected profile.

Reference

Profile Entity Maintenance User Interface

This section describes:

 ➤  Profile Entity Maintenance Page on page 315
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Profile Entity Maintenance Page

The following elements are included:

Description Enables administrators to exclude - per profile - specific 
transactions, locations, and groups from all HP Business 
Availability Center reports for the current and future 
profile sessions. 

To access: Select Admin > Platform > Data Collection > 
Profile Entity Maintenance

Important 
Information

➤ To activate global filter settings for the current user, 
log out of HP Business Availability Center and log in 
again. 

➤ Filtered values still appear in user-defined (Custom 
and Trend) reports that were created before 
configuring the filter. To remove newly filtered values 
from existing user-defined reports, you must remove 
and re-add the components containing the elements 
for which filters have been set, and save the report. 

Useful Links “Profile Entity Maintenance Overview” on page 313

GUI Element (A–Z) Description

Apply Click to activate the selected filter(s). 

Associated Hosts The machine that hosts the location machine, if 
applicable.

Note: This field appears only on the Locations tab.

Associated Scripts The scripts associated with the specified transaction, if 
applicable.

Note: This field appears only on the Transactions tab.

Associated Locations The locations where the specified group is located, if 
applicable. 

Note: This field appears only on the Groups tab.
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Delete Select the check box next to the transactions, locations, 
or groups you want to delete.

Important: You can delete only those transactions, 
locations, or groups which are no longer associated with 
the selected profile (i.e. - not in use). Only the check 
boxes for those entities are enabled for deletion. If an 
entity is still associated with the selected profile, the 
Delete check box is disabled for that entity. 

Filter from Reports Select the check box next to the transactions, locations, 
or groups you want to exclude from reports for all users 
in the system.

Group Name The name of the group you can exclude from reports for 
all users in the system.

Note: This field appears only on the Groups tab.

Groups tab Displays a table of the groups associated with the selected 
profile.

Location Name The name of the location you can exclude from reports 
for all users in the system.

Note: This field appears only on the Locations tab.

Locations tab Displays a table of the locations associated with the 
selected profile.

GUI Element (A–Z) Description
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Select Profile Choose the profile from which you want to select 
transactions, locations, or groups to exclude from 
reports. 

Transaction Name The name of the transaction you can exclude from 
reports for all users in the system. 

Note: This field appears only on the Transactions tab.

Transactions tab Displays a table of the transactions that are running on 
the selected profile. 

GUI Element (A–Z) Description
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15
Working with Measurement Filters

Note to HP Software-as-a-Service customers: HP Operations administers 
these pages and the interface is hidden from view.

This chapter includes the main concepts and tasks for Measurement Filters.

This chapter includes:

Concepts

 ➤  Measurement Filters Overview on page 320

Tasks

 ➤  Define Measurement Filters on page 321

Reference

 ➤  Measurement Filters User Interface on page 323
Concepts
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Measurement Filters Overview

Measurement filters enable you to harvest significant data from the 
quantities of data sent to the HP Business Availability Center database from 
various data sources (including HP data collectors and third-party data 
sources) by creating filters that display only the most relevant data required.

You can create measurement filters for all data samples for which 
HP Business Availability Center uses the Universal Data Exchange (UDX) 
framework. These include Real User Monitor data samples, SiteScope 
Integration Monitor data samples, and Business Logic Engine data samples. 
If you are building a measurement filter for certain Real User Monitor data 
types, you can choose the value from a list (instead of typing it in the field). 
For details on the applicable data types and the samples used in HP Business 
Availability Center, see “Data Samples” in Reference Information.

Once you set up measurement filters, you can use them in various contexts 
in HP Business Availability Center, including:

➤ when defining trend reports using the Custom monitor type.

➤ when creating views in CMDB Administration (all defined measurement 
filters are automatically added as CIs to the UDX Measurement Filters view).

➤ when creating service level agreements (by adding measurement filter CIs to 
the SLA).

Note: In certain contexts in the HP Business Availability Center Web 
interface, the term custom data is used to categorize the data samples for 
which HP Business Availability Center uses the Universal Data Exchange 
(UDX) framework. 

Tasks
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Define Measurement Filters

This task describes how to define a measurement filter.

You define measurement filters from the Measurement Filters page, which 
you access from the Admin > Platform > Data Collection tab. For details, see 
“Measurement Filters Page” on page 326.

For details on the data types listed on the Measurement Filters page, see 
“Data Samples” in Reference Information.

This task includes the following steps:

➤ “Prerequisites” on page 321

➤ “Create a New Filter” on page 321

➤ “Create a Category” on page 321

➤ “Assign a Category to a Measurement Filter” on page 321

 1 Prerequisites
You must access the Measurement Filters page to define a measurement 
filter. Select Admin > Platform > Data Collection tab, and click the New Filter 
button.

 2 Create a New Filter
You create measurement filters to display only the most relevant data 
entering HP Business Availability Center. For details on the user interface for 
creating a measurement filter, see “Filter Page” on page 323.
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 3 Create a Category
Optionally, you define categories that help to organize your filters in a 
meaningful manner. For details on defining categories, see “Measurement 
Filters Page” on page 326.

 4 Assign a Category to a Measurement Filter
Optionally, you can assign one or more categories to a filter. For details on 
assigning categories to a filter, see “Measurement Filters Page” on page 326.

Reference
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Measurement Filters User Interface

This section describes:

 ➤  Filter Page on page 323

 ➤  Measurement Filters Page on page 326

Filter Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure a new filter for filtering data, 
according to data type, from HP Business Availability 
Center.

To access: Select Admin > Platform > Data Collection > 
Measurement Filters, click the New Filter button.

Important 
Information

➤ You build an expression by working in the following 
order: Field, Operator, Value.

➤ You should not use a field and operator combination 
twice in the same And phrase.

➤ The values you enter in the Value box are case 
sensitive and you must enter them precisely as they 
are used in the samples.

Included in Tasks “Define Measurement Filters” on page 321

Useful Links “Measurement Filters Overview” on page 320

GUI Element (A–Z) Description

Add ’OR’ Expression Click to define alternate parameters for the filter.

Add Values Click to add specified values to the Value field.

Note: This button is enabled only for select RUM data 
types fields. For details, see “Add Predefined Values to 
Fields” on page 325.

And Click to define additional parameters for the filter.



Chapter 15 • Working with Measurement Filters

324

Boolean Expression Displays the result of the configured filter as a boolean 
expression. 

Field Choose the field by which to filter the sample. For a list 
of fields associated with each sample, see “Data Samples” 
in Reference Information.

Name Enter a descriptive name for the filter.

Operator Choose an operator to server as a rule for filtering data in 
fields for the chosen sample. 

Note: 

➤ The list of operators displayed depends on the selected 
field.

➤ If you select a numeric operator, the value must be in 
the same numeric format as appears in the database.

➤ If you select a text operator, you can enter a single 
value without quotation marks, as they are added 
automatically when HP Business Availability Center 
builds the expression. To add two values, add 
quotation marks around each value, and separate 
them by a comma. For example, to define a filter that 
searches for a transaction name that is either HP or 
OVO, enter "HP","OVO".

Select if this event is 
intended only for 
failures

Select Yes to create an event that monitors failures only.

Note: This field is displayed only if you are creating a 
filter for one of the following data types:

➤ Alert Log

➤ Event

➤ KPI Statuses

GUI Element (A–Z) Description
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Add Predefined Values to Fields

When configuring a new measurement filter, you enter a value that the 
boolean expression compares with the value in the data sample. However, if 
you are building a measurement filter for certain Real User Monitor data 
types, you can choose the value from a list (instead of typing it in the Value 
field). This is true for the following data types: 

 

Set the event’s failure 
definition

Set a severity value that filters data according to the 
values sent from an external application. 

Note:

➤ This field is enabled only if Yes is selected in the Select 
if this event is intended only for failures field.

➤ Severity values are defined in the external application.

Value Enter a value that the expression compares with the 
value in the data sample.

Data Type Field Operator

RUM Pages Page Name

End User Name

in/not in

RUM End Users End User Name in/not in

RUM Transactions Transaction Name

End User Name

in/not in

GUI Element (A–Z) Description
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Measurement Filters Page

The following elements are included:

Description Displays the measurement filters configured for the data 
received by HP Business Availability Center, to display 
only the most relevant data. 

To access: Select Admin > Platform > Data Collection > 
Measurement Filter

Important 
Information

To edit a filter, click the filter’s name in the list of filters.

Included in Tasks “Define Measurement Filters” on page 321

Useful Links “Measurement Filters Overview” on page 320

“Data Samples” in Reference Information.

GUI Element (A–Z) Description

Click to collapse and hide the filter list.

Note: This option appears only selecting Category to 
view the Measurement Filter list by category.

Click to expand and view the filter list.

Note: This option appears only selecting Category to 
view the Measurement Filter list by category.

Category Select to display the filters by category.

Category button Click to view the category that the filter is associated 
with. 
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Category Manager Click to open the Category Manager dialog box and view 
the list of filter categories. For details on the Category 
Manager dialog box, see “Category Manager Dialog Box” 
on page 328. 

Note: This button is visible only if you have chosen to 
view filters by category.

The Category Manager page contains of the following 
elements:

➤ Category Name. Lists the available categories.

➤ New Category. Click to create a new category.

Data Type The data type for which you want to define a filter. 

Duplicate button Click to copy settings of the specific filter to a new filter. 

Note: If categories were assigned to the original filter, 
they are also assigned to the new filter. You can change 
the category assignments, as deemed necessary. 

Filter The name of the specific filter.

Name Select to display the filters by name.

New Filter Click to create a new filter. 

Search Enter the complete or partial filter name in the Search 
box and click Go to locate a specific filter. 

Note: You can type an asterisk to replace characters. For 
example, to search for the filter probe on cats machine, 
enter *cat*.

GUI Element (A–Z) Description
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Category Manager Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the list of filter categories, and to add 
a new filter category. 

To access: Select Admin > Platform > Data Collection > 
Measurement Filter, select the Category option and click 
Category Manager. 

Included in Tasks “Define Measurement Filters” on page 321

GUI Element (A-Z) Description

Category Name Lists the available categories.

New Category 
Button

Click to open the New Category dialog box and create a 
new category. Enter the name of the category in the 
Name field of the New Category dialog box.
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16
Central Repository Service

Note to HP Software-as-a-Service customers: The repository for 
HP Software-as-a-Service scripts functions differently from the repository 
described here. For details on working with scripts, see “HP Software-as-a-
Service Script Repository” on page 350.

This chapter includes the main concepts, tasks, and reference information 
for the Central Repository Service.

This chapter includes:

Concepts

 ➤  Central Repository Service - Overview on page 330

 ➤  Uploading Scripts and Creating File Sets on page 331

Tasks

 ➤  Upload Scripts on page 332

 ➤  Work with Scripts on page 333

Reference

 ➤  Central Repository Service Permissions on page 335

 ➤  Central Repository Service User Interface on page 338
Concepts
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Central Repository Service - Overview

The Central Repository Service is the central storage in which all your 
organization’s Business Process Monitor scripts are stored. The repository 
enables you to organize your scripts into logical groups and to view and 
manage the properties of those scripts. The repository also enables version 
control and version updates.

The Central Repository Service enables you to: 

➤ create and manage user-defined folders for organizing your scripts.

➤ upload scripts to a repository folder for use when creating monitors.

➤ manage the scripts that have been uploaded to the repository.

➤ control the versions of the file sets with check in and check out 
functionality, including downloading script content onto your local system 
for editing.

The Central Repository Service is installed during HP Business Availability 
Center deployment and resides along with the management database 
configured for your HP Business Availability Center installation.

To generate business process data, you must create profiles and transaction 
monitors to run scripts that include those processes you want monitored. 
When you add a transaction monitor to a profile in End User Management 
Administration, you can add only those scripts that have been stored in the 
Central Repository Service. For details on adding profiles and transaction 
monitors, see “Creating Business Process Profiles and Monitors Overview” 
and “Managing Business Process Profiles Overview” in Using End User 
Management.
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Note: If your HP Business Availability Center management database is 
running on an Oracle Server: For the Central Repository Service to function 
correctly, the management user schema requires execution permissions (the 
default) for the DBMS_LOB package. If these permissions have been revoked, 
the Central Repository Service is unable to access the database. Before using 
the Central Repository Service, confirm with your database administrator 
that these permissions are in place.

You can import the Production Analysis Reports from Application 
Performance Lifecycle (APL) Scripts to the Central Repository Service. For 
details, see “Work with the Central Repository Service (CRS)” in Solutions 
and Integrations.

Uploading Scripts and Creating File Sets

You create file sets that contain the scripts you upload to the Central 
Repository Service. File sets are the collection of files that make up the script 
and enable the transactions to be run by the Business Process Monitor. 
These file sets must be created within an existing folder in the Central 
Repository Service. For details on how to create file sets, see “Upload Scripts” 
on page 332.

To create scripts for use in HP Business Availability Center, you must record 
Business Process Monitor scripts using the HP Virtual User Generator 
recording tool. For details, see “VuGen Recording Tips” in Using End User 
Management.

Once these scripts are recorded and saved as .zip files, you upload them to 
the Central Repository Service.

Note: When zipping a script in Virtual User Generator for upload to the 
Central Repository Service, it is recommended that you zip only the script's 
run-time files. 
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You must upload scripts to the repository to access them when creating 
profiles in End User Management Administration. You create profiles and 
transaction monitors to collect performance data on the transactions within 
the scripts. For details on creating profiles, see “Creating Business Process 
Profiles and Monitors Overview” in Using End User Management.

Tasks

Upload Scripts

This task describes how to upload scripts in the Central Repository Service. 

This task includes the following steps:

➤ “Prerequisites” on page 332

➤ “Upload Scripts to the Central Repository Service” on page 332

➤ “Results” on page 333

 1 Prerequisites
You must create folders to store scripts in. For details on creating and 
managing folders, see “Panel Tree Pane” on page 346.

 2 Upload Scripts to the Central Repository Service
You upload scripts to the Central Repository Service folders. 

 a In the folder tree in the left pane, highlight the folder into which you 
want to upload the script.

 b In the right pane, click the New button on the bottom right corner of the 
Folder Content area, and fill in the relevant cells in the Create File Set 
dialog box. 

For details on uploading scripts, see “File Set Table Pane” on page 338.
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 3 Results
Folders are created under the Root folder.

The folders contain the various scripts you upload to the Central Repository 
Service.

Work with Scripts

This task describes how to work with scripts in the Central Repository 
Service.

This task includes the following steps:

➤ “Prerequisites” on page 333

➤ “Check out a Version” on page 334

➤ “Download File Set Content” on page 334

➤ “Upload File Set Content” on page 334

➤ “Checking In a File Set” on page 334

➤ “Results” on page 335

 1 Prerequisites
You must upload a script in the Central Repository Service. For details on 
uploading scripts, see “Upload Scripts” on page 332.
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 2 Check out a Version
You can check out a version of a file set to ensure that no other user makes 
changes to this version of the script while you are editing it. For details on 
the user interface for checking out a version, see “Action Buttons” on 
page 340.

 3 Download File Set Content
You download file set content to open and edit the downloaded script. It is 
good practice to check out the file set before downloading it to ensure that 
another user is not simultaneously editing the same file set’s script. For 
details on the user interface for downloading a file set, see “Action Buttons” 
on page 340.

 4 Upload File Set Content
Optionally, you can upload a script without creating a new file set version. 
For details on the user interface for uploading a script, see “Action Buttons” 
on page 340.

 5 Checking In a File Set
You check the file set back into the Central Repository Service once you 
have finished editing the script and saving the .zip file in your file system. 
Alternatively, you can cancel the check out to prevent the Central 
Repository Service from creating a new version number and leave the file 
checked in with its current version number. For details on the user interface 
for checking in a file set and cancelling check out, see “Action Buttons” on 
page 340.
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 6 Results
Your scripts appear in the File Set Table Pane on the right side of the page.

 Reference

Central Repository Service Permissions 

This section includes the following topics:

➤ “Setting Permission Mode” on page 336

➤ “Assigning Permissions Operation” on page 337

You can restrict a user’s access to individual folders and all of its scripts and 
subfolders. In the example below, if a user has permission to access the 
folder_1 folder, he also has permission to access its scripts and its subfolders. 
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Setting Permission Mode
Permission management is in either of the following modes:

➤ enforce permission. This is the default mode. Users authenticated in 
HP Business Availability Center are allowed to perform actions on specific 
folders. Only those folders and scripts that the user has permission to access 
are displayed in the Folder Content area. 

➤ do not enforce permission. Any user authenticated in HP Business 
Availability Center can perform any action on any folder. All folders and 
scripts are displayed in the Folder Content area.

You can change the permission mode from enforce permission to do not 
enforce permission, and vice versa. 

The following procedure changes the mode from enforce permission to do 
not enforce permission. 

To change permission mode:

 1 Stop HP Business Availability Center on the Gateway server. 

 2 Using WinZip or WinRAR, extract and then open <HP Business Availability 
Center root directory>/lib/crs_resources.jar. Do the following:

 a rename crs_common_config.xml to crs_common_config_tas.xml

 b rename crs_common_config_full_permissions.xml to 
crs_common_config.xml

 c save and close crs_resources.jar 

 3 In the <HP Business Availability Center root directory>/conf/tas directory, 
do the following:

 a rename crsContext.xml to crsContext.xml.old 

 b rename crsContext.properties to crsContext.properties.old

 4 Restart HP Business Availability Center.
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Assigning Permissions Operation

If Permission management is in enforce permission mode, you can assign 
the appropriate permissions operation. For details about permissions, see 
“Permissions Overview” on page 371.

To assign a permissions operation:

 1 Select Admin > Platform > Users and Permissions. In the Resource Context 
list, select Central Scripts Repository. Select the appropriate folder 
underneath the Root folder. Operations assigned to a folder affect all folders 
contained beneath it.

 2 In the Users and Groups area, select the user.

 3 In the Roles and Operations area, select the Operations tab. 

 4 Check or clear either the View or the Full Control operation box:

➤ If View is checked, the user can view and download a script in the 
Central Scripts Repository.

➤ If Full Control is checked, the user can edit or delete any script in the 
selected folder or its subfolders.

Giving Full Control on the Root folder grants the user permissions on all 
folders under Root. If he later adds a folder under the Root folder, Full 
Control is automatically granted on that folder.

➤ If neither View nor Full Control is checked, the user has no access to any 
script or subfolder in the selected folder. This is the default permissions 
operation.

 5 Click Apply Permissions to save the settings.

If the user was logged in while you changed his permissions operation, he 
must log out and log in again for the changes to take effect.
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Central Repository Service User Interface

This section describes:

 ➤  Central Repository Service Main Page on page 338

 ➤  File Set Table Pane on page 338

 ➤  Panel Tree Pane on page 346

Central Repository Service Main Page

File Set Table Pane

Description Displays the Business Process Monitor scripts stored in 
the Central Repository Service, and the folders that 
contain the scripts.

To access: Select Admin > Platform > Data Collection > 
Central Repository Service

Useful Links “Central Repository Service - Overview” on page 330

Description Displays, in table format, the file sets that have been 
created within the folder that is highlighted in the folder 
tree. The table also contains: 

➤ information relating to the file sets.

➤ action buttons for managing the file sets. 

To access: Select Admin > Platform > Data Collection > 
Central Repository Service

Useful Links “Central Repository Service - Overview” on page 330

For details on viewing version properties, see “Version 
Properties Dialog Box” on page 346. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Denotes a Virtual User Generator (VUGen) script.

Denotes a QuickTest Professional script.

Click to activate the search for the string entered in the 
Search By Name box.

Action Icons denoting the available options you can perform on 
the fileset.

Checked Out By The user who has the file set currently checked out.

Note: If the file set is not checked out, this column is 
blank.

Last Update The date when the file set was last checked into the 
repository. 

Note: This could be the date the file set was first created.

Name The name given to the file set when it was created and 
the script was uploaded.

Tooltip: Displays the full name of the fileset, in case the 
name was long and therefore truncated in the table.

New Click to open the Create File Set dialog box and create a 
new file set. For details, see “Create File Set Dialog Box” 
on page 342.

Owner The user who created the file set by uploading the script. 

Search By Name Enter a string you want to search for appearing in the 
Name field of the File Set Table.
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Action Buttons

The following elements are included in the Action column:

GUI Element (A–Z) Description

Click to open the Version History page and view version 
history for the file set. For details, see “Version History 
Dialog Box” on page 343.

Click to open the File Set Properties page and view 
properties of the file set. 

Note:

➤ When a file is checked in, none of the fields in the File 
Set Properties dialog box are editable. When a file set is 
checked out, the Description field can be edited only 
by the user who checked out the file set.

➤ You can click Show Additional Properties to view the 
properties related to the script itself.

Click to check out the selected file set for editing. 

Note:

➤ Checking out a file set ensures that no other user 
makes changes to this version of the script while you 
are editing it. 

➤ Only one user at a time can check out a file set.

➤ Once that file set is checked out, only that user can 
check it in, delete it, or create a new version.



Chapter 16 • Central Repository Service

341

Click to open a check-in version of the Version properties 
dialog box and check in the file set version. For details on 
the Version properties dialog box, see “Version Properties 
Dialog Box” on page 346.

Important:

➤ This button is displayed only for those file sets that 
have been checked out.

➤ When you check in a file set, the Central Repository 
Service automatically creates a new version number 
for the file set. For example, if you checked out version 
number 1.1.1 of a file set, the Central Repository 
Service creates version number 1.1.2 as a result of 
checking the file set back into the Central Repository 
Service. File set version 1.1.1 is still accessible and its 
script can be added to transaction monitors in End 
User Management Administration, but the latest 
version, file set version 1.1.2, becomes the default 
version.

Click to cancel checkout of the file set.

Note: 

➤ This button is displayed only for those file sets that 
have been checked out.

➤ Cancelling a check out prevents the Central 
Repository Service from creating a new version 
number and leaves the file checked in with its current 
version number. If you have made modifications to 
the script that you do not want saved in the Central 
Repository Service file set, cancelling the check out 
ensures that those changes are not brought into the 
Central Repository Service.

GUI Element (A–Z) Description
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Create File Set Dialog Box

The following elements are included:

Click to upload a script to save your recent script 
modifications to the Central Repository Servicewithout 
creating a new file set version. 

Note:

➤ This action serves as an extra precaution when making 
many modifications to scripts so that the file set is 
saved to the repository. This is useful, for example, 
while you are testing the script in the recording tool. 

➤ When you upload a script without checking in the file 
set, the content of this version of the file set is not 
available to other users. 

➤ When you check in a file set that has been uploaded, 
you do not have to specify a location in your file 
system to locate the file set. 

➤ The most recently uploaded file set is automatically 
checked in during the check in procedure.

Click to download file set contents for editing.

Note: It is good practice to check out the file set before 
downloading it to ensure that another user is not 
simultaneously editing the same file set’s script.

GUI Element (A–Z) Description

Content Enter the path of the .zip file containing the script. You 
can also click Browse to locate the .zip file in your file 
system.

Description Optionally, add a description for the new file set. The 
description appears in the file set properties. 

GUI Element (A–Z) Description
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Version History Dialog Box

Name The name of the content or .zip file specified in the 
Content field. You cannot fill this field in manually.

Type Choose the type of file set you want to add to the Central 
Repository Service from the Type list. 

Note: 

➤ If you select AUTO-DETECT, the script type is 
determined during the upload.

➤ Currently, the following types are supported in 
HP Business Availability Center: AUTO-DETECT, 
VUGEN SCRIPT, and QTP SCRIPT. 

Description Displays a listing of all the versions of a file set and the 
actions that can be performed on that file set version. 

To access: Click the Show Versions button  in the 
Action column of the File Set table. 

Important 
Information

When you view the file set versions of a file set that has 
been checked out, the Version History dialog box is 
divided into the following tables: 

➤ Checked Out Version. 

➤ Available Version List. 

Note: The elements displayed are identical, whether you 
are viewing the file set versions of a file set that is 
checked out or is not checked out. 

Included in Tasks “Upload Scripts” on page 332

GUI Element (A–Z) Description
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Checked Out Version Table

The following elements are included:

GUI Element (A-Z) Description

Action If you are the user who checked out the file set, you can 
perform a variety of actions on the version checked-out 
version. For details on the available actions, see “Action 
Buttons” on page 340.

Locked By The user who checked out the file set.

Modified The date and time when the file set was last checked into 
the repository. If the file set has never been checked in, 
this is the date it was first created.

Version The version number of the file set that is checked out.
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Available Version List Table

The following elements are displayed:

GUI Element (A–Z) Description

Select to view version properties. 

➤ You can optionally modify the Version Comment field. 
All other fields are uneditable. 

➤ Click the Show Additional Properties to view 
properties of the script itself. 

Click to restore a previous version of a file set and make it 
the current version, which enables you to view 
information relevant to a specific date or activity.

Click to download the specific version of the file set for 
editing. 

Notes:

➤ It is good practice to check out the file set before 
downloading it to ensure that another user is not 
simultaneously editing the same file set’s script.

➤ You cannot download the version of a file set version 
that is checked out.

Action Buttons enabling you to perform actions on the specified 
version, as follows: 

➤  Click to view properties of the current version. 

➤  Click to restore the selected version.

➤  Click to download the selected version.

Modified The date and time when the file set was last checked into 
the repository. If the file set has never been checked in, 
this is the date the script was first downloaded and the 
file set was first created. 

Modified By The user who last checked in the version of the file set.

Version The number given to the file set when it was last checked 
into the Central Repository Service. 
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Version Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Panel Tree Pane

Description Displays properties and property values of the file set 
version you are checking in.

To access: Click the Version Properties button  next 
to the file you want to view properties and property 
values for. 

Included in Tasks “Upload Scripts” on page 332

GUI Element (A-Z) Description

Property The property relevant to the specified file set version. 

Show Additional 
Properties

Click to display advanced file set properties for the file 
set. Click Hide Additional Properties to hide the 
advanced file set properties. 

Value The value of the specified property.

Description Displays a tree hierarchy of the folders in the Central 
Repository Service, and the buttons used to manage 
them.

To access: Select Admin > Platform > Data Collection > 
Central Repository Service.

You can hide and view the Panel Tree by clicking the 
Hide  or View icon  between the Panel Tree and 
File Set Table panes. 

Useful Links “Central Repository Service - Overview” on page 330
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to create a new folder. You create folders below the 
Root level folder.

Click to delete the selected folder.

Click to rename the selected folder.

Click to cut the selected folder from its place in the tree 
hierarchy. 

Click to paste the previously cut folder to a new location 
in the tree hierarchy. 

Note: You cannot paste a folder into the same folder from 
which it was cut.

Click to refresh the navigation tree. 

Tip: You refresh the tree to load the folder data that may 
have been modified by other users.

Note: The tree refreshes automatically when you perform 
any of the folder operations, so it is not necessary to 
refresh it manually.

Denotes the Root folder in the tree hierarchy. 

Denotes a Central Repository Service folder.
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17
Data Collection Administration for 
HP Software-as-a-Service

Note: The Location IP Ranges, Script Repository, and Package Information 
pages are available to HP Software-as-a-Service customers only.

This chapter provides information on Data Collection Administration for 
HP Software-as-a-Service.

This chapter includes:

Concepts

 ➤  Data Collection Administration for HP Software-as-a-Service - Overview 
on page 350

 ➤  HP Software-as-a-Service Script Repository on page 350

Tasks

 ➤  Create and Upload Scripts to the Script Repository – Workflow on page 352

Reference

 ➤  Understanding the Script Verification Results on page 353

 ➤  HP Software-as-a-Service Data Collection User Interface on page 356
Concepts
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Data Collection Administration for HP Software-as-a-
Service - Overview

Data Collection Administration for HP Software-as-a-Service enables you to 
do the following: 

➤ Maintain your scripts and view their verification information. For details, 
see “HP Software-as-a-Service Script Repository” on page 350.

➤ View the customer’s list of locations and related information. For details, see 
“Location IP Ranges Page” on page 356.

➤ View information on the package the customer agreed to when the 
HP Software-as-a-Service contract is signed. For details, see “Package 
Information Page” on page 357.

HP Software-as-a-Service Script Repository

The HP Software-as-a-Service Script Repository is a central shared folder in 
which all your organization’s Business Process Monitor scripts are stored.

The Script Repository enables you to: 

➤ create and manage user-defined folders for organizing your scripts.

➤ upload scripts to a repository folder for use when creating monitors.

➤ manage the scripts that have been uploaded to the repository.

➤ control the versions of the file sets with check in and check out 
functionality, including downloading script content onto your local system 
for editing.
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When you add a monitor to a profile in End User Management 
Administration, you can add only those scripts that have been stored in the 
Script Repository and were manually verified. For details, see “Managing 
Business Process Profiles Overview” in Using End User Management. 

Once you have created and recorded the scripts, you upload them using the 
Script Repository page. For details, see “Create and Upload Scripts to the 
Script Repository – Workflow” on page 352. 

To select a previous version of the script you must download it and upload it 
again; it then becomes the current version.

Tasks
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Create and Upload Scripts to the Script Repository – 
Workflow

This task describes how to create and upload scripts to the Script Repository.

This task includes the following steps:

➤ “Create and Record Business Process Monitor Scripts” on page 352

➤ “Zip Script Files” on page 352

➤ “Upload Scripts” on page 352

➤ “Edit Scripts” on page 353

➤ “Re-upload the Script” on page 353

 1 Create and Record Business Process Monitor Scripts
You record Business Process Monitor scripts using the HP Virtual User 
Generator recording tool. For details, see “VuGen Recording Tips” in Using 
End User Management..

 2 Zip Script Files
You zip only the Business Process Monitor scripts’ run-time files for upload. 
Zipping all files may cause script verification to fail due to a limit in the file 
size allowed by the repository.

 3 Upload Scripts
You upload scripts by clicking the Upload button on the Script Repository 
page. For details on uploading scripts, see “Upload Script Dialog Box” on 
page 365.
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 4 Edit Scripts
Click the script name link and save the script to a local or network drive. 
You can then edit the file at a later time using the Virtual User Generator or 
you can open the file using any program that supports the .zip format.

 5 Re-upload the Script
After editing a script, you must upload it again to the repository. You must 
zip the script before uploading. After you upload the edited script, 
HP Business Availability Center reruns the verification process on the script. 

Reference

Understanding the Script Verification Results

After you upload a script to the script repository, HP Business Availability 
Center runs a verification process to verify that the script executes properly 
when it is run in a profile. Once the script passes verification, HP Business 
Availability Center displays the Passed status in the Status column. You can 
add a script to a profile only after it passes verification.

You can check the verifications for which your transaction failed in the 
<Script Name> Versions dialog box.

The complete list of conditions is as follows:

Running Verifications Rule Actual Result

Disallowed function calls: 
system;lr_load_dll

Do not use the function calls 
that are listed.

Lists the actual function calls 
used in the script.

Download size must be less 
than 3000000 bytes

The maximum size of the 
download.

Indicates the actual download 
size.

Execution must be less than 
300 seconds

The maximum execution time 
of the script.

Indicates the actual execution 
time of the script.
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Expected protocol:

QTWeb; NCA; WinSock; 
Sap_web; SapGui; Siebel_Web; 
HTTP; SOAP; PS8; PS8WebJS; 
WinSockWeb; Oracle_NCA; 
OracleWebJS; WebJS; 
WinSockWeb; Tulip; 
Citrix_ICA; OracleWebJS; 
General-vbs; General-Js SMTP; 
POP3; IMAP; Oracle; ODBC; 
FTP; EJB-Testing; MLDAP; Rmi-
Java; Java_protocols

Only use the listed protocol 
types. 

Indicates the actual protocol 
type used in the script.

Extra files with the following 
extensions are allowed: 
ini;h;tst

Only use extra files with the 
listed extensions.

Lists the actual extensions 
used in the script.

Failed transactions are 
disallowed

Do not use failed transactions. Indicates whether there were 
failed transactions in the 
script.

Maximum number of dynamic 
transactions allowed:0

Do not use more dynamic 
transactions than the allowed 
maximum number.

Indicates the number of 
dynamic transactions in the 
script. Dynamic transactions 
are the transactions that are 
not defined in the USR file; 
meaning their name has been 
generated dynamically (for 
example: Transaction + i == 
Transaction 1,Transaction 2, 
and so forth).

Running Verifications Rule Actual Result
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Note: The verification process differs depending on the contents of the 
script. Some scripts may go through a subset of the verifications listed 
above.

If any of these verification checks are not applicable to your organization, 
contact HP Software-as-a-Service Support.

Maximum number of 
iterations allowed:1

Do not use more iterations 
than the allowed maximum 
number.

Indicates the number of time 
each action in a script is run. 
Every script is composed of 
actions (.c code files) which 
can be run more than once 
during one running of the 
script (a feature used mainly in 
LoadRunner and not in 
HP Business Availability 
Center). This iteration number 
must be limited so that 
duplicate transactions are not 
reported.

Maximum number of 
transaction instances 
allowed:1

Do not use more transaction 
instances than the allowed 
maximum number.

Indicates the number of 
transaction instances in the 
script.

Maximum number of 
transactions allowed:100

Do not use more transaction 
than the allowed maximum 
number.

Indicates the number of 
transactions in the script.

Total size must be less than 
600000 bytes

The maximum total size of the 
script.

Indicates the actual total size 
of the script.

Running Verifications Rule Actual Result
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HP Software-as-a-Service Data Collection User Interface

This section describes:

 ➤  Location IP Ranges Page on page 356

 ➤  Package Information Page on page 357

 ➤  Script Repository Page on page 361

Location IP Ranges Page

The following elements are included:

Description Displays a list of locations defined in your package, 
including the detailed IP address ranges. 

To access: Select Admin > Platform > Data Collection > 
Location IP Ranges

GUI Element (A-Z) Description

IP Address/Subnet 
Mask

The range of IP addresses for the location. The first 
number is the IP Address (and the beginning of the 
range). The second number is the Subnet Mask. The 
Subnet Mask is used to calculate the number of addresses 
in the range by subtracting the last set of three numbers 
(in this example: 240) from the set of three numbers 
before last (in this example: 255). The result is: 255-
240=15. This result is then added to the last set of three 
numbers in the IP Address (in this example 144+15=159) 
to provide the upper IP Address in the range: 
195.193.104.159. The range of Amsterdam IP Addresses is 
then from the IP Address: 195.193.104.144 to the 
calculated upper IP address: 195.193.104.159.

Location Name The physical location: city, county, state, or province, 
and the name of the location.



Chapter 17 • Data Collection Administration for HP Software-as-a-Service

357

Package Information Page

The following elements are included:

Description Displays information about the customer package, as 
agreed upon and entered in the HP Business Availability 
Center application when the HP SaaS contract is signed. 

To access: Select Admin > Platform > Data Collection > 
Package Information

GUI Element (A–Z) Description

Click to view the available Business Process Monitor 
locations on which to run the packages. For details, see 
“Package Locations Page” on page 358.

Click to open the Package Properties page to view and 
modify package properties information. For details, see 
“Package Properties Page” on page 358.

Business Process 
Monitor Transactions

The total number of Business Process Monitor 
transactions that can be run as part of the package.

Expiration The expiration date of the package. 

The expiration date becomes red 14 days before the 
expiration date of a paying customer package, and 7 days 
before the expiration date of an evaluation customer 
package. 

Global POPs The total number of Global Points Of Presence that can 
be run as part of the package. Any customer can access 
these package locations. 

A Point of Presence is a place where the package is 
located. 

Name The name of the package. 
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Package Locations Page

The following elements are included:

Package Properties Page

Private POPs The total number of Private Points Of Presence that can 
be run as part of the package. Only the associated 
customer can access these package locations. 

A Point of Presence is a place where the package is 
located.

URLs The total number of single URL monitors that can be 
accessed as part of the package.

Description Displays the available Business Process Monitor locations 
on which to run the package.

To access: Select Admin > Platform > Data Collection > 
Package Information, and click the Package Location 
button .

GUI Element (A-Z) Description

Location Name Indicates the locations that the package is available to 
run on. Select the check box to run the package; de-select 
the check box to disable the package from running.

Package Name Indicates the name of the selected package. 

Description Displays information about the customer package for 
specific applications (Business Process Monitor and 
SiteScope). 

To access: Select Admin > Platform > Data Collection > 
Package Information, and click the Edit button . 

Important 
Information

This information is entered in HP Business Availability 
Center when the contract is signed with HP. You can 
modify only the subscribed recipients.

GUI Element (A–Z) Description
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General Tab

The following elements are included:

Description Displays general information about the selected package.

To access: Admin > Platform > Data Collection > Package 
Information, click the Edit button .

Important 
Information

The General Tab is the default selection on the Package 
Properties screen. 

GUI Element Description

Customer Name The name of the customer.

Customer UDX Name The customer name to be used when reporting data into 
the system. 

Package Name The name of the selected package.

Expiration Date The expiration date of the package. The number to the 
right of the box indicates the number of days left before 
the package expiration date.

Number of 
Scheduled Reports

Number of scheduled reports included in the package. 
The number to the right of the box indicates the number 
of scheduled reports that have already been configured.

Subscribed 
Recipients

The names of the recipients configured to receive 
package expiration notices via e-mail. Click Change to 
open the Select Recipients dialog box. For details on the 
Select Recipients dialog box, see 

➤ If you are a paying customer, the appropriate recipient 
will receive a package expiration notice via e-mail 14 
days before the due date. 

➤ If you are an evaluation customer, the appropriate 
recipient will receive a package expiration notice via e-
mail 7 days before the due date. 
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End User Management Tab

The following elements are included:

System Availability Management Tab

Description Displays package information related to End User 
Management. 

To access: Select Admin > Platform > Data Collection > 
Package Information, click the Edit button  and 
select the End User Management tab.

GUI Element Description

Number of Private 
POPs

The number of private POPs allowed for the package. The 
number to the right of the box indicates the number of 
private POPs already in use. 

Number of locations The number of locations allowed by the package. The 
number to the right of the box indicates the number of 
locations already in use.

Number of 
transactions

The number of transactions allowed by the package. The 
number to the right of the box indicates the number of 
transactions already in use.

Number of URLs The number of single URL monitors allowed by the 
package. The number to the right of the box indicates the 
number of URLs already in use.

Schedule - max. 
frequency (min.)

The maximum frequency in minutes that your profiles 
can be scheduled to run.

Number of WebTrace 
addresses

The number of WebTrace addresses allowed for this 
package. The number to the right of the box indicates the 
number of WebTrace addresses already being monitored.

Description Displays package information related to SiteScopes. 

To access: Select Admin > Platform > Data Collection > 
Package Information, click the Edit button  and 
select the System Availability Management tab.
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The following elements are included:

Script Repository Page

The following elements are included:

GUI Element (A–Z) Description

Number of SiteScope 
profiles

The number of System Availability Management profiles 
allowed for this package. The number to the right of the 
box indicates the number of System Availability 
Management profiles already in use.

Description Displays the Business Process Monitor scripts that have 
been uploaded. 

To access: Select Admin > Platform > Data Collection > 
Script Repository

Important 
Information

The Script Repository Page consists of the following tabs:

➤ Business Process Monitor. Used to manage your 
Business Process Monitor scripts.

➤ Subscription Verification. Used to configure recipients 
to receive email notification when Business Process 
Monitor script verification is complete. For details, see 
“Subscription Verification Tab” on page 366. 

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

Useful Links “HP Software-as-a-Service Script Repository” on page 350

GUI Element (A–Z) Description

Click to open the Manual Script Verification dialog box 
and manually verify the script. For details, see “Manual 
Script Verification Dialog Box” on page 363.

Click to open the .usz file directly in the Virtual User 
Generator (if you have installed it). 



Chapter 17 • Data Collection Administration for HP Software-as-a-Service

362

Last Update The date the script was most recently updated. 

Owner The name of the most recent user to update the script.

Script Name The name of the script. Click to open the .zip or .obs files 
that comprise the transaction. 

You click the script name link and save the script to a 
local or network drive. You can then edit the file at a later 
time using the Virtual User Generator, or you can open 
the file using any program that supports the .zip or .obs 
formats. 

Starts with Filter your view of the Script Repository content 
according to the first character in the Script Name.

Status The status of the verification process for the script. 

You double-click the status to open the Script Verification 
Results dialog box and modify it. For details, see “Script 
Verification Results Dialog Box” on page 363.

Upload Click to upload Business Process Monitor scripts to the 
Script Repository. For details, see “Upload Script Dialog 
Box” on page 365.

Version The current version of the script. 

The version of the script that is stored is the active 
version. To use a newer version or to go back to an older 
version of the script you must upload the script 
corresponding to the version you want. That script then 
becomes the active version of the script. For details on 
accessing older versions of a script, see “<Script Name> 
Versions Dialog Box” on page 364.

GUI Element (A–Z) Description
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Manual Script Verification Dialog Box

The following elements are included:

Script Verification Results Dialog Box

Description Enables you to change the verification status of a script 
and to remove a script from use. 

To access: Select Admin > Platform > Data Collection > 
Script Repository, click the Manual Verification button 

.

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

Useful Links “Script Repository Page” on page 361

“HP Software-as-a-Service Script Repository” on page 350

GUI Element (A-Z) Description

Script Status Select from the following status options:

➤ Verified for private POP. Select for scripts that you 
want to verify for use on your private Business Process 
Monitor.

➤ Verification failed. Select to disable a transaction 
before running your profile.

Description Displays the status of the verification process for the 
script. 

To access: Select Admin > Platform > Data Collection > 
Script Repository, select the Business Process Monitor tab 
and click the value in the Status field.

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

Useful Links “Script Repository Page” on page 361
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The following elements are included:

<Script Name> Versions Dialog Box

GUI Element Description

Expected/Allowed 
Value Verifications

The conditions for the script verification.

Actual Results The current results of the verification.

Description The description of the verification.

Status The status of the verification. Possible values are: 

➤ Passed

➤ Warning

➤ Failed

Description Displays the history of the script. Enables you to track 
changes made to scripts and to access them to perform 
additional changes.

To access: Select Admin > Platform > Data Collection > 
Script Repository, select the Business Process Monitor tab 
and click the script version number. 

The <script-name> versions dialog box displays the 
history of the script. Each time you upload the script, a 
new line is added to this list and the version is 
incremented.

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

Useful Links “Script Repository Page” on page 361
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The following elements are included:

Upload Script Dialog Box

The following elements are included:

GUI Element (A–Z) Description

Description The description of the script. This is useful for version 
control: you can describe why changes were made to this 
version of the script.

Last Update The date the script was most recently updated. 

Owner The name of the most recent user to update the script.

Status The status of the verification process for the script. 

Click the status to open the Script Verification Results 
dialog box and modify it. For details, see “Script 
Verification Results Dialog Box” on page 363.

Version Click to open the scripts. Scripts are stored in .zip format

Description Enables you to upload a Business Process Monitor script 
to the Script Repository.

To access: Select Admin > Platform > Data Collection > 
Script Repository, select the Business Process Monitor tab 
and click Upload. 

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

Useful Links “Script Repository Page” on page 361

GUI Element (A–Z) Description

Browse Click to browse your system and select a Business Process 
Monitor script to upload.

Description Enter a description of the script. 
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Subscription Verification Tab

The following elements are included:

Script The path of the Business Process Monitor script you are 
uploading. 

Upload Click to upload the script to the Script Repository.

Description Enables HP Business Availability Center to send email 
notification to specified recipients when Business Process 
Monitor script verification is complete.

To access: Select Admin > Platform > Data Collection > 
Script Repository, select the Subscription Verification tab.

Included in Tasks “Create and Upload Scripts to the Script Repository – 
Workflow” on page 352

GUI Element (A-Z) Description

Email address(es) Specify one or more e-mail addresses of the recipients to 
receive email notification. Multiple recipient addresses 
must be separated by a semi-colon.

Notify the following 
recipients when 
script verification is 
complete

Click to enable subscription verification.

GUI Element (A–Z) Description
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18
User Management

This chapter includes the main concepts, tasks, and reference information 
for User Management.

This chapter includes:

Concepts

 ➤  User Management – Overview on page 370

 ➤  Permissions Overview on page 371

 ➤  Group and User Hierarchy on page 377

 ➤  Customizing User Menus on page 379

Tasks

 ➤  Configure Users and Permissions - Workflow on page 380

 ➤  Configure Users and Permissions - Scenario on page 382

 ➤  Assign Permissions on page 392

 ➤  Configure Group and User Hierarchy on page 394

 ➤  Customize User Menus - Workflow on page 396

 ➤  Customize User Menus - Scenario on page 398

Reference

 ➤  User Management Roles on page 403

 ➤  User Management Operations on page 426

 ➤  User Management User Interface on page 462
Concepts
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User Management – Overview

You use the User Management interface to: 

➤ Configure HP Business Availability Center Groups and Users. You group 
users to make managing user permissions more efficient. Instead of 
assigning access permissions to each user one at a time, you can group users 
who are assigned the same permissions levels on the same resources.

You may want to create different groups based on how users access the 
different resources in HP Business Availability Center. Examples of criteria 
for grouping users that are relevant to your organization may be:

One superuser is defined for every installation of HP Business Availability 
Center. This superuser's default login name and password are admin, admin. 
This original superuser is not listed among the users in User Management 
and therefore, this user's password can be changed only on the General 
Settings page in Personal Settings (Admin > Personal Settings). For details on 
the user interface for performing this task, see “General Settings Page” on 
page 490. 

The superuser permissions role can be applied to other users in the system. 
These users with superuser permissions are listed, and can be modified, in 
User Management. For details on applying permissions, see “Assign 
Permissions” on page 392.

You can change a user’s parameters, including their username and password, 
in the General Tab. For details, see “General Tab” on page 464.

For details on creating groups and users, see “Groups/Users Pane” on 
page 475.

Tasks Within the Organization Locations and Territories

Customer service representatives Users working in different sales 
territories

System administrators Users based on geographical location

High-level management Users accessing network servers in 
different locations
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➤ Assign Permissions to Groups and Users. The User Management interface is 
available only to users with appropriate permissions. A user’s permissions 
are either inherited from their assigned role, or granted individually when 
their parameters are configured. For details on permissions, see “Permissions 
Overview” on page 371.

➤ Set Group and User Hierarchy. You can add users to groups and nest groups 
within other groups. For details, see “Group and User Hierarchy” on 
page 377.

➤ Customize User Settings. Select the page users see when entering HP 
Business Availability Center, and choose the menu items available on pages 
throughout HP Business Availability Center. For details, see “Customizing 
User Menus” on page 379.

Permissions Overview

You can assign permissions to the groups and users defined in your 
HP Business Availability Center platform, enabling access to specific areas of 
HP Business Availability Center.

Granting permissions has the following components: 

➤ The user

➤ The resource

➤ The operation or role being granted

The Permissions tab is divided into the following areas:

➤ The resource tree area in the center of the page, containing the resources 
and resource instances (known as contexts) on which permissions are 
assigned. For details, see “Understanding Permissions Resources” on 
page 373.

➤ The roles and operations area on the right side of the page. For details on 
roles, see “Roles” on page 376. For details on operations, see “Operations” 
on page 376.
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Additionally, the Groups/Users pane is continually visible on the left side of 
the page.

For details on assigning permissions, see “Assign Permissions” on page 392.

Note: 

➤ If you have upgraded from a previous version of HP Business Availability 
Center and had specific users and security levels defined, those users and 
security levels are mapped to the new roles functionality in the 
Permissions tab. For details, see “Roles” on page 376.

➤ You can export users and groups, together with their assigned roles and 
permissions, from one HP Business Availability Center machine to 
another. For details, contact HP Software Support. 
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Understanding Permissions Resources
HP Business Availability Center enables you to fine tune your permissions 
management by applying permissions at the resource level. All of the 
resources on which permissions can be applied have been identified and 
categorized in a hierarchical tree, representing the HP Business Availability 
Center platform.

The resources and instances of those resources are organized according to 
logical groupings called contexts. Contexts make it easier to identify and 
select the area of the platform on which you want to apply permissions.

The resources are divided according to the context in which they function 
within the platform and not necessarily where they are found in the user 
interface.

Resources and Resource Instances
There are three types of resources in Permissions Management. Each is 
represented by a different icon in the resource tree:

➤ resource collection (a resource that can have instances) 

➤ instance of a resource 

➤ resource that cannot have instances in the permissions resource tree

An instance of a resource is displayed only if it has been defined in the 
platform. The instance of a resource appears as a child object of the resource 
in the tree with the name as it has been defined in the application. After 
instances of a resource are defined in the system, the resource collection acts 
as the parent resource for those instances.

There are some resources, such as the different data collector profiles, that 
contain other resources within them in the resource tree hierarchy. Some of 
these sub-resource types appear only if there are instances of the resource 
defined in your platform, such as Monitor and Transaction resources within 
a profile resource.
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Resources that cannot have instances in the permissions tree are divided 
into the following types:

➤ Resources that are functions or options within the system that do not have 
any other instances or types. 

Example

The Outlier Value resource determines whether the user can edit the outlier 
threshold value. It has no instances.

➤ Resources that do have instances - permissions can be applied only on the 
resource type and affect all instances of the resource. 

Example

The Category resource includes all categories defined in End User 
Management Administration. Change permissions granted on the categories 
resource enables a user to modify all the categories defined in the system. 
You cannot grant or remove permissions for specific categories, only for 
every category defined in End User Management Administration.

Examples of Resources and Instances

An example of how resources and instances are displayed in the permissions 
hierarchy is the Business Process Profile resource within the Monitors 
context. The Business Process Profile resource includes instances only if 
there have been Business Process profiles defined in the system. If there are 
profiles defined in the system, each of those appears as an instance of the 
Business Process Profile resource with the name defined for the profile in 
End User Management Administration. 

Because monitors, transactions, and alerts are defined in your platform per 
profile, the Monitors, Transactions, and Alerts resources appear under each 
of the instances of the profile resource. Monitors and Transactions are 
resource collections and can have their own instances, but Alerts is a 
resource that cannot have instances. 
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You can apply permissions to the Business Process Profile resource level. This 
enables the user access to all Business Process profiles created in the system. 
If you want to restrict a user’s access to specific Business Process profiles that 
relate to the user’s tasks, you can apply permissions to a specific Business 
Process profile, to the Monitors resource or to any instance of monitors that 
have been defined under the profile.

Guidelines for Working with Resources

➤ The Business Availability Center resource refers to all contexts in 
HP Business Availability Center. 

➤ Only roles and not operations can be applied to the Business Availability 
Center resource. For details, see “Roles” on page 376.

➤ To manage the permissions on a subresource, you must provide the user 
with at least View permission on the selected resource's parent. 

➤ You grant Add permission only on a resource and not on an instance of a 
resource. 

➤ When a user defines or creates an instance of a resource, for example creates 
a Business Process profile, that user has Full Control permission on that 
resource instance and all of its child resources. 
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Roles
HP Business Availability Center enables you to apply permissions using 
predefined roles for specific users or groups in your organization. These roles 
include a preconfigured collection of resources and a set of operations that 
apply to those resources.

Roles are organized by context as to which resources and which operations 
have been preconfigured and included in the role. For details on how each 
operation applies to a specific resource, see “Operations” on page 376. 

Roles can be applied only to specific resources:

➤ Roles that include resources from several contexts can be applied only to the 
Business Availability Center resource. Business Availability Center appears as 
the first resource collection in every context.

➤ Roles whose resources are all within one context can be applied to specific 
resources within that context. 

For a description of each role, including details of the resources on which 
roles can be applied, see “User Management Roles” on page 403.

Operations
When working with operations, keep the following in mind:

➤ All of the operations that can be applied to a resource collection can also be 
applied to any instance of that resource. The one exception is the Add 
operation which cannot be applied to an instance of a resource.

➤ The Full Control operation automatically includes all the other operations 
available on the resource. When applied, the other operations are 
automatically selected.

➤ When the Full Control operation is applied to any resource, the user also has 
permissions to grant and remove permissions on that resource, or resource 
instance, for other users or groups.

➤ When the View operation is one of the resource’s available operations and 
you select one of the other available operations, the View operation is also 
automatically selected.
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For details on the available operations in HP Business Availability Center, 
see “User Management Operations” on page 426.

Group and User Hierarchy

You can nest groups to make managing user and group permissions easier. 
Instead of assigning access permissions to each group one at a time, you can 
nest a group to inherit the permissions of its direct parent.

When nesting groups, note the following: 

➤ A group can be a member of several groups.

➤ Permissions are assigned to nested groups in the same way as for regular, 
non-nested, groups. Changes in nested group permissions take effect at the 
user’s next login.

➤ There is no maximum number of levels of nested groups.
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Example

In the example below, Group_A and Group_B are nested members of 
Group_C. Group_C inherits the combined permissions of both groups. 
Group_C and Group_D are nested members of Group_E. Group_E directly 
inherits the permissions of Group_C and Group_D, and indirectly inherits 
the permissions of Group_A and Group_B. 

When permissions are added to, or removed from, a nested group, the 
changes are automatically implemented in the nested group’s immediate 
parent and continue to propagate onward. For example, if delete permission 
in Group_B is removed, Group_C’s permissions become add + change + view. 
Group_E’s permissions become add + change + view + execute.

A circle of nested groups is not permitted. For example, Group_A is a 
member of Group_B, and Group_B is a member of Group_C. Group_C cannot 
be a member of Group_A.

Group_A
(add + change + view)

Group_C
(add + change + delete + view)

Group_B
(add + delete + view) 

 Group_A is a member 
of Group_C

Group_B is a member 
of Group_C

Group_D
(execute + view)

Group_E
(add+change+delete+view+execute)

Group_C is a member 
of Group_E

Group_D is a member 
of Group_E
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Note: All permissions in the previous example refer to the same resource.

For details on setting up nested groups, see “Configure Group and User 
Hierarchy” on page 394.

Customizing User Menus

You can customize user menus to:

➤ select the default context that is displayed for specific users when logging 
into HP Business Availability Center. 

➤ specify the first page that is displayed for specific users in each of the 
different parts of HP Business Availability Center.

➤ specify the tabs and options that are available on pages throughout 
HP Business Availability Center.

Customizing your entry page, menu items, and tabs enables the interface to 
display only the areas of HP Business Availability Center that are relevant to 
specific users.

For details on customizing user menus, see “Customize User Menus - 
Workflow” on page 396. 

You customize user menus on the Customization tab. For details on the 
Customization tab user interface, see “Customization Tab” on page 462.

Tasks
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Configure Users and Permissions - Workflow

This task describes a suggested working order for the User Management 
application. You can configure User Management settings in any other 
logical order you choose.

For a scenario of this task, see “Configure Users and Permissions - Scenario” 
on page 382.

This task includes the following steps:

➤ “Prerequisites” on page 380

➤ “Create Groups” on page 381

➤ “Assign Permissions to Groups” on page 381

➤ “Create Users” on page 381

➤ “Configure User and Group Hierarchy” on page 381

➤ “Customize User Settings” on page 381

 1 Prerequisites
Before you configure the User Management portal, you should map out the 
required users and user groups and their relevant permission levels before 
defining them in HP Business Availability Center. For example, in a 
spreadsheet enter the following information:

➤ A list of users required to administer the system, as well as the end users who 
are to access Dashboard and reports. Gather appropriate user details such as 
user names, login names, initial passwords, and user time zones. Although 
not needed to define users, at this stage it might be useful to also collect user 
contact information such as telephone number, pager, or email address 
(contact information is required for HP Software-as-a-Service customers).

➤ If categorization of users into modes (operations and business) is required, 
specify into which user mode to categorize each user. For details, see “KPIs 
for User Modes” in Using Dashboard.

➤ If multiple users require similar system permissions, a list of user groups and 
the users that should belong to each group.
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➤ The permissions each user or user group requires. To aid in this process, 
review the Permissions Management page to learn about the different 
contexts and resources for which permissions can be granted. For details, see 
“Understanding Permissions Resources” on page 373.

 2 Create Groups
You create groups in the Groups/Users pane as follows: 

 a Click the Create New User/Group button in the Browse tab, after 
selecting an existing group or the root group.

 b Select Create Group and enter the group’s information in the Create 
Group dialog box. For details on the Create Group dialog box on the 
Groups/Users pane user interface, see “Create Group Dialog Box” on 
page 478.

 3 Assign Permissions to Groups
HP Business Availability Center enables you to apply permissions to groups 
and users for specific resources and instances of those resources that are 
defined in the system. For details on assigning permissions, see “Assign 
Permissions” on page 392.

 4 Create Users
You create users and then place them into the appropriate groups. For 
details on the user interface for creating users, see “Groups/Users Pane” on 
page 475.

 5 Configure User and Group Hierarchy
In the Hierarchy tab, you set user and group hierarchy by adding users to 
groups and nesting groups within other groups. For details on configuring 
user and group hierarchy, see “Configure Group and User Hierarchy” on 
page 394.

 6 Customize User Settings
In the Customization tab, you customize the menu items that are displayed 
in different contexts for users. For details on customizing menu items, see 
“Customize User Menus - Workflow” on page 396.
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Configure Users and Permissions - Scenario

This scenario describes how to configure users and user groups in the User 
Management portal. 

For a task of this scenario, see “Configure Users and Permissions - Workflow” 
on page 380.

This scenario includes the following steps:

➤ “Mapping Out Users and Groups” on page 382

➤ “Creating Groups” on page 383

➤ “Assigning Permissions to Groups” on page 384

➤ “Creating Users” on page 385

➤ “Configuring User and Group Hierarchy” on page 385

➤ “Customizing User Settings” on page 390

 1 Mapping Out Users and Groups
Jane Smith is the System Administrator at NewSoft Company, and wants to 
configure users and user groups to be authorized to use HP Business 
Availability Center, as well as end users who will be accessing Dashboard 
and reports. Before doing so, she requests the following preliminary 
information from relevant staff members:

➤ User names

➤ Login names

➤ Initial Passwords

➤ User Time Zones

➤ Contact Information (for example, telephone number, pager, email 
address)
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Note: Contact information is mandatory only for HP Software-as-a-Service 
customers.

With this information, she then decides to create one group of users with 
the permission level of System Modifiers, and another with the permission 
level of System Viewers. Furthermore, one of the users is to have an 
additional role of SiteScope Administrator. 

 2 Creating Groups
Jane creates groups to group users together, according to the level of 
permissions they are to be granted. She clicks the New Group/User button 
in the Groups/Users pane and creates the following groups:

➤ System Viewers

➤ System Modifiers

The Groups/Users pane appears as follows:
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 3 Assigning Permissions to Groups
Once the groups have been created, Jane assigns the relevant permission 
levels to the groups. After selecting System Modifiers in the Groups/Users 
pane, she navigates to the Permissions tab in the Information Pane, and 
chooses the Root instance (Business Availability Center) from any context. 
In the Predefined Roles tab, she selects System Modifier and then clicks 
Apply Permissions. She then selects System Viewers in the Groups/Users 
pane and chooses the System Viewer role in the Predefined Roles tab, 
clicking Apply Permissions to assign the role.

The results are displayed on the Permissions tab as follows:
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 4 Creating Users
Jane must now create users to nest within the groups, in accordance with 
the desired permission levels of the individual users. She clicks the New 
Group/User button in the Groups/Users pane and while on the Root group, 
(All), she selects Create User and configures settings for each new user. The 
Groups/Users pane appears as follows:

 5 Configuring User and Group Hierarchy
Now that Jane has created users authorized to access HP Business 
Availability Center, she assigns their permission level by nesting them 
within the appropriate group. 
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She selects the System Modifiers group from the Groups/Users pane to nest 
the appropriate users in this group. Jane then selects the Hierarchy tab from 
the Information Pane on the right side of the page. The hierarchy tab 
indicates that the System Modifiers group has no child groups, as follows:
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Jane clicks the Edit Child Groups and Users button to open the Edit Child 
Groups and Users dialog box:
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She then selects the relevant users from the Groups/Users pane and clicks 
the right arrow to move them to the Child Groups and Users pane. The 
Hierarchy tab indicates that these users are nested within the System 
Modifiers group, as follows:
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After following the same procedure to nest the relevant users in the System 
Viewers group, the Groups/Users pane is displayed as follows:
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Since Steve has the added permission level of SiteScope Administrator, Jane 
selects the username of the user in the Groups/Users pane whom she wants 
to give the added permission level of SiteScope Administrator, and in the 
Permissions tab, selects the System Availability Management context. After 
selecting a resource, she then selects SiteScope Administrator from the 
Predefined Roles tab, and clicks Apply Permissions. The resulting screen 
appears as follows:

 6 Customizing User Settings
Jane now sets the page each user sees when entering HP Business Availability 
Center, and the menu items available to them on pages throughout HP 
Business Availability Center. After selecting each user, she clicks the 
Customization tab and sets the following parameters: 

➤ The entry context that the user sees when logging into HP Business 
Availability Center. For example, Admin - End User Management.

➤ The page within the entry context that the user sees on the selected context. 
For example, Reports.
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➤ The pages and tabs that are to be visible on each HP Business Availability 
Center page by selecting or clearing the relevant check boxes. For example, 
the Views page and the Report Filters tab are cleared to ensure that they are 
not visible on the Admin - End User Management context when the user 
logs in.

The configured settings are displayed on the Customization tab as follows:
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The login page that the user sees according to their customized 
configurations is as follows:

Assign Permissions

This task describes how to configure group and user permissions in User 
Management. For the applied permissions to take effect, the user for whom 
permissions have been granted or removed must log out and log in again to 
HP Business Availability Center.

This task includes the following steps:

➤ “Prerequisites” on page 393

➤ “Select a Group or User” on page 393

➤ “Select a Context” on page 393

➤ “Assign a Role” on page 393

➤ “Assign Operations - Optional” on page 393

➤ “Configure Permissions Settings - Optional” on page 393
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 1 Prerequisites
Ensure that groups and users are configured in your system. For details on 
the user interface for creating groups, see “Groups/Users Pane” on page 475.

 2 Select a Group or User
Select a group or user from the Groups/Users pane on the left side of the 
page. 

 3 Select a Context
Select a context from the context list box above the resource tree in the 
center of the page. For details on the available contexts, see “Resource 
Contexts” on page 470.

 4 Assign a Role
Permissions are assigned using predefined roles. You assign a role for the 
selected group or user in the Predefined Roles tab on the right side of the 
page. For details on the available roles, see “User Management Roles” on 
page 403.

 5 Assign Operations - Optional
Optionally, you can assign individual operations in the Operations tab that 
the group or user can perform in HP Business Availability Center. For details 
on the available operations, see “User Management Operations” on 
page 426.

 6 Configure Permissions Settings - Optional
Optionally, click Settings at the bottom of the resource tree. The Apply 
Permissions Settings dialog box opens and you can configure the settings for 
the current session of applying permissions. For details, see “Resource Tree 
Pane” on page 469.
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Configure Group and User Hierarchy

This task describes how to configure user and group hierarchy. For details on 
the Hierarchy Tab user interface, see “Hierarchy Tab” on page 466.

This task includes the following steps:

➤ “Prerequisites” on page 394

➤ “View Group and User Hierarchy” on page 394

➤ “Nest Groups and Users” on page 394

➤ “Results” on page 395

 1 Prerequisites
Ensure that you have configured at least one group and one user in the 
Groups/Users pane. For details on the Groups/Users pane, see 
“Groups/Users Pane” on page 475.

 2 View Group and User Hierarchy
Select a group or user in the Groups/Users pane, and select the Hierarchy tab 
on the right side of the page to view the parent and child groups of the 
group or user, if applicable.

 3 Nest Groups and Users
You choose a group in the Groups/Users pane, and choose groups and users 
to nest beneath it.

 a Click a group or user in the Browse tab of the Groups/Users pane on the 
left side of the screen.

 b Click the Hierarchy tab on the right side of the screen.
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 c Select the group in the Groups/Users tab that you want to administer, 
and click the Edit Child Groups and Users button. The Edit Child Groups 
and Users window opens, and is displayed as follows:

 d Assign users and nest groups by selecting the user or group in the 
Groups/Users pane, and clicking on the left-to-right arrow to move the 
group or user to the Child Groups and Users pane.

Unassign users and remove nested groups by selecting the group or user 
in the Child Groups and Users pane, and clicking on the right-to-left 
arrow.

 4 Results
The nested groups and users appear in the Child Groups and Users pane in 
the Hierarchy tab.
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Example

Customize User Menus - Workflow

This task describes how to customize the page users see when entering 
HP Business Availability Center, and choose the menu items available on 
pages throughout HP Business Availability Center.

For a scenario of this task, see “Customize User Menus - Scenario” on 
page 398.

This task includes the following steps:

➤ “Prerequisites” on page 397

➤ “Select a User” on page 397

➤ “Assign a Default Context” on page 397
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➤ “Select Context Pages and Tabs” on page 397

➤ “Assign a Default Entry Page” on page 397

➤ “Results” on page 398

 1 Prerequisites
Ensure that you have configured at least one user in the Groups/Users pane. 
For details on the Groups/Users pane, see “Groups/Users Pane” on page 475.

 2 Select a User
Select a user from the Browse tab in the Groups/Users pane whose pages 
and menu items you want to customize, and select the Customization tab.

 3 Assign a Default Context
Select a context from the Contexts pane that you want to be the default 
entry context this user sees when logging into HP Business Availability 
Center, and click Set as Default Entry Context. For details on the Contexts 
pane, see “Customization Tab” on page 462.

 4 Select Context Pages and Tabs
In the Pages and Tabs pane, select the check boxes of the pages and tabs 
that you want to be visible on the selected context for the user. Clear the 
check boxes of the pages and tabs that you want hidden from the user. 

 5 Assign a Default Entry Page
Select a page or tab to be the default entry page for the selected context, and 
click Set as Default Entry Page. 
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 6 Results
The Default Entry icon appears next to the default entry context and page. 
Pages and tabs visible to the user are selected in the Pages and Tabs pane.

Example

Customize User Menus - Scenario

This scenario describes how to customize user menus for individual users.

For a task of this scenario, see “Customize User Menus - Workflow” on 
page 396.

This scenario includes the following steps:

➤ “Choosing a User” on page 399

➤ “Assigning a Default Context” on page 399

➤ “Selecting Context Pages and Tabs” on page 400

➤ “Results” on page 401
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 1 Choosing a User
The administrator of ABC Insurance Company is creating several users in 
the User Management section of HP Business Availability Center. She 
decides that the user John Smith should be able to view only certain pages 
and tabs in HP Business Availability Center, and that a specific page should 
appear on his screen when he logs into HP Business Availability Center.

 2 Assigning a Default Context
Since John’s chief responsibility at ABC is to monitor alerts, the 
administrator designates the Applications - Alerts page as their default entry 
context. She selects Applications-Alerts in the Contexts pane, and clicks Set 
as Default Entry Context. The Applications - Alerts context is indicated as 
the default entry context with the default entry icon, as appears in the 
following image:
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 3 Selecting Context Pages and Tabs
Since John is not authorized to view Event-Based Alert Reports, that option 
is cleared in the Pages and Tabs pane, leaving the remaining tabs, CI Status 
Alerts Report and SLA Alerts Report, checked to be visible when John logs 
into HP Business Availability Center. As Configuration Items Alerts are of 
the highest priority for ABC Insurance, the administrator designates this as 
the first page for John to see upon logging in. She selects CI Status Alerts 
Report in the Pages and Tabs pane, and then clicks Set as Default Entry 
Page. The CI Status Alerts Report is indicated as the default entry page with 
the default entry icon, as appears in the following image:
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 4 Results
The context that opens when John Smith logs into HP Business Availability 
Center is the Alerts context on the Applications menu. The CI Status Alerts 
Report page opens, and the SLA Alerts Report page is also available to him. 

The configured Customization tab in User Management appears as follows:
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The screen that John sees when logging into HP Business Availability Center 
is displayed as follows:

Reference
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User Management Roles

Details of the resources on which roles can be applied appear within the 
description of each role below. Some of the resources are applicable to 
HP Software-as-a-Service customers only and are noted accordingly.

This section describes the following roles: 

➤ “Superuser” on page 404

➤ “Administrator” on page 404

➤ “System Modifier” on page 407

➤ “System Viewer” on page 412

➤ “Business Process Profile Administrator” on page 414

➤ “Business Process Profile User” on page 415

➤ “SiteScope Administrator” on page 415

➤ “TransactionVision User” on page 416

➤ “TransactionVision Administrator” on page 416

➤ “CmdbOpenApiImpact” on page 416

➤ “TransactionVision Operator” on page 417

➤ “CmdbOpenApiUpdate” on page 417

➤ “CmdbOpenApiQuery” on page 417

➤ “CmdbOpenApiClassModel” on page 418

➤ “Customer Superuser” on page 418

➤ “Customer Administrator” on page 421

➤ “BPI User” on page 423

➤ “Problem Isolation User” on page 424

➤ “Problem Isolation Advanced User” on page 424

➤ “Problem Isolation Administrator” on page 425

➤ “BPI Administrator” on page 425
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Superuser
The Superuser role can be applied only to the Business Availability Center 
resource. 

This role includes all available operations on all the resources in all the 
contexts. Only a superuser can apply the Superuser role to another user. 

Important: The default superuser does not have permissions to write to 
Business Availability Center from the UCMDB WS API. Specific roles exist 
for that purpose. For details, see “CmdbOpenApiQuery” on page 417 and 
“CmdbOpenApiUpdate” on page 417.

Administrator
The Administrator role can be applied only to the Business Availability 
Center resource. 

An administrator has a collection of permissions that enable adding profiles 
to the system, and managing the resources related to those profiles. Once a 
profile is added, the administrator has full control privileges on all resources 
within that profile instance.

Note: In the TransactionVision context, the Administrator has access to the 
TVB UI Administration tab.

 

Context Resource Allowed Operations

Business 
Process Insight

Business Process Insight Application View

Business Process Insight 
Administration

Full Control

CMDB Views Full Control
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Central 
Repository 
Service

Root Folder and Sub Level Folders Full Control

My BSM Manage Modules page Full Control

Manage Portlet Definitions page Full Control

Monitors Containers Full Control

Filters Add

Diagnostics Full Control

Business Process Profile Add

Real User Monitor Add

Operations 
Orchestration 
Integration

Operations Orchestration 
Integration Administration

Full Control

Operations Orchestration 
Integration Execution

Full Control

Platform Audit Log Full Control

Custom Data Types Full Control

Database Full Control

Data Collectors Change

View

Recipients Full Control

Scheduled Reports Full Control

Users Full Control

User Groups Full Control

Context Resource Allowed Operations
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Problem 
Isolation

Problem Isolation application Full Control

Problem Isolation Adminstration Full Control

Isolation History Full Control

Problem Isolation On Demand 
Monitror

Full Control

Problem Isolation Revalidation 
Transaction

Full Control

Proactive Full Control

Production 
Analysis

Production Analysis Full Control

Service Level 
Management

SLAs Full Control

System 
Availability 
Management

SiteScopes Add

TransactionVisi
on

Projects Full Control

User-created reports Full Control

Analyzer Full Control

User Data Full Control

User Defined 
Reports

Custom Links Full Control

Custom Reports Full Control

Default Header/footer Full Control

Excel Reports Full Control

Trend Reports Full Control

Favorite Filter Full Control

Annotation Full Control

Service Report Full Control

Context Resource Allowed Operations



Chapter 18 • User Management

407

System Modifier
The System Modifier role can be applied only to the Business Availability 
Center resource.

A system modifier can view and change any and all of the resources within 
HP Business Availability Center. There are some resources on which the view 
or the change operation is not applicable. A system modifier has 
permissions for only those operations that are available in HP Business 
Availability Center. 

A system modifier does not have full control privileges on any resource and 
therefore, cannot grant or remove permissions for other users.

Context Resource Allowed Operations

Business 
Process Insight

Business Process Insight Application View

Business Process Insight 
Administration

Full Control

CMDB Views View

Change

Central 
Repository 
Service

Root Folder and Sub Level Folders View

Full Control

Monitors Alerts (Business Process) View

Change

Alerts - Create Dependency Change

Alerts - Log Event Change

Alerts - Run Executable File Change

Alerts - SNMP Change

Monitors (Business Process) View

Change

Containers Change
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Monitors Filters View

Change

Diagnostics View

Change

Business Process Profile View

Change

Real User Monitor Engines View

Change

Alerts (Real User Monitor) View

Change

End User (Real User Monitor) View

Change

Engine Settings (Real User Monitor) View

Change

Transactions (Real User Monitor) View

Change

Context Resource Allowed Operations
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Monitors SiteScope Preferences View

Change

Solution Sets Change

Notification Templates View

Change

Outlier Value (Business Process) Change

Transactions (Business Process) View

Change

Notification Templates View

Change

Customer Notification View

Change

Operations 
Orchestration 
Integration

Operations Orchestration 
Integration Administration

Change

View

Operations Orchestration 
Integration Execution

Execute

Context Resource Allowed Operations
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Platform Audit Log View

Databases Change

View

Data Collectors View

Change

Recipients View

Change

Sample Type Change

View

Scheduled Reports Change

View

Users Change

View

User Group Change

View

Problem 
Isolation

Problem Isolation application View

Problem Isolation Adminstration View

Isolation History Change

Problem Isolation On Demand 
Monitror

Execute

Problem Isolation Revalidation 
Transaction

Execute

Proactive Change

View

Service Level 
Management

SLAs Change

View

Context Resource Allowed Operations
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System 
Availability 
Management

SiteScopes Change

View

TransactionVisi
on

Projects Change

View

User-created reports View

Analyzer Execute

User Defined 
Reports

Custom Links View

Change

Custom Reports View

Change

Default Header/footer Change

Excel Reports View

Change

Trend Reports View

Change

Favorite Filter View

Change

Annotation View

Change

Service Report View

Change

Context Resource Allowed Operations
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System Viewer
The System Viewer role can be applied only to the Business Availability 
Center resource.

A system viewer can only view resources within HP Business Availability 
Center and has no permissions to change, add, or delete any resources or 
resource instances. There are some resources on which the view operation is 
not applicable. A system viewer has no access to those resources.

 

Context Resource Allowed Operations

Business 
Process Insight

Business Process Insight Application View

CMDB Views View

Monitors Alerts (Business Process) View

Monitors (Business Process) View

Filters View

Diagnostics View

Business Process Profile View

Real User Monitor Engines View

Alerts (Real User Monitor) View

End User (Real User Monitor) View

Engine Settings (Real User Monitor) View

Transaction View

Notification Templates View

Transactions (Business Process) View

Customer Notification Format View
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Platform Audit Log View

Database View

Data Collectors View

Recipients View

Sample Types View

Scheduled Reports View

Users View

User Group View

Operations 
Orchestration 
Integration

Administration View

Problem 
Isolation

Problem Isolation application View

Problem Isolation Adminstration View

Service Level 
Management

SLAs View

System 
Availability 
Management

SiteScopes View

TransactionVisi
on

Projects View

User-created reports View

User Defined 
Reports

Custom Links View

Custom Reports View

Excel Reports View

Trend Reports View

Context Resource Allowed Operations
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Business Process Profile Administrator
The Business Process Profile Administrator role can be applied to only the 
Business Process Profile resource or specific instances of the profile resource.

When granted this role at the resource collection level, the Business Process 
Profile administrator can manage all of the platform’s Business Process 
profiles, including permissions on all the profiles. When granted this role at 
the instance level, the administrator can manage only those resources 
associated with the specific Business Process Profile instance.

Any administrator who was added as a user on a specific Business Process 
profile in the previous version is upgraded to the Business Process profile 
administrator role for that profile. This is in addition to being assigned the 
administrator role as described above. For details on the Administrator role, 
see “Administrator” on page 404. 

 

Context Resource Allowed Operations

Monitors Business Process Profile Full Control

Monitor Full Control

Transaction Full Control

Alert Full Control

Scripts Repository Full Control

Package Work Manipulation Full Control
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Business Process Profile User
The Business Process Profile User role can be applied to only the Business 
Process Profile resource or specific instances of the profile resource.

These users have view permissions, but can modify transaction threshold 
settings and transaction descriptions. 

Any regular user who was added as a user on a specific Business Process 
Profile in the previous version is upgraded to the Business Process Profile 
User role for that profile. 

SiteScope Administrator
The SiteScope Administrator role can be applied to only the SiteScope 
resource or specific instances of the resource.

When granted this role at the resource collection level, the SiteScope 
administrator can manage all of the platform’s SiteScopes, including 
permissions on the SiteScopes. When granted this role at the instance level, 
the administrator can manage only those resources associated with the 
specific SiteScope instance.

Any administrator who was added as a user on a specific SiteScope in the 
previous version is upgraded to the SiteScope administrator role for that 
SiteScope.

Context Resource Allowed Operations

Monitors Business Process Profile View

Transaction Change

Context Resource Allowed Operations

System 
Availability 
Management

SiteScopes Full Control
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TransactionVision User
The TransactionVision User role can be applied only to the Projects resource 
in the TransactionVision context. 

TransactionVision Administrator
The TransactionVision Administrator role can be applied only to the 
Projects resource in the TransactionVision context. The TransactionVision 
Administrator role is useful in providing added security by enabling users to 
have Full Control access of TransactionVision administration, but not 
enabling access to the User Data resource.

Note: In the TransactionVision context, the TransactionVision 
Administrator has access to the TVB UI Administration tab.

CmdbOpenApiImpact
This role enables users to impact operations on the CMDB. 

Context Resource Allowed Operations

TransactionVisi
on

Projects View

User-created Reports View

Context Resource Allowed Operations

TransactionVisi
on

Projects Full Control

User-created Reports Full Control

Analyzer Full Control

Context Resource Allowed Operations

UCMDB WS 
API

Cmdb Open API View
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TransactionVision Operator
The TransactionVision Operator role can be applied only to the Projects 
resource in the TransactionVision context. 

CmdbOpenApiUpdate
The CmdbOpenApiUpdate role can be applied to only the Cmdb Open API 
resource.

This role enables users to update the CMDB (Configuration Management 
Database) for communication with third-party applications.

CmdbOpenApiQuery
The CmdbOpenApiQuery role can be applied to only the Cmdb Open API 
resource.

This role enables users to query the CMDB (Configuration Management 
Database) for communication with third-party applications.

Context Resource Allowed Operations

TransactionVisi
on

Projects View

User-created Reports View

Analyzer Execute

Context Resource Allowed Operations

UCMDB WS 
API

Cmdb Open API Change

Context Resource Allowed Operations

UCMDB WS 
API

Cmdb Open API View
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CmdbOpenApiClassModel
This role enables users to perform operations on CITs.

Customer Superuser

Note: This role can be applied to HP Software-as-a-Service customers only.

The Customer Superuser role can be applied only to the Active Customer 
resource instance. The Active Customer resource instance is available only to 
HP Software-as-a-Service customers and represents the customer level in the 
permissions resource tree. It is available in all contexts and applies to all 
contexts (like the Business Availability Center resource). The customer 
superuser is granted full control on all the resources and instances that 
belong to that customer. These include all resources, instances of those 
resources, and child resources under the customer resource.

 

Context Resource Allowed Operations

UCMDB WS 
API

Cmdb Open API View

Context Resource Allowed Operations

My BSM Manage Modules page Full Control

Manage Portlet Definitions page Full Control

CMDB Views Full Control



Chapter 18 • User Management

419

Monitors Alerts Full Control

Alert - Create Dependency Full Control

Notification Templates Full Control

Diagnostics View

Execute

Monitors (Business Process) Full Control

Containers Full Control

Filters Full Control

Template Full Control

Business Process Profile Full Control

Real User Monitor Engines Full Control

Alerts (Real User Monitor) Full Control

End User (Real User Monitor) Full Control

Engine Settings (Real User Monitor) Full Control

Transactions (Real User Monitor) Full Control

Outlier Value (Business Process) Full Control

Transactions (Business Process) Full Control

Context Resource Allowed Operations
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Platform Audit Log Full Control

Custom Data Types Full Control

Hosts Full Control

Package Information Full Control

Recipients Full Control

Scheduled Reports Full Control

Script Repository Full Control

System Tickets Full Control

Users Full Control

User Groups Full Control

Production 
Analysis

Production Analysis Full Control

Service Level 
Management

SLAs Full Control

System 
Availability 
Management

SiteScopes Full Control

UCMDB Open 
API

CMDB Open API Change

View

User Defined 
Reports

Custom Links Full Control

Custom Reports Full Control

Default Header/Footer Full Control

Excel Reports Full Control

Trend Reports Full Control

Favorite Filter Full Control

Annotation Full Control

Service Report Full Control

Context Resource Allowed Operations
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Customer Administrator

Note: This role can be applied to HP Software-as-a-Service customers only.

The Customer Administrator role can be applied only to the Active 
Customer resource instance. The Active Customer resource instance is 
available only to HP Software-as-a-Service customers and represents the 
customer level in the permissions resource tree. It is available in all contexts 
and applies to all contexts (like the Business Availability Center resource).

The Customer Administrator is granted full control on a selection of 
resources, as well as either view, execute, or both on other resources. This 
user can add profiles of any type, and has full control on the created profile. 
However, the user is not granted permissions for profiles that were created 
by other users, even if these profiles are for the same customer. In the case of 
the My BSM resources, any user with this role can make changes to resources 
defined by other users.

Context Resource Allowed Operations

CMDB Views Full Control

Production Analysis Full Control

System 
Availability 
Management

SiteScopes Add
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Monitors Alerts View

Alerts Create Dependency Full Control

Diagnostics View

Execute

Containers Full Control

Filters Add

Monitoring Filter (Views) Full Control

Business Process Profile Add

RUM Add

Customer Notification Format Full Control

Platform Audit Log Full Control

Customer Data Types Full Control

User Groups Full Control

Users Full Control

Package Information Full Control

Recipients Full Control

Scheduled Reports Full Control

Script Repository Full Control

System Tickets Full Control

Service Level 
Management

SLAs Full Control

Context Resource Allowed Operations
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BPI User
The BPI User role can be applied only to the Business Process Insight 
resource.

User Defined 
Reports

Custom Links Full Control

Custom Reports Full Control

Default Header/Footer Full Control

Excel Reports Full Control

Trend Reports Full Control

Favorite Filter Full Control

Annotation Full Control

Service Report Full Control

My BSM Manage Modules page Full Control

Manage Portlet Definitions page Full Control

Context Resource Allowed Operations

Business 
Process Insight

Business Process Insight Application View

Problem List Change

Problem Isolation Administration View

OnDemand Monitors Execute

Revalidation Transactions Execute

Proactive View

Operations 
Orchestration 
Integration

Administration View

Execution Execute

Context Resource Allowed Operations
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Problem Isolation User
The Problem Isolation User role can be applied only to the Problem 
Isolation Application resource.

A Problem Isolation user can only view resources within the Problem 
Isolation application, and has no permissions to change, add, or delete any 
resources or resource instances. There are some resources on which the view 
operation is not applicable. A Problem Isolation user has no access to those 
resources.

Problem Isolation Advanced User
The Problem Isolation Advanced User role can be applied only to the 
Problem Isolation Application resource.

A Problem Isolation advanced user can view and run on demand monitors 
and revalidate problems, as well as view, change, add, or delete entries in the 
problem list.

Context Resource Allowed Operations

Problem 
Isolation

Problem Isolation Application View

Problem Isolation Administration View

Context Resource Allowed Operations

Problem 
Isolation

Problem Isolation Application View

Add

Change

Delete
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Problem Isolation Administrator
The Problem Isolation Administrator role can be applied only to the 
Problem Isolation Application resource.

A Problem Isolation administrator has full permissions on all areas of 
Problem Isolation, and has full control over all resources and resource 
instances.

BPI Administrator
The BPI Administrator role can be applied only to the Business Process 
Insight resource.

Context Resource Allowed Operations

Problem 
Isolation

Problem Isolation Application View

Add

Change

Delete

Execute

Full Control

Context Resource Allowed Operations

Business 
Process Insight

Business Process Insight 
Administrator

Full Control

Business Process Insight Application Full Control

Problem List Full Control

OnDemand Monitors Full Control

Revalidation Transactions Full Control

Proactive Full Control

Operations 
Orchestration 
Integration

Administration Full Control

Execution Full Control
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User Management Operations

Within each context listed below is a table listing:

➤ every resource

➤ which operations can be applied to that resource

➤ a description of what the operation enables

This section describes the following HP Business Availability Center 
contexts, and the operations that can be applied to them: 

➤ “Business Process Insight” on page 427

➤ “CMDB” on page 427

➤ “Central Repository Service” on page 429

➤ “Monitors” on page 429

➤ “My BSM” on page 440

➤ “HP Operations Manager i” on page 441

➤ “Operations Orchestration Integration” on page 442

➤ “Platform” on page 443

➤ “Problem Isolation” on page 449

➤ “Production Analysis” on page 450

➤ “Service Level Management” on page 451

➤ “System Availability Management Administration (SAM Admin)” on 
page 452

➤ “TransactionVision” on page 456

➤ “UCMDB WS API” on page 458

➤ “User Defined Reports” on page 459
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Business Process Insight
Use the Business Process Insight context to assign permissions to the 
Business Process Insight instance configured within the system. 

CMDB 
The CMDB context enables you to define the operations permitted for the 
views defined in IT Universe Administration and viewed in the View 
Explorer, Dashboard, and Service Level Management.

Tip: If a user has permissions on a view in CMDB, all the profiles that are in 
that view are visible to the user, even if the user does not have permissions 
on the profile. To prevent a user from viewing profiles for which the user 
does not have permissions while enabling the user to access a view, create a 
view for the user including only those configuration items for which you 
want the user to have permissions and grant the user permission on that 
view.

Resources Operation Description

Business Process 
Insight Application

View Enables entering the Business 
Process Insight application.

Business Process 
Insight 
Administration

Full Control Enables performing all available 
operations on Business Process 
Insight administration, and granting 
and removing permissions for other 
users. 
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Resources Operation Description

Views Add Enables adding views in the View 
Manager, and creating Enrichments, 
Correlations, Queries, and Reports in 
UCMDB.

Change Enables adding a configuration item 
or relationship to a view, editing the 
view in the View Manager, and if 
user is the creator of the view, 
removing configuration items or 
relationships from the view. Enables 
modifying of Enrichments, 
Correlations, Queries, and Reports in 
UCMDB.

View Enables viewing the configured 
views in read-only mode, and 
viewing of Enrichments, 
Correlations, Queries, and Reports in 
UCMDB.

Delete Enables deleting views from the 
View Manager and deleting of 
Enrichments, Correlations, Queries, 
and Reports in UCMDB.

Full Control Enables performing all available 
operations on the views in the view 
Manager and IT Universe Admin, 
viewing all views in the applications, 
and granting and removing 
permissions for those operations. 
Also enables performing of all 
available options for Enrichments, 
Correlations, Queries, and Reports in 
UCMDB, and the granting of 
permissions to other UCMDB users.
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Central Repository Service 
The Central Repository Service context enables you to define the operations 
permitted for the folders under the Root folder. Operations assigned to a 
folder affect all folders contained beneath it.

Monitors
The Monitors context includes all those resources that relate to data 
collection and monitoring. These resources can be found in Platform 
Administration and End User Management Administration.

The profile resources (Business Process and SiteScope) determine the 
permissions level of the user in all areas of the platform where you must 
select a profile to access the page or perform the action. These include most 
areas of End User Management Administration, Alert Management, 
Downtime/Event Scheduling, Transaction Ordering, Transaction Coloring, 
and various Reports.

CMDB Full Control Enables performing all available 
operations on the CMDB, and 
granting and removing permissions 
to access the CMDB. 

Resources Operation Description

Central Repository 
Service

View Enables downloading scripts and 
reports into the Central Repository 
Service.

Full Control Enables performing all available 
operations on the folders in the 
Central Scripts Repository: view, 
edit, and delete any script or 
subfolder in the folder.

Resources Operation Description
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Some of the resources listed appear only when instances of the parent 
resource have been defined in the platform. For example, the Monitors and 
Transactions resources appear only as child objects of an instance of a 
Business Process Profile.

Resources Operation Description

Alerts - Send SNMP 
Trap

Change Enables selecting the option to send 
SNMP traps on alert, editing SNMP 
trap addresses, and clearing the 
option to send SNMP traps on alert.

Full Control Enables performing all available 
operations on sending SNMP traps 
on alerts, and granting and removing 
permissions for those operations.

Alerts - Run 
Executable File

Change Enables selecting the option to run 
an executable file on alert, selecting 
and editing executable files to run on 
alert, and clearing the option to run 
an executable file on alert.

Full Control Enables performing all available 
operations on running an executable 
file on alert, and granting and 
removing permissions for those 
operations.

Alerts - Log to Event 
Viewer

Change Enables selecting whether alerts 
should be logged in the Windows 
Event Viewer, which is accessed from 
Windows Administrative Tools.

Full Control Enables selecting whether alerts 
should be logged in the Windows 
Event Viewer, and granting and 
removing permissions on that 
operation. 
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Alerts - Create 
Dependencies

Change Enables creating and removing 
dependencies between alerts.

Full Control Enables creating and removing alert 
dependencies, and granting and 
removing permissions for those 
operations.

Business Process 
Profiles

Add Enables creating Business Process 
profiles.

Change Enables renaming Business Process 
profiles and modifying profile 
properties.

View Enables viewing the Business Process 
profile details in End User 
Management Administration, and 
the Business Process profile in any 
application that lists the profiles, 
such as Alert Management, Service 
Level Management, Downtime/Event 
Scheduling, Analytics, and reports. 

Delete Enables deleting Business Process 
profiles.

Execute Enables running and stopping 
Business Process profiles.

Full Control Enables performing all available 
operations on Business Process 
profiles, and granting and removing 
permissions for those operations.

Resources Operation Description
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Monitors (under 
Business Process 
Profile instance)

Add Enables adding transaction monitors, 
WebTrace monitors, and single URL 
monitors (HP Software-as-a-Service 
only) to Business Process profiles.

Change Enables editing transaction monitor, 
WebTrace monitor, and single URL 
monitor (HP Software-as-a-Service 
only) properties.

View Enables viewing transaction monitor, 
WebTrace monitor, and single URL 
monitor (HP Software-as-a-Service 
only) properties.

Delete Enables deleting transaction 
monitors, WebTrace monitors, and 
single URL monitors (HP Software-as-
a-Service only) from the profile.

Full Control Enables performing all available 
operations on transaction monitors, 
WebTrace monitors, and single URL 
monitors (HP Software-as-a-Service 
only), and granting and removing 
permissions for those operations.

Transactions (under 
Business Process 
Profile)

Change Enables editing transaction 
descriptions and threshold settings.

View Enables viewing transaction details.

Full Control Enables performing all available 
operations on transactions, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Outlier Value (under 
Business Process 
Profile > Transaction 
instance)

Change Enables setting a transaction's outlier 
value. 

Full Control Enables setting the transaction's 
outlier value, and granting and 
removing permissions for that 
operation. 

Alerts (under 
Business Process 
Profile instance)

Add Enables adding alerts to the Business 
Process profile. 

Change Enables editing details of alerts 
associated with the Business Process 
profile.

View Enables viewing alerts in the Business 
Process profile and viewing alert 
details in Alerts Management.

Delete Enables deleting alerts associated 
with the Business Process profile.

Full Control Enables performing all available 
operations on the alerts in the 
Business Process profile, and granting 
and removing permissions for those 
operations.

Resources Operation Description
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Diagnostics Change Enables viewing Diagnostics 
administration and configuring the 
Diagnostics settings.

View Enables viewing the Diagnostics 
application when accessing 
Diagnostics from the Business 
Application Center.

Execute Enables changing the settings in the 
HP Diagnostics UI, such as setting 
thresholds.

Full Control Enables performing all operations on 
Diagnostics, and granting and 
removing permissions for those 
operations.

Real User Monitor 
Engines

Add Enables adding Real User Monitor 
engines to End User Management 
Administration.

Change Enables editing Real User Monitor 
engine details.

View Enables viewing Real User Monitor 
engine details. 

Delete Enables removing Real User Monitor 
engines from End User Management 
Administration.

Full Control Enables performing all available 
operations on Real User Monitor 
engines, and granting and removing 
permissions for those operations.

Resources Operation Description
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Engine Settings 
(under Real User 
Monitor Engine 
instance)

Change Enables editing the Real User 
Monitor preferences details.

View Enables viewing the preferences of a 
Real User Monitor engine.

Full Control Enables performing all available 
operations on Real User Monitor 
engines, and granting and removing 
permissions for those operations.

Domains (under Real 
User Monitor Engine 
instance)

Add Enables adding a domain to the the 
Real User Monitor engine.

Change Enables editing the Real User 
Monitor properties.

View Enables viewing a Real User Monitor 
domain. 

Delete Enables deleting a domain from a 
Real User Monitor Engine.

Full Control Enables performing all available 
operations on Real User Monitor 
domains, and granting and removing 
permissions for those operations.

Resources Operation Description
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RUM Applications 
(under Real User 
Monitor Engine 
instance)

Add Enables adding applications to a Real 
User Monitor engine, and pages and 
transactions to an application.

Change Enables editing the Real User 
Monitor application, page, and 
transaction details.

View Enables viewing the Real User 
Monitor application, page, and 
transaction.

Delete Enables deleting an application from 
a Real User Monitor engine.

Full Control Enables performing all available 
operations on a Real User Monitor 
application, page, and transaction, 
and granting and removing 
permissions for those operations.

Alerts (under Real 
User Monitor Engine 
instance)

Add Enables adding alerts to a Real User 
Monitor engine. 

Change Enables editing Real User Monitor 
alert properties.

View Enables viewing the properties of a 
Real User Monitor alert. 

Delete Enables deleting an alert from a Real 
User Monitor engine.

Full Control Enables performing all available 
operations on Real User Monitor 
alerts, and granting and removing 
permissions for those operations.

Resources Operation Description
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SiteScope Add Enables adding SiteScopes and 
SiteScope profiles to Monitor 
Administration.

Change Enables modifying SiteScope and 
SiteScope profile properties and 
attaching a SiteScope to, or detaching 
it from, Monitor Administration.

View Enables viewing SiteScope or 
SiteScope profile properties.

Delete Enables deleting a SiteScope profile 
from Monitor Administration.

Full Control Enables performing all available 
operations on SiteScopes and 
SiteScope profiles, and granting and 
removing permissions for those 
operations.

Template Containers Add Enables adding a container for 
templates to the Monitor 
Administration enterprise.

Change Enables modifying template 
container properties.

View Enables viewing template container 
properties in Monitor 
Administration.

Delete Enables deleting a template container 
from the Monitor Administration 
enterprise.

Full Control Enables all available operations on 
template containers, and granting 
and removing permissions for those 
operations.

Resources Operation Description
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Solution Sets Change Enables editing the Solution Set 
container, and adding, editing, and 
deleting Solution Set template 
objects.

Full Control Enables all operations on Solution 
Sets, and granting and removing 
permissions for those operations.

Views Add Enables creating view setting filters 
in Monitor Administration.

Change Enables editing view setting filters in 
Monitor Administration.

View Enables viewing view setting filter 
definitions in Monitor 
Administration.

Delete Enables deleting view filters from 
End User Management 
Administration.

Full Control Enables performing all available 
operations on view filters, and 
granting and removing permissions 
for those operations.

Categories Add Enables creating a category in 
Monitor Administration.

Change Enables editing Monitor 
Administration category definitions.

Delete Enables deleting categories from 
Monitor Administration. 

Full Control Enables performing all available 
operations on Monitor 
Administration categories, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Containers Add Enables adding a container to the 
Monitor Administration enterprise.

Change Enables renaming and modifying the 
properties of a container. 

Delete Enables deleting a container from 
Monitor Administration. 

Full Control Enables performing all available 
operations on an Monitor 
Administration container, and 
granting and removing permissions 
for those operations.

Solution Sets Change Enables editing the Solution Set 
container, and adding, editing, and 
deleting Solution Set template 
objects.

Full Control Enables all operations on Solution 
Sets, and granting and removing 
permissions for those operations.

Notification 
Templates
(HP Software-as-a-
Service only)

Add Enables creating and cloning a 
customer-specific notification 
template. 

Change Enables editing the properties of a 
customer-specific notification 
template. 

View Enables viewing the properties of a 
customer-specific notification 
template. 

Delete Enables deleting a customer-specific 
notification template. 

Full Control Enables performing all available 
operations on a customer-specific 
notification template, and granting 
and removing permissions for those 
operations.

Resources Operation Description
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My BSM 
The My BSM context enables you to assign permissions to work with the 
module and portlet definition pages in My BSM Administration.

Notification 
Templates

Add Enables creating and cloning 
notification templates.

Change Enables editing notification template 
properties.

View Enables viewing notification 
template properties.

Delete Enables deleting a notification 
template.

Full Control Enables performing all available 
operations on notification templates, 
and granting and removing 
permissions for those operations.

Resources Operation Description

Modules Full Control Enables creating, editing, deleting, 
and performing all operations on the 
Manage Modules page.

Portlet definitions Full Control Enables creating, editing, deleting, 
and performing all operations on the 
Manage Portlet Definitions page.

Resources Operation Description
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HP Operations Manager i

Note: The HP Operations Manager i (OMi) context is available only if you 
have installed OMi on your HP Business Availability Center machine. For 
details on the OMi context, see "User Context Pane" in Using HP Operations 
Manager i.

The HP Operations Manager i (OMi) context enables you to assign 
permissions to work with the Operations Manager context. For details on 
the operations available for the HP Operations Manager i (OMi) context, see 
"User Operations Tab" in Using HP Operations Manager i.
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Operations Orchestration Integration

Resources Operation Description

Administration Add Enables adding a run book.

View Enables viewing run book 
administration.

Change Enables editing run book 
administration.

Delete Enables deleting a run book.

Full Control Enables performing all available 
operations on run book 
adminstration, and granting or 
removing permissions for other 
users. 

Execution Execute Enables run book execution.

Full Control Enables performing all available 
operations on run book execution, 
and granting or removing  
permissions for other users.
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Platform
The Platform context includes all the resources related to administering the 
platform. Some of the resources listed are available for HP Software-as-a-
Service customers only, and are marked accordingly. 

 

Resources Operation Description

Authentication 
Strategy

Change Enables the Configure button on the 
Authentication Strategy page, which 
enables changing configurations on 
the Authentication Strategy Wizard.

View Enables viewing the Authentication 
Strategy Wizard.

Full Control Enables performing all available 
operations on the Authentication 
Strategy Wizard. 

Audit Log View Enables viewing the audit log.

Full Control Enables viewing the audit log, and 
granting and removing permission 
to view the audit log.

Users Add Enables adding users to the system.

Change Enables modifying user details.

View Enables viewing user details.

Delete Enables deleting users from the 
system.

Full Control Enables performing all available 
operations on users, and granting 
and removing permissions for those 
operations.
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User Groups Add Enables adding user groups to the 
system.

Change Enables modifying user group 
details.

View Enables viewing user group details.

Delete Enables deleting user groups.

Full Control Enables performing all available 
operations on user groups, and 
granting and removing permissions 
for those operations.

Data Collectors Change Enables performing remote 
upgrades, remote uninstalls, and 
settings updates on data collectors in 
Data Collector Maintenance.

View Enables viewing the data collectors 
in Data Collector Maintenance.

Delete Enables removing data collector 
instances.

Full Control Enables performing all available 
operations in Data Collector 
Maintenance, and granting and 
removing permissions for those 
operations.

Resources Operation Description
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Notification System Change Enables modifying system ticket 
details.

View Enables viewing system tickets 
details.

Delete Enables deleting system ticket 
details.

Add Enables adding system tickets to the 
system.

Execute Enables executing system tickets in 
the system.

Full Control Enables performing all available 
operations on System Tickets, and 
granting and removing permissions 
for those operations.

Scheduled Reports Add Enables creating new scheduled 
reports.

Change Enables modifying scheduled 
reports.

View Enables viewing scheduled reports.

Delete Enables deleting scheduled reports.

Full Control Enables performing all available 
operations on scheduled reports, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Recipients Add Enables adding recipients to the 
platform.

Change Enables editing recipient details.

View Enables viewing recipients and 
recipient details.

Delete Enables deleting recipients from the 
platform.

Full Control Enables performing all available 
operations on recipients, and 
granting and removing permissions 
for those operations.

Custom Data Types Add Enables adding custom data types to 
the system.

Change Enables modifying custom data 
types in the system.

View Enables viewing custom data types 
in the system.

Delete Enables deleting custom data types 
in the system.

Full Control Enables performing all available 
operations on sample types, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Databases Add Enables adding profile databases to 
the system.

Change Enables modifying profile database 
details in database management.

View Enables viewing profile database 
management details.

Delete Enables deleting profile databases 
from the system.

Full Control Enables performing all available 
operations on profile databases in 
database management, working with 
the purging manager, and granting 
and removing permissions for those 
operations.

Script Repository 
(HP Software-as-a-
Service only)

Add Enables uploading new scripts to the 
script repository.

View Enables viewing scripts in the script 
repository.

Remove Enables deleting a script from the 
script repository.

Execute Enables subscribing to script 
verification and verifying scripts for 
private POP only.

Full Control Enables performing all available 
operations on scripts in the script 
repository, and granting and 
removing permissions for those 
operations.

Resources Operation Description
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Package Work 
Manipulation
(HP Software-as-a-
Service only)

Change Enables modifying package 
locations, renaming packages, and 
selecting recipients for package 
notifications.

View Enables viewing package 
information.

Delete Enables removing packages from a 
location.

Full Control Enables performing all available 
operations on package information, 
and granting and removing 
permissions for those operations.

System Tickets

(HP Software-as-a-
Service only)

View Enables viewing system ticket 
details.

Execute Enables registering system 
notifications.

Full Control Enables performing all available 
operations on system tickets, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Problem Isolation
Use the Problem Isolation context to assign permissions for accessing the 
Problem Isolation application. Problem Isolation enables you to isolate and 
manage enterprise problems discovered in HP Business Availability Center, 
and to identify likely suspects, to help find the root cause of a problem.

Resources Operation Description

Problem Isolation 
Application

View Enables entering the Problem 
Isolation application.

Full Control Enables performing all available 
operations on the Problem Isolation 
application, and granting or 
removing permissions for other users

Problem Isolation 
Administration

Change Enables editing Problem Isolation 
administration.

View Enables viewing of Problem Isolation 
administration.

Full Control Enables performing all available 
operations for Problem Isolation 
administration, and granting and 
removing permissions for other 
users.

Isolation History Change Enables editing an existing Isolation 
History item, adding a root cause, 
and attaching or detaching service 
center entities. 

Execute Enables triaging an existing Isolation 
History item.

Full Control Enables performing all available 
operations on the Isolation History 
and grant or remove permissions for 
other users.
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Production Analysis
Use the Production Analysis context to assign permissions to access the 
Production Analysis reports generating from the Application Performance 
Lifecycle application. These reports enable users to extract real-user 
transaction data to be used in Performance Center load tests and to create 
Virtual User Generator (VuGen) script templates, based on real-user activity.

Problem Isolation 
On Demand Manual 
Run

Execute Enables manually running On-
demand Monitors to check the 
status of Suspect Configuration 
Items.

Full Control Enables performing all available 
operations on On Demand 
monitors, and granting or removing 
permissions for other users. 

Problem Isolation 
Revalidation 
Transactions 
Manual Run

Execute Enables manually running 
revalidation transactions.

Full Control Enables performing all available 
operations on revalidation 
transactions and grant or remove 
permissions for other users.

Proactive Execute Enables performing all available 
operations on the Proactive resource.

Resources Operation Description

Production Analysis Full Control Enables accessing and downloading 
Production Analysis reports 
generated by Application 
Performance Lifecycle.

Resources Operation Description
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Service Level Management
Use the Service Level Management context to assign permissions to all SLAs 
or specific instances. 

Resources Operation Description

SLAs Add Enables adding SLAs.

Change Enables renaming SLAs, adding 
descriptions to SLAs, viewing SLA 
configuration in administration 
pages, and changing SLA 
configurations.

View Enables generating and viewing 
reports and custom reports on SLAs.

Delete Enables deleting SLAs. 

Full Control Enables performing all available 
operations on SLAs, and granting 
and removing permissions for those 
operations.
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System Availability Management Administration (SAM 
Admin)
Use the SAM Admin context to assign permissions to the various SiteScopes 
configured within the system. 

Note: The permission levels granted via the System Availability 
Management Administration (SAM Admin) context override any permission 
levels granted in the SiteScope standalone interface. 
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Resources Operation Description

SiteScopes Add Enables adding SiteScope profiles to 
System Availability Management.

Change Enables modifying a SiteScope 
profile in System Availability 
Management and enables adding the 
contents to the SiteScope root node 
(group, alert, report) and modifying 
contents to the SiteScope root node 
(alert, report), if the user has 
permissions for these resources.

View Enables viewing SiteScope profiles in 
System Availability Management.

Delete Enables deleting a SiteScope profile 
from System Availability 
Management and enables deleting 
the contents of the SiteScope root 
node (alert, report), if the user has 
permissions for these resources.

Execute Enables executing contents of the 
SiteScope root node (alert, report), if 
the user has permissions for these 
resources.

Full Control Enables performing all available 
operations on SiteScope profile and 
SiteScope root node.
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<SiteScope Groups>

Note: Groups are 
listed individually, 
as you can configure 
different permission 
levels for each 
group.

Change Enables modifying and adding a 
SiteScope group and enables 
modifying and adding the contents 
of the group (monitor, alert, report), 
if the user has permissions for these 
resources.

View Enables viewing the SiteScope group 
and reports contained within that 
group, and creating SiteScope Over 
Time reports.

Delete Enables deleting a SiteScope group 
and enables deleting the contents of 
the group (monitor, alert, report), if 
the user has permissions for these 
resources.

Execute Enables executing SiteScope 
monitors, generating SiteScope and 
HP Business Availability Center 
reports, and testing alerts contained 
within the group.

Full Control Enables performing all available 
operations on the SiteScope group 
and all the objects contained within 
the group (monitor, alert, report), if 
the user has permissions for these 
resources.

SiteScope Monitors Change Enables modifying, adding, deleting, 
disabling or enabling SiteScope 
monitors.

Execute Enables executing SiteScope 
monitors, acknowledging SiteScope 
monitors from the Dashboard, and 
using monitor tools.

Full Control Enables performing all available 
operations on SiteScope monitors.

Resources Operation Description
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SiteScope Alerts Change Enables modifying, adding, deleting 
and disabling SiteScope alerts.

Execute Enables creating Adhoc alert reports 
and test SiteScope alerts.

Full Control Enables performing all available 
operations on SiteScope alerts.

SiteScope 
Preferences

Change Enables modifying and viewing any 
of the Preference objects.

Execute Enables executing tests of SiteScope 
preferences.

Full Control Enables performing all available 
operations on SiteScope preferences.

SiteScope Reports Change Enables modifying, adding, deleting, 
disabling, and enabling SiteScope 
reports.

Full Control Enables performing all available 
operations on SiteScope reports.

SiteScope Views Change Enables modifying, adding, and 
deleting SiteScope views.

View Enables viewing predefined and 
user-defined SiteScope views.

Full Control Enables performing all available 
operations on SiteScope views.

SiteScope Categories Change Enables modifying, adding, and 
deleting SiteScope categories.

View Enables viewing SiteScope categories.

Full Control Enables performing all available 
operations on SiteScope categories.

Resources Operation Description
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TransactionVision
Use the TransactionVision context to assign permissions to the various 
TransactionVision instances configured within the system.

Projects and User-created reports are containers that are dynamically 
populated, based on which projects and user created reports are available in 
TransactionVision. Project child resource instances are added and deleted 
from the Resource Tree pane in the User Management interface, as new 
projects are created and deleted using the project wizard.

SiteScope Templates Change Enables modifying, adding, and 
deleting SiteScope templates.

View Enables viewing SiteScope templates 
and copying templates for 
deployment.

Full Control Enables performing all available 
operations on SiteScope templates.

SiteScope Other 
Options

View Enables viewing SiteScope Progress 
and Logs.

Execute Enables using SiteScope Tools, 
Browse and Summary.

SiteScope Users Change Enables modifying, adding, and 
deleting user preferences for all other 
SiteScope users, except the SiteScope 
administrator user.

SiteScope 
Dashboard

Change Enables modifying Dashboard 
favorites.

Resources Operation Description
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User-created reports child resource instances are added and deleted from the 
Resource Tree pane whenever the following file is updated with custom 
report definitions: <TVISION_HOME>/config/ui/Reports.xml.  The Report 
element's title attribute is then displayed in the Resource Tree pane.

Resources Operation Description

Projects Change Enables creating, editing, and 
deleting projects, as well as starting 
and stopping jobs on a project.

View Enables viewing projects. The user 
can also access all built-in reports, as 
well as view and modify queries.

Full Control Enables performing all available 
operations on projects, and granting 
and removing permissions for those 
operations.

User-created Reports View Enables viewing user-created reports.

Full Control Enables performing all available 
operations on user-created reports, 
and granting and removing 
permissions for those operations.

Analyzer Execute Enables starting and stopping the 
analyzer.

Full Control Enables performing all available 
operations on the analyzer, and 
granting and removing permissions 
for those operations.

User Data View Enables viewing user data in reports 
and in event details.

Full Control Enables performing all available 
operations on user data, and 
granting and removing permissions 
for those operations.
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UCMDB WS API
The UCMDB WS API context includes the resource Cmdb Open API.

You can give a user permissions so that they can query or update the CMDB 
using the CMDB API. This enables the user to write API methods to add, 
remove, and update CIs.

Resources Operation Description

Cmdb Open API Change Enables running of updates in the 
cmdb open API.

View Enables running queries in the cmdb 
open API.
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User Defined Reports
Use the User Defined Reports context to assign permissions to the various 
types of user-defined reports and related settings.

Resources Operation Description

Custom Reports Change Enables creating, editing, and 
deleting custom reports.

View Enables viewing custom reports.

Full Control Enables performing all available 
operations on custom reports, and 
granting and removing permissions 
for those operations.

Trend Reports Change Enables creating, editing, and 
deleting trend reports.

View Enables viewing trend reports.

Full Control Enables performing all available 
operations on trend reports, and 
granting and removing permissions 
for those operations.

Custom Links Change Enables creating and deleting 
custom links.

View Enables viewing custom links.

Full Control Enables performing all available 
operations on custom links, and 
granting and removing permissions 
for those operations.
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Excel Reports Change Enables adding, deleting, and 
updating Excel open API reports.

View Enables viewing Excel open API 
reports.

Full Control Enables performing all available 
operations on Excel open API 
reports, and granting and removing 
permissions for those operations.

Default 
Header/Footer

Change Enables modifying the default 
header and footer for custom and 
trend reports.

Full Control Enables modifying, and granting 
and removing permissions to 
modify, the default header and 
footer for custom and trend reports.

Favorite Filter Remove Enables deleting a Favorite Filter.

Change Enables editing a Favorite Filter.

Full Control Enables performing all available 
operations on Favorite Filters, and 
granting and removing permissions 
for those operations.

Annotation Remove Enables deleting an Annotation.

Change Enables editing an Annotation.

Full Control Enables performing all available 
operations on Annotations, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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Service Report Remove Enables deleting a Service Report.

Change Enables editing a Service Report.

Full Control Enables performing all available 
operations on Service Reports, and 
granting and removing permissions 
for those operations.

Resources Operation Description
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User Management User Interface

This section describes:

 ➤  Customization Tab on page 462

 ➤  General Tab on page 464

 ➤  Hierarchy Tab on page 466

 ➤  Permissions Tab on page 468

 ➤  User Management Main Page on page 474

Customization Tab

Description Enables you to select the page users see when entering 
HP Business Availability Center, and choose the menu 
items available on pages throughout HP Business 
Availability Center. 

To access: Select Admin > Platform > Users and 
Permissions, select a user from the Groups/Users pane, 
and click the Customization tab.

Important 
Information

The Customization tab is displayed only when a user has 
been selected in the Groups/Users pane on the left side 
of the page. 

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

“Customize User Menus - Workflow” on page 396

Useful Links “Customizing User Menus” on page 379
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The following elements are included:

GUI Element (A–Z) Description

Contexts Select an HP Business Availability Center context. You 
can perform the following actions on the context:

➤ Select pages and tabs in the Pages and Tabs pane to be 
visible for the specified user. 

➤ Click the Set as Default Entry Context button to make 
it the context that is displayed when the user logs into 
HP Business Availability Center. 

For details on HP Business Availability Center contexts, 
see “Resource Contexts” on page 470.

Pages and Tabs ➤ Select the pages and tabs you want to be visible for the 
HP Business Availability Center context selected in the 
Contexts pane. 

➤ Assign a page or tab as the default page that opens for 
the context selected in the Contexts pane.

Set as Default Entry 
Context

Click to set the selected context in the Contexts pane as 
the entry context that is displayed when the specified 
user logs into HP Business Availability Center.

Note: The Default Entry Context icon  appears next 
to the specified context.

Set as Default Entry 
Page

Click to assign the specified page or tab as the default 
page that opens for the context selected in the Contexts 
pane. 

Note: The Default Entry Page icon  appears next to 
the specified page or tab. 
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General Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the parameters of the selected user or group. 

To access: Select Admin > Platform > Users and 
Permissions > General tab.

Important 
Information

➤ You can edit the user or group’s parameters by editing 
the relevant fields on the General tab. 

➤ The Group Name and Group Description fields appear 
only when a group is selected in the Groups/Users 
pane. All other fields appear only when a user is 
selected in the Groups/Users pane.

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

Useful Links “User Management – Overview” on page 370

“Groups/Users Pane” on page 475

“Information Pane” on page 481

GUI Element (A-Z) Description

Confirm password Re-enter the edited password that you entered in the 
Password field. 

email The email address of the user. 

Note: This field is displayed for HP Software-as-a-Service 
customers only.

Group description The description of the group, as configured on the Create 
Group dialog box. 

Note: This field is optional. 

Group name The name of the group, as configured on the Create 
Group dialog box. 



Chapter 18 • User Management

465

Login name The name that the user logs into HP Business Availability 
Center with. 

Note: The Login name cannot be changed. 

Password The password of the selected user. 

Note: As a security precaution, this field appears blank on 
the General tab. To change the password, enter the new 
password and re-enter it in the Confirm Password field. 

Time zone The time zone configured on the Create User dialog box, 
according to the user’s location.

User mode The user mode, as configured on the Create User dialog 
box. Available options are: 

➤ Unspecified. Leaves the user without a particular 
mode. Select this option if: 

➤ HP Business Availability Center is working with user 
modes and you want this user to see KPIs for both 
modes in Dashboard views.

➤ Your system is not working with user modes.

➤ Operations User. Enables the user to view the 
operations version of KPIs.

➤ Business User. Enables the user to view the business 
version of KPIs. 

User name The name of the user, as configured on the Create User 
dialog box.

GUI Element (A-Z) Description
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Hierarchy Tab

Description Enables you to assign users to a group, unassign users 
from a group, or nest one group within another.

To access: Select Admin > Platform > Users and 
Permissions, select a group or user from the 
Groups/Users pane, and click the Hierarchy tab.

The Hierarchy tab displays:

➤ Parent Groups. The groups that the selected group is 
nested under.

➤ Child Groups and Users. The groups and users that are 
nested directly beneath the selected group.

Important 
Information

➤ To nest a user, you must select the group into which 
you want to nest it and click the Edit Child Groups and 
Users button.

➤ When removing a nested group from its parent, the 
group itself is not deleted.

➤ When deleting a parent group, the child groups and 
users are not deleted.

➤ If HP Business Availability Center groups have been 
synchronized with groups on an external LDAP server, 
HP Business Availability Center users cannot be moved 
between groups, and only groups appear on the 
interface. For details on synchronizing groups, see 
“Synchronizing Users” on page 525.

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

“Configure Group and User Hierarchy” on page 394

Useful Links “Group and User Hierarchy” on page 377
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The following elements are included:

Edit Child Groups and Users Dialog Box

The following elements are included:

GUI Element (A–Z) Description

Denotes a group that the selected group or user is nested 
under. 

Denotes a user that is nested beneath the selected group.

Child Groups and 
Users

Displays the groups and users that are nested directly 
beneath the group selected in the Groups/Users pane.

Edit Child Groups 
and Users

Click to open the Edit Child Groups and Users window 
and nest or remove groups and users from the selected 
group. For details, see “Edit Child Groups and Users 
Dialog Box” on page 467.

Note: This button is displayed only when selecting a 
group in the Groups/Users pane. 

Parent Groups Displays the groups that the group or user selected in the 
Groups/Users pane is directly nested under.

GUI Element (A–Z) Description

Click to move the group or user to the Child Groups and 
Users pane and nest the group or user under the specified 
group.

Click to move the group or user to the Groups/Users 
pane and remove the group or user from being nested 
beneath the specified group.

Child Groups and 
Users

Select a group or user you want to remove from the 
specified group.

Groups/Users Select a group or user you want to nest under the 
specified group. 
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Permissions Tab

Description Enables you to apply permissions to groups and users for 
specific resources and instances of those resources that 
are defined in the system. 

To access: Select Admin > Platform > Users and 
Permissions > Permissions tab.

The Permissions tab is divided into the following areas: 

➤ Resource tree pane in the center of the page. For 
details, see “Resource Tree Pane” on page 469.

➤ Roles and operations pane on the right side of the 
page. For details, see “Roles and Operations Pane” on 
page 472.

Important 
Information

➤ You can grant permissions to only one user or group at 
a time.

➤ Assigning Add permissions on the Operations tab does 
not automatically grant View permissions on the given 
resource.

➤ If you have many users for whom you have to grant 
permissions, it is recommended that you organize 
your users into logical groups via the Hierarchy tab. 
For details, see “Hierarchy Tab” on page 466.

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

“Assign Permissions” on page 392

Useful Links “Permissions Overview” on page 371
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Resource Tree Pane

The following elements are included:

Description Displays the instances and resources available within 
each HP Business Availability Center context for which 
you set permissions.

To access: Select Admin > Platform > Users and 
Permissions > Permissions tab.

The types of resources displayed in the Resource Tree 
pane are: 

➤ Resource with instances 

➤ Instances of a resource 

Note: When a user defines or creates an instance of a 
resource, for example creates a Business Process 
profile, that user has Full Control permission on that 
resource instance and all of its child resources.

➤ Resource without instances

Important 
Information

➤ The Business Availability Center resource refers to all 
contexts in HP Business Availability Center and can 
have only roles applied to it.

➤ The resources are divided according to the context in 
which they function within the platform and not 
necessarily where they are found in the user interface.

➤ You can select multiple resources only when selecting 
instances. For information on instances, see 
“Resources and Resource Instances” on page 373.

Included in Tasks “Assign Permissions” on page 392

Useful Links “Understanding Permissions Resources” on page 373

“Resource Contexts” on page 470

GUI Element (A–Z) Description

An instance of a resource.

A resource without instances. 
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Resource Contexts

The following contexts are included:

A resource that has instances (a resource collection).

Select Context Select an HP Business Availability Center context for 
which to configure permissions. For details on the 
HP Business Availability Center contexts, see “Resource 
Contexts” on page 470.

Settings Click to apply specific permissions settings for 
configurations in your User Management session. Select 
from the following options: 

➤ Apply permissions automatically when selecting 
another resource. Selecting this option removes the 
necessity for clicking the Apply Permissions button 
after each operation. If this option is not selected, you 
must click Apply Permissions before going on to the 
next operation.

➤ Do not display warning message when revoking VIEW 
from resource. When the view operation is removed 
from a resource for a user, that user has no access to 
the resource or to any of its child resources or 
instances. Therefore, by default, a warning message 
appears when removing view permissions. Selecting 
this option will disable that warning message.

Note: When you select the settings for applying 
permissions, the options selected apply only to the 
current HP Business Availability Center session.

GUI Element (A–Z) Description

Business Process 
Insight

Includes the resources enabling permissions for operating 
and administering the Business Process Insight 
application.

CMDB Includes the view resources for the CMDB in IT Universe.

GUI Element (A–Z) Description
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Central Repository 
Service

Includes the storage location of all BPM scripts.

Monitors Includes all the resources relating to data collection and 
monitoring.

My BSM Includes resources needed to administer modules and 
portlet definitions.

Operations 
Orchestration 
Administration

Includes the resources enabling permissions for operating 
and administering the Operations Orchestration 
Administration application.

Platform Includes all the resources for administering the platform.

Problem Isolation Includes all the resources for working with and 
administering Problem Isolation.

Production Analysis Includes all the resources relating to Application 
Performance Lifecycle (APL).

Service Level 
Management

Includes the SLA resource.

System Availability 
Management

Includes the various SiteScope groups.

TransactionVision Includes the resources relating to working with the 
TransactionVision application.

UCMDB WS API Includes the extraction of data from the CMDB for use 
with third-party or custom tools or to write data to the 
database.

User Defined Reports Includes the Custom report, Trend report, Custom link, 
and Excel report resources.

GUI Element (A–Z) Description
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Roles and Operations Pane

The following elements are included:

Description Displays the predefined roles and operations 
configurable for groups and users in HP Business 
Availability Center.

To access: Select Admin > Platform > Users and 
Permissions > Permissions tab.

Included in Tasks “Assign Permissions” on page 392

Useful Links “Understanding Permissions Resources” on page 373

“User Management Roles” on page 403

“User Management Operations” on page 426

GUI Element (A–Z) Description

Apply Permissions Click to apply the permissions configured for the role or 
resource.

Grant Click the check box to assign the specified role or 
operation to the group or user. 

Granted from 
Group/Role/Parent

Displays those permissions that have been granted from 
either a group, a predefined role, or a parent resource.

Note: 

➤ You cannot remove any of these permissions 
individually, but you can grant additional 
permissions. 

➤ If you want to remove permissions that are granted 
from a group, role, or parent resource, you must make 
the change at the group, role, or parent resource level.
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Inherit Select the check box in the Inherit column for the 
operation to be inherited to all the child resources within 
the selected resource.

Note: 

➤ The Inherit check box is enabled only for selected 
resources. 

➤ By default, the Inherit check box is selected when you 
assign an operation to specific resource instances. You 
can remove the Inherit option to prevent the 
operation from being inherited to all the child 
resources within the selected resource.

Operation The operations that can be assigned to a group or user for 
the selected resource or instances. For details on the 
available operations, see “User Management Operations” 
on page 426.

Operations Click this tab to apply specific operations on a resource 
for a user or group. For a detailed table of what each 
operation enables as it is applied to each resource, see 
“User Management Operations” on page 426

Note: When assigning operations, the operation 
descriptions are displayed under the operations table. 
They appear when a resource or instance is selected and 
you move your cursor over an operation name.

Predefined Roles Click this tab to apply roles that have been predefined for 
various resources. For a detailed description of each role, 
see “User Management Roles” on page 403.

Role The roles that can be assigned to a group or user for the 
selected resource or instances. For a description of the 
available roles, see “User Management Roles” on 
page 403.

GUI Element (A–Z) Description
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User Management Main Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information on the groups and users configured 
to access HP Business Availability Center, including their 
respective permission levels. 

To access: Select Admin > Platform > Users and 
Permissions.

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

Useful Links “User Management – Overview” on page 370

“Groups/Users Pane” on page 475

“Information Pane” on page 481

GUI Element (A-Z) Description

<workflow page> Displays an introductory workflow for the User 
Management application in the Information pane when:

➤ you enter the User Management application.

➤ you have selected the Root group (All) in the 
Groups/Users pane. 

The <workflow page> displays introductory information 
about the User Management application, and a suggested 
workflow for configuring groups and users.

Groups/Users pane Displays the groups and users configured to access 
HP Business Availability Center. For details, see 
“Groups/Users Pane” on page 475.

Information Pane Located on the right side of the page; displays 
information on the permissions, nested group hierarchy, 
and menu customization options of the selected user or 
group. For details, see “Information Pane” on page 481.

Note: The Information pane is visible only if you have 
selected a specific group or user in the Groups/Users 
pane. 
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Groups/Users Pane

Description Displays the list of users and groups of users configured 
to access HP Business Availability Center. 

The Groups/Users pane contains the following tabs: 

➤ Browse. Displays a list of configured users and groups, 
and enables you to create or delete users and groups.

➤ Search. Displays a table view of users and groups, and 
enables you to search for a user or group by any of the 
following criteria:

➤ Group name

➤ Login name

➤ User name

➤ User last login

You can sort the columns by clicking on the column 
headers above the boxes.

You can include wildcards (*) in your search.

To access: Select Admin > Platform > User Management; 
the Groups/Users pane appears on the left side of the 
page, and is visible on all views of the User Management 
application.

Important 
Information

➤ When selecting more than one user or group and 
modifying parameters, the changes take effect only for 
the first selected user. The exception is the Delete 
option, which deletes multiple users at once.

➤ When creating a group, the access permissions are 
automatically inherited by the group’s users. 

➤ When creating users while resting on a group, the 
users are automatically nested within that group. 

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380

Useful Links “User Management Main Page” on page 474
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to create a user or group. 

Depending on whether you choose to create a user or 
group, the Create User or Create Group window opens.

Click to copy the settings of an existing user or group to a 
new user or group.

Click to collapse or expand the groups selected in the 
hierarchy tree. 

Click and select Group Mappings to map local groups to 
groups configured on the LDAP server, or Delete 
Obsolete Users to delete HP Business Availability Center 
users no longer configured on the LDAP server. After 
selecting Delete Obsolete Users, you can remove 
mulitple users at once by holding the Ctrl button while 
selecting users.

For details, see “Group Mappings Dialog Box” on 
page 479.

Note: This button is displayed only if the Mapping 
option has been enabled in the Authentication Strategy 
Wizard. For details, see “Authentication Wizard - 
Introduction Page” on page 500.

A configured user.

A configured group of users.

The root directory. 
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Create User Dialog Box

The following elements are included:

GUI Element (A–Z) Description

Confirm password Re-enter the password specified in the Password field.

Email Enter a valid email address.

Note: The Email field is available for HP Software-as-a-
Service customers only. 

Login name Enter a login name for the user, to be used when 
accessing HP Business Availability Center.

Syntax Exceptions: The following characters are not 
supported: “ \ / [ ] : | < > + = ; , ? *

Note:

➤ The Login name appears as a tooltip when hovering 
over the user name in the Browse tab of the 
Groups/Users pane.

➤ The maximum number of characters you can enter is 
50. 

Password Enter a password to be used when accessing HP Business 
Availability Center.

Time zone Select the appropriate time zone, according to the user’s 
location.
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Create Group Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

User mode Select the user mode for the user, from the following 
options:

➤ Unspecified. Leaves the user without a particular 
mode. Select this option if: 

➤ HP Business Availability Center is working with user 
modes and you want this user to see KPIs for both 
modes in Dashboard views.

➤ Your system is not working with user modes.

➤ Operations User. Enables the user to view the 
operations version of KPIs.

➤ Business User. Enables the user to view the business 
version of KPIs. 

User name Enter a user name for the user. 

Syntax exceptions: The following characters are not 
supported: “ \ / [ ] : | < > + = ; , ? *

Note: The maximum number of characters you can enter 
is 50. 

GUI Element (A–Z) Description

Group description Enter a description for the group. 

Note: The group description is displayed as a tooltip 
when hovering on the group name in the Browse tab of 
the Groups/Users pane.

Group name Enter a name for the group.

GUI Element (A–Z) Description
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Group Mappings Dialog Box

Description Enables you to map groups configured in HP Business 
Availability Center to groups configured on the LDAP 
server. 

The Group Mappings dialog box consists of the following 
panes:

➤ Corporate Directory Pane. For details, see “Corporate 
Directory Pane” on page 480.

➤ BAC Local Repository For Remote Group Pane: <group 
name>. For details, see “BAC Local Repository for 
Remote Group: <group name> Pane” on page 481.

➤ Local Groups to Remote Group Mappings. Displays a 
table of the LDAP groups and the BAC groups that 
they are assigned to. The LDAP groups are displayed in 
the Remote Group Name column, and the BAC 
Groups are listed in the Local Group Name column. 

To access: Select Admin > Platform > Users and 
Permissions; in the Groups/Users pane, click the LDAP 
Configuration button  and select Group Mappings.

Important 
Information

If you are switching from one LDAP server to another, 
ensure that you remove all existing group mappings from 
the original LDAP server before mapping to the new one.
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Corporate Directory Pane

Description Enables you to assign HP Business Availability Center 
groups to LDAP groups, and to list the users in the LDAP 
groups. 

To access: Select Admin > Platform > Users and 
Permissions; in the Groups/Users pane, click the LDAP 
Configuration button  and select Group Mappings. 

Important 
Information

➤ To synchronize LDAP groups with HP Business 
Availability Center groups, click Assign Groups to 
open the Select Local Groups for Remote Group dialog 
box. 

➤ To view the list of users associated with the respective 
LDAP groups, click List Users.

You can also select either of these options by right 
clicking on the group. 

➤ Once the LDAP groups have been mapped to the 
HP Business Availability Center groups, the 
HP Business Availability Center groups are managed 
only from the LDAP interface. This means that the 
following are fields are affected on the Users and 
Permissions interface:

➤ The Create User field is disabled.

➤ The User Name field is disabled.

➤ The Password field is invisible.

➤ The Hierarchy tab is enabled only for groups and 
not for users. 
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BAC Local Repository for Remote Group: <group name> Pane

Information Pane

Description Displays the HP Business Availability Center mapped to 
the LDAP group selected in the Corporate Directory Pane, 
and enables you to remove the mapped HP Business 
Availability Center groups. 

To access: Select Admin > Platform > Users and 
Permissions; in the Groups/Users pane, click the LDAP 
Configuration button  and select Group Mappings. 

Important 
Information

➤ To remove groups, select the group you want to 
remove and click Remove Groups. 

➤ You can remove mulitple groups at once by holding 
the Ctrl button while selecting groups.

Description Displays information on the specific user or group 
selected in the Groups/Users pane. 

The Information pane is located on the right side of the 
User Management Main Page.

To access: Select Admin > Platform > Users and 
Permissions

Included in Tasks “Configure Users and Permissions - Workflow” on 
page 380
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The following tabs are included:

GUI Element (A-Z) Description

Customization Enables you to set the default entry page and context for 
the user specified in the Groups/Users pane. For details, 
see “Customization Tab” on page 462.

Note: The Customization tab is visible only if you have 
selected a user in the Groups/Users pane.

General Displays general information about the user or group 
selected in the Groups/Users pane. 

Note: The fields on the General tab are identical to those 
in the Create User dialog box (for users), and the Create 
Group dialog box (for groups), accessed from the 
Groups/Users pane. For details, see “Groups/Users Pane” 
on page 475.

Hierarchy Displays the parent and child groups, if applicable, for 
the user or group selected in the Groups/Users pane. For 
details, see “Hierarchy Tab” on page 466.

Permissions Displays the permission level for the specific user or 
group selected in the Groups/Users pane, as well as the 
HP Business Availability Center contexts that the 
permission levels apply to. For details, see “Permissions 
Tab” on page 468.
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19
Personal Settings

This chapter provides information on Configuring Personal Settings within 
HP Business Availability Center.

This chapter includes:

Concepts

 ➤  Personal Settings Overview on page 483

Tasks

 ➤  Customize Your HP Business Availability Center Menus and Pages - Workflow 
on page 485

 ➤  Customize Your HP Business Availability Center Menus and Pages - Scenario 
on page 486

Reference

 ➤  Personal Settings User Interface on page 490
Concepts

Personal Settings Overview

Personal settings enable customization of the way HP Business Availability 
Center presents information to individual users.

Individual users can configure personal settings to customize their specific 
user-related behavior of HP Business Availability Center.
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The Personal Settings tab contains the following options:

➤ General Settings. For details, see “General Settings” on page 484.

➤ Menu Customization. For details, see “Menu Customization” on page 484.

General Settings
On the General Settings tab, you can configure the following personal 
settings:

➤ User name

➤ User mode

➤ Time zone used when displaying reports

➤ Password

➤ Refresh rate of reports

➤ Customized menu items

For details on the user interface for changing your password and updating 
other Personal Settings, see “General Settings Page” on page 490.

Menu Customization
On the Menu Customization tab, you can:

➤ Specify the default context that is displayed when logging into HP Business 
Availability Center.

➤ Specify the first page that is displayed in each of the different parts of 
HP Business Availability Center.

➤ Specify the tabs and options that are available on pages throughout 
HP Business Availability Center.

Customizing your entry page, menu items, and tabs enables your interface 
to display only the areas of HP Business Availability Center that are relevant 
to you. For details on the Menu Customization User Interface, see “Menu 
Customization Page” on page 492.

Tasks
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Customize Your HP Business Availability Center Menus 
and Pages - Workflow

This task describes how to customize the page you see when entering 
HP Business Availability Center, and choose the menu items available on 
pages throughout HP Business Availability Center.

For a scenario of this task, see “Customize Your HP Business Availability 
Center Menus and Pages - Scenario” on page 486.

This task includes the following steps:

➤ “Assign a Default Context” on page 485

➤ “Select Context Pages and Tabs” on page 485

➤ “Assign a Default Entry Page” on page 485

➤ “Results” on page 485

 1 Assign a Default Context
Select a context from the Contexts pane that you want to be the default 
entry context you see when logging into HP Business Availability Center, 
and click Set as Default Entry Context. For details on the Contexts pane, see 
“Menu Customization Page” on page 492.

 2 Select Context Pages and Tabs
In the Pages and Tabs pane, select the context of the pages and tabs that you 
want to be visible on the selected context for the user. Clear the check boxes 
of the pages and tabs that you want hidden from the user.

 3 Assign a Default Entry Page
Select a page or tab to be the default entry page for the selected context, and 
click Set as Default Entry Page. 

 4 Results
The default entry icon appears next to the default entry context and page. 
Pages and tabs visible to the user are selected in the Pages and Tabs pane. 
Pages and tabs hidden from the user are cleared in the Pages and Tabs pane.
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Example

Customize Your HP Business Availability Center Menus 
and Pages - Scenario

This scenario describes how to customize user menus for individual users.

For a task of this scenario, see “Customize Your HP Business Availability 
Center Menus and Pages - Workflow” on page 485.

This task includes the following steps:

➤ “Assigning a Default Context” on page 487

➤ “Selecting Context Pages and Tabs” on page 488

➤ “Results” on page 489
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 1 Assigning a Default Context
John Smith is a registered HP Business Availability Center user for the ABC 
Insurance Company. He wants to configure the Service Level Management 
application interface to be the default Business Availability Center context 
that he sees when logging in. He navigates to the Personal Settings option 
by selecting Admin > Personal Settings, and selects Menu Customization to 
open the Menu Customization page. He selects Applications - Service Level 
Management in the Contexts pane and clicks Set as Default Entry Context. 
The Applications - Service Level Management option is indicated as the 
default entry context:
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 2 Selecting Context Pages and Tabs
John wants to see only the pages and tabs that are relevant for his work, and 
wants to view the Service Level Agreements (SLAs) Summary report 
immediately upon logging in to HP Business Availability Center. In the 
Pages and Tabs pane, he deselects the SLA Management option, as the 
information presented on this tab is not relevant to his work. He selects the 
SLAs Summary option and clicks Set as Default Entry Page. The SLAs 
Summary page is indicated as the default entry page that John sees when 
logging in to HP Business Availability Center: 
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 3 Results
The context that opens when John Smith logs into HP Business Availability 
Center is the Service Level Management context on the Applications menu. 
The SLAs Summary Report page is displayed on the SLA Reports tab: 

Reference
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Personal Settings User Interface

This section describes:

 ➤  General Settings Page on page 490

 ➤  Menu Customization Page on page 492

General Settings Page

The following elements are included:

Description Enables you to configure the user name, user mode, time 
zone, password, and refresh rate settings. 

To access: Select Admin > Personal Settings > General 
Settings

Note: The Personal Settings tab can also be accessed by 
clicking Change the default page on the Site Map.

Important 
Information

HP Business Availability Center saves these settings per 
defined user. Any changes you make remain in effect for 
all future Web sessions for only that user.

Useful Links “General Settings” on page 484

GUI Element (A–Z) Description

Confirm Password Re-enter the password specified in the Password field.

Email Enter a valid email address.

Note: The Email field is available for HP Software-as-a-
Service customers only. 

Login name The name used to log into HP Business Availability 
Center.

Note: You cannot change the entry in this field. 

Old Password Enter the existing password.

Password Enter a password to be used when accessing HP Business 
Availability Center.
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Select auto-refresh 
rate

Select the rate at which you want HP Business 
Availability Center to automatically refresh the browser 
and load the most up-to-date data from the database.

Note: This setting is active only when in the Past day or 
Past hour time resolution in reports.

Time zone Select the appropriate time zone, according to the user’s 
location.

User mode Select the user mode for the user, from the following 
options:

➤ Unspecified. Leaves the user without a particular 
mode. Select this option if: 

➤ HP Business Availability Center is working with user 
modes and you want this user to see KPIs for both 
modes in Dashboard views.

➤ Your system is not working with user modes.

➤ Operations User. Enables the user to view the 
operations version of KPIs. For details on user types, 
see “KPIs for User Modes” in Using Dashboard.

➤ Business User. Enables the user to view the business 
version of KPIs. For details on user types, see “KPIs for 
User Modes” in Using Dashboard.

User name Enter a user name for the user. 

Note: 

➤ The maximum number of characters you can enter is 
50. 

➤ All special characters are allowed except the following: 
“ \ / [ ] : | < > + = ; , ? *

GUI Element (A–Z) Description
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Menu Customization Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to: 

➤ Specify the default context that is displayed when 
logging into HP Business Availability Center.

➤ Specify the first page that is displayed in each of the 
different parts of HP Business Availability Center.

➤ Specify the tabs and options that are available on 
pages throughout HP Business Availability Center.

To access: Select Admin > Personal Settings > Menu 
Customization

Note: The Personal Settings tab can also be accessed by 
clicking Change the default page on the Site Map.

Included in Tasks “Customize Your HP Business Availability Center Menus 
and Pages - Workflow” on page 485

Useful Links “Personal Settings Overview” on page 483

GUI Element (A–Z) Description

Contexts Select an HP Business Availability Center context. You 
can perform the following actions on the context:

➤ Select pages and tabs in the Pages and Tabs pane to be 
visible for the specified user. 

➤ Click the Set as Default Entry Context button to make 
it the context that is displayed when the user logs into 
HP Business Availability Center. 

Pages and Tabs ➤ Select the pages and tabs you want to be visible for the 
HP Business Availability Center context selected in the 
Contexts pane. 

➤ Assign a page or tab as the default page that opens for 
the context selected in the Contexts pane.
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Set as Default Entry 
Context

Click to set the selected context in the Contexts pane as 
the entry context that is displayed when the specified 
user logs into HP Business Availability Center.

Note: The Default Entry Context icon  appears next 
to the specified context.

Set as Default Entry 
Page

Click to assign the specified page or tab as the default 
page that opens for the context selected in the Contexts 
pane. 

Note: The Default Entry Page icon  appears next to 
the specified page or tab. 

GUI Element (A–Z) Description



Chapter 19 • Personal Settings

494



495

20
Authentication Strategies

This chapter includes the main concepts and reference information for 
Authentication Strategies in HP Business Availability Center.

This chapter includes:

Concepts

 ➤  Authentication Strategies - Overview on page 496

 ➤  Setting Up a Single Sign-On Authentication Strategy on page 496

 ➤  Setting Up a Lightweight Directory Access Protocol (LDAP) Authentication 
Strategy on page 497

Reference

 ➤  Authentication Modes in HP Business Availability Center on page 498

 ➤  Authentication Strategy User Interface on page 499
Concepts
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Authentication Strategies - Overview

HP Business Availability Center authentication is based on a concept of 
authentication strategies. Each strategy handles authentication against a 
specific authentication service. Only one authentication service can be 
configured with HP Business Availability Center at any given time. 

The default authentication strategy for logging into HP Business Availability 
Center is the HP Business Availability Center internal authentication 
service. You enter your HP Business Availability Center user name and 
password from the login page, and your credentials are stored and verified 
by the HP Business Availability Center database. For a description of the 
authentication process in HP Business Availability Center, see “HP Business 
Availability Center Login Flow” on page 21. 

You can choose to configure authentication using the Lightweight Directory 
Access Protocol (LDAP). HP Business Availability Center uses the LDAP 
server to verify a user’s credentials. For details on LDAP, see “Lightweight 
Directory Access Protocol (LDAP) Authentication and Mapping” on 
page 523. 

Authentication strategies are configured in the Authentication Management 
Wizard. For details on the Authentication Management Wizard, see 
“Authentication Wizard - Introduction Page” on page 500. 

Setting Up a Single Sign-On Authentication Strategy

Single Sign-On is a method of access control that enables a user to log in 
once and gain access to the resources of multiple software systems without 
being prompted to log in again. The applications inside the configured 
group of software systems trust the authentication, and you do not need 
further authentication when moving from one application to another. 

The default single sign-on authentication strategy for HP Business 
Availability Center is Lightweight Single Sign-On Authentication (LW-SSO).  
LW-SSO is embedded in HP Business Availability Center and does not 
require an external machine for authentication. For details on LW-SSO, see 
“Lightweight Single Sign-On (LW-SSO) Strategy - Overview” on page 513.
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If the applications configured outside of HP Business Availability Center do 
not support LW-SSO, or if you want a stronger Single Sign-On 
implementation, you can configure Identity Management Single Sign-On 
(IDM-SSO) using the Authentication Management Wizard. When enabled as 
a Single Sign-On strategy, IDM-SSO also serves as an authenticator. Any user 
authenticated through IDM-SSO can log into HP Business Availability 
Center, provided they fulfill the criteria defined in the Users Filter field of 
the LDAP Vendor Attributes dialog box. For details, see “LDAP Vendor 
Attributes Dialog Box” on page 508.

All requests to client applications are channeled through the SSO 
authentication. The supported applications need to know only the name of 
the authenticated user.

For details on the IDM-SSO authentication strategy, see “Identity 
Management Single Sign-On (IDM-SSO) - Overview” on page 520.

Setting Up a Lightweight Directory Access Protocol 
(LDAP) Authentication Strategy

The Lightweight Directory Access Protocol (LDAP) is an Internet protocol 
that email and other programs use to look up information from an external 
server. LDAP can be configured with HP Business Availability Center in one 
of the following ways:

➤ As an authentication mechanism for users logging into HP Business 
Availability Center.

➤ To map groups and synchronize HP Business Availability Center users with 
users configured on the external LDAP server, thereby simplifying the 
process of managing users for HP Business Availability Center 
administrators. For details, see “Map Groups and Synchronize Users” on 
page 528.

You enable and disable LDAP using the Authentication Management 
Wizard. For details, see “Authentication Wizard - Introduction Page” on 
page 500.

Reference
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Authentication Modes in HP Business Availability Center

The following table displays the Authentication Strategy used by 
HP Business Availability Center, as determined by both the Single Sign-On 
mode and the LDAP mode selected in the Authentication Management 
Wizard: 

Single Sign-On Mode LDAP Mode Authenticator

Disabled Disabled HP Business Availability 
Center Internal

Enabled LDAP

LW-SSO Disabled HP Business Availability 
Center Internal

Enabled LDAP

IDM-SSO Disabled IDM-SSO

Enabled IDM-SSO
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Authentication Strategy User Interface

This section describes:

 ➤  Authentication Strategy Page on page 499

 ➤  Authentication Wizard - Introduction Page on page 500

Authentication Strategy Page

Description Displays the current authentication strategy and Single 
Sign-on configurations for logging into HP Business 
Availability Center. 

To access: Select Admin > Platform > Users and 
Permissions > Authentication Management

Important 
Information

Access to the Authentication Management page is 
dependent on the following permission levels:

➤ View. Enables viewing the Authentication 
Management Page. 

➤ Change. Enables you to access the Authentication 
Management Wizard and change configurations. The 
Configure button is enabled. 

You configure permissions on the Users and Permissions 
interface. For details, see “Assign Permissions” on 
page 392.

Useful Links “Authentication Strategies - Overview” on page 496

“Infrastructure Settings” on page 133
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The following elements are included:

Authentication Wizard - Introduction Page

GUI Element (A-Z) Description

Configure Click to open the Authentication Wizard and configure 
an authentication strategy. For details on the 
Authentication Wizard, see “Authentication Wizard - 
Introduction Page” on page 500.

Name The name of the Single Sign-On or Lightweight Directory 
Access Protocol parameter. 

Value The value of the specified Single Sign-On or Lightweight 
Directory Access Protocol parameter.

Description Enables you to create an authentication strategy for 
logging into HP Business Availability Center. 

To access: Select Admin > Platform > Users and 
Permissions > Authentication Management, and click 
Configure.

The Introduction page provides introductory 
information on the Authentication Wizard. Click Next to 
continue. 
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Single Sign-On Page

Important 
Information

If the User Interface does not respond properly after 
upgrading your version of HP Business Availability 
Center (for example, the page does not load, or an error 
message is displayed), clean the java cache by following 
this procedure on your client PC: 

➤ Navigate to Start > Control Panel > Java.

➤ In the Temporary Internet Files section, click Settings. 

➤ In the Temporary File Settings dialog box, click Delete 
Files.

Wizard Map The Authentication Wizard contains:

Introduction Page > Single Sign-On Page > LDAP 
General Configuration Page > LDAP Users 
Synchronization Configuration Page > Summary Page

Description Enables you to configure a Single Sign-On strategy.

To access: Select Admin > Platform > Users and 
Permissions > Authentication Management, and click 
Configure. Navigate to the Single Sign-On page.

The elements displayed on the Single Sign-On page are 
determined by the Single Sign-On mode you choose. 

Important 
Information

If a value in one of the wizard fields is blank or invalid, 
an error icon  is displayed on the field’s cell. You can 
view a description of the error in one of the following 
ways: 

➤ Hover over the error icon to display a tooltip with the 
error message. 

➤ Access the log file 
<HPBAC>/log/EJBContainer/login.log.

Wizard Map The Authentication Wizard contains:

Introduction Page > Single Sign-On Page > LDAP 
General Configuration Page > LDAP Users 
Synchronization Configuration Page > Summary Page
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The following elements are included:

GUI Element (A-Z) Description

Disabled Select to disable the Single Sign-On (SSO) authentication 
strategy.

Identity 
Management

Select to configure the Identity Management Single Sign-
On (IDM-SSO) authentication strategy. For details on the 
elements displayed this page, see “Identity Management 
Single Sign-On (IDM-SSO) Configuration” on page 503.

Note: If you have selected this option, LDAP can be 
configured only for group mapping and not for 
authentication.

Lightweight Select to configure the Lightweight Single Sign-On (LW-
SSO) authentication strategy. For details on the elements 
displayed on this page, see “Lightweight Single Sign-On 
(LW-SSO) Configuration” on page 503.
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Identity Management Single Sign-On (IDM-SSO) Configuration

The following elements are included:

Lightweight Single Sign-On (LW-SSO) Configuration

The following elements are included:

GUI Element (A-Z) Description

Indicates that the value in the specified field is empty or 
invalid. 

Hover over this icon to view a tooltip describing the 
error.

Header Name Enter the header name for the token name passed by the 
Identity Management Single Sign-On. 

Example: sso_user

Note: Ensure that the Identity Management Single Sign-
On strategy is securing HP Business Availability Center 
resources before you enter this information. 

Logout URL Enter an alternate logout URL, to view a page other than 
the main login page when logging out of HP Business 
Availability Center.

Example: \<alternativeLogoutURL>.jsp

Note: This field is optional.

GUI Element (A-Z) Description

Indicates that the value in the specified field is empty or 
invalid. 

Hover over this icon to view a tooltip describing the 
error.

Add Click to add the domain to the list of protected domains. 
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HP Business 
Availability Center 
Domain

Enter the relevant HP Business Availability Center 
domain, to be used for token creation. This field is 
required for multi-domain support and normalized URLs.

Example: devlab.ad

Note: This field has no relevance for HP Business 
Availability Center 8.0x, as domain parsing is done 
automatically. 

Protected Domains Displays the list of protected domains that allow multi-
domain support in the lower cell. Type a protected 
domain in the upper cell, and click Add to add the 
domain to the list of protected domains in the lower cell. 

Example: emea.hpqcorp.net, devlab.ad 

Note: All domains must be added as Fully Qualified 
Domain Names (FQDN).

Remove Click to remove the domain selected in the box from the 
list of protected domains. 

Token Creation Key 
(initString)

Enter an initString value, used for encryption and 
decryption of the token. 

Example: Xy6stqZ

GUI Element (A-Z) Description
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LDAP General Configuration Page

Description Enables you to use an external LDAP server to store 
authentication information (user names and passwords) 
and to enable user synchronization between LDAP users 
and HP Business Availability Center users. 

To access: Select Admin > Platform > Users and 
Permissions > Authentication Management, and click 
Configure. Navigate to the LDAP General Configuration 
page.

The available LDAP modes are: 

➤ Enabled

➤ Disabled 

Note: LDAP cannot be used for authentication when you 
choose IdentityManagement on the Single Sign-On 
Configuration page of the wizard. 

Important 
Information

When configuring LDAP parameters, consult your LDAP 
Administrator for assistance. 

Wizard Map The Authentication Wizard contains:

Introduction Page > Single Sign-On Page > LDAP 
General Configuration Page > LDAP Users 
Synchronization Configuration Page > Summary Page
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LDAP General Configuration Section

The following elements are included:

GUI Element (A-Z) Description

Indicates that the value in the specified field is empty or 
invalid. 

You can view a description of the error in one of the 
following ways: 

➤ Hover over the error icon to display a tooltip with the 
error message. 

➤ Access the log file 
<HPBAC>/log/EJBContainer/login.log.

Advanced Click to enable the LDAP Vendor Attributes dialog box 
and modify configurations for the selected LDAP vendor. 
For details, see “LDAP Vendor Attributes Dialog Box” on 
page 508.

Distinguished Name 
(DN) Resolution

Select to enable entering only the Unique User ID, 
instead of the full Distinguished Name (DN) when 
logging in.

Note: 

➤ Selecting this checkbox enables the various 
Distinguished Name (DN) Resolution elements.

➤ If you do not select this checkbox, you must use the 
full Distinguished Name (DN) to log into HP Business 
Availability Center. 

Distinguished Name 
of Search Entitled 
User

Defines the Distinguished Name (DN) of a user with 
search privileges on the LDAP directory server. 

Note: Leave this entry blank for an anonymous user. 
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LDAP server URL Enter the URL of the LDAP server.

The required format is: 
ldap://machine_name:port/[??scope]

Example: 
ldap://my.ldap.server:389/ou=People,o=myOrg.com??sub

➤ Possible values of scope = sub, one, or base, and are 
case sensitive.

➤ Business Availability Center ignores the attribute 
between the two question marks, if one exists.

➤ When the port number and scope value are empty, 
default values are used. 

➤ Default port number for regular communication: 
389

➤ Default port number for SSL communication: 636

➤ Default scope value: sub

LDAP vendor type Enter the LDAP vendor you are using. Select from: 

➤ Common LDAP

➤ Microsoft Active Directory

➤ Other

Note: If you click Advanced and modify the LDAP 
Vendor Attribute settings, the value of this field 
automatically changes to Other. 

Password of Search 
Entitled User

Defines the password of the user entitled to search the 
LDAP server entities for groups. 

Note: Leave this entry blank for an anonymous user.

GUI Element (A-Z) Description
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Test DN Resolution Section

The following elements are included:

LDAP Vendor Attributes Dialog Box

Description Enables you to verify that both the configured LDAP 
parameters and the credentials of a specified user are 
valid. 

Important 
Information

General information about the wizard is available in 
“Authentication Wizard - Introduction Page” on 
page 500.

GUI Element (A-Z) Description

Password The password of the user whose credentials are entered in 
the UUID field. 

Note: This field is optional. If left empty, anonymous 
user is tested. 

Test Click to test the LDAP configuration and user credentials 
validity. A message is displayed indicating whether or not 
the validation was successful.

UUID The actual login name (Unique User ID) of the LDAP user 
you want to verify.

Description Enables you modify the default LDAP settings that are 
specific to the selected vendor. 

To access: Click Advanced on the LDAP General 
Configuration Page of the Authentication Management 
Wizard. 

Important 
Information

If you modify the LDAP Vendor Attribute settings, the 
value of the LDAP Vendor Type field on the LDAP 
General Configuration page automatically changes to 
Other.
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The following elements are included:

LDAP Users Synchronization Configuration Page

GUI Element (A-Z) Description

Group class object Defines which LDAP entities are to be considered groups 
on the LDAP server. 

Groups member 
attribute

Defines the specific attribute that determines which of 
the LDAP group’s entities are to be considered members 
of the LDAP group.

Restore Current Click to restore the LDAP vendor attributes to their state 
upon logging into the current session of HP Business 
Availability Center.

Users filter Defines which LDAP users are enabled to log into 
HP Business Availability Center.

Users object class Defines which LDAP entities are to be considered users 
on the LDAP server. 

Users unique ID 
attribute

The attribute with which you want to log into 
HP Business Availability Center, as it appears on the 
LDAP server. 

Example: uid, mail

Description Enables you configure the LDAP server to synchronize 
LDAP users with HP Business Availability Center users.

To access: Select Admin > Platform > Users and 
Permissions > Authentication Strategy, and click 
Configure. Navigate to the LDAP Users Synchronization 
Configuration page.

Important 
Information

This page is enabled only if the LDAP General 
Configuration page has been configured correctly.

Wizard Map The Authentication Wizard contains:

Introduction Page > Single Sign-On Page > LDAP General 
Configuration Page > LDAP Users Synchronization 
Configuration Page > Summary Page
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The following elements are included:

GUI Element (A-Z) Description

Indicates that the value entered in the specified field is 
invalid.

Enable User 
Synchronization

Select to enable User Synchronization upon logging into 
HP Business Availability Center, to synchronize LDAP 
users with HP Business Availability Center users.

Important: Ensure that you have mapped LDAP groups to 
HP Business Availability Center groups before selecting 
this checkbox. If you have not performed Group 
Mapping, all users are nested under the Root group and 
are assigned Viewer permissions. For details on mapping 
groups, see “Map Groups and Synchronize Users” on 
page 528. 

Groups base DN The Distinguished Name (DN) of the LDAP entity from 
which you want to start your groups search.

Groups search filter Enter the relevant parameters to indicate which 
attributes are to be included in the groups search.

Root groups base DN The Distinguished Name (DN) of the LDAP groups that 
are to be first on the hierarchical tree of mapped groups. 
This value must be a subset of the Groups base DN. 

Root groups filter Enter the parameters to determine which LDAP entities 
are to be the hierarchical base for the LDAP groups. The 
specified entities are then available to be mapped to 
groups in HP Business Availability Center. 

Test Click to verify that the parameters entered to define the 
LDAP groups structure are valid. 

Test Groups 
Configuration Pane

Displays the groups available for mapping with 
HP Business Availability Center groups and the LDAP 
groups’ hierarchical structure. The displayed groups are 
determined by the parameters entered into the fields on 
the LDAP Users Synchronization Configuration page.



Chapter 20 • Authentication Strategies

511

Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a summary of the authentication strategies 
configured in the Authentication Management Wizard. 

To access: Select Admin > Platform > Users and 
Permissions > Authentication Management, and click 
Configure. Enter information in the Single Sign-On and 
LDAP pages, and navigate to the Summary page.

Wizard Map The Authentication Wizard contains:

Introduction Page > Single Sign-On Page > LDAP General 
Configuration Page > LDAP Users Synchronization 
Configuration Page > Summary Page

GUI Element (A-Z) Description

LDAP General 
Configuration

Displays the LDAP General Configuration parameters, as 
configured on the LDAP General Configuration page of 
the wizard. 

LDAP Users 
Synchronization 
Configuration

Displays the LDAP Users Synchronization Configuration 
parameters, as configured on the LDAP Users 
Synchronization Configuration page of the wizard. 

Single Sign-On 
Configuration

Displays the Single Sign-On parameters, as configured in 
the wizard. 
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21
Lightweight Single Sign-On Strategy

This chapter provides information on the Lightweight Single Sign-On 
strategy.

This chapter includes:

Concepts

 ➤  Lightweight Single Sign-On (LW-SSO) Strategy - Overview on page 513

Tasks

 ➤  Configure Unknown User Handling Mode on page 514

 ➤  Modify Lightweight Single Sign-On (LW-SSO) Parameters Using the JMX 
Console on page 515

Troubleshooting and Limitations on page 516
Concepts

Lightweight Single Sign-On (LW-SSO) Strategy - 
Overview

The default single sign-on authentication strategy for HP Business 
Availability Center is Lightweight Single Sign-On (LW-SSO).  LW-SSO is 
embedded in HP Business Availability Center and does not require an 
external machine for authentication. HP Business Availability Center 
currently uses version 2.2 of LW-SSO.

For an overview of Single Sign-On strategies, see “Setting Up a Single Sign-
On Authentication Strategy” on page 496.
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You configure LW-SSO in HP Business Availability Center using the 
Authentication Wizard. For details on the Authentication Wizard, see 
“Authentication Wizard - Introduction Page” on page 500.

For details on limitations of working with LW-SSO, see “Lightweight Single 
Sign-On Authentication – General Reference” on page 535. 

Note: Demonstration mode enables LW-SSO to be used between 
applications that are not in the same domain and without having to use the 
FQDN. This option should be used for demonstration and testing purposes 
only. Cookies can be passed to machines and applications that are not in the 
same domain, making this mode unsecure.  This option is not supported for 
use in product environments. You can enable this option using the JMX 
console. For details, see “Modify Lightweight Single Sign-On (LW-SSO) 
Parameters Using the JMX Console” on page 515.

Tasks

Configure Unknown User Handling Mode

This task describes how to handle unknown users trying to login to 
HP Business Availability Center - users that were authenticated by the 
hosting application but do not exist in the HP Business Availability Center 
users repository:

To configure unknown user handling mode:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, and select Single Sign On.

 2 Locate the Unknown User Handling Mode entry in the Single Sign On - 
Lightweight (LW-SSO) field, and select one of the following options: 

➤ Integration User. A user with the User name Integration User is created 
in place of the user who attempted to log in. This user has System Viewer 
permissions.
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➤ Allow. The user is created as a new HP Business Availability Center user 
and allowed access to the system. This user has System Viewer 
permissions, and his default password is his login name.

➤ Deny. The user is denied access to HP Business Availability Center, and is 
directed to the login page.

The changes take effect immediately.

Note: When User Synchronization is enabled between HP Business 
Availability Center and the LDAP server, unknown users are always denied 
entry into HP Business Availability Center.

Modify Lightweight Single Sign-On (LW-SSO) Parameters 
Using the JMX Console

This task describes how to modify options and parameters used with LW-
SSO in the JMX Console. These options include the ability to enable to 
demonstration mode (beginning with LW-SSO version 2.2). 

You can also use the JMX console if you are locked out of HP Business 
Availability Center and must change SSO parameters to gain access.

To modify Lightweight Single Sign-On (LW-SSO) parameters via the JMX 
console:

 1 Enter the URL of the JMX console (http://<server name>:8080/jmx-
console/) in a web browser.

 2 Enter your JMX console authentication credentials. If you do not know your 
authentication credentials, contact your system administrator.

 3 Locate the Lightweight Single Sign-On context, as follows:

 a Domain name: Topaz

 b Service: LW-SSO Configuration

 4 Modify parameters accordingly. 
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Note: To enable demonstration mode, change the property 
LwSsoFrameworkDemoMode from its default value of False to True.

The changes take effect immediately. 

Troubleshooting and Limitations

This section includes the following topics:

➤ “Unable to Access HP Business Availability Center Due to Changes in LW-
SSO Parameters” on page 516

➤ “Synchronizing Users When Using LW-SSO” on page 517

Unable to Access HP Business Availability Center Due to 
Changes in LW-SSO Parameters
If you are locked out of HP Business Availability Center, you can update 
selected Lightweight Single Sign-On (LW-SSO) parameters remotely using 
the JMX console on the application server that is embedded in HP Business 
Availability Center. 

For details on how to change LW-SSO parameters outside the HP Business 
Availability Center interface, see “Modify Lightweight Single Sign-On (LW-
SSO) Parameters Using the JMX Console” on page 515.
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Synchronizing Users When Using LW-SSO
LW-SSO does not ensure user synchronization between integrated 
applications. Therefore, you must enable LDAP and configure group 
mapping for the integrated application to monitor users. Failure to map 
groups and synchronize users may cause security breaches and negative 
application behavior. For details on mapping users between applications, see 
“Map Groups and Synchronize Users” on page 528.
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22
Identity Management Single Sign-On 
Authentication

This chapter provides information on the Identity Management Single Sign-
On (IDM-SSO) Authentication Strategy.

This chapter includes:

Concepts

 ➤  Identity Management Single Sign-On (IDM-SSO) - Overview on page 520

Reference

 ➤  Securing HP Business Availability Center Resources Under IDM-SSO 
on page 521

Concepts
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Identity Management Single Sign-On (IDM-SSO) - 
Overview

You implement IDM-SSO if you want a more secure connection than that 
offered by LW-SSO, or if the applications configured outside of HP Business 
Availability Center do not support LW-SSO. The IDM server is monitored by 
a single center Policy Server, and consists of a User Repository, a Policy Store 
(both could reside over the same server as the policy server), and a Web 
Server Agent installed over each of the application's web servers 
communicating with the Policy Server. The IDM server controls users’ access 
to various organizational resources, protecting confidential personal and 
business information from unauthorized users. For details, see your IDM 
vendor’s documentation. 

HP Business Availability Center requires the IDM vendor to store user 
information to render it available as a header on http requests. You 
configure both the Header name and the IDM-SSO strategy in the 
Authentication Wizard. For details, see “Authentication Wizard - 
Introduction Page” on page 500.

Note: If you have upgraded from a version prior to HP Business Availability 
Center 7.5 with IDM-SSO enabled, the HP Business Availability Center 
AuthenticationUpgrader takes the values of the header and URL attributes 
configured in the SYSTEM table and converts them to the appropriate values 
in the Header name and Logout URL fields in Infrastructure Settings, and 
sets the Single Sign-On Mode field value to IdentityManagement.

Reference



Chapter 22 • Identity Management Single Sign-On Authentication

521

Securing HP Business Availability Center Resources Under 
IDM-SSO

The following HP Business Availability Center resources should be secured 
when using IDM-SSO as a Single Sign-On strategy: 

Additionally, the following resources should be unprotected: 

➤ /topaz/images

➤ /topaz/Imgs/chartTemp

➤ /topaz/static

Resource Authentication Scheme

/ext/* basic

/filters/* form

/mam/* basic

/mam-images/* form

/mam-collectors/* basic

/mcrs/* form

/MercuryAM/* form

/opal/* form

/topaz/* form

/topazSettings/* form

/topaz/topaz_api/* basic

/webinfra/* form

/topaz/sitescope/* basic

/tv/* form

/tvb/* form

/utility_portlets/* form
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Lightweight Directory Access Protocol 
(LDAP) Authentication and Mapping

This chapter provides information on the Lightweight Directory Access 
Protocol (LDAP) Authentication and User Synchronization processes.

This chapter includes:

Concepts

 ➤  Lightweight Directory Access Protocol (LDAP) Authentication - Overview 
on page 524

 ➤  Mapping Groups on page 524

 ➤  Synchronizing Users on page 525

Tasks

 ➤  Map Groups and Synchronize Users on page 528

 ➤  Synchronize Users After Upgrading from a Previous Version of HP Business 
Availability Center on page 531

 ➤  Modify the Attribute Used to Log into HP Business Availability Center 
on page 532

 ➤  Delete Obsolete Users on page 532

Troubleshooting and Limitations on page 533
Concepts
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Lightweight Directory Access Protocol (LDAP) 
Authentication - Overview

You can use an external LDAP server to store users’ information (usernames 
and passwords) for authentication purposes, instead of using the internal 
HP Business Availability Center service. You can also use the LDAP server to 
synchronize HP Business Availability Center and LDAP users. For optimal 
performance, it is recommended that the LDAP server be in the same subnet 
as the rest of the HP Business Availability Center servers. For optimal 
security, it is recommended to either configure an SSL connection between 
the HP Business Availability Center Gateway server and the LDAP server, or 
to have HP Business Availability Center servers and the LDAP server on the 
same secure internal network segment.

Authentication is performed by the LDAP server, and authorization is 
handled by the HP Business Availability Center server. 

You configure the LDAP server for authentication and user synchronization 
using the Authentication Wizard. For details on the Authentication Wizard, 
see “Authentication Wizard - Introduction Page” on page 500.

For details on securing communication between an LDAP server and your 
HP Business Availability Center server over SSL, see “Securing 
Communication Between an LDAP Server and HP Business Availability 
Center Server Over SSL” in the HP Business Availability Center Hardening 
Guide PDF.

Mapping Groups

You map groups to enable user synchronization between LDAP users and 
HP Business Availability Center users. The Group Mapping feature is 
accessible through the Users and Permissions interface, using the Group 
Mappings button menu. This button is enabled only if the following 
conditions are met: 

➤ The LDAP mode on the Authentication Strategy page is configured to 
Enabled.

➤ The user has administrator permissions.
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Once user synchronization is enabled, the User Management interface has 
the following limitations:

➤ You cannot create a user.

➤ The User name and Login name fields for individual users are disabled.

➤ The Password field is invisible.

➤ You cannot nest users in groups via the Hierarchy tab.

You can optionally map an LDAP group to multiple HP Business Availability 
Center groups, or multiple LDAP groups to an HP Business Availability 
Center group.

When enabling the Group Mapping feature, you can log into HP Business 
Availability Center with any unique user attribute that exists on the LDAP 
server (for example, an email address). For details, see “Modify the Attribute 
Used to Log into HP Business Availability Center” on page 532.

Synchronizing Users

The user synchronization feature maps users on an LDAP server to users in 
HP Business Availability Center. This simplifies the process of managing 
users for HP Business Availability Center administrators, as all of the user 
management functions are done through the LDAP server. It is 
recommended to grant permissions on the group level in HP Business 
Availability Center, and then nest users into groups according to their 
desired permission level. If users are moved between LDAP groups, they are 
moved between their corresponding mapped groups on the HP Business 
Availability Center server after logging into HP Business Availability Center.

An LDAP user that does not exist in HP Business Availability Center who 
logs into HP Business Availability Center is created as an HP Business 
Availability Center user. Their status is determined as follows:

➤ If the user belongs to a mapped LDAP group, they are automatically 
assigned to the HP Business Availability Center group that is mapped to 
their LDAP group.
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➤ If their group is not mapped to an HP Business Availability Center group, or 
if they do not belong to an LDAP group, they are nested under the Root 
group and created as an HP Business Availability Center user with System 
Viewer permissions. Their permissions and user hierarchy can be modified 
on the User Management interface.

The following flowchart displays the process of User Management when 
LDAP is enabled, as performed by the HP Business Availability Center 
administrator and HP Business Availability Center itself when the user logs 
in:
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For an LDAP user to log into HP Business Availability Center, they must 
match the criteria defined in the Users filter field on the LDAP Advanced 
General Configuration dialog box in the Authentication Wizard. For details 
on the LDAP General Configuration page, see “LDAP Vendor Attributes 
Dialog Box” on page 508.

Users that have been removed from the LDAP server are still displayed as 
HP Business Availability Center users, even though they are no longer 
registered as LDAP users and cannot log into HP Business Availability 
Center. These users are called Obsolete Users. For details on removing 
Obsolete Users from HP Business Availability Center, see “Delete Obsolete 
Users” on page 532. 

For details on synchronizing LDAP users with HP Business Availability 
Center users, see “Map Groups and Synchronize Users” on page 528.

For details on synchronizing groups after upgrading from a previous version 
of HP Business Availability Center, see “Synchronizing Users After 
Upgrading from a Previous Version of HP Business Availability Center” on 
page 527. 

Synchronizing Users After Upgrading from a Previous 
Version of HP Business Availability Center
When upgrading from a previous version of HP Business Availability Center, 
the Enable User Synchronization setting in Infrastructure Settings is set to 
False by default. This enables you to map the LDAP groups to groups in 
HP Business Availability Center using the LDAP Configuration button on the 
Users and Permissions interface. If you do not map the groups at this time, 
all HP Business Availability Center groups are nested under the Root 
directory. 

Once the LDAP and HP Business Availability Center groups have been 
mapped, you must change the Enable User Synchronization setting in 
Infrastructure Settings to True for users to be synchronized upon login to 
HP Business Availability Center.

For details on performing this task, see “Synchronize Users After Upgrading 
from a Previous Version of HP Business Availability Center” on page 531.

Tasks
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Map Groups and Synchronize Users

This task describes how to map LDAP groups to HP Business Availability 
Center groups, and how to synchronize LDAP users with HP Business 
Availability Center users:

This task includes the following steps:

➤ “Configure the LDAP Server for Mapping Groups” on page 528

➤ “Create HP Business Availability Center Groups and Hierarchy” on page 528

➤ “Map LDAP Groups to HP Business Availability Center Groups” on page 528

➤ “Enable User Synchronization” on page 530

 1 Configure the LDAP Server for Mapping Groups
You enable the LDAP server for Group Mapping, using the Authentication 
Wizard. For details on how to perform this task, see “Authentication Wizard 
- Introduction Page” on page 500.

 2 Create HP Business Availability Center Groups and Hierarchy
You create local groups in HP Business Availability Center with the 
appropriate roles to nest users into, and users adopt the permission level of 
the group they are nested in. For details on how to perform this task, see 
“Groups/Users Pane” on page 475.

 3 Map LDAP Groups to HP Business Availability Center Groups
You map user groups on the LDAP server to groups in HP Business 
Availability Center. 
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Important: Administrators must do one of the following, to avoid being 
locked out of HP Business Availability Center when logging out after 
enabling the LDAP server but before configuring group mapping and user 
synchronization: 

➤ Ensure that they have mapped their own group, to enable logging into 
HP Business Availability Center after enabling User Synchronization.

➤ Create an account in HP Business Availability Center with superuser 
permissions.

 a On the Users and Permissions interface, navigate to the Groups/Users 
pane, click the LDAP Configuration button and select Group Mappings 
to open the Group Mappings dialog box.

 b In the <Repository Name> Remote Repository pane, select a remote 
LDAP server group and click Assign Groups. 

The HP Business Availability Center groups mapped to the selected LDAP 
group are displayed in the BAC Local Repository for Remote Group: <group 
name> pane. 
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Existing mapping of all LDAP groups is displayed in the Local Groups to 
Remote Groups Mapping pane.

 4 Enable User Synchronization
You enable synchronization of user groups on the LDAP server with user 
groups in HP Business Availability Center by configuring the relevant 
settings on the LDAP Users Synchronization Configuration page in the 
Authentication Wizard. 
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Note: 

➤ Before enabling user synchronization, ensure that you have either 
created a superuser account in HP Business Availability Center that 
matches your own LDAP user login, or mapped an appropriate LDAP 
group to an HP Business Availability Center group that has the superuser 
role assigned to it. If you have not done so, and log out of HP Business 
Availability Center after enabling LDAP but before group mapping is 
completed and user synchronization is enabled, the designated 
HP Business Availability Center superuser account will be locked out of 
HP Business Availability Center. 

➤ To disable user synchronization and enable management of users 
through the User Management interface in HP Business Availability 
Center, clear the Enable User Synchronization checkbox on the LDAP 
Users Synchronization Configuration page in the Authentication Wizard. 

For details on synchronizing users through the Authentication Wizard, see 
“LDAP Users Synchronization Configuration Page” on page 509.

Synchronize Users After Upgrading from a Previous 
Version of HP Business Availability Center

To synchronize LDAP and HP Business Availability Center users after 
upgrading from a previous version of HP Business Availability Center: 

 1 If you have upgraded from a version prior to HP Business Availability Center 
7.50, ensure that the Enable User Synchronization checkbox on the LDAP 
Users Synchronization page of the Authentication Wizard is cleared. 

 2 Ensure that LDAP groups have been mapped to HP Business Availability 
Center groups. For details on performing this task, see “Map Groups and 
Synchronize Users” on page 528.

 3 Navigate to the LDAP Users Synchronization page in the Authentication 
Wizard, and select the Enable User Synchronization checkbox. 
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Modify the Attribute Used to Log into HP Business 
Availability Center

This task describes how to modify the LDAP attribute with which you want 
to log into HP Business Availability Center.

To modify the LDAP attribute with which you want to log into HP Business 
Availability Center:

 1 Navigate to Admin > Platform > Users and Permissions > Authentication 
Strategy. 

 2 Click the Configure button to activate the Authentication Strategy Wizard.

 3 Navigate to the LDAP General Configuration page, and click the Advanced 
button.

 4 Modify the User unique ID attribute to the attribute you want to log in with, 
as it appears on the LDAP server.

Delete Obsolete Users

This task describes how to delete HP Business Availability Center users who 
no longer exist on the LDAP server. 

This option is enabled only if the following conditions are met: 

➤ The Remote user repository mode on the Authentication Strategy page is set 
to Enabled.

➤ The user has Delete permissions.

To delete obsolete users:

 1 Select Admin > Platform > Users and Permissions, click the LDAP 
Configuration button in the Groups/Users pane, and select Delete Obsolete 
Users.

 2 Select the user you want to delete. 
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Troubleshooting and Limitations

If you have configured HP Business Availability Center to use LDAP 
Authentication and are unable to log into HP Business Availability Center, 
see the HP Software Self-solve knowledge base 
(http://h20230.www2.hp.com/selfsolve/document/KM547160). To enter the 
knowledge base, you must log in with your HP Passport ID.
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24
Lightweight Single Sign-On 
Authentication – General Reference

This chapter provides general reference information on the Lightweight 
Single Sign-On (LW-SSO) authentication strategy, applicable to LW-SSO 
version 2.2.

This chapter includes:

Reference

 ➤  About Lightweight Single Sign-On on page 535

 ➤  LW-SSO System Requirements on page 536

 ➤  HP Products Integrated with LW-SSO on page 537

 ➤  Web Single Sign-On – Use Cases on page 537

 ➤  LW-SSO Limitations on page 539

 ➤  LW-SSO Security Warnings on page 543

 ➤  LW-SSO Important Information on page 545

 ➤  Troubleshooting LW-SSO on page 546
Reference

About Lightweight Single Sign-On

Single Sign-On is a method of access control that enables a user to log on 
once and gain access to the resources of multiple software systems without 
being prompted to log on again. The applications inside the configured 
group of software systems trust the authentication, and there is no need for 
further authentication when moving from one application to another.
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The default single sign-on authentication strategy for HP Business 
Availability Center is Lightweight Single Sign-On (LW-SSO). LW-SSO is 
embedded in HP Business Availability Center and does not require an 
external machine for authentication.

LW-SSO System Requirements

The requirements for LW-SSO configuration, per application, are as follows:

Application Version Comments

Java 1.5 and higher N/A

HTTP Sevlets API 2.1 and higher N/A

Internet Explorer 6.0 and higher Browser should enable 
HTTP session cookie 

and HTTP 302 Redirect 
functionality

FireFox 2.0 and higher Browser should enable 
HTTP session cookie 

and HTTP 302 Redirect 
functionality 

Jboss 
Authentications

Jboss 4.0.3

Jboss 4.3.0

Tomcat 
Authentications

Standalone Tomcat 
5.0.28 

Standalone Tomcat 
5.5.20 

N/A

Acegi 
Authentications 

Acegi 0.9.0 

Acegi 1.0.4 

N/A

Web Services 
Engines 

Axis 1 - 1.4 

Axis 2 - 1.2 

JAX-WS-RI 2.1.1

N/A
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HP Products Integrated with LW-SSO 

The HP products that are currently integrated with the LW-SSO 
authentication strategy are:

Web Single Sign-On – Use Cases

This section describes the use cases of LW-SSO via the Web.

This section includes: 

➤ “Login Use Case” on page 538

➤ “Logout Use Case” on page 538

➤ “Application Checks if Request Is Secured” on page 539

HP Product Version

Universal CMDB 8.02

NNMi and SPi 8.11

Operations Orchestration 7.5

SAR (Service Automation Reporter) 7.5

SiteScope 10.0

Release Control 4.10
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Login Use Case
The login use case is as follows:

 1 The application authenticates the user.

 2 The application creates a user context using one of the 
SecurityContextFactory methods:

 3 The application enables Single Sign-On.

Note: The weakest authentication framework used by the LW-SSO integrated 
applications determines the level of authentication security for all of the 
applications. It is recommended that only applications using strong and 
secure authentication frameworks issue an LW-SSO token. 

Logout Use Case
A logout is declarative in LW-SSO. The logout pages are configured in the 
LW-SSO infrastructure configuration file.

When an application requests a logout URL, LW-SSO cleans the security 
context.

// The application creates user context with SecurityContextFactory.
// Please find below one example. Application can use any API of 
SecurityContextFactory
String userName = "Bob";
SecurityContextFactory factory = 
SecurityContextFactoryUtils.getSecurityContextFactory();
SecurityContext securityContext = factory.createSecurityContext(userName);

LWSSOUtils.enableSSO(servletRequest, servletResponse, securityContext);



Chapter 24 • Lightweight Single Sign-On Authentication – General Reference

539

Application Checks if Request Is Secured
LW-SSO uses the isRequestSecured function to verify that the request is 
secured. This function is used when the LWSSOUtils.getSecurityContext 
returns a value of null, and the application wants to distinguish the 
following:

➤ You want to access a protected resource in the application without being 
authenticated, and a login screen is shown.

➤ You want to access the login page or a resource that is not protected (for 
example, help documents).

By default, all URLs are secured, but the LW-SSO infrastructure is configured 
with non-secure URLs.

If user accesses the non-secure URLs, the function returns a value of false.

If secure URLs are accessed, it returns a value of true.

Note: The method returns the correct answer only when the LW-SSO Filter is 
used.

LW-SSO Limitations

This section describes limitations of the LW-SSO configuration:

➤ Accessing the application:

➤ If a domain is defined in the LW-SSO configuration:

➤ The client must access the application with the Fully Qualified 
Domain Name (FQDN) in the login URL, for example: 
http://myserver.companydomain.com:8080/WebApp

➤ LW-SSO does not support URLs with an IP Address, or URLs without a 
domain.

boolean isSecured = LWSSOUtils.isRequestSecured(servletRequest);
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➤ If a domain is not defined in the LW-SSO configuration:

The client can access the application without the FQDN in the login 
URL. 

Note: In this case a LW-SSO session cookie will be created specifically for 
a single machine without any domain information, and therefore will 
not be delegated by the browser to another and will not pass to other 
computers located in the same DNS domain. This means that SSO will 
not work in the same Domain.

➤ LW-SSO framework integration:

Applications can leverage and use LW-SSO capabilities only if integrated 
within the LW-SSO framework in advance. 

➤ JAAS Realm:

The JAAS Realm in Tomcat is not supported.

➤ Using spaces in tomcat directories:

Using spaces in Tomcat directories is not supported.

It is not possible to use LW-SSO when a Tomcat installation path (folders) 
includes spaces (for example, Program Files) and the LW-SSO configuration 
file is located in the common\classes Tomcat folder.

➤ Load balancer configuration:

A load balancer deployed with LW-SSO must be configured to use sticky 
sessions.

➤ Multi-Domain Support:

➤ Multi-domain functionality is based on the HTTP referrer. Therefore, LW-
SSO supports links from one application to another and does not support 
typing a URL into a browser window, except when both applications are 
in the same domain.

➤ The first cross domain link using HTTP POST is not supported.
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Multi domain functionality does not support the first HTTP POST request 
to a second application (only the HTTP GET request is supported). For 
example, if your application has an HTTP link to a second application, an 
HTTP GET request is supported, but an HTTP FORM request is not 
supported. All requests after the first can be either HTTP POST or HTTP 
GET.

➤ LW-SSO Token size:

The size of information that LW-SSO can transfer from one application in 
one domain to another application on another domain is limited to 15 
Groups/Roles/Attributes (note that each item may be an average of 15 
characters long). 

➤ Linking from Protected (HTTPS) to Non protected (HTTP) in a Multi 
domain scenario: 

Multi domain functionality does not work when linking from a protected 
(HTTPS) to a non protected (HTTP) page. This is a browser limitation 
where the referring header is not sent when linking from a protected to a 
non-protected resource. For an example, see: 
http://support.microsoft.com/support/kb/articles/Q178/0/66.ASP

➤ Third-Party cookies behavior in Internet Explorer: 

Microsoft Internet Explorer 6 contains a module that supports the 
"Platform for Privacy Preferences (P3P) Project", meaning that cookies 
coming from a Third Party domain are by default blocked in the 
"Internet" security zone. Session cookies are also considered Third party 
cookies by IE, and therefore are blocked, causing LW - SSO to stop 
working. For details, see: http://support.microsoft.com/kb/323752/en-us. 

To solve this issue, add the launched application (or a DNS domain 
subset as *.mydomian.com) to the "Intranet"/"Trusted" zone on your 
computer (on Microsoft Internet Explorer, select Menu > Tools > Internet 
Options > Security > Local Intranet > Sites > Advanced), which causes the 
cookies to be accepted. 

Important: The LW-SSO session cookie is only one of the cookies used by 
the Third party application that is blocked. 

➤ SAML2 token:

➤ Logout functionality is not supported when the SAML2 token is used.
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Therefore, if the SAML2 token is used to access a second application, 
then a user who logs out of the first application will not be logged out of 
the second application.

➤ The SAML2 token's expiration is not reflected in the application's session 
management.

Therefore, if the SAML2 token is used to access a second application, 
then each application's session management will be handled 
independently of each other.

➤ IdM security and outbound web services:

Applications that are integrated with LW-SSO, that use IdM security as the 
security token for outbound web service security, will not be able to create 
or issue LW-SSO security tokens for UI (either automatically created or else). 

In this case, the LW-SSO configuration must include the following values:

➤ enableAutoCreation = "false"

➤ enableCookieCreation = "false"
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➤ Security context:

The LW-SSO security context supports only one attribute value per attribute 
name.

Therefore, when the SAML2 token sends more than one value for the same 
attribute name, only one value is accepted by the LW-SSO framework.

Similarly, if the IdM token is configured to send more than one value for the 
same attribute name, only one value is accepted by the LW-SSO framework.

➤ Multi-domain logout functionality when using Internet Explorer 7: 

Multi-domain logout functionality may fail when using Internet Explorer 7 
and when the application is invoking more then 3 consecutive HTTP 302 
redirect verbs in the logout procedure. 

In such a scenario, Internet Explorer 7 may mishandle the HTTP 302 
redirect response and display an "Internet Explorer cannot display the 
webpage" error page instead.

As a workaround, it is recommended that, if possible, you reduce the 
number of application redirect commands in the logout sequence.

➤ When using the LW-SSO Demo mode:

LW-SSO supports links from one application to another but does not 
support typing a URL into a browser window due to an HTTP referrer header 
absence when this mode is used.

LW-SSO Security Warnings

This section describes security warnings that are relevant to the LW-SSO 
configuration:

➤ Enable LW-SSO only if required:

LW-SSO should be disabled unless it is specifically required.

➤ Level of authentication security:
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The application that uses the weakest authentication framework and issues a 
LW-SSO token that is trusted by other integrated applications determines 
the level of authentication security for all the applications.

It is recommended that only applications using strong and secure 
authentication frameworks issue an LW-SSO token. 

➤ Confidential InitString parameter in LW-SSO: 

LW-SSO uses Symmetric Encryption to validate and create a LW-SSO token. 
The initString parameter within the configuration is used for initialization 
of the secret key. An application creates a token, and each application using 
the same initString parameter validates the token.

Note: 

➤ It is not possible to use LW-SSO without setting the initString parameter.

➤ The initString parameter is confidential information and should be 
treated as such in terms of publishing, transporting, and persistency.

➤ The initString parameter should be shared only between applications 
integrating with each other using LW-SSO.

➤ It is recommended to use at least 12 characters for the initString 
parameter.

➤ Symmetric encryption implications: 

LW-SSO uses symmetric cryptography for issuing and validating LW - SSO 
tokens. Therefore, any application using LW-SSO can issue a token to be 
trusted by all other applications sharing the same initString. This potential 
risk is relevant when an application sharing an initString either resides or is 
accessible in an untrusted location.

➤ User mapping (Synchronization): 

The LW-SSO framework does not ensure user mapping between the 
integrated applications. Therefore, the integrated application must monitor 
user mapping. We recommend that you share the same user registry (as 
LDAP/AD) among all integrated applications. 
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Failure to map users may cause security breaches and negative application 
behavior, such as the same user name being assigned to different real users 
in the various applications.

In addition, in cases where a user logs onto an application (AppA) and then 
accesses a second application (AppB) that uses container or application 
authentication, the failure to map the user will force the user to manually 
log onto AppB and enter a username. If the user enters a different username 
than was used to log onto AppA, the following unexpected behavior can 
arise: If the user subsequently accesses a third application (AppC) from 
AppA or AppB, then they will access it using the usernames that were used 
to log onto AppA or AppB respectively.    

➤ Identity Manager: 

Used for authentication purposes, all unprotected resources in the Identity 
Manager must be configured with the nonsecureURLs setting in the LW-SSO 
configuration. 

➤ LW-SSO in Demo mode:

➤ The LW-SSO Demo mode should be used for demonstrative purposes 
only.

➤ The Demo mode should be used in unsecured networks only.

➤ Do not use the Demo mode with the Production mode. Any combination 
of the Demo mode with the Production mode should not be used.

LW-SSO Important Information

This section contains important information regarding LW-SSO.

➤ LW-SSO Token expiration. The LW-SSO Token's expiration value determines 
the application's session validity. Therefore, its expiration value should be at 
least the same value as that of the application session expiration value.

➤ Recommended configuration of the LW-SSO Token expiration. Each 
application using LW-SSO should configure token expiration. The 
recommended value is 60 minutes. For an application that does not require 
a high level of security, it is possible to configure a value of 300 minutes.
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➤ GMT time. All applications participating in an LW - SSO integration must 
use the same GMT time with a maximum difference of 15 minutes.

➤ Multi-domain functionality. Multi-domain functionality requires that all 
applications participating in LW-SSO integration configure the 
protectedDomains settings, if they are required to integrate with 
applications in different DNS domains. In addition, they must also add the 
correct domain in the lwsso element of the configuration.

➤ Get SecurityToken for URL functionality. To receive information sent as a 
SecurityToken for a URL from other applications, the host application 
should configure the correct domain in the lwsso element of the 
configuration.

Troubleshooting LW-SSO

The following tables describe potential problems that can occur with LW-
SSO, and possible solutions for these problems.

This section includes:

➤ “LW-SSO Related Use Cases” on page 547

➤ “SAML2 Related Use Cases” on page 550
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LW-SSO Related Use Cases

Problem Possible Cause Possible Solution

LW-SSO cookie 
is not created 
after logging 
in.

A domain is not defined 
properly in the LW-SSO 
element of the configuration. 

Make sure that the domain 
defined in the LW-SSO 
element of the configuration 
is equal to the application's 
domain.

A domain that is passed as a 
parameter to the enableSSO 
function is not correct.

Make sure that the domain 
that is passed as a parameter 
to the enableSSO function is 
equal to the application's 
domain.

You did not access the 
application with the Fully 
Qualified Domain Name 
(FQDN) in the login URL 
when a domain is defined in 
the LW-SSO configuration. For 
example, 
http://192.168.12.13/WebApp.

Make sure that you access the 
application with the Fully 
Qualified Domain Name 
(FQDN) in the login URL. For 
example, 
http://myserver/companydomai
n.com/WebApp.

LW-SSO fails to 
create a cookie 
for 
AutoCookieCr
eation 
functionality.

A domain is not defined 
properly in the LW-SSO 
element of the configuration. 

Make sure that the domain 
defined in the LW-SSO 
element of the configuration 
is equal to the application's 
domain.
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The LW-SSO 
token is not 
validated.

The two applications have 
different initString parameters 
in the crypto element of the 
configuration (or other crypto 
parameters).

Use the same initString in 
both applications (in addition 
to all other crypto parameters 
in the LW-SSO creation 
element).

Some applications have a 
GMT time difference greater 
than 15 minutes. 

Make sure that all applications 
participating in a LW - SSO 
integration are set to the same 
GMT time, with a maximum 
difference of 15 minutes.

A domain is not defined in 
the LW-SSO element of the 
configuration, and you 
accessed a second application 
on another computer with the 
same DNS domain.

Add a domain to the LW-SSO 
element and make sure that 
the domain is defined as being 
equal to the application’s 
domain.

Problem Possible Cause Possible Solution



Chapter 24 • Lightweight Single Sign-On Authentication – General Reference

549

LW-SSO fails to 
validate the 
LW-SSO token 
in a multi 
domain 
environment.

In the configuration of one of 
the applications, a domain is 
not defined properly in the 
LW-SSO element.

The domain defined in the 
LW-SSO element of the 
application’s configuration 
must be the same as the 
application’s domain 
according to real domains in 
use.

In the configuration of one of 
the applications, a domain is 
not defined correctly in the 
protectdDomains list.

Make sure that the domains in 
the protectedDomains list 

of all of the applications' 
configurations are defined 
correctly.

The LW-SSO session cookie is 
blocked/denied when using 
the Internet Explorer 6.0 or 
7.0 browsers.

Add all LW-SSO servers to the 
"Intranet"/"Trusted" zone in 
the Internet Explorer security 
zones on your computer 
(Tools > Internet Options > 
Security > Local Intranet > 
Sites > Advanced). This will 
allow all cookies to be 
accepted. 

Some applications have 
different initString parameters 
in the crypto element of the 
configuration (or other crypto 
parameters).

Use the same initString in all 
applications (in addition to all 
other crypto parameters in the 
LW-SSO creation element).

Some applications have a 
GMT time difference greater 
than 15 minutes. 

Make sure that all applications 
participating in a LW - SSO 
integration are set to the same 
GMT time with a maximum 
difference of 15 minutes.

Multi domain link goes from 
the protected (HTTPS) to the 
Non protected (HTTP) 
resource. 

When linking/crossing from 
one domain to another, make 
sure that the first link/cross 
request goes from one 
protected resource (HTTPS) to 
another protected resource 
(HTTPS). 

Problem Possible Cause Possible Solution
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SAML2 Related Use Cases

Problem Possible Cause Possible Solution

LW-SSO fails to 
issue a SAML2 
Token.

A keystore configuration for 
SAML2 creation is not valid 
and most likely does not point 
to a valid keystore. 

Make sure that the keystore 
configuration for SAML2 
creation is valid and points to 
a valid keystore.

A privateKeyAlias or 
privateKeyPassword 
configuration for SAML2 
creation is not valid. They 
might not be pointing to a 
valid private key.

Make sure that the 
privateKeyAlias or 
privateKeyPassword 
configuration for SAML2 
creation is valid and point to a 
valid private key.

LW-SSO fails to 
validate the 
SAML2 token. 

A keystore configuration for 
SAML2 validation is not valid. 
It most likely does not point 
to a valid keystore. 

Make sure that the keystore 
configuration for SAML2 
validation is valid and points 
to a valid keystore.

A certificate used for signing is 
not imported in the 
configured keystore with a 
required public key alias. Note 
that the public key alias may 
be configured in the SAML2 
validation configuration or it 
can be passed in SAML2 token 
by the issuer.

Make sure that the certificate 
used for signing in is imported 
in the configured keystore 
with a required public key 
alias.

LW-SSO fails to 
receive all 
roles or 
groups. 

The element’s 
roleAttributeName or 
groupAttributeName defined 
in the SAML2 configuration is 
different then the one 
configured in the applications' 
configurations element. 

Make sure that the elements 
roleAttributeName or 
groupAttributeName is 
defined equally in all of the 
applications' configurations as 
in the SAML2 configuration.
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